User Manual PlaﬂtPAX

Distributed Control System
Original Instructions

PlantPAx Distributed Control System
Infrastructure Configuration

System Release 4.5
W i 1\\ ‘!

Rockwell
@ Allen-Bradley - Rockwell Software  AAUITOMation



Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws,
and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are
required to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may
be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from
the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or

liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation,
Inc., is prohibited

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous
environment, which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

> D>

IMPORTANT  Identifies information that is critical for successful application and understanding of the product.

Labels may also be on or inside the equipment to provide specific precautions.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may
reach dangerous temperatures.

ARCFLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).

B> > >
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Preface

The PlantPAx” system provides a modern approach to distributed control by
using common technology (integrated architecture) shared with all other
automation disciplines within the plant. This approach creates a seamless
information flow across the plant to create optimization opportunities and
enables a Connected Enterprise.

Our scalable platform provides you with the flexibility to implement a system
appropriate for your application. Figure 1 shows the documents (this manual in
the highlighted section) that are available to help design and implement your
system requirements.

Figure 1 - PlantPAx System Implementation and Documentation Strategy

Define and
Procure

« Selection Guide
PROCES-SG001

- Instal

9528-UM001

_ _
Prep Develop - Operate
\ y _ _
« Virtualization User Manual » Infrastructure User Manual  « Application User Manual « Verify and Troubleshoot User Manual
PROCES-UM001 PROCES-UMO003 PROCES-UM004
+ Reference Manual + Reference Manual + Reference Manual

« Library of Process Objects
PROCES-RM002
PROCES-RM013
PROCES-RM014

¢ Define and Procure — Helps you understand the elements of the PlantPAx
system to make sure that you buy the proper components.

o Install - Provides direction on how to install the PlantPAx system.

o Prep - Provides guidance on how to get started and learn the best
practices to follow before you develop your application.

o Develop — Describes the actions and libraries necessary to construct your
application that resides on the PlantPAx system.

o Operate — Provides guidance on how to verify and maintain your systems
for operation of your plant.

Purpose of the User Manual

This manual provides screen facsimiles and step-by-step procedures to configure
infrastructure components for your system requirements. While flexibility and
scalability are among the strengths of the PlantPAx system, we offer suggestions,
such as how to set IP addresses and naming conventions, to help you get started.
We suggest that you perform the tasks in the order that is outlined in each
chapter. However, we explain each procedure from the start to help you reference
specific topics if you choose to skip around to other chapters.

Each chapter has a flowchart that summaries the topics, similar to a mini
Table of Contents. See page 10 for descriptions of the tools that are used in

the documentation.
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Preface

New and Updated This table contains the changes that are made to this revision.
Information Topic Page
PlantPAx infrastructure revised with three network layers: Supervisory, Control, and I/0. | 16
Procedures added for security exception for CRYPTO version of Stratix® switches. 22
Control network switch configurations added to Chapter 1. 37
Terminal emulator interface and Port Link Aggregation (EtherChannel) procedures added. | 41
PlantPAx system common topologies added to Chapter 2. 46
/0 Network switch configuration procedures include Star, Ring, and Redundant Star. 52
Parallel Redundant Protocol (PRP) and Redhox functionality added for 1/0 Network. 63
Reverse DNS Lookup Zone aids database search for computer name via IP address. 923
IP address scope and range added for Control and Supervisory Networks. 104,107
Group policy procedures include units, roles, and areas. 118,119,121
Password strength, account lockout, network authentication policies added to group 148,150, 154
policy management.
Procedures added to import roles and areas. 187,189
Shortcut configuration paths added for enabling redundant controllers. 267
Security codes revised for user permissions on workstations. 288
PIPerMon interface procedures added to enhance evaluation of system performance. 373
Manual Conventions For instructional purposes, this manual uses visual tools to complement the

procedures. Icons that represent system elements are shown at the start of a
section to help identify the system element that is being configured in the steps.

The abbreviation for an element is listed with the icon for identification as shown

in the example.

Use a domain controller

with these procedures <«— System Element Description

<«——— System Element Icon

PADCA 4———— System Element Identifier (see Table 1)

See page 11 for visual naming conventions.
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Table 1 - Visual Naming Conventions

See Table 1 for descriptions and abbreviations of the system element icons.

Icon Description Abbreviation Element Names Topic Page
Stratix switch « Stratix 5400 or Stratix 5410 Layer 2 access switch 16,21, 29, 31, 33,35,
ﬁ « Stratix 5700 Layer 2 access switch 38,53, 59, 55,56, 58,
63,64,68,71,72
— Stratix switch « Stratix 5400 or Stratix 5410 Layer 3 distribution switch | 16,21, 29, 31, 33, 35,
o 37,39,63,73,231,
A 232
PlantPAx Domain controllers « PADCA™") - PlantPAx parent domain controller 79, 86,93, 99,102,
« PADCBY - PlantPAx child domain controller 116,118, 133, 140,
143,148,150, 154,
155,158, 160, 161,
163,231,232, 234,
344,373
PlantPAx workstations « OWS01% - Operator workstation 16,20, 113,167,177,
« EWS01® - Engineering workstation 185,191,193, 197,
199, 205, 207, 210,
212,213,217, 231,
232,236,239, 234,
245,247,254, 261,
281,284,288, 293,
379, 386, 387, 390,
395, 396, 398, 405,
411,413
PlantPAx Application servers « ASISOT - AppServ-Info SQL server 16,37,38,39,113,
« ASIHOT - AppServ-Info Historian server 116,167, 231, 232,
« ASIV01 - AppServ-Info VantagePoint® server 315,319,321,324,
+ ASAMOT - AppServ-Asset Management server 326,327,331,334,
“ « ASBMOT - AppServ-Batch server 336, 342, 346, 370,
+ ASEWSO01 - AppServ-Engineering Workstation server 375,379, 382, 386,
« ASOWSO1 - AppServ-Operator Workstation server 390, 395, 399, 405
Firewall Firewall 231
PASS + PASSO1 - FactoryTalk® directory 16,175, 239, 257, 260,
(Process Automation System Server) o PASSO2A - Primary HMI server 284,331, 334,336,
« PASS02BY - Secondary HMI server 342,349, 358, 359,
362,367,370
Logix controllers + LGXCO1 - Controller 16, 58,59, 63, 64, 68,
+ LGXC02 - Controller 73,231,232,248, 250,
252,267,269, 274

(1) A ="Parent and/or Primary element
(2) B=AChild and/or Secondary element

(3) EWSand OWS are used throughout the manual but the same procedures apply for AppServ-EWS and AppServ-OWS.

Default User Name

In this manual, we use ‘Admin’ and ‘Administrator’ as referenced user names in
sample screen examples. But, we recommend that you do not use these user
names in production.
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Rebranding of FactoryTalk Linx Software

As of version 6.00, RSLinx" Enterprise software is known as
FactoryTalk Linx software.

Action Identifier

Dialog boxes have red boxes to identify areas that require some type of user
action, such as to type text or click ‘Next’.

The Directory Services Restore Mode Adminiztrator account is different fron the domain
Administrator account.

Azzign a pazsword for the Administrator account that will be uzed when this damain
controller iz started in Directony Services Festore Mode, 'We recommend that you
chooge a ghrong pazsword,

Pagzaword: TIIITIITY

LCanfirmn paszward: seassnsns

tore about Directory Services Restore Mode password

COnfigure Programs Menu We strongly suggest that you perform the following procedure in the system

computers to group folders under ‘Programs’ on the taskbar. When complete, you

access Windows and software folders by clicking the Programs E symbol.

1. Click the Windows symbol.
2. Click Control Panel and choose Folder Options.

The Folder Options dialog box appears.
Folder Options -

| General I_VIEW i-Seart:h |

Folder views
You can apply this view (such as Details or lcons) to

all folders of this type.
Beeset Folders

Advanced settings:

Files and Folders ~
Always show icons, never thumbnails
[] Mways show menus

Display file icon on thumbnails

Display file size information in folder tips
[] Display the full path in the titls bar
Hidden files and folders

Hide extensions for known file types

Hide folder merge conflicts w
ok || Cancd |[ Appy |
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3. On the View Tab, select ‘Show hidden files, folders, and drives’
and click OK.

4. Right-click in the taskbar, click Toolbars, and choose New Toolbar.

Toolbars 3 | Address
| Cascade windows Links
| Show windows stacked Desktop
| Show windows side by side MNew toolbar...
Show the desktop
| Task Manager
' Lock the taskbar
- e Properties

5. On the New Toolbar window, designate a path for your Programs folder.

For example:
C:\ProgramData\Microsoft\Windows\StartMenu\Programs.

Organize *  New folder

‘E] Recentplaces |~ Name Date modified Type

. Accessibility 8/22/2013 11:39 AM  File folder
. Administrative Tools 8/12/20159:06 AM  File folder
L CGCM 8/12/2015 &:21 AM File folder
| Embedded Lockdown Manager 11/22/201412:06 ... File folder
| Hiprom Software 8/12/2015%:41 AM  File folder
. Maintenance 8/22/201311:39 AM  File folder
. Microsoft Office 8/14/20132:11 PM  File folder
U Microsoft SOL Server 2008 8/11/201311:16 PM  File folder
J Microsoft SOL Server 2008 R2 811/201511:16 PM  File folder

U Barlaell fdbnenatinn 27127918 2.71 AKA Filz faldar

18 This PC
u Desktop
j—j Documents
i. Downloads
ﬂ Music
_EI Pictures
i Videos
i, Local Disk (C2)

v

Folder: | Programs

Select Folder Cancel

6. Click Select Folder.
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Additional Resources

These documents contain additional information that concern-related products

from Rockwell Automation.

Resource

Description

PlantPAx Distributed Control System Selection Guide,
publication PROCES-SG001

Provides basic definitions of system elements and sizing
guidelines for procuring a PlantPAx system.

PlantPAx Distributed Control System Reference Manual,
publication PROCES-RM001

Provides characterized recommendations for
implementing your PlantPAx system.

PlantPAx Distributed Control System Application
Configuration User Manual, publication PROCES-UM003

Describes procedures to start development of your
PlantPAx distributed control system.

Rockwell Automation Library of Process Objects,
publication PROCES-RM002

Provides information on how to use the Rockwell
Automation Library of Process Objects.

Rockwell Automation Library of Process Objects: Logic
Instructions Reference Manual,
publication PROCES-RM013

Provides controller codes and tags for Rockwell
Automation Library objects. The objects are grouped by
family and attached as Microsoft Excel files to the man-
ual PDFfile.

Rockwell Automation Library of Process Objects: Display Ele-
ments Reference Manual,

publication PROCES-RM014

Provides common display elements for the Rockwell
Automation Library. Forimproved accessibility, the ele-
ments are combined into one manual.

Activate Rockwell Software® Products,
publication FTA-Q5002

Explains how FactoryTalk Activation generates
activation files and distributes them over the Internet to
activate software.

Converged Plantwide Ethernet (CPwE) Design and
Implementation Guide, publication ENET-TD001

Describes tested and validated industrial network
architectures, recommendations and best practices,
including network resiliency and security

Resilient Converged Plantwide Ethernet Architecture
Technical Data, publication ENET-TD010

Describes design considerations to implement a
scalable and secure CPwE architecture that helps
maximize plant efficiency.

Stratix Managed Switches User Manual,
publication 1783-UM007

Describes how to set up, configure, and troubleshoot
Stratix switches.

Embedded Switch Technology Reference Architectures,
publication ENET-RM003

Provides design recommendations for connecting
device-level topologies to larger, switch networks
comprised of Layer 2 access switches. Document also
covers the implementation of embedded switch
technology within the Converged Plantwide Ethernet
(CPwE) Cell/Area zone. The Cell/Area zone is where the
device-level topologies connect Industrial Automation
and Control System (IACS) end-devices into the
Cell/Area zone.

Securely Traversing IACS Data Across the Industrial
Demilitarized Zone Technical Data, publication ENET-TD009

Describes requirements and design considerations to
deploy an Industrial Demilitarized Zone (IDMZ) within
Industrial Automation and Control System (IACS)
plant-wide architectures.

Ethernet Design Considerations Reference Manual,
publication ENET-RM002

Explains the infrastructure components that allow this
open network to communicate seamlessly throughout
a plant, from shop floor to top floor.

Integrated Architecture® and CIP Sync Configuration
manual, publication |A-AT003

Explains CIP Sync technology and how you can
synchronize clocks within the Rockwell Automation®
Integrated Architecture® system.

PlantPAx Virtualization User Manual,
publication 9528-UM001

Describes the catalog numbers and details for using
virtual image templates to configure virtual machines.

You can view or download publications at

http://www.rockwellautomation.com/literature/. To order paper copies of

technical documentation, contact your local Allen-Bradley distributor or

Rockwell Automation sales representative.
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Chapter 1

Overview

Configure Network Infrastructure

A traditional distributed control system (DCS) is typically limited to a single
model option for servers, workstations, and network switches. A traditional
DCS provides specific configurations that are based on closed and fixed
networks. This traditional approach makes it difficult to manage I'T support
and integrate with business systems.

The PlantPAx” system leverages a more

modern approach, being open to '
commcrcifz)lll)off-thc-shefgf sfrvers, P’ an t P A /(
workstations, and servers. The PlantPAx Distributed Control System
system supports the adoption of the

latest IT technology for automation,

including virtualization. The use of virtualization breaks the dependency
between your server and workstation system elements from the specific
hardware that hosts those elements. By rationalizing to a common IT

infrastructure, companies can mitigate security risks and improve uptime to
help protect people, assets, and information.

However, without specific guidance, poor infrastructure configuration can
cause system performance and functionality of your control system to be
degraded. The PlantPAx System Infrastructure User Manual steps you through
the procedures that are necessary to prepare your system infrastructure,
inclusive of operating systems and network configuration.

The performance of the PlantPAx system is dependent upon following the
sizing guidelines and application rules that are provided by the PlantPAx
Reference Manual. These rules and guidelines are developed through a process
called characterization.

Characterization is the activity of measuring system performance against key
operational criteria called Critical System Attributes (CSA). CSAs provide
specific recommendations for application sizing and system performance.
Follow the instructions that are contained in this manual to help make sure
that your control system is built as prescribed by the PlantPAx Reference
Manual and characterization.

If you have more complex requirements, you can take advantage of the
flexibility of the PlantPAx system. For more information, see Distributed
Control Systems under the Products webpage.

The Converged Plantwide Ethernet (CPwE) Design and Implementation
Guide provides a broader set of manufacturing focused reference architectures.
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Chapter1  Configure Network Infrastructure

The CPwE manual helps accelerate the deployment of standard networking
technologies and convergence of manufacturing and enterprise/business
networks. You also can engage technical specialists by using Network and
Support Services from Rockwell Automation”.

PlantPAx Topology Examples

This manual describes how to install infrastructure components,
including switches and routers, to serve as a blueprint for commissioning

a PlantPAx network.

Figure 2 is an example of a PlantPAx system topology for high availability. The
illustration comprises different network layers, including Supervisory,

Controller, and I/0O. Each of these network layers is described in Chapter 2.

Figure 2 - PlantPAx Architecture Example

Supervisory Network (VLAN 601)
Control Network (VLAN 501)
1/0 Network (VLAN 503)
MCC Network (VLAN 504))
Trunk - (Native VLAN 301)
EtherChannel

---------------- Secondary Connection
Logix Redundancy (RM)

Supervisory Network

Control Network

1/0 Network

PanelView™

16

Operators and
Engineering

Workstations

Application Servers
(hypervisor)

[ 1 0 [ |
ControlLogix® I/0 !

ePes

Field Devices
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Example: 172.18.0.2029)

VLAN Basics

A VLAN (virtual local area network) creates network segmentation that forms
network groups that are identified by VLAN IDs. The grouping of computers
into VLANS enables the switches and routers to control the flow of
information on a network.

IMPORTANT  Network Address Translation (NAT) is another way to enable network
segmentation by using switches and routers. But, we do not provide NAT
guidelines in this manual.

Switches are inter-connected through trunk ports. Trunk ports send
information from multiple VLANSs between switches.

A dedicated VLAN called native VLAN is defined on trunk ports. A native
VLAN transports, by default, all VLANs on a trunk port. But, a native VLAN
is isolated because of security concerns of mixing a native VLAN with access
and management VLANS. The native VLAN is not to have any assigned IP
addresses. By default, the native VLAN ID is 1 but it is recommended to
change it. For example, the native VLAN is assigned a VLAN ID of 301 in the
example in Table 2 on page 18.

All computers, controllers, and I/O modules are connected through access
ports. Access ports are assigned to a VLAN within the ID range of 501...509
and 601...603 depending on the device and your architecture.

We recommend implementing physical security, like plugging unused ports
and disabling ports that are not going to be used. For more information on
physical security recommendations, see the PlantPAx Distributed Control
System Reference Manual, publication PROCES-RMO001.

IMPORTANT  Itis recommended to use the Crypto firmware for Stratix switches to add
additional levels of security. The procedures in this section require the
Crypto firmware.

The instructions in this manual use IP addresses that have a CIDR (Classless
Inter-domain Routing), which contains a slash mark before a number. We
recommend that you use the number (24) that means that the first 24 bits of
the IP address constitutes the network address. In the example, the network
mask is configured to 255.255.255.0 for the routing functionality to work.

Subnets are used to segment the devices in a network into smaller groups. The
IP address and associated subnet mask are unique identifiers for the switch ina
network. The subnet mask is the network address that identifies the
subnetwork (subnet) to which the switch belongs.

IMPORTANT  Make sure that the IP address that you assign to the switch is not being used
by another device in your network.
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Table 2 describes typical VLANs and media access control (MAC) address
ranges that are suggested for use on the PlantPAx system. More VLANS can be
used depending on your configuration.

The following pages describe how to configure network segmentation with
switches on the Control and Supervisory networks.

Table 2 - Descriptions for VLANs and Ethernet Address Ranges“)

VLAN ID (Name) EtherNet/IP Address Range Description
1 — — Not used
300 (Management VLAN) 172.18.0.1 Default gateway
172.18.0.2 172.18.0.9 VLAN routing — switch addresses®)
172.18.0.10 172.18.0.253 Application - switch addresses
301 (Native VLAN) — — Not to have any assigned IP addresses
501 (Control network) 172.18.1.1 Default gateway
172.18.1.2 172.18.1.9 VLAN routing
172.18.1.10 — Domain/DNS primary server
172.18.1.11 Domain/DNS secondary server
172.18.1.12 172.18.1.99 Servers and workstations (DHCP)
172.18.1.100 172.18.1.253 Ethernet interface to controllers for HMI and system communication
502...509 (I/0 network) 172.18.2...1.1 172.18.[...9].1 Default gateway
172.18.[2...]12 172.18.[...91.9 VLAN routing
172.18.[2...]1.10 172.18.[...9].253 Ethernet interface between controllers and 1/0 modules (fixed)
6071 (Supervisory network - 172.20.1.1 172.20.1.1 Default gateway
wirednetwork) 172.20.1.2 172.20.1.9 VLAN routing
172.20.1.10 172.20.1.25 Workstation interface
602 (Supervisory network - 172.20.2.1 172.20.2.1 Default gateway
witeless network) 172.20.2.2 172.20.2.9 VLAN routing
172.20.2.10 172.20.2.253 Mobile interface
602 (External - untrusted network) | 172.20.3.1 172.20.3.1 Default gateway
Note: From IDMZ (industrial
demilitarized zone) 172.20.3.2 172.20.3.9 VLAN routing
172.20.3.10 172.20.3.253 External interface

(1) The referenced IP Addresses can be changed for your system requirements.
(2)  All networks do not use a dedicated management VLAN, but it is a good practice. Many times, a supervisory VLAN is the same VLAN as the management VLAN.
(3) Ifthere are more than eight Layer 3 switches on your system, more IP addresses must be reserved.

IMPORTANT  One network range is assigned per VLAN only. For example, the 172.18.1.xxx
network range is assigned to VLAN 501. Table 2 identifies nine VLANS for
access ports to provide logical segregation of your system. More VLANS can
be used, if necessary.
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Figure 3 lists the configuration topics that are described in this chapter. Click
the page number or the links for quick access to specific information in
each subsection.

Figure 3 - PlantPAx Network Infrastructure Workflow

Common Network Switch Configurations - Verify Workstation IP Address Settings
« (Configure the Switch Express Setup
See page 20 « Complete Switch Optimization
h 4 «  Enable Switch Routing
Control Network Switch Configuration - Configure EtherChannels (Link Aggregation)
- (Configure Switch Ports
See page 37 «Using a Terminal Emulator (PuTTY)
« Enabling IP Helper

See Chapter 2 Control Network Switch Configurations

« See page 53 for switch configurations for Star,
Ring (DLR), and Redundant Star (PRP)

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018

19



Chapter1  Configure Network Infrastructure

Common Network Switch
Configurations

Use an Engineering Workstation
with these procedures.

EWS

20

This section describes how to configure the Express Setup for each Stratix
switch. We recommend that you complete the tasks in the order that they are
listed. These tasks help to define IP addresses, create and assign VLANS, and

enable faster network convergence time with Rapid pvST+.)

Verify Workstation IP Address Settings

Before you start switch setup, you must verify that no fixed IP address is
assigned to the workstation that is being used to configure the switch. You
want the switch to manage the IP address configuration in your computer.

Complete these steps.

1. Click the Windows L symbol.

2. Click Control Panel and choose Network and Sharing Center>Change

adapter settings.

The Network Connections dialog box appears.

Right-click the network and choose Properties.

4. Double-click Internet Protocol Version 4 (TCP/IPv4).

The Internet Protocol Version 4 Properties dialog box appears.

Internet Protocol Version 4 (TCP/IPv4) Properties

General  Alternate Configuration

for the appropriate IP settings.

(@) Obtain an IP address automatically
(D) Use the following IP address:

(@ Obtain ONS server address automatically:

(C)Use the follawing DMS server addresses:

te setlings upon exit

You can get IP settings assigned automatically if your network supports
thiz capability, Otherwise, you need to ask your network administrator

[
[
=

Advanced. ..

Cancel

P

5. Select Obtain an IP address automatically and Obtain DNS server

address automatically, and click OK.

You are ready to assign an IP address to the switch by using the express setup.

See page 21.

(1) Default mode (MST) is comparably the same performance as RPVST+, just a different standard.
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Use Layer 2 and Layer 3 switches with these procedures.

\6/
Pan)
Stratix 54x0

Layer 3

Stratix 54x0

Layer 2
=

Stratix 5700
Layer2

Configure the Switch Express Setup

You must configure Switch Express Setup for each switch in your system. The
settings enable the switches to operate as managed switches with a default
configuration that supports industrial automation.

IMPORTANT  We walk you through how to configure a 5410 Stratix switch. The steps are
basically the same for different switch types. Make sure that for each switch

you repeat the steps on pages 21...36.

Initiate Express Setup

The following steps require a switch with factory defaults. An out-of-box
switch is ready for these steps. You can reset an existing switch by pressing the
Express Setup button for 16...20 seconds to default switch settings. After a
restart, the switch can be initialized.

1. On the Ethernet switch, press once on the Express Setup button (as
identified on the devices by red circles).

TIP  The Express Setup button is recessed in the hole. Use a small tool or
a paper clip to reach the button.

@50 T B @011 15ks |

[ ] =
sl=Isl=s]=Te]=] s =] u]=] w s WP o
5 . o o '@ju— o I.|-|:|I:I"
3 T 5
Q
£

aafa2&

Displey
Made

Stratix 5400

Stratix 5410
<p et
3 1=
S
Allen-Bradiey)|
n-or:
Streatix" Sgg)ey 0000 Q000"

o

Setup EIP EIP
Net Mad

Stratix 5700

2. Connect a network cable from your workstation to the flashing
switch port.

Continue with Configure Security Fxception on page 22.
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Configure Security Exception

We recommend that you use the Crypto version of Stratix switches. This
version provides a self-signed certificate to each switch. You must add a
security exception for the application to initialize each switch.

IMPORTANT  Our recommended web browsers are Internet Explorer and Mozilla Firefox.

1. Start a web browser session.

2. Type the IP address 169.254.0.1 into the browser and press Enter to
navigate to the switch that you are setting up.

Follow the browser message prompts in steps 3...5.

(& Insecure Connection *

@ hittps://169.254.0.1 ¢ Q Search wB ¥ & O &

Your connection is not secure

The owner of 169.254.0.1 has configured their website improperly. To protect your
information from being stolen, Firefox has not connected to this website.

Learn more...

Report errors like this to help Mozilla identify and block malicious sites

3. Click Advanced.
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4. Click Add Exception.
— 0 b
(1 Insecure Connection *x G
) hittps://169.254.0.1 @  Q Search wB ¥ # L =
el
Learn more...
Report errors like this to help Mozilla identify and block malicious sites
169.254.0.1 uses an invalid security certificate.
The certificate is not trusted because it is self-signed.
The certificate is not valid for the name 169.254.0.1.
Error code: SEC_ERROR_UNKNOWN_ISSUER
Add Exception...
5. Click Confirm Security Exception.
Add Security Exception X
. You are about to override how Firefox identifies this site.
_!_\‘ Legitimate banks, stores, and other public sites will not ask you to do this.
Server
0 A Rt ps:/ /160,254, | | Get Certificate
Certificate Status
This site atternpts to identify itself with invalid information, i
Wrong Site
The certificate belongs to a different site, which could mean that sormeone is trying to
impersonate this site,
Unknown ldentity
The certificate is not trusted because it hasn't been verified as issued by a trusted authority using
a secure signature.
Permanently store this exception
Confirm Security Exception Cancel
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6. On the switch Login page, leave the Username blank and type ‘switch’
for the default password.

TIP  The ‘switch’ password lets you continue to the Device Manager for
additional steps. We recommend that you change the default
password in step 2 on page 25.

— O x
Device Manager x4+
@ B https//169.254.0.1 ¢ Q Search w8 4+ & 9 & =
© Alen-Bradiey [k
arowsers ¥
Login
Username:
Password: I..lll" I
Log In Clear

7. Click Log In.
The Device Manager dialog box appears.

Continue to Configure a Switch in Device Manager on page 25.
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Configure a Switch in Device Manager

You must complete this section for each switch in your system to define
settings for managed switches. The Device Manager has two sections: Network

Settings and Advanced Settings (see page 26).

The Network Settings portion of the dialog box provides the ability to perform
the following:

e Name the switch
o Select the VLAN
o Set IP addresses

e Create a password (to replace the ‘switch’ default).

169.254.0.1 *x G

€ | © R https;/169.254.0.1/homed.shtm

Stratix 5410 Solution
Device Manager - Switch

Allen-Bradley

Express Setup

Select device inftial setup mode: Express Setup Y

¥ Network Settings

Host Name: [ swoo1

Management Interface (VLAN): 300

1P Assignment Mode: ® static O DHCP

IP Address: [172.18.0.1 | /' [255.255.255.0

Default Gateway:

NTP Server:

User: Password: Confirm Passward:

1. Type the switch configuration that is similar to the example shown in

the illustration and the IP addresses in Table 3.
Table 3 - Management Network IP Addresses

Host Name Management (VLAN) IP Address Mask Default Gateway NTP Server™

SWoo1 300 (management) 172.18.0.1 255.255.255.0 172.18.0.1 172.18.1.10

(1) NTP server can be a different address according to the Time Synchronization application option.

IMPORTANT  The IP addresses and default gateway for the 5410 switch example
are for illustration purposes only.

2. Type a user name.
Change the default admin’.
3. Type a password (which replaces the default ‘switch’).

Retype the password to confirm your entry.
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4. In the Advanced Settings, make sure that you click the SSH
(secure shell) checkbox.

SSH provides more security for remote connections than Telnet by
providing strong encryption.

¥ Advanced Settings

Enable CIP VLAN:
CIP VLAN: 33
IP Address: /
Same As Management VLAN:
Must be checked mmmm | Enable S5H:
Telnet |

CIP and Enable Password:(leave it
blank if no change)

Same As Admin Password

Confirm Password:

Submit |

S. Click Submit.

A message appears.

‘fou have chosen VLAN300. After you dick
Submit, The connection between the switch and
your laptop or PC ends. To manage the switch
through the device manager, enter the switch IP

address from a browser session, Make sure that
the switch and your management station are in
the same subnetwaork.,

See Table 4 on page 27 to configure additional managed switches in

your system.
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Table 4 - Network IP Addresses

6. Table 4 shows the IP addresses to be used with these procedures for each

switch in your system.

Host Name (Switch Type) | Management (VLAN) IP Address Mask Default Gateway NTP Servert")
SWo10 300 (Management) 172.18.0.10 255.255.255.0 172.18.0.1 172.18.1.10
SWo020 172.18.0.20

SWo022 172.18.0.22

SWo30 172.18.0.30

SWo40 172.18.0.40

SWo042 172.18.0.42

SWo043 172.18.0.43

SWo044 172.18.0.44

(1) NTP server can be a different address according to the Time Synchronization application option.
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Complete Switch Optimization

After you have completed the Express Setup procedures for all your system
switches, you must log in to each switch. The following pages describe how to
optimize switch operation for these functions:

o Createa VLAN
e Enable CIP VLAN

e Enable Rapid PVST+
o Enable Precision Time Protocol (PTP)

o Enable Simple Network Management Protocol (SNMP)

Login to Switches

Use your login name and password to access a desired switch.

1. On the workstation that is being used, change your network
adapter address to a fixed mode by following steps on page 21

through page 27.
Choose an IP address under the management network range

(172.18.0.xxx)/255.255.255.0/172.18.0.1. See suggestions in
Table 3 and Table 4.

2. Connect to another switch port.

3. Loginto the switch by using the same information that you entered on

the Device Manager on page 25.

Device Manager X+

€ | ® 8 hitpsy/172.18.0.1 @  Q Search wBe ¥ & @ &

© Alen-Bradiey [l

Supported browsers ¥

[%e}
8]

Login
Username: |admin |
Password: |l......ll |

Log In Clear

4. Click LogIn and proceed to page 29.
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Create a VLAN
_ , A VLAN segments switches and routers in specific subnets to control the flow
Use Layer 2 and Layer 3 switches with these procedures. . .
of information.
\6} I
Za ﬂ IMPORTANT  This procedure requires that the VLAN and IP addresses are assigned as
Stratix 54x0 Stratix 54x0 outlined in Table 2 on page 18. Do not use VLAN 1. The following example
Layer3 Layer2 is for switch SW001.
ﬂ 1. From the main menu of the Device Manager, click Configure and
Stratli( 5700 choose Network>VLAN Management.
ayer2
172.18.0.1 X 4+
€ D& https;//172.18.0.1/homed.shtml ¢ Q Search W B

@ Allen-Bradley Stratix 5410 Solution

Device Manager - Switch

#& Dashboard Monitor Admin

o Hetwork | VLAN Management

B Network B Security
Smartports NAT
To add or edit ports in a VLAN, use the Physical Port Settings page. Global Macros PorE Seduiy
Port Settings IGMP Snooping
VTP Mode :Transparent Port Thresholds SNMP
EtherChannels ACL

o= Add | 7 Edit 3 Delete 8 Alarms
Alarm Settings
VLAN ID MName Ports PHE A
Alarm Profiles
Q 4 default Gil/1

2. Click Add.
3. Create the native VLAN ID and click OK.
Our example is 301.

(®) Create a single VLAN

VLAN D
tiame

IP Assignment Mode: (8 Mo IP Address () Static ) DHCP

O Create a range of VLANs
VLAN Range

ook

IMPORTANT A native VLAN is separate from the infrastructure VLANs as well as
the other CIP VLANs that are used.
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4. Repeat step 2 and create a range of VLANS (501...509 and 601...603).

x
() Create a single VLAN
VLAN ID
x
Name
1P Assignment Mode:  No P Address  Static  DHCP O Sreatea shgl VAN
VLAN ID
Name
®) Create a range of VLANs IP Assignment Mode: Mo IP Address Static DHCP
VLAN Range | 501 | - [500 |
ml Cancel |
®) Create a range of VLANs
VLAN Range | 601 | - [s03 |
m Cancel |
= E
5. Click OK.
The VLANS appear as listed in the graphic.
— O =
172.18.0.1 b 4 +

€ @& httpsy//172.18.0.1/homed shtml e Q Search A ¥+ @ i =

Stratix 5410 Solution
@ A”en'Bradfey Device Manager - Switch
o Hetwork | VLAN Management

To add or edit ports in a VLAN, use the Physical Port Settings page.

VTP Mode :Transparent

/Edit 3¢ Delete

VLAN ID MName Ports VLAN Status | IP address
@ = default Git/1 Active
O 300 VLANO300 Gil/2, Gil/3, Gil/4, Gil/S, Gil/6, Gil/7, Gil/8, Gil/9, Gil/10, Gil/11, Gil/12, Gil/13, .. Active 172.18.0.1
O 30 Native Active
O s01 VLANO501 Active
O s02 VLAND502 Active
O s03 VLANO503 Active
O s04 VLANOS04 Active
O s0s VLANOS05 Active
O s06 VLANOS06 Active
O s07 VLANOS07 Active
O so8 VLANO508 Active
O so9 VLANO502 Active
O &01 VLANDB01 Active
O &2 VLANOB02 Active
O &03 VLANOGO3 Active
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Use Layer 2 and Layer 3 switches with these procedures.

\6}
N
Stratix 54x0

Layer 3

Stratix 54x0

Stratix 5700
Layer 2

Layer 2

Enable CIP VLAN

The CIP VLAN is used to create infrastructure diagnostics and configurations
in the application level. For our example, CIP VLAN is isolated from the
management VLAN (300).

Table 5 shows example IP addresses to be associated with the switches for
CIP VLAN.

Table 5 - Example CIP VLAN Conﬁguration“)

Host Name CIP (VLAN) IP Address Mask

SWo020 501 (Control network) 172.18.1.200 255.255.255.0
SWo022 172.18.1.202

SWo023 172.18.1.203

SWo030 172.18.1.210

Swo4o 172.18.1.220

SWo42 172.18.1.222

SWo43 172.18.1.223

SWo044 172.18.1.224

SWo045 172.18.1.225

(1)  Ifthere are more than eight switches on your system, more IP Addresses must be reserved. Additional switch IP Addresses start
with a higher number.

Complete these steps to configure CIP VLAN for each applicable switch.

1. From the main menu of the switch Device Manager, click the Admin tab
and choose Device Management>Express Setup.
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2. In the Advanced Settings section, type the information as shown

in Table S.

172.18.0.20

@ Allen-Bradley

o Device Management | Express Setup

Select device initial setup mode:

¥ Network Settings
Host Name:
Management Interface (VLAN):

IP Assignment Mode:

-

€ @& https;//172.18.0.20/homed

Stratix 5700 Solution

Device Manager - Switch

#& Dashboard Monitor

Configure

Express Setup

SDM-Template
Express Setup v Restart/Reset

Access Management
MTU

[ swozo

300 ¥
® static O DHCP

1P Address: [172.18.0.20 | / [255.255.255.0

Defaul: Gateway:

NTP Server: 172.18.1.10

» Advanced Settings

Enable CIP VLAN:

CIP VLAN: 501 ||

1P Address: [172.18.1.200 | / [255.255.255.0 |

Same As Management VLAN: O

CIP and Enable Password:{leave it blank if no change) Confirm Password:

=]

© 2009-2017 Rockwell Automation, Inc. ALL RIGHTS RESERVED.

Aarms @ 0 W12 4 0 B0

3. Click Submit.

IMPORTANT  SWO001 and SWO010 (Stratix 5410 switches) do not enable
CIP VLAN because these switches are not used in the
controller 1/0 configuration.
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Use Layer 2 and Layer 3 switches with these procedures.

Enable Rapid PVST+

Complete these steps for all switches to enable Rapid Per-VLAN Spanning

1
I ﬂ Tree Plus (Rapid PVST+). This functionality provides better convergence
T . . .
. time for communication.
Stratix 54x0 Stratix 54x0
Layer3 Layer 2

IMPORTANT  This procedure requires that the VLAN and IP addresses are assigned as
outlined in Table 4 on page 27. The following example is for SW0O1.

Stratix 5700
Layer2 . . . . '
1. From the main menu of the switch Device Manager, click Configure and
choose Network>Spanning Tree>STP Settings.
— O X
172.18.0.1 X 4+
€ O https;//172.18.0.1/homed.shtml [ Q Search ﬁ B ¥+ @ & =
Lal
Stratix 5410 Solution

@ A”en'Bfadfey Device Manager - Switch

0 Spanning Tree | STP Settings & nNetwork B security
Smartports NAT
Global Macros Port Security

Port Fast Port Settings IGMP Snooping
Port Thresholds SHMP
. EtherChannels ACL

Spanning Tree Mod Rapid PVST+ bt h
DHCP 9 Alarms

| Submit | VLAN Management Alarm Settings
Power Management Alarm Profiles
PTP

o= Add [ Edit  3Delete NTP
Routing

Instance VLANs Mapped . .
. nning Tree

O o 14004 * e
STP Settings
PRP

2. Select Rapid PVST+ from the Spanning Tree Mode pull-down, and
click Submit.

A warning message appears.

Changing the STP settings may cause the web

browser to lose connectivity to the device for a
while
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The Spanning Tree of all the VLANS is enabled.

| Submit |

— 8] =
172.18.0.1 X 4+
€ D& https;//172.18.0.1/homed.shtml c \ Search w B 4+ & QO &2 =

@ Allen-Bradley

o Spanning Tree | STP Settings

Port Fast

Spanning Tree Mode Rapid PVST+ hié

Stratix 5410 Solution

Device Manager - Switch

@& Dashboard Configure Monitor Admin

Spanning Tree Instances

VLAN ID VLAN Name Enable Spanning Tree Priority

1 default 32768 —

300 VLANG300 32768

301 Native 32768

501 VLANDS501 32768

502 VLAN0S502 32768

503 VLANOS03 32768 In order to create a predictable spanning tree

504 VLANOS04 12768 convergence, we recommend that you change the
s i AkaEHE Sl VLAN priorities (lower number is higher priority).
506 VLANO506 P For example, configure all SW00T VLANs with a
507 VLAN0507 32768 piizegéii

508 VLAN0S508 32768

509 VLANOS509 32768

601 VLANOGO1 32768 —

"0 20092017 Rockwel Automation, Inc. ALL RIGHTS RESERVED. PO y

IMPORTANT Do not enable Rapid PVST + if you have non-Cisco/Stratix switches
on your network. The use of Rapid PVST+ with non-Cisco/Stratix
switches could result in a longer convergence time after a fault
has occurred.
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Use Layer 2 switches with these procedures.

Enable Precision Time Protocol (PTP)

PTP functionality is necessary for end devices to operate in the same time
frame as with the clock that is deemed the Grandmaster clock. This section

Stratix 5400 Stratix 5700 describes how to enable PTP in switch ports.
Layer 2 Layer 2
For details on time synchronization, see Chapter 8.
1. From the main menu of the switch Device Manager, click Configure and
choose Network>PTP.
- O s
172.18.0.1 X 4
€ | @R https://172.18.0.1/homed.shtml (o) Q Search e 4§ & QO & =
Allen-Bradle Stratix 5410 Solution
@ y Device Manager - Switch & Dashboard Manitor Admin
© network | PR B network B security
Smartports NAT
d B d Global Macros Port Security
Moda e = Port Settings IGMP Snooping
Priorityl 128 Port Thresholds SNMP
Priority2 ‘ h | EtherChannels ACL
DHCP 4 Alarms
Clock Identity: VLAN Management Alarm Settings
r Management Alarm Profiles

Offset From Master(ns):

=]

¥ PTP Clock Settings

PTP Device Type:

Number of PTP ports:

¥ Device Clock Details
Device Time Source: NTP

Device Clock Time:

Port Name State Enable
Gil/1 SLAVE
Gil/2 PASSIVE

Gil/3 MASTER

PTP

Routing

A sSpanning Tree
STP Settings

REP
PRP

2. Do one of the following from the Mode pull-down depending on the

switch that is used:

e For the 5400 switch, select NTP-PTP clock and type Priority 1

and Priority 2
e For the 5700 switch, select Boundary.

By default, PTP is enabled for the ports.
3. Click Submit.

IMPORTANT  Boundary clock is required when using a PRP network topology or a
DLR redundant gateway. By selecting boundary clock, it’s necessary
to configure the VLAN ID to be propagated (for example, 300) under
device clock details in the device manager or via the terminal

emulator interface (CLI).

Delay Request Interval = Announce Timeout  Announce Interval Sync Interval
5 3 1 1]
5 3 1 0
5 3 1 i
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Enable Simple Network Management Protocol (SNMP)

Enable SNMP to provide connectivity for FactoryTalk® AssetCentre inventory
discovery and FactoryTalk” Network Manager™ Complete these steps.

1. From the main menu of the switch Device Manager, click Configure and
choose Security>SNMP.

172.18.0.1 X 4

€ | @ https;//172.18.0.1/homed.shtm| ¢ Q Search wBe ¥ & O &

Stratix 5410 Solution
@ A”e"-Brad’ey Device Manager - Switch

o Security | SNMP 8/ network 8 security
Smartports NAT
Global Macros Port Security
Port Sefttings IGMP Snooping

Port Thresholds SHMP

EtherChannels A

DHCP & Alarms

VLAN Management Alarm Setfings
Power Management Alarm Profiles
PTP

NTP

Routing

M Spanning Tree
STP Seffings
REP
PRP

Community

RO/RW

2. Click Community Strings.
3. Click Add.
A popup window appears.
4. Type a community string in the Community text field.
Our example shows ‘PlantPAx.
5. Use the default of ro’ (read-only) from the RO/RW pull-down menu.
6. Click OK.

IMPORTANT  You must repeat the steps on pages 21. .. 36 for each switch in your
PlantPAx system.
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Distribution Switch The Control Network is aptly named for its control of switches between the

. . Supervisory Network and the I/O Network. If different subnets are
conflguratlon applicable, Control Network switches serve as distribution switches to
perform routing.

Figure 4 - Control Network Switches

For color legend, see page 16. To Supervisory Network
A

SWo10 Gi1/1-12

.
Tel/25 €1/26
O SW001 ®
......... . dilk s

G Gi1/13 Y Gil/4 i3

v

To Control Network

Enable Switch Routing

Complete these steps to enable routing for the SW001 switch. While switches
apply VLAN segmentation and forward data within a VLAN on the same
network, routers send data between multiple VLANs and connect different
networks. Routers act as dispatchers to choose the best path to travel for faster,
efficient communication.

1. From the main menu of the Device Manager, click Configure and
choose Routing.

1721804 x

« ¢ o TR tiipe 1721801

Stratix 5410 Solution
@ Allen-Bradiey [Esbrabattie

O stk | Routing

Gateway. [172.18.0.1

Subimit

Stat

[ Destnation Network Dastination Mask Next Hap Rauter

No data avaiable

2. Click Enable Routing
3. Validate the gateway is set to 172.18.0.1
4. Click Submit.
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Configure EtherChannels (Link Aggregation)

Port link aggregation, also called EtherChannel, lets you combine multiple
Ethernet ports to improve the aggregated file transfer speed. Link aggregation
also provides redundancy if one of the links fails

An aggregation group combines a number of physical ports to create a single
data path. This single data path shares the traffic load among the member ports
in the group.

For color legend, see page 16.

Port channel 3

Port channel 1 Port channel 2

Table 6 identifies EtherChannel ports.
Table 6 - Control Network Access

Port Role VLAN

Gi1/1...Gi1/2 Desktop for Automation 501 (Control network)
(EtherChannel Po1)

Gi1/3 ... Gi1/4

(EtherChannel Po2)

Gi1/5...Gi1/24 Switch for Automation 301 (Native VLAN)

Te1/25 ... Tel/26
(EtherChannel Po3)

Te1/27...Te1/28 — —

Complete these steps to configure the EtherChannels for SW001 and for the
Layer 2 switches that link back to SW001.

1. On the Device Manager, click Configure and choose EtherChannels.

@ Allen-Bradley [t )

Device Manager - Switch

4 Dashboard E Monitor Admin

B Network H Security
Uptime: 1 week, 21 hours, 18 minutes Smartports NAT

Global Macros Port Security
Front Panel /

Port Settings IGMP Snooping
View: Status - Locate Sw s s i

EtherChannels ACL

DHCP A Alarms

VLAN Management Alarm Settings

Power Management Alarm Profiles

PTP

NTP
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. Click the Add button.

3 Hetwork | EtherChannels

nel Table
o Add f Edit Delete  ; Modify Channel Settings

| Channel Group Number ‘ Channel Mode | Ports Port Status
No data available

3. Type a group number for the EtherChannel.
. From the Channel Mode pull-down, select LACP (Active).

. In the Port List, select the ports that are used for the EtherChannel.

Channel Group Number u |

Channel Mode Liace (Active) | |~
T GIJT
[ @iz
[ Gin/z
[ Gitj4
[ Git/s
[ Gi/e
[ iz
[ /s
[ /o
[ Git/10
O Gitf11
O Gitj12
[ Git/13
[ Gitj14
Port List O Git/15
[ Git/16
[ Git/17
[ Gitj18
O Gitj19
[ Git/z0
[ Gitf21
[ Gitj22
[ Gi/z3
[ Git/24
[ Te1/2s

[] Te1/26
Tel/27 B
V| Tei/2g] -

-

6. Click OK.

Configure Switch Ports

The greater the number of available ports the more additional devices, as
necessary, you can add to your PlantPAx system.

See page 38 for an illustration and a table with port descriptions.
p p

Complete these steps to configure ports.

1. On the Device Manager, click Configure and choose Port Settings.
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2. Select an EtherChannel port and click Edit.

© network | Port Settings

Ph

gl Port Table

O00C0000O0O0O0C0OOOO0OCOOOOCOOOOCOC

Port Name Description
Gitf1
Glif2
Gil/3
Git/4
Gilfs
Gil/6
GiLf7
Gil/8
Gilf9
Gitf10
Gil/11
Gilf12
Gil/13
Gil/14
Gilf15
Gilf16
Gilf17
Gil/18
Git/19
Gilf20
Gilf21
Git/22
Gil/23
Gitf24
Tel/25
Tel/26

® po1

O

el
Tel/2s

Port: Status

000 OCOODODOOOCOOOODODOOCOPOODOOODR®POCOG®O

Speed
Auto

Auto

Auto
Auto-1000Mb/s
Auto

Auto

Auto

Auto

Auto

Auto

Auto

Auto

Auto

Auto

Auto

Auto

Auto

Auto

Auto

Auto

Auto

Auto

Auto

Auto
10000Mby/s
10000Mby/s
Auto
10000Mby/s
10000Mb/s

3. Do the following to configure the port:

a. Type a port description

Duplex
Auto
Auto
Auto
Auto-Full
Auto
Auto
Auto
Auto

Auto

Ful

Media Type
10/100/1000BasaTX
10/100/1000BasaTX
10/100/1000BaseTX
10/100/1000BaseTX
10/100/1000BaseTX
10/100/1000BaseTX
10/100/1000BaseTX
10/100/1000BasaTX
10/100/1000BaseTX
10/100/1000BaseTX
10/100/100083seTX
10/100/1000BasaTX
Not Present
Not Present
Not Present
Not Present
Not Present
Not Present
Mot Present
Not Present
Not Present
Not Present
Not Present
Mot Present
Not Present

Not Present

5FP-10GBase-5R
SFP-10GBase-SR

b. Click the Administrative Mode pull-down and select Trunk
c. Change the Access VLAN and Native VLAN to ‘Native 301°

Edit Physical Port b 4
Port Mame Pol i

Description I Port Group 1 SW001 to Swo10| I (Range: 1-200 Characters)
Administrative Enable

Speed 10000Mbfs | ¥

Duplex Full M

Auto MDIX ¥ Enable

Media Type =

Administrative Mode Trunk ¥

Access VLAN

Allowed VLAN

Native VLAN

d. Click OK

Native-301

(®) Al VLANS
(O VLAN IDs

(e.0., 24)

Native-301
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4. Repeat steps 1...3 on SWO001 to create an EtherChannel port for each
Layer 2 switch that is to be connected.

5. Follow the same steps on the Layer 2 switches to complete the
EtherChannel.

Using a Terminal Emulator (PuTTY)

Besides the Device Manager, the Cisco IOS command-line
interface (CLI) enables you to configure, monitor, and
maintain Cisco switches. The CLI interface is not available via
a web browser like the Device Manager. Therefore, you must
configure a terminal emulator to use the CLI interface.

We recommend that you use a terminal emulator, such as
PuI'TY, to access the CLI interface. PUT'TY is an open-source software that is
available with source code, which a group of volunteers develops and supports.

IMPORTANT  Access the switch by using a Secure Shell (Ethernet) connection (SSH) or via
a Console (Serial) Port. By using SSH, it’s necessary to be connected through
amanagement VLAN (300).

Complete these steps for an Ethernet connection.

TIP  The following steps are for enabling an SSH (secure shell) connection. See
page 42 if you are using a Serial connection.

1. From the PuI'TY Configuration dialog box, click the Session category.
2. Type a host name or an IP address.

#R PUTTY Configuration 7 >
Category:
[=- Session Basic options for your PUTTY session
- 5 I..og?ing Specify the destination you want to connect to
=~ Teminal "
- Keyboard Hojl MName {or IP address) Part
- Bell 172.18.0.1
- Features onnection type:
- Window ORaw O Telnet O Rlogin (O Serial
Appearance Load, save or delete a stored session
- Behaviour
... Translation Saved Sessions
- Selection | |
O C0|0!.II'5 Default Settings Load
[=- Connection
. Data o
- Prasy
- Telnet Delete
- Rlogin
+- 55H
- Seed Cloge window on exit:
(O Mways (O Never  (®) Only on clean exit
About Help Cpen Cancel
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3. Select SSH and click Open.

Complete these steps for a Serial connection.

TIP  Skip this procedure if you are enabling an SSH connection, which is
explained on page 41.

1. From the PuI'TY Configuration dialog box, click the Serial category.

ﬁ PuTTY Configuration

[=I- Terminal
. Keyboard

. Bell

- Features
- Window

- Appearance
- Behaviour
- Translation
- Selection

- Colours

[=I- Connection

. Proxy

- Telnet

- Rlogin

- SSH

- Serial

About Help

-3
*

Options controlling local serial lines

Select a senal line

Senal line to connect to @ 3—
Corfigure the serial line

St ) o |
Parity MNone ~
Flow control MNone ~

COpen Cancel

2. Use the dialog box options as shown and click Open.

ﬁ PuTTY Configuration

- Window

- Appearance
- Behaviour
- Translation
- Selection
- Colours

[=I- Connection

. Proxy

- Telnet

- Rlogin

- SSH

- Serial

About Help

? X

Basic aptions for your PUTTY session

Specify the destination you want to connect to

Serial line Speed
[coms |[os00 |
Connection type:

ORaw  OTelnet ORlogin OSSH @

Load, save or delete a stored session

Saved Sessions

Default Settings Load

Close window on exit:
O Mways O Never (@ Only on clean exit

Cpen Cancel

(OMS5 is an example only.

| Youmust use the COM

port that corresponds to
your specific devices.

When you click Open with either connection procedure (SSH or
Serial), the Cisco CLI appears.
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Enabling IP Helper

In this section, we are configuring the IP helper-address for each VLAN, which
uses the system DHCP servers. An IP helper-address command is required
when the DHCP server is connected to a different subnet.

Complete these steps to configure SW010 (as shown on page 39).

1. Repeat steps 1...2 on page 41 or steps 1...2 on page 42 if you are using an
Ethernet or Serial connection to access the command line
interface (CLI).

When you click Open with cither connection procedure (SSH or
Serial), the command interface appears.

On the terminal emulator interface (CLI), type the text exactly as shown
in boldface for each prompt. Press Enter after each entry.
2. Type the following to login.
login as: admin
Using keyboard-interactive authentication.
Password:
3. Enable configuration mode.

SWOO1 #configure terminal
Enter configuration commands, one per line. End with CNTL/Z.

4. Copy and paste the information in Table 7 into a text editor, such
as Notepad.

Table 7 - Routing Configuration

SWoo1

|

interface Vlan601
ip helper-address 172.18.1.10 redundancy 172.18.1.11
|

interface Vlan602
ip helper-address 172.18.1.10 redundancy 172.18.1.11
|

interface Vlan603
ip helper-address 172.18.1.10 redundancy 172.18.1.11

5. In a text editor, edit the configuration according to application
requirements.

6. Copy from the text editor, and paste into the terminal emulator
configuration software.

IMPORTANT Do not use the Ctrl+V command to paste the data into the PuTTy
software. Right-click the mouse to paste the information in one,
single file.

7. Type end and press Enter.
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8. At the SW001# prompt, type copy running-config startup-config.

IMPORTANT  Ifyou do not execute step 8 your configuration is lost during a
power cycle.

9. Confirm the routing status by using the terminal emulator interface.

SWOO1#show running config
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Chapter 2

Before You Begin

Control Network Switch Configurations

This chapter describes switch configurations for several topologies depending
on your application requirements. Each of these topologies for a PlantPAx®
system is explained separately to provide illustrations and procedures for the
necessary port settings on the Control Network.

Topologies, and respective pages, include the following:
e Star, see page 52
e Ring (redundant DLR), see page 58
o PRP (redundant Star), see page 63

Regardless of your experience with switch configuration, we recommend that
you follow the procedures on how to select the correct type of ports for devices,

starting on page 47.

This chapter includes illustrations and procedures on how to configure
redundant media. Port aggregation links two Ethernet ports to provide
redundancy if one of the links fails.

Before starting the procedures in this chapter, you must complete common
network configuration for all switches in your PlantPAx system. See Chapter 1
for how to initiate switches.

Managed switch configuration includes the following:
o Switch Express Setup
e VLAN segmentation
« Rapid PVST+
e Precision Time Protocol (PTP)
e Simple Network Management Protocol (SNMP)

e Switch routing
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Figure 5 lists the topics that are described in this chapter. Click the page

number or the links for quick access to specific information in each subsection.

Figure 5 - PlantPAx Topology Configuration Workflow

Configure Smartports «  |dentify Connected Devices with a Port Description
- 1/0 Network Switch Configuration

See page 47
Topology
A ¥
Star Topology Switch Configuration Ring Topology Switch Configuration Redundant Star Switch Configuration

See page 53 See page 58 See page 63
- (Configure Controller Switches - (Configure Controllgr Switches - Configure Controller Switches
- (Configure 1/0 Switches - EnableaDLR « (Configure PRP Distribution
« (Configure MCC Switiches « (Configure MCC Swikches « Enable PRP I/0 (RgdBox) Switch

« (Configure MCC Switches

r
Optimize Switches for Redundant Controllers - Configure Switch Routing
- Configure a Static IP Address

See page 73

r

See Chapter 3 Configure System Servers
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COnfigure Smartports Device Manager is a web-based management tool for configuring, monitoring,
and troubleshooting individual switches. You can display Device Manager
from anywhere in your network through a web browser. Device Manager
displays real-time views of switch configuration and simplifies configuration
tasks with features such as Smartports.

Smartports help designate the ports that are pre-defined for the application.
Port roles are based on the type of devices to be connected to the switch ports.
For example, the Desktop for Automation port role is specifically for switch
ports to be connected to computers.

Table 8 describes the port types that are selected with procedures in
this section.

Table 8 - Available Ports

Smartport Description

Automation Device The Automation Device Smartport is used for any EtherNet/IP devices. Devices include controllers, HMI displays,
distributed I/0, and so forth. The Automation Device Smartport enables the following features:

« Sets the port to host mode that enables Spanning Tree PortFast and BPDU Guard

«Enables port security (one MAC address per port)

+ Sets the VLAN number

« Enables the automation QoS policy

« Configures the output queues

« Enables the alarm profile

+Disables Cisco Discovery Protocol (CDP)

Multiport Automation device Apply this role to ports connected to multiport EtherNet/IP devices, such as multiport EtherNet/IP devices arranged in a linear
or dalsy chain topology. You also can use this role for Device Level Ring (DLR). The following devices apply:
1783-ETAP module (for connection to the device port only)
« Unmanaged switches (such as the Stratix® 2000)
«Managed switches with Rapid Spanning Tree Protocol (RSTP) disabled:
— Portis set to Access mode
— No port security
— Optimize queue management for CIP™ traffic

Desktop for Automation The Desktop for Automation Smartport can be used for computers on the Cell/Area zone EtherNet/IP network. Do not use this
port role for any systems that run virtual machines without turning off the port security configuration. This Smartport enables
the following features:
Sets the port in access mode
+ Setthe VLAN number
«Enables port security (one MAC address per port)
« Enables Spanning Tree PortFast
- Enables Spanning Tree BPDU Guard
- Enables the automation QoS policy
« Sets the alarm profile
« Provides up to two MAC addresses per port (physical computer and virtual machine)

VM-Desktop for Automation Apply this role to ports connected to computers that run virtualization software. This port role can be used with devices that run
two MAC addresses.

IMPORTANT: Do not apply the Virtual Desktop for Automation role to ports that are connected to switches, routers, or
access points.

VM-Desktop for Automation enables the following features:
« Sets the port access mode

«Enables port security (two MAC addresses per port)

« PortFast is enabled

« Setthe VLAN number

« (IP-PTP-Traffic Policy enabled

Switch for Automation The Switch for Automation Smartport is used on ports that connect to other managed Ethernet switches that support STP
(Spanmng Tree Protocol). This port role enables the following features:
Sets the port in trunk mode
« Sets the native VLAN
«Sets Spanning Tree to use a point-to-point link
« Sets the port to trust QoS policy
« Configures the output queues
« Sets the alarm profile
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Complete these steps to configure Smartports. This procedure must be
repeated for each switchport based on the devices that you are using.

1. From the main menu of the switch Device Manager, click Configure and
choose Network>Smartports.

2. Select the desired ports and click Edit.

@ Allen-Bradley [t

@ network | Smartports jetwork Security

Smartports NAT
obal Macros Port Security

Port Sefttings IGMP Snooping
Part Thresholds SHMP
EtherChannels ACL
DHCP 5 Alarms
VLAN Management Afarm Settings
PTP Alarm Profiles
NTP
Routing
DLR

H Spanning Tree
STP Setfings

Role: | Automation Device | ReD

Smartports: Customize

Interface Mame: |Falf' 1

Access Vlan: | 501 [+

3. Select a desired role from the Role pull-down menu.

4. Select an Access VLAN or Native VLAN based on the use as described
in Table 8 on page 47.

For example:
VLAN 501 - Control network
S. Click OK.
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6. Select another Smartport from the Role pull-down menu, and

click OK.

172.18.0.20 X i

€ | @ f htips;//172.18.0.20/homed.shtml @ | Q Search wBe ¥ & O &

Stratix 5700 Solution
@ A”en-BMdfey Device Manager - Switch

o Network | Smartports

Smartports: Customize

Interface Name: |Fa 1/9

Role: | Switch for Automation

Native Vian: 301

7. Select each port, click Edit, and type a Native VLAN.
For example:

VLAN 301 - Trunk
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8. Repeat step 6 and step 7 for each port that is being used.

IMPORTANT  Ifyou have a virtualized system, connect the hypervisor to a port
with the Desktop for Automation role.

— L 51

172.18.0.20 X 4+
€ O & https;//172.18.0.20/homed.shtml ¢ Q Search B ¥+ # i =
@ Stratix 5700 Solution

Allen-Br. adfey Device Manager - Switch Monitor Admin
@ network | Smartports
Custom Smartports

Smartport Role
[ Port Name Role
O Fi11 Automation Device
O Fai/2 Automation Device
| Fal/3 Automation Device
O r4 None
O rays None
[] Fai/o Mone
O ri7 None
O rys None
O Fra1jo Switch for Automation
O ratj10 Switch for Automation
| Falfil Automation Device
O rij12 Automation Device
O Fat/12 None
[] Fai/i14 Mone
O Fra1/15 None
O Fra1/16 None
O Fa1/17 None
O Fai/i8 Mone
Gilj1 Switch for Automation
O eitf2 None

© 2009-2017 Rockwell Automation, Inc. ALL RIGHTS RESERVED. Aarms @ 0 W 11 4 0 0 o
< >
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Identify Connected Devices with a Port Description

Port settings define the application requirements. You can change these
settings to fit your network needs and to troubleshoot network problems. The
settings on a switch port must be compatible with the port settings of the
connected device.

We recommend that you configure each switch port with a port description to
help with diagnostics and maintenance. Complete these steps.

1. From the main menu of the switch Device Manager, click Configure and
choose Network>Port Settings.

2. Selecta portand click Edit.

172.18.0.20 X 4

€ @& https;//172.18.0.20/homed.shtml ¢  Q Search wB ¥ # &

@ Allen-Bradley [t

@ network | Port Settings & network  security
Smartports MNAT

Global Macros Port Security
Port Seffings IGMP Snooping
) resholds SHMP
Edit Physical Port EtherChannels ACL
DHCP 4 Alarms
Port Name _Gil/1 2 VLAN Management Alarm Settings
PTP
Description [swao1-61-1-13] | Range: 1200 char | Al Brofies
Administrative Enable Routing
Speed _Auto ] R
M Spanning Tree
Duplex _Auto b STP Seffings
REP

Auto MDIX | Enable

Media Type Auto -

VLAN-0 Enable

Trunk

Administrative Mode

Access VLAN VLAN0300-300 =

Allowed VLAN (®) All VLANS
() VLAN IDs

(e.q., 24)

Native VLAN Native-301

© 2009-2017 Rockwel Automation, Inc. ALL RIGHTS RESERVED. Aerms @ 0 T 11 4 0 0

3. We recommend that in the Description text box, type the
connected device.

4, Click OK.

The switch description is listed next to the port name.
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| /0 Network Switch This section describes three topologies on the I/O Network, starting with a
. . Star configuration. The switches that are used for each are described in their
conflguratlon respective sections. Each section includes set up for controller, I/O, and

MCC switches.

See the following pages for basic PlantPAx topologies:

e Star, page 53
¢ Device Level Ring, page 58

e Redundant Star, page 63

Figure 6 - Control and 1/0 Network

— Supervisory Network (VLAN 601)
Control Network (VLAN 501)

—— 1/0Network (VLAN 502)

——————— Safety Network (VLAN 401) To SW001

————  Trunk - (Native VLAN 301)

—— Management (VLAN 300)

---------------- Secondary Connection

————— Secondary Connection LGXCO1

SW020

Control Network

1/0 Network
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Star Topology Switch
Configuration

Use Layer 2 switches with these procedures.

Stratix 5700 switch

Access switches serve as an uplink from the servers to the workstations. Layer 2

switches also send packets at the controller level from the end devices. With
multiple network levels, access switches control the flow of information to
make sure that packets are delivered to the correct network level. Complete

these steps.

1. From the main menu of the Device Manager, click Configure and

choose Network> Smartports.

IMPORTANT  See page 47 for Smartport descriptions.

2. Select the desired ports and click Edit.

@ A”e.ﬂ"Brad’ey Stratix 5700 Sollition

Device Manager - Switch

o Network | Smartports

Smartports: Customize

5_network 5 Security
Smartports NAT
obal Macros Port Security

Port Settings IGMP Snooping
Part Thresholds SHMP
EtherChannels ACL

DHCP

A Alarms

VLAN Management Alarm Settings

PTP
NTP

DLR

Interface Name: |Falf1

Role: | Automation Device BER

Access Vlan: | 501 v

Alarm Profiles

Routing

H Spanning Tree
STP Setfings

3. Select a desired role from the Role pull-down menu.

Smartports: Customize

b4

Interface Name: }Gilfl

Role:  Switch for Automation

Native Vln: | 301

Example I/O configurations:
VLAN 301 - Trunk
4, Click OK.
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Use Layer 2 switches with these procedures.

Stratix 5700 switch

For color legend, see page 52.
LGXC01

Configure Controller Switches

Complete these steps to configure SW020 and SW021 switches to route data

from I/O Network (Level 1) devices.

SW001Gi1/13 1

SWo020

e T

Fa11

\

5

/T\SW001 Gi1/14

Fa1/m

Fal/2 g
I Fal/3 Fal/12 e

Controllers - VLAN 501 Fal/4

LGXCOTENOTA - 172.18.1.100/24 , .

LGXCOTENOTB - 172.18.1.101/24 Fal/9 Fal/10

LGXCOTENOTT - 172.18.1.102/24

I/0-VIAN 502 — LGXCOTEN02-172.18.2.010/24 SWo22  SWoz3
Table 9 - Control Network - Control Star

Port Role VLAN SW020
Fa1/1 Automation Device 501 (Control Network) LGXCOTENOTA
Fa1/2 o LGXCOTENO1B
Fa1/3 LGXCOTENO1T
Fa1/4 502 (1/0 Network) LGXCO1EN02
Fa1/5...Fa1/8 — — —
Fa1/9 Switch for Automation Trunk (Native VLAN 301) SW022-G1/1
Fa1/10 SW023-G1/1
Fa1/11...Fa1/12 Automation Device 501 (Control Network) SISOTENO1A
Fa1/13...Fa1/18 — — SISO1ENO1B
G110 Switch for Automation Trunk (Native VLAN 301) SW001-G1/13
612" — SW001-61/14

(1) Ports Gi1/1and Gi1/2 must be configured as an EtherChannel to connect to SW001.

AN

From the main menu of the Device Manager, click Configure and

ChOOSC NCtWOl‘k> Smartports.

Select the desired ports and click Edit.

Select a desired role from the Role pull-down menu and click OK.

Use information in Table 9 to configure switch ports.

Select the desired ports and click OK.
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Use Layer 2 switches with these procedures. conﬁgure I/0 Switches

ﬂ In our example, the SW022 switch is used for the I/O connection and the
OWS/EWS access connection.

SW020-Fa1/9

SWo022 G

For color legend, see page 52. Fal/9
Fa1/3
0ws20 LGXCOTENO2R02 - 172.18.2.2.12/24

| Raln
| Fa1/2

' i F
[ &
p——

Stratix 5700 switch

LGXCOTENO2RO1 - 172.18.2.2.11/24

Table 10 - 1/0 Network - 1/0 Star

Port Role VLAN SW022

Faln Automation Device 502 (1/0 Network) LGXCOTENO2RO1
Fa1/2 LGXCOTENO2R02
Fa1/3 LGXCOTENO2FMO1
Fa1/4...Fa1/8 —

Fa1/9 Desktop for Automation 501 (Control Network) 0Ws20
Fa1/10...Fa1/18 — — —

Gi1/ Switch for Automation Trunk (Native VLAN 301) SW020 Fa1/9
Gi1/2 — — —

1. From the main menu of the Device Manager, click Configure and
choose Network>Smartports.

IMPORTANT  See page 47 for Smartport descriptions.

2. Select the desired ports and click Edit.
3. Select Switch for Automation from the Role pull-down and click OK.

4. Use the information in Table 10 to configure switch ports.
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Configure MCC Switches

Complete these steps to configure a Linear or Star topology for motor control

center (MCC) devices.
For color legend, see page 52.
Linear
MCC
‘“ SW024 1 7‘
] | |
i | |
= | |
| |
| |
| |
| |
Lo - . _
MCC

"B

1. From the main menu of the Device Manager, click Configure and
choose Network>Smartports.

IMPORTANT  See page 47 for Smartport descriptions.

2. Select the desired ports and click Edit.
3. Select arole type from the Role pull-down and click OK.
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4. Use the information in Table 11 and Table 12 to configure switch ports.

Table 11 - 1/0 Network - MCC Linear/Star

Port Role VLAN SW024 - Linear

Fa1/1...Fa1/15 Automation Device 502 (1/0 Network) —

Fa1/16 Desktop for Automation 300 (Management) —

Fa1/17...Fa1/18 — — —

Gi1/1 Switch for Automation Trunk (Native VLAN 301) SW020-F1-10

Gi1/2 SW025-G1-1
Table 12 - 1/0 Network - MCC Star (Additional)

Port Role VLAN SW023 - Star

Fa1/1...Fa1/15 Switch for Automation 301 (Native VLAN) —

Fa1/16 Desktop for Automation 300 (Management) —

Fa1/17...Fa1/18 — — —

Gi1N Switch for Automation 301 (Native VLAN) SW020-F1-10

Gi1/2 — — —
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Ring Topology Switch
Configuration

For color legend, see page 52.

This section details the switch configuration for a Ring topology by using a
Device Level Ring (DLR) on the I/O Network.

-IIFI- E M?ﬁi

Primary Controller SW030 Secondary Controller

1715 Redundant I/0 ControlLogix® /0

58

Field Devices

A DLR topology is a device-level network topology that helps prevent a loss of
communication between devices if a fault occurs. Multiport EtherNet/IP
devices equipped with DLR technology connect directly to neighboring nodes
and form a ring topology at the end devices. If a break in the line is detected,
the network provides an alternate routing of the data to help recover the
network at fast rates.

All end devices that are tightly coupled to a controller must be a part of the
same embedded switch topology. This peer-to-peer architecture reduces the
physical amount (and therefore cost) of cabling.

Enhanced diagnostics built into DLR-enabled products identify the point of
failure, helping to speed maintenance and reduce mean time to repair.

For more information, see the Embedded Switch Technology Reference

Architectures, publication ENET-RMO003.
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Configure Controller Switches

Complete these steps to select the switch ports for SW030.

SW001G11/15  SW001Gi1/16

For color legend, see page 52. é

LGXC02A

LGXCO2ENOTA - 172.18.1.105/24 —  LGXCO2EN01B - 172.18.1.106/24
LGXC02ENO3A - 172.18.3.010/24

HEe n = - R-of - LGXCO2EN03B - 172.18.3.011/24
LGXC02ENO4A - 172.18.4.010/2 ‘ == LGXCO2EN04B - 172.18.4.011/24

SW032Gi1/1  MCC Remotel/0  MCC

Table 13 - Control Network - Control DLR

Port Role VLAN SW030
Gi1/1 Switch for Automation Trunk (Native VLAN 301) SW001-G1/15
G120 SW001- Gi1/16
Gi1/5 Automation Device 501 (Control Network) LGXCO2ENOTA
Gi1/6 LGXCO2ENO1B
Gi1/7 503 (1/0 Network) LGXCO2ENO3A
Gi1/8 LGXCO2ENO3B
Gi1/9 504 (MCC Network) LGXCO2ENO4A
Gi1/10 LGXCO2EN04B

(1) Ports Gi1/1 and Gi1/2 must be configured as an EtherChannel to connect to SW001.

1. From the main menu of the Device Manager, click Configure and
choose Network>Smartports.

IMPORTANT  See page 47 for Smartport descriptions.

2. Select the desired ports and click Edit.

172,18.0.30 x4

€& @& hitps//172.18.0.30/ho @ Q Search THa ¥+ A D 2 =

@ Allen-Bradley Stratix 5400 Solution

Device Manager - Switch

Monitor

o Network | Smartports M Network M Security
002l Macros Port Security
Qustom Srartoorts Port Settings IGMP Snooping
oo Hols Port Thresholds SHMP
P EtherChannels ACL
J/ Edt DHCP 4 Alarms
[ ] Port Name Role VLAN Management Alarm Settings
G Non PTP Alarm Profiles
O gz None rPELT’inu
O aif3 None DR
O G4 None &l Spanning Tree
O cuys None STP Settings
O aiifs None REP
O &itf7 None PRP
U eiys None
T dreramse o mwsss
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3. Select Switch for Automation from the Role pull-down.

. |

Smartports: Customize x

Interface Name:IGilfl

Role: | Switch for Automation ”.

Mative Vian: | 301 |
Cancel

4. Select a Native Vlan and click OK.

5. Use the information in Table 13 to configure switch ports.

Enable a DLR

Our single DLR example in this section is between the controllers and access
switch (SW030) for server-to-controller communication.

1. From the main menu of the Device Manager, click Configure and
choose Network>DLR.

IMPORTANT  See page 47 for Smartport descriptions.
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2. Select Ring 1 from the DLR Ring ID pull-down.

172.18.0.30 %

€& @& httpsy//172.18.0.30/homed.shtml @  Q Search wBe ¥ & QO & =

@ Allen-Bradley Stratix 5400 Solution

Device Manager - Switch

#& Dashboard Admin
o Metwork | DLR B network 4 security
Smartports NAT
Global Macros Port Security
DER gD Port Settings IGMP Snooping
Port Thresholds SNMP
EtherChannels ACL
DHCP 4 Alarms
Config DHCP VLAN Management Alarm Settings
PTP Alarm Profiles
NTP
Routing

Mode: Supervisor |
il Spanning Tree
b Ll o Bl STP Settings
REP
PRP

Port2: _GigabitEthemet1/6 | ~

Supervisor Setfings

Role(Precedence): 255

Beacon Interval: uSec

Beacon Timeout:| 1960 uSec
DLR Vian Id:[0 |

| Reset To Default Values |

© 20092017 Rockwel Automation, Inc. ALL RIGHTS RESERVED. Abrms @0 W15 4 2 B0 L,

3. Select Supervisor from the Mode pull-down.
4. Select the ports.
S. Select Primary for the Role (Precedence) pull-downs.

Continue to the next gateway section by scrolling down the
DLR dialog box.
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Configure MCC Switches

Complete these steps to configure SW033 and SW034 switches on a
DLR network.

For color legend, see page 52. LGXCO2ENO4A  LGXCO2ENO4B

Ring (DLR)

(LN
Gi1/2 Gl

Fa1/1-15

Table 14 - 1/0 Network - MCCDLR

Port Role VLAN SW033 - Ring SW034 - Ring
Fa1/1...Fa1/15 | Automation Device 504 (MCC Network) Device tag Device tag
Fa1/16 Desktop for Automation 300 (Management)m — —
Fa1/17...Fa1/18 | — — — —
Gl Switch for Automation'” Trunk (Native VLAN 301) LGXCO2ENO4A SW033 - Gi1/2
Gi1/2 SW034 - Gi/1 LGXC02EN04B
(1) Ports Gi1/1and Gi1/2 must be configured for DLR.
(2) Optional.
1. From the main menu of the Device Manager, click Configure and
choose Network>Smartports.
IMPORTANT  See page 47 for Smartport descriptions.
2. Select the desired ports and click Edit.
3. Select arole type from the Role pull-down and click OK.
4. Use the information in Table 14to configure switch ports.
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Redundant Star Switch This section details the switch configuration for a Redundant Star topology
Confi gur ation with a Paralle] Redundancy Protocol (PRP) on the I/O Network.

R = Redundant Box
For color legend, see page 52. A=LANA
SW001-Gi1/17  SWO001-Gi1/18

B=LANB

LGXCo3B

LANA
LANB

RedBox

ows

PRP is available on Stratix 54x0 switches. PRP offers alternative network
topologies for interconnecting EtherNet/IP devices. PRP technology builds
redundancy into the end devices so that network infrastructure can be
duplicated by using standard components, such as managed and
unmanaged switches.

IMPORTANT  You must use a 1756-EN2TP, PRP communication module for PRP topologies.

For more information, see the Stratix Managed Switches User Manual,

publication 1783-UMO007.
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Configure Controller Switches

Complete these steps to select the switch ports for redundant switches. The
PRP switch is referred to as a RedBox.

For color legend, see page 52.

R =Redundant Box
A=LANA
B=LANB

SW001-Gi1/17 ~ SW001-Gi1/18

A
613G/

LGXCO3A LGXCo3B

v ¥V

LANB LANA

Table 15 - Control Network - Control PRP

Port Role VLAN SWo040

Gi11 Switch for Automation Trunk (Native VLAN 301) SW042 - Gi1/1
| SW043 - Gil/1

63" SWO001-Gi1/17
| SW001-6i1/18
Gi1/5...Gi1/20 | —

(1) Ports Gi1/3 and Gi1/4 must be configured as an EtherChannel to connect to SW001.

IMPORTANT  You must use a 1756-EN2TP, PRP communication module
for PRP topologies.

1. From the main menu of the Device Manager, click Configure and
choose Network>Smartports.

TIP  See page 47 for Smartport descriptions.
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2. Select the desired ports and click Edit.

Stratix 5400 Solution
@ A."eﬂ'BrEIﬂey Device Manager - Switch

o Hetwork | Smartports

HEeLWOTK
Smartports

0Dal Macros
Port Settings
Port Thresholds
EtherChannels
DHCP
VLAN Management
PTP
NTP
Routing
Smartports: Customize DLR
# Spanning Tree

STP Seffings

Interface Name:|Gi1/1 REP
PRP

Role: | switch for Automation

Native Vian: I 301

M security
NAT
Port Security
IGMP Snooping
SNMP
ACL

A Alarms
Alarm Settings
Afarm Profiles

3. Select Switch for Automation from the Role pull-down.

4, Select a Native Vlan and click OK.

5. Use the information in Table 15 to configure switch ports.
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Enable PRP (RedBox) Switch

A RedBox switch allows non-PRP devices to be added to both LANSs. Devices
that are connected to both LANs through a RedBox are called Virtual Doubly
Attached Nodes (VDANSs). VDANS do not have media redundancy between
the device and the RedBox, however, media redundancy exists on the

LAN A/LAN B side of the RedBox.
Complete these steps.

1. From the main menu of the Device Manager, click Configure and
choose Configure>PRP.

172.18.0.40 X 4+

€ 8 https;//172.18.0.40/homed.shtm & Q Search w B 4+ & QO & =

Stratix 5400 Soluti
ACQYEDR:TET I Siratix 5400 Solution|

Monitor Admin
o Spanning Tree | PRP & nNetwork 8 security
Smartports NAT
Global Macros Port Security
\Vdan Table Node Table Port Settings IGMP Snooping
Port Thresholds SHMP
ERE Channel Tahle EtherChannels ACL
DHCP [
= Add || / Edit 3¢ Delete e 5 i Alarms
= » VLAN Management Alarm Settings
Channel Group Number & | Layer Type Member Paorts PP Alarm Profiles
No data available ”TP_
Routing
DLR
sl Spanning Tree
STP Seffings
REP

1

2. Click Add and select Trunk from the Administrative Mode pull-down.

Add PRP Channel b4
Channel Group Number | 1]

Port 1 _ GigabitEthemnet1/1 |

Port 2 _ GigabitEthemet1/2 | ~

Administrative Enable

Administrative Mode _Trunk -

Description | | (Range: 1-200 Characters)
Access VLAN defaul-1 v

Allowed VLAN (®) All VLANS

ST —CTA
Native VLAN I Native-301 '_I

3. Select All VLANS for the Allows VLAN.
4. Select Native-301 from the Native VLAN pull-down.
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5. Click OK.

172.18.0.40 X

Q Search

l.shtm [

€ @& https//172.18.0.40/1

Stratix 5400 Solution
Device Manager - Switch

@ Allen-Bradley

o Spanning Tree | PRP

#& Dashboard  Configure

Vdan Table Node Table
PRP Channel Table
add  fEdit 3€Delete
Channel Group Number «  Layer Type Member Ports

Layer2 Gil/1[Not-Inuse (link down)] ,Gil/2[Not-Inuse (link down)]

O 1

lonitor

Channel Status
MNot-Inuse
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Configure PRP Distribution

The two ports for each PRP device are attached to two separated networks of
similar topology to minimize downtime and enhance high availability.

For color legend, see page 52.

R = Redundant Box
A=LANA
B=LANB

Fa1/9—
Fa1/m

B 1 VAR Fal/14
I"’LANA | L Fa1/1-4 | i
hils i [ ————— l,l ................... l i
SWo044  SW045 SW044 SW045
Gi1/1 Gi1/1 Gi1/2  Gi1/2
Table 16 - 1/0 Network - Control PRP
Port Role VLAN SW042 (LAN A) SW043 (LAN B)
Fa1/ Switch for Automation 301 (Native VLAN - Trunk) SW044 - Gi1/1 SW044 - Gi1/2
Fa1/2 SW045 - Gi1/1 SW045 - Gi1/2
Fa1/3-4 — —
Fa1/5...Fa1/8 — — — —
Fa1/9-10 Multiport Automation 501 (Control Network) LGXCO3A LGXC03B
Fa1/11-12 505 (1/0 Network)
Fa1/13-14 506 (MCC Network)
Fa1/15...Fa1/18 | — — — —
GilN Switch for Automation 301 (Native VLAN - Trunk) SW040 - Gi1/1 SW040 - Gi1/2
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1. From the main menu of the Device Manager, click Configure
and choose Smartports.

Stratix 5700 Solution
@ AHEH'BfadIBy Device Manager - Switch

9 Network | Smartports B network 4 Security
Smartports NAT
obal Macros Port Security

Port Settings IGMP Snooping
Port Thresholds SNMP
EtherChannels ACL
DHCP 4 Alarms
VLAN Managemant Alarm Settings
PTP Alarm Profiles
NTP

Smartports: Customize Routing

DLR

S Spanning Tree

Interface Name:\Falfl STP Settings

REP

Role:  Switch for Automation &

Native Vlan: 301 [+

Select the desired ports and click Edit.
Select Switch for Automation from the Role pull-down.

Select a Native Vlan and click OK.

AN

Use the information in Table 16 to configure switch ports.

IMPORTANT  The next procedure must be performed to configure the MTU
(maximum transmission) for each distribution switch in your
application. The PRP architecture can support a maximum
of seven hops.

6. From the main menu of the Device Manager, click Admin and
choose MTU.

172.18.0.42 X 4

e Of https://172.18.0.42/homed.shtml [ Q, Search ‘ﬂ’ 8 ¥+ @ & =

@ Allen-Bradley [t

0 Device Management | MTU 8 Device Management H File Management
Exprass Setup Software Update
9 Users Sync
ystem MTU :| 1506 (Sets the MTU value for all interfaces. Range: 1500-1998 bytes.) SDM-Template Load/Save

Restart/Reset
Access Management

Status:

7. Select an MTU value and click Submit.
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A Warning message appears.

Attention

Device must reload for the MTU size to take effect. Click OK to
restart now or cancel to exit without applying the change.

| Cancel:;

8. Click OK to restart.
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For color legend, see page 52.

Enable PRP 1/0 (RedBox) Switch

This section describes how to configure a redundant switch on the PRP

I/O Network.

Port SW042  Port SW043

R = Redundant Box (PRP) 1788-EN2FF
Table 17 - 1/0 Network - PRP
Port Role VLAN SWo44
Gi1/1...Gi1/2 Switch for Automation Trunk (Native VLAN 301) SW042, SW043
Gi1/3...Gi1/4 — — _
Gi1/5...Gi1/9 Automation Device 505 (1/0 Network) —
Gi1/10...Gi1/20 — — _

1. From the main menu of the Device Manager, click Configure and

choose Smartports.

&« Or https://172.18.0.44/homed.shtml

@ Allen-Bradley

o Network | Smartports

Stratix 5400 Solution
Device Manager - Switch

Smartports: Customize

Interface Name: }Gilfl

Role: | Switch for Automation

Native Vlan: | 301

@ Q Search B 3 @ o

H network M security

Smartports NAT
lobal Macros Port Security

Port Sattings IGMP Snooping
Port Thresholds SHMP
EtherChannels ACL
DHCP 5 Alarms
VLAN Management Alarm Settings
PTPR Afarm Profiles
NTP
Routing
DLR

M Spanning Tree
STP Setfings
REP
PRP
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2.

3

4. Select a Native Vlan and click OK.
5.

Configure MCC Switches

Select the desired ports and click Edit.

. Select Switch for Automation from the Role pull-down.

Use the information in Table 17 to configure switch ports.

This section describes how to configure MCC-level switches for a Redundant

Star (PRP) topology.
For color legend, see page 52. LAN A
LANB |
Gi1/1 G2 R = Redundant Box (PRP)
- SWo045
| 1] 2] ] |
| Gi1/1 |
SWo46 |
| |
| |
| |
| |
| |
| |
| |
Table 18 - 1/0 Network - MCC PRP
Port Role VLAN SWo045
Gi1/1...Gi1/19 Switch for Automation Trunk (Native VLAN 301) Switch tag
Gi1/20 Desktop for Automation 300 (Management) —
1. From the main menu of the Device Manager, click Configure and
choose Smartports.
2. Select the desired ports and click Edit.
3. Select Switch for Automation from the Role pull-down.
4. Select a Native Vlan and click OK.
5. Use the information in Table 18 to configure switch ports.
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Optimize Switches for
Redundant Controllers

For color legend, see page 52.

This section describes how to configure routingat the controller level to reduce
multitasking. This functionality minimizes the Internet Group Management
Protocol (IGMP) members on the control level.

IMPORTANT  This configuration can be executed only in one switch. Moving the default
gateway to the controller level requires changes in the upper level (CLI).

EEEEEEEEEAA'E: + =+ ®N
EEEEEEEEYyEAEEEEE =N

Gi1/16

LGXC02A

al 1

Gt/ dGi/2 T
] Gi1/5 Gil/6 _ I
Gil/7 Gi1/8
Gi1/9 i1/10
[ 1 | HEEER

LGXco28

SWo030

Configure Switch Routing

Complete these steps to change the VLAN IP address to modify the gateway
address. This example shows the VLAN IP address is changing from
172.18.2.1 to 172.18.2.2. The same configurations are required for additional
VLANS and subnets.

1. From the Device Manager, click Configure and choose

VLAN Management.
2. Select the VLAN that you are changing, and click Edit.
&= Add ¥ Delete
VLAN ID Name Ports
O 1 default Tel/27
O 300 VLANO300 Gilf13,
O 301 Native
Q501 VLAND501 P03, Pt
502 VLANO502
O 503 VLANOS03
O s04 VLANO504
Q s05 VLANDS05
O s06 VLANOSD6
O s07 VLANOS07
O s08 VLANOS08
) s09 VLAND509
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3. Inthe IP Address text box, type the new IP address.

VLAN ID | 502
Mame | VLANOS02

1P Assignment Mode: ) Mo IP Address (®) Static ) DHCP

1o naress | [EBREE_ ]|/
Cancel |

4, Click OK.

Configure a Static IP Address

Complete these steps to configure a VLAN with a static IP address.

1. From the main menu of the Device Manager, click Configure and
choose Routing.

2. Click Enable Routing.

Stratix 5400 Soluti
@ Allen-Bradley [SHatamiboara

o Network | Routing 8 network 8 security
Smartports NAT
Global Macros Port Security

Enable Routing : Port Settings IGMP Snooping
Port Thresholds SNMP

Gateway: 172.18.0.1 EtherChannels ACL
DHCP

i
VLAN Management Alarm Settings
PTP Alarm Profiles
NP

Static Routes

E?:__Add Edit 3 Delete DLR

[ | Destination Network | Destination Mask | Next Hop Router A Spanning Tree
STP Settings

No data available
RFED
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3. Return to the main menu of the Device Manager, click Configure and
choose VLAN Management.

@ Allen-Bradley [Braa

Device Manager - Switch

& Dashboard A\l onitor Admin

@ network | VLAN Management B network M Security

Smartports MNAT

To add or edit ports in a VLAN, use the Physical Port Settings page. Global Macros Bort Secrity
Port Settings IGMP Snooping

VTP Mode :Transparent Port Thresholds SHNMP
EtherChannels ACL
Maleiz A Alarms
VLAN Management Alarm Settings

Ports PP o
Afarm Profiles

O 1 default NTP

O 300 VLANO300 Gil/2, Gil/3, Gil/4, Gilf11, Gilf12, Gilf13, Gil /14, Gil/15, Gil Routing il

O 301 Native DLR

O 501 VLANO501 Gil/5, Gil/6 +# Spanning Tree

® 502 vianosoz | SIE Settngs

: 2 REP

QO s03 VLANOS03 Gil/7, Gil/8 PRP

O s04 VLANOS04 Gil/9, Gil/10

O s05 VLANOS0S Active

O so6 VLANOS06 Active

4. Click Edit and choose an I/O Network VLAN.
See page 18 for alist of VLAN descriptions.
5. Select Static and type an IP address followed by a network mask.

4
VLAN ID | 502
Name | VLANOS02
TP Assignment Mode ) Mo IP Address (&) Static ) DHCP
1P Address]| [ 172.18.2.1 | / [255.255.255.0 |
- cancel |

6. Click OK.
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Notes:
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Chapter 3

Configure System Servers

This chapter describes how to configure a Windows domain, which centralizes
the administration of users, policies, and security. Use of a Windows domain
also improves performance, especially for larger systems. We recommend that
all PlantPAx" system servers and workstations be a member of a domain.

A domain is a collection of computers that share rules and procedures. These
computers comprise a central directory database, which is the active directory.
The sharing of network objects creates a unified base to manage users, groups,
and security settings.

Procedures in this chapter explain how to build a Windows domain named
System. The System domain is a child domain of parent domain PlantPAx.
Hence, the following fully qualified domain namespace:

System.PlantPAx.local

This domain forms a domain tree that’s rooted at PlantPAx. Your Windows
active directory implementation (for example forest), can include one tree or
be composed of multiple trees.

When a Windows secondary domain is created, the following
operations occur:

e Secondary domain is verified

e Domain controller in the primary domain is located (referenced) and
the secondary domain time is synchronized

e Two-way transitive trust relationships between the secondary domain
and the primary domain are established

e Existing Active Directory Schema and Configuration containers are
replicated to the secondary domain controllers.

IMPORTANT  To perform tasks in this chapter, you must verify the naming conventions
of your computers or use the names as shown in the examples. You cannot
change computer names in the middle of the procedures for any
domain controller.

Rockwell Automation® does not support the installation of application
software on a computer that is configured as a domain controller.

For additional server recommendations, see the PlantPAx Distributed Control
System Reference Manual, publication PROCES-RMO001.
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Considerations Consider the following suggestions before starting this chapter:

o We assume that your active directory (forest) exists and that a hosting
primary domain, such as PlantPAx.local, exists as well. The domain
names that are used herein are only arbitrary to denote a respective
hierarchy that works for you.

e Our recommendation is to use domain controllers. But, if you want to

create a workgroup, see the procedures in Appendix B.

e This chapter describes how to set up a dedicated domain for your
PlantPAx system. If you are adding your PlantPAx system to an existing
domain and DHCP server, skip to page 99 for details.

Figure 7 - PlantPAx System Server Workflow

Configure the Primary Domain Controller

See page 79

r

Configure a Secondary Domain Controller

See page 86

h 4

(reate a Reverse DNS Lookup Zone
+ Map Host Name to IP Address

See page 93
r « Add DHCP Server Role
Enable the DHCP Server in the Primary - Configure DHCP Server
and Secondary Controllers « Enable DHCP Scope (Control Network)
- Enable DHCP Scope (Supervisory Network)
See page 99 - Configure Failover

A

Join the Domain - Confirm Computers in DNS Server

« Confirm Computers in DHCP Server

See page 113
r « Unit Groups
(reate Groups and Users « Role Groups
« Area Groups
See page 118 « Create Users
+ Assign Users to a Group
y
See Chapter 4 Configure Group Policy Management
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Configure the Primary
Domain Controller

Use a domain controller with
these procedures.

Primary Controller
(PADCA)

For high availability, primary and secondary domain controllers are required.
Complete these steps to configure a primary domain controller.

IMPORTANT  Before you begin to configure a primary domain controller, you must assign
afixed IP address to the domain controller, such as 172.18.1.10.

1. Click the Windows Ll symbol.

2. Click Control Panel and choose Network and Sharing Center>Change
adapter settings.

The Network Connections dialog box appears.
3. Right-click the network and choose Properties.
4. Double-click Internet Protocol Version 4 (TCP/IPv4).

The Internet Protocol Version 4 Properties dialog box appears.

Intemet Protocol Version 4 (TCP/IPvd) Properties -

General

You can get TP settings assigned sutomatically if your netwerk supports
this capahbilizy, Othensise, you need to ask vour network. adminestrabor
for the appropriate IP sattings,

) bkain an TP address sutomaticaly
(w) Lz the Fallowing 1P address:
P adkress: 172,18, 1,10 |

Subinet mask:

Defauk gateway:

#) Use the fallowing DNS server addresses:

Freferced DHS server: 172,18 . 1 .11

Altermate DS server: 12,0 .0 .1 |

| wakdate settings upon exit [ Feaeed |
| O Cancel

5. Type an IP address, default gateway address, and a Preferred DNS

(Domain Name System) server address.

IMPORTANT  You could receive Windows Event Log errors related to the Preferred
DNS server (for example 172.18.1.11). However, these errors go
away when you add the DNS server.

127.0.0.1s a special purpose address that is reserved for use on
each computer (computer loopback address).

Typically, the alternate DNS server is your secondary domain controller.

6. Click OK.
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After defining the IP address, complete these steps to configure the primary
domain controller.

1. From the Server Manager, click Manage and choose Add Roles and
Features.

Server Manager

TO SERVER MANAGER

Add Roles and Features |

| Remove Roles and Features

. Add Servers

| Create Server Group

| Server Manager Properties

0 Configure

2. Click Next on each of the successive installation wizard dialog boxes for

the following:

e Review Before You Begin

o Select Installation Type

B

Before you begin

Bef

ou Begin

Installation Ty

Server 5

Add Roles and Features Wizard

- El-
DESTINATION sERVER

This wizard helps you install rales, role services, or features. You determir
features ta install based on the computing needs of your organization,
hosting & website.

To remave roles, role services, or features:
Start the Remove Roles and Features Wizard

Before you continue, verify that the following tasks have been completed|

* The Administrator account has a strang password
* Network settings, such as static IP addresses, are configured
* The most current security updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been com
complete the steps, and then run the wizard again,

To continue, click Next.

[] Skip this page by default

80

[

=

DESTINATION SERVER
PADCA

Add Roles and Features Wizard

Select installation type

Select the installation type. You can install roles and features on a running physical computer or virtual
machine, ar on an offline virtual hard disk (VHD).

® Role-based or feature-based installation
Configure a single server by adding roles, role services, and features.

() Remote Desktop Services installation
Install required role services for Virtual Desktop Infrastructure (VDI) to create a virtual machine-based
or session-based desktop deployment.
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3. Click ‘Select a server from the server pool’ and select your primary

domain (PADCA in the example).

4. Click Next.

DESTINATION SERVER

Select destination server PADCA

Before You Begin Select a server or a virtual hard disk on which to install roles and features.

Installztion Type (®); Select a server from the server pool
() Select a virtual hard disk

Server Roles Server Pool
Features
Filter:
Name IP Address Operating System

172.18.1.10 Microsoft Win

1 Coemputer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.

| Install H Cancel |

5. Choose Active Directory Domain Services, and then click Add Features.

DESTINATION SERVER

Select server roles PADCA

Select one or more roles to install on the selected server.

Before You Begin

Installation Type Roles Description
Server Selection R B |~ Active Directory Do
[ Active Directory Certificate Services I~ {AD DS) stores infor
ory Domain Servic objects on the netwq
Features i i this information avail - - :
""C‘f"e D‘_’em‘"Y F_Ederat'_""” Se’:“"ces ) and network admimdl Add features that are required for Active Directory
[ Active Directory Lightweight Directory Services REN R e Domain Services?
[ Active Directory Rights Management Services network users acces:
[] Application Server = resources anywhere You cannot install Active Directory Domain Services unless the
[] DHCP Server through a single log following role services or features are also installed,
[ DNS Server [Tools] Group Policy Management
[ Fax Server 4 Remote Server Administration Tools
b [E] File and Storage Services {2 of 12 installed) 4 Role Administration Tools
[ Hyper-v || 4 AD DS and AD LDS Tools
[ Metwork Palicy and Access Services Active Directory module for Windows PowerShell
[] Print and Document Services 4 ADDS Tools
[ Remote Access [Tools] Active Directory Administrative Center
[[] Remote Desktop Services v [Tools] AD DS Snap-Ins and Command-Line Tools
< Previous ‘ | Mext > | ‘ Install Include management tools (if applicable)
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6. Make sure 'Active Directory Domain Services' is checked and click Next.

7. Make sure the Features selections match as shown, and click Next.

Select server roles

‘Select one or mere roles to install on the selected server,

Before You Begin

Select features

DESTINATION SERVER

PADCA

Installation Type Roles Descril
Server Salection i = Select one or more features to install on the selected server.

[ i Disiting Copticoe Senrss lad (AA‘[‘)"'; Before You Begin

object] Installation Type Features Description

Featiie: [ Active Directary Federation Services this inf Server Selection L —
AD DS [ Active Directory Lightweight Directory Services z::s": et pies T e e o o powier of the NET Framework 20
Confirmation [[] Active Directory Rights Management Services W : _ | APIswith new technalogies for

[ Application S o] b [ Background Intelligent Transfer Service (BITS) = building applications that offer

pfication Sever B 40 DS T ———— appealing user interfaces, protect

] DHCP Server roug e your customers' personal identity

[ DNS Server Cenfirmation [ BitLocker Network Unlock information, enable seamlass and

[ Eaxs [] BranchCache secure communication, and provide

SR [ Client for NFS the ability to mode! a range of
b [B] File and Storage Services (2 of 12 installed) Srimangy

[ Hyper-V [] Data Center Bridging

[ Network Policy and Accass Services m [ Direct Play

[ Print and Document Services [ Enhanced Storage

] Remcic e [] Failover Clustering

[] Remote Desktop Services | Group Policy Management

v [ 115 Hostable Web Core

[] Ink and Handuwriting Services

<] u I

[<previous || Net> | | st |[ cancel

8. Make sure AD DS is highlighted and click Next.

DESTINATION SERVER
PADCA

Active Directory Domain Services

Active Directory Domain Services (AD DS) stores information about users|
on the network. AD DS helps administrators securely manage this inform
sharing and collaboration between users. AD DS is also required for direq
such as Microsoft Exchange Server and for sther Windows Server technol

Before You Begin

Installation Type

DESTINATION SERVER

Confirm installation selections Tanca

Server Selection

Server Roles :
Things to note: . . . .
Before You Begin To install the following roles, role services, or features on selected server, click Install.

* To help ensure that users can still log on to the network in the case of
minimum of two domain controllers for a domain.

Installation Type [} Restart the destination server automatically if required

Server Selection Optionl features (such as administration tools) might be displayed on this page because they have
been selected automatically, If you do not want to install these optional features, click Previous to clear

their check boxes,

Confirmation

* AD DS requires a DNS server to be installed on the network. If you do
installed, you will be prompted to install the DNS Server role on this m;

Server Roles

* Installing AD DS will also install the DFS Namespaces, DFS Replication,

which ae foruired big AB DS, Festures " =
e Active Directory Domain Services
Group Policy Management
Remote Server Admiistration Tools
Festure Administration Tools
WINS Server Tools )
Role Administration Tools
AD DS and AD LDS Tocls
Active Directory module for Windows PowerShel
AD DS Tools
Active Directory Administrative Center
AR NE Cnan_lac and Cammand_lina Tanle »

Export configuration settings
Specify an altemate source path

<Previous | | Next> | Cancel

I s

9. On Confirmation, make sure ‘Restart the destination server
automatically if required’ is not checked.

10. Click Install.

The installation can take a few minutes. Do not close the Wizard.
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11. Click Promote this server to a domain controller.

Insta ”ation progress DESTINATION SERVER

PADCA
View installation progress

0 Feature installation

Configuration required. Installation succeeded on PADCA.

Active Directory Domain Services Al

Additional steps are required to make this machine a domain controller.
I Promote this server to a domain controller I

Group Policy Management
Remote Server Administration Tools
Feature Administration Tools
WINS Server Tools

Role Administration Tools
AD DS and AD LDS Tools
Active Directory module for Windows PowerShell
AD D5 Tools

|

You can close this wizard without interrupting running tasks, View task progress or open this

page again by clicking Notifications in the command bar, and then Task Details.

Export configuration settings

| < Previous H Next > | | Close || Cancel ‘

12. On the Configuration wizard, select Add a new forest, and type a root
domain name.

- - TARGET SERVER
Deployment Configuration PADCA

Select the deployment operation

Domain Conftroller Options
Additional Cptions

Paths

Review Options

Specify the domain information for this operation

Prerequisites Chack

Root domain name: I System.PlantPAx local I

More about deployment configurations

< Previous

13. Click Next.
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14. Type the Directory Services Restore Mode (DSRM) password, confirm
the password, and click Next.

= Active Directory Domain Services Configuration Wizard =l i -
. — .- TARGET SERVER
Domain Controller Options PADICA

Select functional level of the new forest and root domain

Forest functional level: | Windows Server 2012 R2 e

-]
Aclditional Srtinm Domain functional level: | Windows Server 2012 R2 |'|

Specify domain controller capabilities

Domain Name System (DNS) server
7] Global Catalog (G

Type the Directory Services Restore Mode (DSRM) password

Password: sssssases

LConfirm password: sssssssee

More about domain controller options

< Previous Cancel

IMPORTANT  We recommend that you document these credentials and store
themin a secure location. For security, the domain controller verifies
passwords for all users and computers in the PlantPAx network. The
domain controller also authenticates the installation and upgrade
of network software.

15. Do not specify DNS Delegation options and click Next.

16. In the NetBIOS™ Domain Name text box, make sure the domain name
is ‘System’ and click Next.

17. Click Next on the successive two windows to do the following:
e Accept the location of the AD DS database, log files, and SYSVOL

e Review selections
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18. Click Install.

B Active Directory Domain Services Configuration Wizard [= [o |
p R .. C ‘ | TARGET SERVER
releqU|5|teS Neck PADCA
| @ Al prerequisite checks passed successfully. Click ‘Install’ to begin installation. Show more x

Deployment Configuration . " R, . o -
Prerequisites need to be validated before Active Directory Domain Services is installed on this
Domain Controller Cptions computer

~ View results

1. Windows Server 2012 R2 domain controllers have a default for the security setting fal
named "Allow cryptography algorithms compatible with Windows NT 4.0" that prevents
weaker cryptography algorithms when establishing security channel sessions.

For more information about this setting, see Knowledge Base article 942564 (hittp://
go.microsoft.com/fwlink/?Linkld=104751).

1. A delegation for this DNS server cannot be created because the authoritative parent
zone cannot be found or it does not run Windows DNS server. If you are integrating
with an existing DNS infrastructure, you should manually create a delegation to this
DNS server in the parent zone to ensure reliable name resolution from outside the
domain *System.PlantPAx.local”. Otherwise, no action is required. w

5. If you click Install, the server automatically reboots at the end of the promotion operation.

More about prerequisites

Next >

The installation can take a few minutes before the computer
automatically restarts.
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Configure a Secondary
Domain Controller

Use a domain controller with
these procedures.

Secondary Controller
(PADCB)

86

The secondary domain controller is a replication of the Active Directory (AD)
and runs the alternate DNS server. We recommend that you configure a second
domain controller as a backup to the primary domain for high availability.

You must assign a fixed IP address to the secondary domain controller.

Complete the following steps.

1. Click the Windows |- symbol.

2. Click Control Panel and choose Network and Sharing Center>Change
adapter settings.

The Network Connections dialog box appears.
Right-click the network and choose Properties.
4. Double-click Internet Protocol Version 4 (TCP/IPv4).

The Internet Protocol Version 4 Properties dialog box appears.

Internet Protocol Version 4 (TCP/IPv4) Properties -

General

‘fou can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically
(®) Use the following IP address:

—
IP address: 172,18 .1 .11
Subnet mask: [ 255 .255.255. 0 |
Default gateway: [172.18. 1.1 |

Obtain DMS server address automatically

(®) Use the following DNS server addresses:

Preferred DMS server: 172,18 . 1 .10
Alternate DNS server: [127.0 .0 . 1|
[[validate settings upon exit

5. Type an IP address that matches the primary domain controller IP
address as the preferred DNS server.

This secondary domain server is the alternate DNS server for the
system infrastructure.

6. Click OK.
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After defining the IP address, complete these steps to create the
secondary domain.

1. From the Server Manager, click Manage and choose Add Roles
and Features.

‘Server Manager [ = [ = [

Add Roles and Features

Remove Roles and Features

[0 SERVER MANAGER

Add Servers

Create Server Group

- S M P rti
o CO’\TIQLII’G erver Manager Properties

2. Click Next on each of the successive dialog boxes to do the following.
o Verify that certain tasks have been completed

e Select an installation type

3. Click Select a server from the server pool, and select your secondary
domain (PADCB in the example).

4. Click Next.

DESTIMATION SERVER

Select destination server PADCE

Before You Begin Select a server or a virtual hard disk on which to install roles and features.

lect a server from the server pool
Select a virtual hard disk

Server Ro Server Pool
Features
Filter:
Name IP Address Operating System

172.18.1.11 Microsoft Windows Server 2012 R2 Standard

1 Computer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.

= Add Roles and Features Wizard HEIEN
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5. Click Active Directory Domain Services, and then click Add Features.

DESTINATION SERVER
PADCE

Select server roles

Select one or more roles to install on the selected server.

Before You Begin

Installztion Type Roles Description
Server Selection 5 o i i i
[ Active Directory Certificate Services ~|  Active Directory Domain S Add fe_atures_that are required for Active Directory
(AD DS} stores information, Domain Services?
objects on the network and
Featuras e D : i i
[ Active Dirsctory Federation Services thi infarmation ayﬁljab\gt You cannot install Active Directory Domain Services unless the
| - o . " " . and network administratory 5 .
Active Directory Lightweight Directory Services e following role services or features are also installed.
Active Directory Rights Management Services
= L 1 7 HERWEE tseps it cess o e [Tools] Group Paolicy Management
[] Application Server = resources anywhere on the| v A N 2
through a single logon pros 4 EMOT EVer iministration 1 0ois
DHCP Server & grregonp
g e 4 Role Administration Tools
erver
e 4 AD DS and AD LDS Tools
ax Jerver
: _ : Active Directory module for Windows PowerShell
I [®] File and Storage Services (2 of 12 installed)
0 W 4 AD DS Tools
er-
i i L [Tools] Active Directory Administrative Center
[ Network Policy and Access Services .
[ Print and D S [Tools] AD DS Snap-Ins and Command-Line Teols
TNt an 'OCUMENT SErvices
[] Remote Access
[] Remote Desktop Services e Include management tools (if applicable)
[<brevious | [ Net> | [ instat | [

6. Click Next on each of the successive dialog boxes to do the following.
o Verify selected server role
o Confirm installation selections

e Verify “Things to note' concerning AD DS

7. Confirm your installation selections and click Install.

DESTINATION SERVER

Confirm installation selections 2DCE

To install the following roles, role services, or features on selected server, click Install.

Before You Begin

Installztion Type

Server Salection Optional features (such as a
been selected automatically. If you do not want to install these optional features, click Previous to clear
B fak their check boxes,
Features
AD DS Active Directory Domain Services

Group Policy Management

Remate Server Administration Tools
Role Administration Tools
AD DS and AD LDS Tools
Active Directory module for Windows PowerShell
AD DS Tools
Active Directory Administrative Center
AD DS Snap-Ins and Command-Line Tools

Export configuration settings
Specify an alternate source path

<previous | | Next> | [ istal [ concel
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8. Click Promote this server to a domain controller.

Installation p]"og ress DESTINATION SERVER

PADCE

View installation progress

o Feature installation

Configuration required. Instzllation succeeded on PADCE.

Active Directory Domain Services A

Additional steps are required to make this machine a domain controller,
Promote this server io a doi coniroller

Group Policy Management
Remote Server Administration Tools
Role Administration Tools
AD DS and AD LDS Tools
Active Directory module for Windows PowerShell
AD DS Tools
Active Directory Administrative Center
AD DS Snap-Ins and Command-Line Tools

You can close this wizard without interrupting running tasks. View task progress or open this
page again by clicking Notifications in the command bar, and then Task Details.

Export configuration settings

[ <Previous | [ met> | [ Cose |[ cancel |

9. Click Add a domain controller to an existing domain and click Select.

3 - TARGET SERVER
Deployment Configuration PADCE

Select the deployment operation

a new domain to an existing Torest
) Add a new forest

Specify the domain information for this operation

®

Domain: Select...

10. Type a user name under the domain.

For example, System.PlantPAx local\Administrator

Credentials for deployment operation
Supply credentials for the deployment operation

stem.PlantP Ax.local\Administrator
LI TILL L] .l

Domain: System.PlantPAx.local

11. Type a password and click OK.
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12. Select the domain and click OK.
Select a domain in the forest where the new domain controller will
reside.
[SystemPlantPACIOal ;
. Select the deployment operation
Domain Controller Cptions . o .
% = @ Add a domain controller to an existing domain
Additionz| Options ) Add a new domain to an existing forest
Paths () Add a new forest
Review Options B . R .
Specify the domain information for this operation
Frereguisites Chack
Domain: System.PlantPAx.local
Supply the credentials to perform this operation
System.PlantPAxlocal\Administrator
More about deployment configurations
< Previous I Mext > I Install Cancel
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14. Type the Directory Services Restore Mode (DSRM) password, confirm,

and click Next.
- . TARGET SERVER
Domain Contraller Options R
Deployment Configuration ~ . . .
Specify domain controller capabilities and site information
Domain Col
z Diomain Name System [DNS) server
EREEpibns Global Catalog (GC)
Additional Cptions [] Read only domain controller (RODC)
Paths Site name: Default:-First-Site-Name [~]
Review Options
e Type the Directory Services Restore Mode (DSRM) password
Freraguisites Chace
Password: ssssssnes
Confirm password: ---------‘
More about domain controller options
[<Brevious | Met> [| | insten | [ Cancel

15. Click Next on the DNS Options window.

Ignore thC warning message.

16. From the Replicate from pull-down menu, select
PADCA.System.PlantPAx.local.

Additional Options e e

Deployment Configuration } )
Specify Install From Media (IFM) Options

Domain Contreller Optiens

DNS Options

[ Install from media

Additional Options Specify additional replication options

Paths Replicate from: M panCASystem PlantPaxiocal B |
Review Options

Prereguisites Chack

More about additional options

[cereviows |f| met> | | sl | [ Concal |

17. Click Next on each of the successive windows for the following:
e Accept the location of the AD DS database, log files, and SYSVOL

e Review selections
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18. Click Install.

e Active Directory Domain Services Configuration Wizard [= o .
P s ® .t C | I TARGET SERVER
rerequisites Check e
| @& Al prerequisite checks passed successfully. Click ‘Install' to begin installation. Show mare x

Deployment Confi

iratien

Prerequisites need to be validated before Active Directory Domain Services is installed on this
ontroller Options  computer

~ View results

I Windows Server 2012 R2 domain controllers have a default for the security setting fal
named "Allow cryptography algorithms compatible with Windows NT 4.0" that prevents
weaker cryptography algorithms when establishing security channel sessions.

For more information about this setting, see Knowledge Base article 942564 (http:// =
go.microsoft.com/fwlink/?Linkid=104751).

A delegation for this DNS server cannot be created because the authoritative parent
zone cannot be found or it does not run Windows DNS server. If you are integrating

with an existing DN5 infrastructure, you should manually create a delegation to this
DNS server in the parent zone to ensure reliable name resolution from outside the
domain “System.PlantPAx.local”. Gtherwise, no action is required. L

1. If you click Install, the server automatically reboots at the end of the promotion operation.

More about prerequisites

The computer automatically restarts.
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Create a Reverse DNS Lookup A reverse lookup zone provides the ability to search a database for a computer

Zone

Use a domain controller with
these procedures.

name based on its IP address. This process is contrary to how a Domain Name
System (DNS) was originally designed. Ordinarily, DNS lookups are forward
lookups, which are searches via a DNS of another computer that is stored in the
host record. The IP address is usually the resource for a response.

To define how a DNS name is indexed with an assigned IP address for a reverse
lookup, you must program a special domain (in-addr.arpa). Subdomains within
the in-addr.arpa domain reverse the address order by using a pointer (PTR)

record that is mapped to the IP address. Thus, the domain name is found in the

query.

Complete these steps to add a reverse lookup zone.

IMPORTANT  The Active Directory installation wizard does not automatically add a
reverse lookup zone to the server. The PTR records are not necessary to
operate an Active Directory, but these records must be mapped to
IP addresses for a reverse lookup zone. See page 96 for the procedure.

1. From the Server Manager, click Tools and choose DNS.

Server Manager

- (-E) I r Manage Tools View Help
| Active Directory Administrative Center
Active Directory Domains and Trusts
D SERVER MANAGER N .

Active Directory Module for Windows PowerShell
Active Directory Sites and Services

Pt ¥ i Active Directory Users and Computers

o Configure this lo{ | aosieai

Component Services

Computer Management

2 Add roles and fea| o
Defragment and Optimize Drives
3 Add other servery 20
HES
A Create a server ar Embedded Lockdown Manager
] Event Viewer
5 Connect this servy Group Policy Management
iSCS! Initiator

The DNS Manager dialog box appears.
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2. Open the primary server (PADCA), right-click Lookup Zones and
choose New Zone.

File Action View Help

e’ 2EXEc=z HBE 88

£ DNS Mame
4 i PADCA [ Forward Lookup Zones
I [] Forward Lookup Zones [] Reverse Lookup Zones

[ R e Lookup Zo =103

Points

1 Trust Points Mew Zone...
| Conditional Forwar!
4 Global Logs
DNS Events

nditional Forwarders
obal Logs
ot Hints

rwarders

Create a new zone.

Wizard installation screens appear to create a zone for your
DNS server.

Welcome to the New Zone
Wizard

This wizard helps you create a new zone for your DNS
SErver,

A zone translates DNS names to related data, such as IP
addresses or network services.

To continue, dick Next.

Zone Type
The DNS server supports various types of zones and storage.

Select the type of zone you want to create:

®
Creates a copy of a zone that can be updated directly on this server,

() Secondary zone
Creates a copy of @ zone that exists on another server. This option helps balance
the processing load of primary servers and provides fault tolerance.

() Stub zone
Creates a copy of a zone containing only Name Server (NS), Start of Authority

(50A), and possibly glue Host (A) records. A server containing a stub zone is not
authoritative for that zone.

Store zone in Active Directory (available only if DNS server is a write, i
the (available only if able domain
controller)

3. Click Next twice to use defaults
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MNew Zone Wizard
Active Directory Zone Replication Scope ;‘
‘fou can select how you want DNS data replicated throughout your network., "
F New Zone Wizard -
Select how you want zone data replicated: Reverse Lookup Zone Name ;'
(") To all DNS servers running on domain controllers in this forest: System.PlantPAx. local A reverse lookup zone translates IP addresses into DNS names, "
L~

(®) To all DNS servers running on domain controllers in this domain: System.PlantPax.loc

Choose whether you want to create a reverse lookup zone for IPv4 addresses or IPve

addresses.

() To all domain controllers in this domain (for Windows 2000 compatibility):
System.PlantPAx.local

To all domain controllers spedfied in the scope of this directory partition:

() IPvE Reverse Lookup Zone

< Badk I| Next > ﬂ| Cancel

W

4. Click Next twice to use defaults.

5. Type the network ID of an IP address or the zone name.

IMPORTANT  Type the network ID portion of the IP address in the normal
(not reversed) order.

MNew Zone Wizard -

Reverse Lookup Zone Name E‘

A reverse lookup zone translates IP addresses into DNS names, "
L~

To identify the reverse lookup zone, type the network ID or the name of the zone,
Metwork ID:
172 18 1 .

e network ID is the portion of the IP addresses that belongs to this zone. Enter the
network ID in its normal (not reversed) order,

If you use a zero in the network ID, it will appear in the zone name. For example,
network ID 10 would create zone 10.in-addr.arpa, and network ID 10.0 would create
zone 0. 10.in-addr.arpa.

() Reverse lookup zone name:

1.18.172.in-addr.arpa

The zone translates the IP address into DNS names.

6. Click Next.
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7. Click Next and Finish to complete the zone installation.

MNew Zone Wizard -‘

Dynamic Update E‘

‘fou can specify that this DNS zone accepts secure, nonsecure, or no dynamic
updates. Ed

Dynamic updates enable DNS dient computers to register and dynamically update their
resource records with a DNS server whenever changes occur.

Select the type of dynamic updates you want to allow:

e
This option is available only for Active Directory-integrated zones.,

) Allow both nonsecure and secure dynamic updates
Dynamic updates of resource records are accepted from any dient,
This option is a significant security vulnerability because updates can be
24 accepted from untrusted sources,

) Do not allow dynamic updates
Dynamic updates of resource records are not accepted by this zone, You must update
these records manually.

< Badk I Next > I| Cancel
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o

MNew Zone Wizard -

Completing the New Zone Wizard

‘fou have successfully completed the New Zone Wizard. You
specified the following settings:

Mame:  1,18.172.in-addr.arpa -
Type: Active Directory-Integrated Primary

Lookup type: Reverse

w

Mote: You should now add records to the zone or ensure
that records are updated dynamically, You can then verify
name resolution using nslookup.

To dose this wizard and create the new zone, dick Finish.

Cancel

Map Host Name to IP Address

Complete these steps to create a pointer (PTR) record that associated the DNS
name to the IP address. During a search, the IP address is reversed to find the

associated DNS name.

1. From the Server Manager, click Tools and choose DNS.

The DNS Manager dialog box appears.

2. Open the primary server (PADCA) and Reverse Lookup Zones folders

and right-click the subdomain.
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3. Choose New Pointer (PTR) from the pull-down menu.

File Action View Help
e’ 2EXEd=z HE 88

él DS Name Type Data Timestamp
F] ﬁ PADCA E] (same as parent folder) Start of Authority (SOA) [1], padca.system.plantpa..  static

b [] Forward Lookup Zones E] (same as parent folder) Name Server (N5) padca.systemn.plantpax.loc.. static
4 [ Reverse Lookup Zones

- 1.18.172in-addr.arpa
[ Trust Points | Update Server Data File
1 Conditional Forwarders
7] Global Logs

DINS Events

-

Reload
AR
Mew Pointer (PTR]...

ew Alias

Mew Delegation...
Other New Records...
| DNSSEC

All Tasks

View

! Delete
Refresh
Export List...

Properties

E Help

Create a new pointer resource record.

The New Resource Record dialog box appears.

Pointer (FTR)

Host IP Address:
f728.110 |

Fully qualified domain name (FQDM):
| 10.1.18. 172.in-addr.arpa

Host name:
PADCA. System. PlantPAx. local| I || Browse... |

[ Allgw any authenticated user to update all DNS records with the same
name, This setting applies only to DNS records for a new name,

.

4. Type an IP address in the normal (not reversed) order.

5. Click Browse and select the host name on the primary server.

6. Click OK.
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7. Repeat step 1...step 6 for ‘secondary’ servers.
# DNS Manager =i “

File Action View Help

e 2EXEoREE i 88
i, DNS || Name Type Data = Timestamp
4 § PADCA = (same as parent folder) Start of Authority (SOA)  [1], padca.system.plantpa...  static
[ Forward Lookup Zones =:_|(san1easparentfolder] Mame Server (M5) padca.systern.plantpax.loc.. static
4[] Reverse Lookup Zones =]172.18.1.10 Pointer (PTR) PADCA System.PlantPAx.L...
.| 1.18.172.in-addr.arpa 1517218111 Painter (PTR) PADCB.System.le
Trust Points

Conditional Forwarders
4 [z Global Logs
§i| DINS Events

The example shows results for a DNS Lookup forward search and a
DNS Lookup reverse search.

=N Administrator, ChWindowsSystem32ycmd.exe

icrosoft Windows [Version 6.3.960801
(c?» 2013 Microsoft Corporation. All rights reserved.

=sonslookup PASSB2ZA
DNS request timed out.
| timeout was 2 seconds.
oy o o u ]{ n
Forward DNS Lookup - address: 172.18.1.10

PASSBE2A . System.PlantPAx. local
172.18.1.67

| =xonslookup PASSO2A
Reverse DNS Lookup . erver: padca.system.plantpax.local
ddress: 172.18.1.18

ame = PASSBEZA.System.PlantPAx.local
ddress: 172_18_1_67

HaS

IMPORTANT  Repeat the steps in the Control Network for the supervisory.
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Enable DHCP in the Primary
and Secondary Controllers

Use a primary and a secondary domain
controller with these procedures.

There are two ways of configuring IP addresses: static (manually) or dynamic
(via server). Both options are supported within a PlantPAx system. By using the
Dynamic Host Configuration Protocol (DHCP) server, you do not need fixed
IP addresses for application servers and workstations. But, you must define a

range and the system manages the IP addresses and names. We are applying
DHCP in PlantPAx computers only.

Add DHCP Server Role

If adding DHCP server roles for the domain controllers, you must do this
procedure for the primary and secondary servers.

In the primary domain, complete the following steps.

1. From the Server Manager, click Manage and choose Add Roles
and Features.

Server Manager -[alx]

| Add Roles and Features

Remove Roles and Features

"0 SERVER MANAGER
Add Servers

Create Server Group

i | Server Manager Properties
I 0 Configure

2. Click Next on each of the successive windows to do the following:

o Verify that certain tasks have been completed

e Select an installation type

3. Click Select a server from the server pool, select the desired server

(PADCA and PADCB), and click Next.

Select destination server PADCASystem PamPAdios

Add Roles and Features Wizard [= =[]

DESTINATION SERVER

Select a server or a virtual hard disk on which to install roles and features.

(@) Select a server from the server poal
() Select a virtual hard disk

Server Pool

Filter: |

Name IP Address Operating System

PADCA System.PlantPAx.... 172.18.1.10 Microsoft Windows Server 2012 R2 Standard

1 Computer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.

Install Cancel

< Previous
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4. Select DHCP Server and click Add Features.

Select server roles AR R

Select one or more roles to install on the selected server.

Before You Begin

Installztion Type Roles Description
Sepver Seection Directory Certificate Services sl (AAC;VCZ}D:;E::?‘ET:;::‘E §

Active Directory Domain Services (installed) R ey Add features that are required for DHCP Server?
Fezturas [] Active Directory Federation Services role services that allow you _ B :

[T Artive Directiory Lightweight Directory Seivices a"‘? manage Eeﬂ,ﬁmles dsed ;.I;he ﬂ:llub\:r_\’?s:;?l;are ;:‘:qulred to manage this feature, but do not

variety of applications. et be Lt ONVHIE SO BLE SEVED!
[[] Active Directory Rights Management Services
[] Application Server . 4 Remate Server Administration Tools
DHCP Server 4 Role Administration Tools
[v] DNS Server {Installed) [Tools] DHCR Server Tools
[ Fax Server
I [®] File and Storage Services (2 of 12 installed)

[] Hyper-v

[ Network Policy and Access Services |

[ Print and Document Services

[] Remote Access

[] Remote Desktop Services v Include management tools (if applicable)

[<brevious | [ Net> | [ imstan | [ 4
| G

5. Click Next on each of the successive dialog boxes to do the following:
o Verify selected server role
e Confirm installation selections

e Verify "Things to note’ concerning DHCP server

6. To confirm installation selections, click Install.

DESTINATION SERVER

Confirm installation selections BADCA o Pl i

Before You Begin To install the following roles, role services, or features on selected server, click Install.

Installation Type

Server Selection Optional features (such as administration tools) might be displayed on this page because they have
been selected automatically. If you do not want to install these optional features, click Previous to clear

Server Roles their check boxes,

Features

DHCP Server DHCP Server

Remote Server Administration Tools

Role Administration Tools
DHCP Server Tools

Export configuration settings
Specify an alternate source path

<Previous | [ mea> | [ sl J[ cancel
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7. Click Complete DHCP configuration. The DHCP Postlnstall
configuration wizard window appears.

8. Click Next.

[ Add Roles and Features Wizard

o

Installation progress

View installation progress

o Festure installation

Configuration required. Installation suc|

DHCP Server
Launch the DHCP post-install wizard

Complete DHCP configuration

Remote Server Administration Tools
Results

Role Administration Tools
DHCP Server Tools

Description

Authorization

DHCP Post-Install configuration wizard

The following steps will be performed to complete the configuration of the DHCP Server on the
target computer:

Create the following security graups for delegation of DHCP Server Administration.
- DHCP Administratars
- DHCP Users

Authorize DHCP server on target computer (if domain joined).

Commit Cancel

9. Click Commit to authorize the configuration and then click Close.

= DHCP Post-Install configuration wizard

Specify the credentials to be used to authorize this DHCP server in AD DS.

@) Use the following user's credentials

User Name; SYSTEM\Administrator

) Uge alternate credentials

Userame:

_) Skip AD authorization

=E |

[ DHCP Post-Install configuration wizard

Summary

The status of the post install configuration steps are indicated below:

Summary

Creating security groups .. Done

Please restart the DHCP server service on the target computer for the security groups to be
effective.

Authorizing DHCP server ... Done

The DHCP Post-Install configuration wizard window closes.

IMPORTANT  Authorize DHCP servers to help avoid damage that is caused by

running incorrect configurations or by using the wrong network
with DHCP servers.
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10. In the Add roles and Features Wizard window, click Close.

2 Add Roles and Features Wizard - [ex]

ESTINATION SERVER

Installation progress PADCA System Plari A oca

View installation progress

0 Feature installation

Configuration required. Installation succeeded on PADCA.System.PlantPAx local.

DHCP Server
Launch the DHCP post-install wizard

Remote Server Administration Tools
2 : Role Administration Tools

DHCP Server Tools

You can close this wizard without interrupting running tasks, View task progress or open this
page again by clicking Notifications in the command bar, and then Task Details.

Export configuration settings

11. Repeat step 1 through step 10 to add the secondary server (PADCB).

Configure DHCP Server

Complete the following steps to configure the DHCP server.
Use a primary domain controller

with these procedures.
1. From the Server Manager, click Tools and choose DHCP.

Server Manager

Tools View

Help

| Active Directory Administrative Center

| Active Directory Domains and Trusts
| Active Directory Module for Windows PowerShel|
| Active Directory Sites and Services

: s | Active Directory Users and Computers
Configure this | | apgean

| Component Services

O SERVER MANAGER

| Computer Management

2 A

roles and f o
| Defragment and Optimize Drives

3 Add other serviLBHP
DNS
4 Create a server Embedded Lockdown Manager
Event Viewer
Connect this se | Group Policy Management
iSCSI Initiator
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2. Right-click DHCP and choose Add Server.

3. To find the primary domain controller, click Browse.

File Action View Help

Select a server you want to add to your console.

= | B
=R 8 P
DHC| cp fi
i i Add Server... m.plant
= - - " This authorized DHCP server:
[ | qe SEMVETS...
2 [iF
| View » padca system plantpax Jocal 172.18.1.10
| Export List...
|Help

The Add Computer dialog box appears.
4. Click Advanced and then Find Now for the secondary

domain controller.

Select this object type:

|Computer Select this object type:
From this location: |Computer
|Sy§em.F‘15nt P local ions... From this location:
|System PlantPAxlocal

Enter the object name to select (zamples):
[ C Commen Queries |

Name: Starts with |
M| oot ] |

["] Disabled accounts

[ MNon expiring password

Days since last logon: l:l

The domain controller servers appear in the Search results.

S. Select the PADCB server and click OK.
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6. To add the secondary domain controller, click OK on the following
dialog boxes.

Select Computer - Add Server _

Select this object type: Select a server you want to add to your console.

|Computer | | Object Types... | (¢ This server:

From this location: |PADCB Browse... |
|System-PlantPP«-local | | Locations... | " This authorized DHCP server:

Enter the object name to select (examples): Name IP Address

PADCE Check Names padca.system plantpax Jocal 172.18.1.10

. .

I oK I Cancel

Enable DHCP Scope (Control Network)

Complete these steps to define the IP address range for the domain controllers.
A scope distributes the IP addresses to the computers on your network.

1. From the Server Manager, click Tools and choose DHCP.

2. In the Primary Domain, right-click on IPv4 and choose New Scope.

File Action View Help
X R ENE
% DHCP
4 ﬂ padca.systern.plantpax.local
3 iIP."' e ]
b G IPVE Display Statistics... | i
- o
4 § p_adcb New Scope... |I1resg
2 __iIF‘ MNew Multicast Scope... ac
by PV
Configure Failover... ope,
Replicate Failover Scopes... At
Define User Classes...

104 Rockwell Automation Publication PROCES-UMO001B-EN-P - August 2018



Configure System Servers ~ Chapter 3

3. Click Next, type Control Network.

A description is optional.

Mew Scope Wizard
Welcome to the New Scope e
Wizard Scope Name ~
You have to provide an identifying scope name. You also have the option of providing
This wizard helps you set up a scope for distibuting |P a description.

addresses to computers on your networl.

To continue, click Next. Type a name and description for this scope. This information helps you quickly identify

how the scope is to be used on your network.

Name: Control Netwarl

Description: |PIantPAx Control Network

1=
El
v

Cancel

4. Click Next.
5. Type the Start and End IP address range.

Mew Scope Wizard
IP Address Range -
‘You define the scope address range by identifying a set of consecutive |F addresses.

Configuration settings for DHCP Server

Enter the range of addresses that the scope distributes.

Start IP address: §| 172. 18 . 1 .12

End IP address: |1?2. 2.1 .9

Configuration settings that propagate to DHCP Client

Subnet mask: 255 .255.285. 0

| < Back I Mext > I| Cancel |

6. Select a CIDR value from the Length pull-down arrows, and click Next.

The number, such as 24 in the example, represents 24 bits on the
network mask. The last 8 bits on the address are used to identify the
device on the network.

7. Click Next on each of the successive dialog boxes to accept the defaults:
o Add Exclusions and Delay
e Lease Duration

¢ Confirm 'Configure DHCP Options now'
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8. Type the gateway IP address that is used in this VLAN and click Add.
The gateway address is added to the list.

9. Click Next.

Mew Scop

Router (Default Gateway)
You can specify the routers, or default gatewa

To add an |P address for a router used by clier

Router (Default Gateway)

Mew Scope Wizard

You can specify the routers, or default gateways, to be distributed by this scope.
To add an IP address for a router used by clients, enter the address below.

IP address:

1721811

dilis

< Back Mext >

Cancel

10.

To select the alternate DNS server, type the secondary domain

controller IP address and click Add. The IP address is added to the list.

TIP  The primary IP address is already in the list (172.18.1.10 in the example).

11. Click Next.

Mew Scope Wizard

Domain Name and DNS Servers =
The Domain Name System (DMNS) maps and translates domain names used by clients
on your networl.
You can specify the parent domain you want the client computers on your network to use for
DNS name resolution.

Parent domain: |System.P|amPAx.|oca|

To configure scope clients to use DNS servers on your network, enter the |P addresses for those
Servers.

Server name:

172.18.1.10

i}

<Back || Net> | [ Cancel
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Mew Scope Wizard

Domain Name and DNS Servers
The Domain Name System (DMNS) maps and translates domain names used by clients
on your networl.

You can specify the parent domain you want the client computers on your network to use for
DNS name resolution.

Parent domain: |System.P|amPAx.|oca|

To configure scope clients to use DNS servers on your network, enter the |P addresses for those
Servers.

Server name: IP address:

[ rad |
[ B |
Lo |
Foeim

< Back I Mext > I Cancel

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018




Configure System Servers

Chapter 3

The WINS Servers dialog box appears.

12. (Optional) To enable WINS servers, type an IP address for a server and
click Add. The IP address is added to the list.

13. Click Next.

Mew Scope Wizard

WINS Servers —
Computers running 'Windows can use WINS servers to convert MetBIOS computer
hames to [P addresses.

Entering server |P addresses here enables ‘Windows clients to query WINS before they use
broadcasts to register and resolve MetBI0OS names.

Server name: IP address:

|
=

(L

To change thiz behavior for ‘Windows DHCP clients modify option 046, WINS/MET Mode
Tupe, in Scope Options.

| < Back I| Mest > ﬂ| Cancel

The Activate Scope dialog box appears.

14. To activate the Scope, click Next and then Finish.

Enable DHCP Scope (Supervisory Network)

Complete these steps to define the IP address range for the
Supervisory Network.

1. From the Server Manager, click Tools and choose DHCP.

2. In the Primary Domain, right-click on IPv4 and choose New Scope.

ey

o

File Action View Help

I ERENCEN =

% DHCP | -

4 F padca.system.plantpaxlocal I-ﬂl Add aScop
b | G 1P L .
b 1Pvél Display Statistics...
= of

| p_adch New Scope... |I1re55
2 ? i | New Multicast Scope... o
b @ PV |

Configure Failover... lope,

Replicate Failover Scopes... fatiol

Define User Classes...
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3. Click Next, type Supervisory Network.

A description is optional.

N

Mew Scope Wizard
Welcome to the New Scope New Scope Wizard
Wizard Scope N N
This wizard helps you set up a scope for distibuting IP :?ji::;;ito?fmwde an identifying scope name. You also have the option of providing

addresses to computers on your networl.

To continue. click Next. Type a name and description for this scope. This information helps you quickly identify

how the scope is to be used on your network.

Name: |Su|:nar\c'isor1.r Network

Description: |PIantPAx Supervisory Metwork

108

1=
El
v

Cancel

4. Click Next.
5. Type the Start and End IP address range.

Mew Scope Wizard

IP Address Range
‘You define the scope address range by identifying a set of consecutive |F addresses.

Configuration settings for DHCP Server
Enter the range of addresses that the scope distributes.

Start IP address: §| 172. 20 . 1 .10

End IP address: 172,20 01 253

Configuration settings that propagate to DHCP Client

Subnet mask: 255 .255.285. 0

| < Back I Next > |I| Cancel |

6. Select a CIDR value from the Length pull-down arrows, and click Next.

The number, such as 24 in the example, represents 24 bits on the
network mask. The last 8 bits on the address are used to identify the
device on the network.

7. Click Next on each of the successive dialog boxes to accept the defaults:
o Add Exclusions and Delay
e Lease Duration

¢ Confirm 'Configure DHCP Options now'
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8. Type the gateway IP address that is used in this VLAN and click Add.
The gateway address is added to the list.

9. Click Next.

Mew Scope

Router (Default Gateway)
You can specify the routers, or default gateways

To add an IP address for a router used by clients

Router (Default Gateway)

Mew Scope Wizard

You can specify the routers, or default gateways, to be distributed by this scope.
To add an IP address for a router used by clients, enter the address below.

IP address:

1722011

dilis

< Back Mext >

Cancel

10. To select the alternate DNS server, type the secondary domain
controller IP address and click Add. The IP address is added to the list.

TIP  The primary IP address is already in the list (172.18.1.10 in the example).

11. Click Next.

New Scope Wizard

Domain Name and DNS Servers
The Domain Mame System (DNS) maps and translates domain names used by clients
on your networlk.

3

You can specify the parent domain you want the client computers on your network to use for
DMS name resolution.

Parent domain: |System.PIardPAx.IocaI

To configure scope clients to use DNS servers on your networle, enter the IP addresses for those
SErvers

|P address:

I'I?2.'IE.'I.'I'III Add
172.181.10

Server name:

Mew Scope Wizard

Domain Name and DNS Servers ~
The Domain Name System (DMNS) maps and translates domain names used by clients
on your networl.

You can specify the parent domain you want the client computers on your network to use for

DNS name resolution.

Parent domain: |System.P|amPAx.|oca|

To configure scope clients to use DNS servers on your network, enter the |P addresses for those
Servers.

Server name: IP address:

i

<Back ||
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The WINS Servers dialog box appears.

12. (Optional) To enable WINS servers, type an IP address for a server and
click Add. The IP address is added to the list.

13. Click Next.

Mew Scope Wizard

WINS Servers —
Computers running Windows can use WINS servers to convert NetBIOS computer

names to IP addresses.

Entering server |P addresses here enables Windows clients to query WINS before they use
broadcasts to register and resolve NetBIOS names.

Server name: IP address:

|
[ At |

dill;

To change this behavior for Windows DHCP clients modify option 046, WINS/NET Node
Type, in Scope Options.

< Back Mext > Cancel

The Activate Scope dialog box appears.

14. To activate the Scope, click Next and then Finish.

Configure Failover

Complete these steps to configure high availability for your domain
controllers.
1. From the Server Manager, click Tools and choose DHCP.

2. In the Primary Domain, right-click on IPv4 and choose Configure
Failover.

ey

= DHCP
File Action View Help

= 7@ XE &=z HE
@ DHcp Mame
4 5 padcasystem.plantpax.local BPva

E %:E:‘; Display Statistics...
4 3 padch New Scope...

4 :3 |PV4E MNew Superscope...

b b IPvG MNew Multicast Scope...

Heplicate Failover Scopes...
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3. Click Next and then Add Server.

Configure Failover

Introduction to DHCP Failover

DHCP Failover enables high availability of DHCP services by
synchronizing | address lease information between two DHCP
servers. DHCP failover also provides load balancing of DHCP
requests.

This wizard will guide you through setup of DHCP failover.
Select from the following list of scopes which are available to be
configured for high availability. Scopes which are already
configured for high availability are not displayed in the list bel

ject gl | Configure Failover

Available scopes: v

172.18.1.0 Specify the partner server to use for failover fﬁi

Provide the host name or IP address of the partner DHCP server with which failover
should be corfigured.

You can select from the list of servers with an existing failover configuration or you can
browse and select from the list of authorized DHCP servers.

Altematively, you can type the host name or IP address of the partner server.
etner Sener || j

-

[l==]
p—
[
w

I| Cancel |

4. Select the backup server, select 'padcb, click OK, and then Next.
Add Server _ Configure Failover

Select a server you want to add to your console. Specify the partner server to use for failover .ﬁ
" This server:
| Provide the host name or IP address of the partner DHCP server with which failover

should be configured.
{+ This authorized DHCP server:
| Name | IP Address

You can select from the list of servers with an existing failover configuration or you can
browse and select from the list of authorized DHCP servers

Altemnatively, you can type the host name or IP address of the partner server.

Partner Server. |padcb j Add Server

~

padch system plantpax local

I oK I Cancel

<Back ||

=

lext > I| Cancel
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5. Select Hot standby from the Mode pull-down, and type a shared secret.

Configure Failover

Create a new failover relationship ‘ﬁ ~

Create a new failover relationship with partner padch

Belationship Name: |padc:a.system.plardpax.local-padcb

Maximum Client Lead Time: 1JZ| hours DJZl minutes

Mode: || Hot standby =l

| Standby |

Addresses reserved for standby server: 5g %

Hot Standby Configuration
Role of Partner Server:

[~ State Switchaver Interval: EZJ: minutes

[¥ Enable Message Authentication

Shared Secret: I|'““““ I

6. Click Next.
7. Click Finish and Close.

Configure Failover

Failover will be set up between padca system plantpacloc... and
padch with the following parameters.

Scopes:
172.18.1.0 Configure Failover _

Progress of failover configuration.

The log below shows the progress of the various tasks for corfiguring failover
including any emors encountered.

Relationship Name: padca system plantpax locy Add scopes on partner server Successful

Mapimum Client Lead Time: 1 hrs 0 mins Disable scopes on partner server . Successful

Mode: Hot standby Creation of failover corfiguration on partner server .

State Switchover Interval: Disabled Creation of failover corfiguration on host server .

< m Activate scopes on partner server. Successful
Configure failover successful.

Hot Standby Configuration

Role of Partner Server: Standby

Addresses reserved for standby: 5%

Close

| < Back I Finish ﬂ| Cancel |

Proceed to page 113 to group the settings for the workstations and servers
under one authority.

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018



Configure System Servers ~ Chapter 3

Join the Domain

Use all servers and workstations
with these procedures.

When you join the system elements into a single domain, the control and
communication of the infrastructure is seamless. The domain centralizes all
administrative settings for the workstations and servers in your application.

1. Click the Windows = i symbol.

2. Click Control Panel and choose System>Change Settings.

ystem settings

System
Processorn Intel(R) Xeon(R) CPU E5-2670 0 @ 2.60GHz 2.60 GHz
Installed memory (RAM):  4.00 GB
Systern type: 64-bit Operating System, x64-based processor
Pen and Touch: Mo Pen or Touch Input is available for this Display

Computer name, domain, and workgroup settings

Computer name: PASS01

Full computer name: PASS01
Computer description:

Domain:

Windows activation

3. Click Change, select Domain, and then type the domain name and
click OK.

e

System Properties -

Computer Name | Hardware I Advanced I Remote |

i L Windows uses the following information to identify your computer
- on the network.

You can change the name and the membership of this
computer. Changes might affect access to network resources.

Computer description: ||

For example: "l15 Production Server” or )

"Accounting Server”. Computer name:
Full computer name: PASSDT PASSO1 |
Workgroup: WORKGROUP Full computer name:

PASSO1
To rename this computer or change its domain or
workgroup, click Change.
Member of

-i% ;
System.PlantP Ax local

O Workgroup:
WORKGROUP

Computer Name/Domain Changes -

system =T ——
1 1% » Control Panel » All Control Panel ltems » System v & | Search Control Panel o |
2]
iel Home . Pl F
View basic information about your computer
BgEr Windows edition

OK | | Cancel Apply
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4. Type a user name and password to add this computer to the domain and
click OK on the dialog boxes.

Computer Name/Domain Changes

Enter the name and password of an account with permission to join the
domain.

Administrator o Welcome to the Systemn.PlantPAx.local domain.

Domain: System.PlantPAx.local

If you have the correct access, the computer is accepted into
the domain.
5. To accept the changes and restart the computer, do the following:
¢ Click OK in the first warning dialog box
e Click close in the Systems Properties dialog box

e Click Restart Now in the second warning dialog box

Comptter Name | Hardware | Advanced | Remote |

You must restart your computer to apply

these changes ﬂEl' Windows uses the following information to identify your computer
on the network.

Before restarting, save any open files and close all

programs. Computer description:

For example: "l15 Production Server” or
"Accounting Server”.

Full computer name: PASS01. System. PlantP Ax local
Domain: System PlantP A« local

To rename this computer or change its domain or
workgroup, click Change.

You must restart your computer to apply these
changes

Before restarting, save any open files and close all programs. /i Changes wil <ct after you restart this computer

| Cancel || Aoply

6. After restarting the computer, press Ctrl+Alt+Delete to log in.
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7. Click Switch User, choose Other User, and type [Domain Name]\user,
such as System\Administrator, followed by the password.

\Administrator

Fass‘v-."ord

©

\Administrator Other user

@ Other user

SYSTEM\Administrator

Sign in to: SYSTEM

8. Repeat step 1 through step 7 for all system computers.
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Use the primary server with
these procedures.

PADCA

116

Confirm Computers in DNS Server

When all system computers are in the domain, you can confirm the addresses
on the Domain Controller DNS server.

Complete the following steps.

1. From the Server Manager, click Tools and choose DNS.

Server Manager

@ |

D SERVER MANAGER

r Manage Tools

o Configure this lo

2 Add roles and fea o
Defragment and Optimize Drives
3 Add other server L2
| |ons
4 Create a server qr Embedded Lockdown Manager
Event Viewer
5 Connect this servg Group Policy Management

View Help
Active Directory Administrative Center
Active Directory Domains and Trusts
Active Directory Module for Windows PowerShell
Active Directory Sites and Services
Active Directory Users and Computers
ADSI Edit
Compaonent Services

Computer Management

iSCSI Initiator

The DNS Manager dialog box appears.

2. Select DNS> <primary domain>>Forward Lookup Zone> <primary
domain name> (System.PlantPAx.local in our example).

2 DNS Manager -0 -
File Action View Help
| 2 XEdz HE § &
: DNS MName Type Data Times
4 [ PADCA =d _msdcs
3 Global Logs 7 _sites
4[] Forward Lookup Zones “ tep
Pl local | _udp
_| DomainDnsZenes
bl hevetse Loo o = ForestDnsZones
b Eru;;.:.omtlsF i ] (same as parent folder) Start of Authority (SOA) [67], padca.system.plantp...  static
b T T =] (same as parent folder) Mame Server (NS} padca.system.plantpaxloc., static
] (same as parent folder) MName Server (NS} padch cstemn plantpax.lo..  static
i—] (same as parent folder) Host (A) 172.18.1.11 81472
i=| (same as parent folder) Host (A) 172.18.1.10 8/13/¢
e—] padca Host (A) 172.18.1.10 static
E]rapce Host (4) 17218111 static
a PASS0T Host (A) 172.18.1.13 8714/
] passoza Host (4) 17218114 8714/
] PASs02B Host (4) 17218115 8/14/%

The Data column displays the IP addresses.

IMPORTANT  The same IP address is not expected for more than one server or

workstation.
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Confirm Computers in DHCP Server

You can confirm all computers in the DHCP server by accessing the Address

Leases folder.

Complete the following steps.

1. From the Server Manager, click Tools and choose DHCP.

Manage Toals View Help
| Active Directory Administrative Center

re this lo

| Active Directory Domains and Trusts
Active Directory Module for Windows PowerShell
| Active Directory Sites and Services
| Active Directory Users and Computers
| ADSI Edit
Component Services
| Computer Management
Defragment and Optimize Drives

| DHCP

| DNS

| Embedded Lockdown Manager
| Event Viewer

| Group Policy Management

| iSCSH Initiator

The DHCP dialog box appears.

2. Select DHCP> <domain controller>>IPv4>Scope>Address Leases.

5 DHCP - [
File Action View Help
I EEEEN =
? DHCP Client [P Address MName Lease E|| Actions
4 ﬂ padca.systemn.plantpax.local 17218002 8/22/20 Adidios A.
4 [ Pvd 8172.18.1.13 PASS01.5ystem.PlantPAx.local 8/22/20 ; = .
4[] Scope [172.18.1.0] PlantPAx Computers || 18172,12,1.14 PASS02A,System.PlantPAx.local 8/22/20 HE
sntflileznbng &j172.18.1.15 PASSD2E.System.PlantPAx.local 8/22/20
5 Address Leases

Scope Options

4| Policies

The Name column lists the computers.

IMPORTANT  The IP address that is assigned to all system computers needs to
match the IP addresses in the DNS list.

Proceed to page 118 to place the users and groups into the
Active Directory.
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Create Groups and Users From operators and maintenance personnel to engineers, the domain

controller manages groups in the active directory. The procedures describe how

to create groups for units, roles, and areas per your application requirements.
Use a domain controller

with these procedures.

Unit Groups

Complete these steps.

1. From the Server Manager, click Tools and choose Active Directory Users
and Computers.

Server Manager

@ F

Manage Tools View elp

Active Directory Administrative Center
Active Directory Domains and Trusts
Active Directory Module for Windows PowerShell

D SERVER MANAGER

Active Directory Sites and Services

I v
f | Active Directory Users and Computers
Configure —

Component Services

2. On the Active Directory Users and Computers dialog box, expand the
domain folder (System.PlantPAx.local).

3. Right-click the domain and choose New>Organizational Unit.

e Active Directory Users and Computers [-T= I
File Action View Help
s 2F H Bz HE 3 &8ETAR
] Active Directory Users and Computers [PADC) | Name - Type Description
b || Saved Queries " Builtin builtinDomain
AI?;E System.PIant@ | Comnuters Container Default container for up...
i (] Builtin Delegate Contral... ollers Organizational... Default container for do...
sl Comp.ute Find... tyPrincipals Container Default container for sec...
. :— Eoc:i;l:Se Change Domain... ice Accounts  Container Default container for ma...
5 Managed Change Domain Controller... Container Default container for up...
| Users Raise domain functional level...
Operations Masters...

New ’I Computer

All Tasks » Coptait

View » Group

Refresh InetOrgPerson

mslmaging-P5SPs
MSMC Queue Alias

Properties e =
Organizational Unit

Help Printer

Export List...

User

<| m » Shared Folder

\Create a new object...
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4. Type the group name and click OK.

New Object - Organizational Unit -

— Createin:  System.PlantP A local/

Mame:
| PlantP Ax

Protect container from accidental deletion

Role Groups

1. To define the roles for the group, right-click the group name and choose
New>Organizational Unit.

> | Managed Ser\riceAccourl
| Users
2| PlantPAx|
1 Delegate Control...
Move...
Find...
New 2 Computer
All Tasks 3 Contact
View ’ Group
Cut InetOrgPerson
Delota mslmaging-PSPs
MSMC Queue Alias
Rename [
| Refrech Organizational Unit
< m | i
— Export List... LTS —
Create a new object., = | User
= Properties - R =

2. Under the PlantPAx Organizational Unit, create these three units:
o Users
o Areas
e Roles
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3. Right-click Roles and choose New>Group.

Delegate Control...

Move...
Find...

|| MNew 3 : Computer ‘
Al Tasks vl gnta

o :

netlUrgHerson |
Cut | g |

mslmaaina-PSPs

4. Type the group name and click OK.

New Object - Group -

Sz_h Createin:  System.PlantPAx.local/Users

IGroup name:
I FlantPAx Operators |

Group name (pre-Windows 2000):
| FlantPAx Operators |

Group scope Group type
) Domain local ®) Security
(®) Global ) Distribution

() Universal

5. Repeat step 4 for all application groups, including the following:
e PlantPAx Operating Supervisor
¢ PlantPAx Maintenance
e PlantPAx Maintenance Supervisor
e PlantPAx Manager
o PlantPAx Engineering
¢ PlantPAx Administrator
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6. Create the roles for all group application, including as shown:

E Active Directory Users and Computers
File Action View Help

s §dB8 XE &= H PRrETER

] Active Directory Users and Com || Name Type Description

H2 PlantPAx Administrator

2, PlantPAx Engineering

82 PlantPAx Maintenance

#2, PlantPAx Maintenance Supervisor
H2, PlantPAx Manager

H2, PlantPAx Operating Supervisor
H2, PlantPAx Operators

I | Saved Queries
4 3 Systermn.PlantPAx.local
> || Builtin
b | Computers
I+ |2 Domain Controllers
[ || ForeignSecurityPrincipals
> || Managed Service Accour
| Users
4 3| PlantPAx
| Users

Security Group - Global
Security Group - Global
Security Group - Global
Security Group - Global
Security Group - Global
Security Group - Global
Security Group - Global

Areas
&l Roles
Area Groups

Complete these steps to define specific areas based on the group.

1. On the Active Directory Users and Computers dialog box (with the
Users folder still selected), right-click New and choose User.

4 2| PlantPax
% Delegate Control...
2| Holes
Move...
Find...
New 3 Computer
All Tasks 3 . Contact !
View ’ Group
Cut InetOrgPerson
Delete mslmaging-P5SPs
MSMQ Queue Alias
Rename
Mraanizatinnal [nit
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The New Object Group dialog box appears.

2. Type an object name for the group and use the defaults for scope
and type.

New Object - Group -

ﬂs_h Createin:  System.PlantPAx.local PlantPAx/Areas

Group name:
| Areall_Basic |

Group name (pre-Windows 2000):

| Areall Basic |
Group scope Group type
) Domain local (®) Security
(®) Global ) Distribution
O Universal

3. Click OK.
4. Repeat step 2 but for the group name type Area0l_Advanced.
5. Click OK.

IMPORTANT  We do not recommend using generic area names like Area01. Be
specific (‘Packaging, ‘Molding;, and so on), but create two types—
Basic and Advanced—for each area.

6. Repeat step 2 for each area of the plant.

= Active Directory Users and Computers I;Ii-
File Action View Help
4§ B XE G = ShETER
] Active Directory Users and Computers [PADC gl = Type Description
I ] Saved Queries H2, Areall1_Advanced Security Group...
4 G System.PlantPAx.local 92, Area01_Basic Security Group...
i (] Builtin H2, Areal2_Advanced Security Group...
- Comp.uters 82, Area02_Basic Security Group...
- DUI’T‘!EIH Cont.rolle.rs . 2, Areal3_Advanced Security Group...
b B8 ForsignSecurityPrincipals 2, Area03_Basic Security Group...
o E‘:Eﬂ:Pg‘:: BENACE ARCOUnt: 82, Areald_Advanced Security Group...
e al 2, Areald_Basic Security Group...
S| Areas 2.
= Roles 82, Areal5_Advanced Security Group...
i 52, Areal5_Basic Security Group...
Users
< m >
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Create Users

Complete these steps to enter personnel names into the domain controller.

1. On the Active Directory Users and Computers dialog box, click the
domain and expand the group (PlantPAx).

2. Right-click Users and choose New>User.

File Action View Help

e 2E F 8 XEBz Hm 2 aaTEh

] Active Directory Users and Computers [PADC) | Name - Type Description
b | Saved Queries
4 3 System.PlantPAx.local
b | Builtin
] Computers

2 Domain Controllers
I [| ForeignSecurityPrincipals
] Managed Service Accounts

4 (3] PlantPAx
[Z] Areas
S| Roles
= Us ;
B Izjsers =l Delegate Control...
| Move...
| Find...
Neﬂ PI | Cﬂmpu‘ter
| All Tasks 3 Contact
\ 3 Group
InetOrgPerson
mslmaging-P5Ps
MSMQ Queue Alias

[< [T

Create a new object. Eiciica otk a

User
ared Folder

The New Object User dialog box appears.
3. Type the name of a user and initials.

Our example shows ‘Jorge’ for instructional purposes only.

& Createin:  System.PlantP ¢ local/Plant P Ax/Users

Last name: |

Full name: Jorge

jorge | PlantPAxlocal

User logon name (pre-Windows 2000):
[svsTENM | fforae
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IMPORTANT  We do not recommend using ‘generic users’ such as ‘Operator’ or “Admin’ to
share on the system.

4. Type a user login name and click Next.

5. Type the initial user password and repeat to confirm the entry.

New Object - User -
2_; Createin:  System.PlantPAclocal/PlantP Ac/Users
Password: Ty |
Confirm password: sssssenns |

I User must change password at next logon I

[] User cannot change password

[ Password never expires
[ Accourt is disabled

B | te>

6. Click ‘User must change password at next logon’ and click Next.

This procedure gives a user a unique password that, for security
purposes, a user can change any time.

TIP  You can consider checking the ‘Password never expires’ checkbox to
help prevent from being locked out if the password expires.

7. Click Finish.

New Object - User -

2_; Createin:  System.PlantPAclocal/PlantP Ac/Users

When you click Finish, the following object will be created:

Full name: Jorge ~
User logon name: jorge @ System. Plant P Ax local

The user must change the password at next logon.

.
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Assign Users to a Group

The created users are not yet members of any group. Complete the following
steps to assign the users to a group.

Assign a User to the PlantPAx Operators Group

In this section, individual users are assigned to the PlantPAx Operators group.
The same procedures apply to assign users to other groups.

1. In the Active Directory Users and Computers window, open the group
folder. (PlantPAx is our example).

2. Click Roles, right-click a group, and choose Properties.

B Active Directory Users and Computers: = = -
File Action View Help
] Active Directory Users and Com || Name Type Description
I- || Saved Queries ! Tt
4 3 System.PlantPAxlocal 2, PlantPAx Operat Add to a group... - Global
I _ Builtin gplantPAx Mainte Move... - Global
> E Comp_uters H2 PlantPAx Mainte Send Mail - Global
[> =] Domain Controllers 52, PlantPAx Manag - Global
[ || ForeignSecurityPrincipaly| 4 o] All Tasks ¥
e v i 52, PlantPAx Engine - Global
b [ Managed service Accourl| g pjantpax Admin | Cut - Global
| Users Delets
4
Rename
Properties
Help
<] i >
|Opens the properties dialog box for the current selection.
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3. In the PlantPAx Operators Properties dialog box, click the Members tab.

This tab shows the members of the PlantPAx Operators group. (Our
example shows no members.)

4. Click Add.
5. Type the user name (Jorge in our example) in the text box and click OK.

6. Repeat step 4 and step 5 to add users.

PlantPAx Operators Properties |2 I TIP: To search for a user name, type a few letters
of the name into the text box and click

| Geneml| Members ||‘v19mber0f I Managed By |

Members:

Check Names.

Name

Active Directory Domain Services Folder

Select Users, Contacts, Computers, Service Accounts, or Groups -

Select this object type:

|Users, Service Accounts, Groups, or Other objects | | Object Types... |

From this location:

|System.PIantPAx.IocaI || Locations... |

Enter the object names to select (examples]:

Jorge [jorgedES vstem. PlantPas local Check Mames

/’V

-
/ Advanced...

PlantPAx Operators Properties |2 IR |

126

|—Geneml Members | Member Of ! Managed By |

Members:
Mame Active Directory Domain Services Folder
?) Jorge System.PlantP &« local /Plart P Ax/Users

ok | o 1]

The PlantPAx Operators Properties dialog box shows all users that you
added in the previous steps. (Jorge in our example.)

IMPORTANT Do not use more than one PlantPAx group for a single user to help
prevent being denied access. The following dialog boxes show how
to identify members that are assigned to groups.
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7. Click OK to close the group Properties dialog box.

The following steps assign a user to a group by using the group
properties.

8. In the Active Directory Users and Computers window, click the Users
folder, right-click on an individual user name (Jorge in our example) and
choose Properties.

File Action View Help

e 2E F 8 XEz Hm 2 aaTEh
] Active Directory Users and Com || Name Type Description
b [ ] Saved Queries ‘

4 3 System.PlantPAx.local Copy...

b [ Builtin Add to a group...
| Computers

i 2| Domain Controllers

I+ [ ] ForeignSecurityPrincipaly
P | Managed Service Accour Move...

[ Users Open Home Page

] Send Mail

Disable Account

Reset Password...

| All Tasks

Cut
Delete

(<

Opens the properties dialog box for the current selection,

The Properties dialog box for the selected user appears.

9. Click Add to add users to areas of the application.

| PRemotecontrol |  Remote Desktop Services Profle | COM=+
General | Address | Account | Profle | Telephones | Organization
MemberOf | Digin |  Envionment | Sessions

Member of:

MName Active Directory Domain Services Folder
Domain Lsers System PlantPAx loc 3
PlantP A« Operators  System Plant P Ax local /PlantP fc/Roles

Primary group; Domain Users

z There is no need to change Primary group unless
Set Prmary Group you have Macintosh clients or POSIX-compliant
applications.

| [ Conesd [[ oy || Hep
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10. From the Select Groups dialog box, type an object name.

‘Area’ is our example as entered on page 122.

Select this object type:

|Gmups or Builtin security principals

From this location:

|5ystem.P1amPMoca|

Enter the object names to select (zamples):

11. Click Check Names.
12. Select an object from the list and click OK.

More than one object matched the name "Area”. Select one or more names
from this list, or, reenter the name.

Matching names:

Name

82 Areall?_Basic
82 Areal3_Advanced
%}\reaﬂS_Basic
%ﬂreaﬂd_}\d\ranced
%ﬂreaﬂ-i_Easic
%ﬂreaﬂE_M\ranced
%Areaﬂ.‘i_Easic

In Folder

System.PlantP A« local /PlantPA..
System.PlantP A« local/PlantPA. ..
System.PlantP A« local /FlantPA...
System.PlantP A« local /FlantPA..
System.PlantP A« local /PlantPA. .
System.PlantP A local/PlantPA. ..
System.PlantP A« local/PlantPA. ..

13. Click OK.

Select this object type:

|Gmups or Builtin security principals

From this location:

|5ystem.P1amPMoca|

Enter the object names to select (zamples):

Arealll Basic

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018




Configure System Servers

Chapter 3

A Properties dialog box appears for the personnel name (for example,

Jorge) that is being added as a ‘member of” a group.

[ S|

Domain Users System . PlantP A local /Users

Jorge Properties
| Remote control i Remote Desktop Services Profile | COM=
| General | Address | Account I Profile I Telephones | Organization
Member Of | Dialin | Environment | Sessions
Member of:
MName Active Directory Domain Services Folder

Areall_Basic System . Plant P A« local/Plart P Ax/ Areas

PlantP A« Operators  System Plart P Ax local /Plant P fc/Roles

[ Add. || Remove

Primary group; Domain Users

applications.

R There is no need to change Primary group unless
SR B you have Macintosh clients or POSIX-compliant

~ ok | o |[ 5w

14. Click OK.

Assign a User to the PlantPAx Administrator Group

IMPORTANT  In the previous procedure, a user was added to a group by using the group

properties. In this procedure, a user is added to a group by using the
individual user properties. Our example is ‘Harry"

1. In the Active Directory Users and Computers dialog box, choose the
Users folder, right-click on a user (Harry in our example) and choose

Properties.

The Properties dialog box appears and 'Harry' is not a member of

any groups.

2. Click Add.

3. Type the group name in the text box and click OK.

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018

129



Chapter3  Configure System Servers

T —— [ [ TIP: To search for a user name, type a few letters
— of the name into the text box and dlick
| Femote control I Femote Desktop Services Profile I COM+
General | Address I Account I Profile I Telephones I Organization ChECk NameS.
Member Of | Dialin I Environment Sessions
Menmber ok Select Groups -

Mame Active Directory Domain Services Folder

Select this object type:

|Gr0ups or Built-in security principals | | Object Types... |

From this location:

|System.PIantPAx.IocaI || Locations... |

Enter the object names to select [examples]:

Check Mames

Add... ) .
T B |
v
Frimary group: | Remote cortrol I Remote Desktop Services Profile I COM+
General I Address I Account I Profile I Telephones I Organization
Set Primary Gri Member Of | Diglin I Environment | Sessions
Member of:
MName Active Directory Domain Services Folder

Areall_Advanced System Plart P Ax local /Plant P A/ Areas

ArealZ_Advanced System Plant P Ax local /PlantP A/ Areas

|: Areal3_Advanced System Plart P Ax local /Plant P A/ Areas
Areald_Advanced System Plart P Ax local /PlantP fc/ Areas

Areal5_Advanced System Plart P A« local /Plant P A/ Areas

Domain Users System Plart P Ax local /Users

PlantP &« Administrator  System.Plart P Ax local /Plant P fc/Roles

£ | _I_II | >
Primary group; Domain Users

There is no need to change Primary group unless
you have Macintosh clients or POSIX-compliant
applications.

'Harry' is now a member of the PlantPAx Administrator group. Harry is
an Advanced user to all areas.

4. Click OK.

IMPORTANT  We recommend for a production environment to disable the
Windows Administrator account and use a new PlantPAx
Administrators Users Group. Do not use default passwords.
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We recommend group policy management as a part of the infrastructure
design. Policies help reduce the maintenance and complexity when you add
new users and computers into the PlantPAx® system. Once that you have
configured specific policies on a domain controller, you do not have to
configure the same policies on the domain computers.

The policies determine what users can and cannot do, such as password
maintenance or to restrict folder access. The same approach applies for how to
define server maintenance.

By carefully planning the control of multiple policies in the Active Directory
environment, you can reduce the cost of system ownership. Group Policy
Objects (GPOs) administer the set of policies that centralize all settings.

This chapter describes procedures to manage configurations for your domain
controller. The optional techniques include the following:

o Windows Time Service with an NTP server
e Password strength configuration

e Lockout policy configuration

e Interactive logon configuration

¢ Group access level definition

e USB drive protection

The settings that are outlined are recommendations; your business, IT, and
security requirements could require additional policies.

Figure 8 on page 132 shows the topics that are described in this chapter.

Consider the following suggestions before starting this chapter:

e Although this chapter offers optional configurations for domain
controllers, we strongly encourage the use of the techniques for a
centralized administration.

e This layer of protection does not supersede any anti-virus protection or
other protection methods. It is best practice to have antivirus software
that is installed on your PlantPAx servers and workstations.

See Knowledgebase Answer ID 35330 at
hetp://www.rockwellautomation.custhelp.com for more information on

compatibility and considerations when you install antivirus software.
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Figure 8 contains the topics that are described in this chapter. Click or see the
page number for quick access to a section.

Figure 8 - Group Policy Management Workflow

{ Start )

4
Default Domain Controller Policy + Configuring the NTP Server
« (Configuring Windows Time Service
See page 133 « Enforcing the Domain Controller Policy
b

Configuring an NTP Client
Configuring Windows Time Service

Configuring Password Strength
Configuring Account Lockout Policy

Default Domain Policy

e o o o e o

See page 143 Configuring an Interactive Logon
Enforcing the Domain Policy
r

Define Group Access Level
USB Drive Protection

Configure Portable Device Enumerator Service

PlantPAx Users Policy Object

e o o o

See page 160 Software Access Restriction
h 4
See Chapter 5 Configure FactoryTalk® Components
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Default Domain Controller
Policy

Use a domain controller
with these procedures.

This section describes how to configure Windows Time Service as a Network
Time Protocol (NTP) server and client. The domain is responsible to
propagate and enforce the clock time to the domain computers. This policy
functionality helps verify that all computers are synchronized with the NTP
server.

For your convenience, the procedures are presented in these subsections:

o Configuring the NTP Server
o Configuring Windows Time Service
e Enforcing the Domain Controller Policy

Configuring the NTP Server

Complete these steps to edit the default domain policy to define the NTP

SCrver.

1. Click to open the Server Manager.

2. Click Tools and choose Group Policy Management.

Server Manager

Manage Tools

Active Directory Administrative Center
Active Directory Domains and Trusts
Active Directory Module for Windows PowerShell
Active Directory Sites and Services

TO SERVER MANAGER

: . Active Directory Users and Computers
Configure this 10{ | apsi it

Component Services

Computer Management

Add roles and fea

Mo

Defragment and Optimize Drives

3 Add other servers| | PHCP
DNS
o 4 (Create a server g Embedded Lockdown Manager
_ Buent fizusr
5 Connect this serv Group Policy Management
[ nitiator

The Group Policy Management dialog box appears with the
system domain.
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3. Right-click Default Domain Controllers Policy and choose Edit.

1

=
5, File Action View Window Help
@ HE X6 H

Group Policy Management

= Group Policy Management
A _ﬁ Forest: System.PlantP Ax.local
a (5. Domains
a g System.PlantPAx.local
s Default Domain Policy
4 2| Domain Controllers
5/ Default Domain Controllers
b [ Group Policy Objects
p [ WMI Filters
I ﬂ Starter GPOs
I [ Sites
s Group Policy Modeling

2 Groun Policw Resulte

Default Domain Controll
Scope Delet
Links
Diisplay links in this lacation:

The following sites, domains, and |

Enforced

Link Enabled

Save Report...

Wier 3

The Group Policy Management Editor dialog box appears.

4.

Click to expand the Computer Configuration folder and choose

Policies> Administrative Templates.

N

. In the System folder, click Windows Time Service.

.Fiie Action .\u"iEW Hel.p

Group Policy Management Editor

BE |

(=] Default Dornain Controllers Policy [PADCA.SYST ~ |
4 & Computer Canfiguration

- System

i Windows Time Service
Palicies

| Software Settings

F

Wiindows Settings

| Administrative Templates: Palicy def| =

b v o |

| Contral Panel

| Metwark

| Printers
| Server

flenu and Taskbar
o Access-Denied Assistance

| Audit Process Creation
_| Credentials Delegation
| Device Installation

| Disk N Cache
Disk Quotas
| Distributed COM
| Driver Installation
Early Launch Antimalware
File Classification Infrastructu
File Share Shadow Copy Prowvi

Filesystern

Setting

| Remote &ssistance

_| Rernote Procedure Call

| Rernowvable Storage Access

| Scripts

_| Server Manager

_| Shutdown

| Shutdown Options

_| Systern Restore

_| Troubleshooting and Diagnostics
| Trusted Platform Module Services
_| User Profiles

Download missing COM components

|E| Allgw Distributed Link Tracking clients to use dary
| Do not automatically encrypt files moved to encry
(=) Do not turn off system power after a Windows sys
|i=] Enable Persistent Time Stamp

=] Activate Shutdown Event Tracker Systemn State Da

i=| Nisnlaw Shutdomn Fuent Tracker
£ >

<

'\ Extended { Standard /

16 settingis)

6. Click to expand Windows Time Service and click Time Providers.
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7. In the Time Providers folder, choose Configure Windows NTP Client.

File Action View Help

=Y | ®

[] Locale Services []
=] Logon

Met Logon

Power Management

Recovery

Remote Assistance

Remote Procedure Call

Removable Storage Access
Scripts

Server Manager

Shutdown

Shutdown Options
Systemn Restore
Troubleshooting and Diagnostic| |
] Trusted Platform Module Service
|| User Profiles

|| Windows File Protection

4 [ Windows Time Service
|| Time Providers
» 5] Windows omponents

L All Settings
b [°] Preferences
4 4% User Configuration

b | Policies

| < m

Configure Windows NTP Client

Edit policy setting

Requirements:

At least Windows Server 2003
operating systems or Windows XP
Professional

Description:

This palicy setting specifies a set
of parameters for controlling the
Windows NTP Client.

If you enable this policy setting,
you can specify the following
parameters for the Windows NTP
Client.

If you disable or do not configure
this policy setting, the Windows
NTP Client uses the defaults of
each of the following parameters.

NtpServer
The Domain Name System (DMNS)
name or [P address of an NTP

Enable Windows NTP Server

<]

Extended Standard/

3 setting(s)

The Configure Windows NTP Client dialog box appears with default
information for the NTP server.

8. Click Enabled and type information as shown in the sample box.
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The configuration data propagates the GPS signal through the NTP
server to the domain computer.

a Configure Windows NTP Client - [o
E} Configure Windows NTP Client
O Mot Configured Comment; ~
O Disabled b
. ] -
Supported on: | e = XP Professional ~
MNtpServer |1?2.1S.1.102,Dx1
Options:
CrossSiteSyncFlags |2 -
. NtpServer ‘ ResolvePeerBackoffMinutes |13 - eters for controlling il
Type ResolvePeerBackoffMaxTimes 5 -
- pecify the following i)
CrossSiteSyncFlags |2 7 v
: : ResolvePesrBackofiMinutes |15 SpecialPollinterval 300 5 cy setting, the
Default information < . . Lch of the following
ResolvePeerBackoffMaxTimes EventlogFlags 0 v
7 ~
, v IP address of an NTP
SpecialPollinterval 3600 dnsMame flags""
= Df the flags for that
— EvenilegFlags 0 2 [lient Group Policy
ction of the Windows
Time Service Group Policy Settings, The default value is
""time.windows.com,(x03"",
Type
This value controls the authentication that W32time uses. The -
| o || Cncel | | Roply |

9. Click OK.
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10. In the Time Providers folder, choose Enable Windows NTP Client.

Eile Action View Help

X EEEN IR
[ Locale Services e esssssmm——————
7] Logon

b ] NetLogon Select an item to view its description. Eeﬁing

cnfig

b | Power Management
| Recovery
] Remote Assistance
| Remote Procedure Call
| Removable Storage Access
[] Scripts
[ ] Server Manager
1 Shutdown
] Shutdown Options
[] System Restore
I [ | Troubleshooting and Diagnostic] |
[ Trusted Platform Module Service
[ User Profiles
] Windows File Protection

) oire

[ All Settings
b [ ] Preferences
4 4 User Configuration
b | Policies

Enable Windows NTP Client

O Not Configured ~ Comment:

At least Windows Server 2003 operating systems or Wi

Help:

This policy setting specifies whether the Windows NTP Client is
enabled.

Enabling the Windows NTP Client allows your computer to
synchronize its computer clock with other NTP servers. You
might want to disable this service if you decide to use a third-
party time provider,

If you enable this policy setting, you can set the local computer
clock to synchronize time with NTP servers.

If you disable or do not configure this policy setting, the local
computer clock does not synchrenize time with NTP servers.
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12. Click Enable Windows NTP Server.

File  Action ‘iew Help
e« =2 BHE T

| File Share Shadow Copy Provi: ™
b B Filesystern
7 Falder Redirection
b | Group Policy
B | Internet Communication Ma
B iscsl Requirements:
E kDC At least Windows Server 2003
] Kerberos operating systems or Windows XP
1 Locale Services Professional
[ Logon Description:
b [ Met Logon This pelicy setting allows you to
b | Power Managernent specify whether the Windows NTP
[ Recovery Server is enabled.

Ml Rerop oSk = || If you enable this policy setting for
|:j] Rernote Procedure Call the Windows NTP Server, your

[ Removable Storage Access computer can service NTP requests
[ Seripts from other computers,

] Server Manager

I:jl Shultdowts ; If you disable or do not configure this

(2] Shutdown Optiens palicy setting, your computer cannct

[ System Restore service NTP requests from other
| Troubleshooting and Diagno computers,

[ Trusted Platform Module Se |

[ User Profiles

Enable Windows NTP Server Setting
Configure Windows NTP Client
Edit policy setting pable i [TD i

[> i_ Extended /(Standard/

13. Click Enabled and then click OK.

Enable Windaows NTP Server Brevious Setting | | [/ "

O Not Configured ~ Comment: A
| ® Enabled
) Disabled =

Supported oni a4 jaast Windows Server 2003 operating systems or Windows XP Professional |

Options: Help:

This policy setting allows you to specify whether the Windows |
NTP Server is enabled.

If you enable this policy setting for the Windows NTP Server,
wour computer can service NTP requests from other computers,

If you disable or do not configure this policy setting, your
computer cannot service NTP requests fram ather computers,

I oK Il Cancel || Apply |
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The Group Policy Management Editor reappears with the NTP server
states ‘enabled’

- Time Providers
Select an item to view its description, Setting
|| Configure Windows NTP Client
Enable Windows NTP Client
Enable Windows NTP Server

Enabled
Enabled
Enabled

[ree] [

Do not close the Group Policy Manager Editor dialog box.
Proceed to Configuring Windows Time Service to enable the service to

automatically commence on start up.

Configuring Windows Time Service

Complete these steps to enable the NTP server policy upon start up.

2.

In the tree configuration of the Group Policy Manager Editor dialog
box, click to expand the Computer Configuration folder and choose
Policies>Windows Settings>Security Settings.

In the System Services folder, click Windows Time.

=f
=|

Group Policy Management Editor [- [

File Action View Help
s 5
= Default Domain Controllers Policy [PADCASYSTEN ~ || Service Name * Startup Permission jal
4 & Computer Configuration {2 Windows Color System Mot Defined  Not Defined
4 [ ] Policies ﬁ’f-;EWindows Connection Ma... Mot Defined Mot Defined
b [E] Software Seftings {{F Windows Driver Foundati.. Mot Defined Mot Defined
4[] Windows Settings {{:F Windows Encryption Prov... Not Defined Mot Defined
I (] Name Resolution Policy {3 Windows Error Reporting ... Mot Defined Mot Defined
':;:' Script.s (Start.up;'Shutdown] ﬁ:.,-'-Windows Event Collector Mot Defined Mot Defined
4 B Security Settings i Windows Event Log Not Defined  Not Defined
. i Accaunt Poficies ¢ Windaws Firewall Not Defined  Not Defined

I+ __E] Local Policies

I 5 Eventlog

o hegistry
4 File System

v W W Wz

[ || Public Key Policies i indows Update Mot Detined Mot Detined
I+ [ Software Restriction Policies ff_;iWinH'I'I'P Web Proxy Aut... Mot Defined Not Defined
I (] Netwaork Access Protection {{:F Wired AutoConfig Mot Defined Mot Defined
b (| Application Control Policies {{FWMI Performance Adapter Mot Defined Mot Defined =
b & IP Security Policies on Active Dir _ || ¢4 Workstation Not Defined  Not Defined
m | > b

& System Services

Wired MNetwork (IEEE 802.3) Polic ﬁ:;FWindows Presentation Fo.. Mot Defined Mot Defined
| Windows Firewall with Advances f\fjWindows Remote Manag... Mot Defined Mot Defined

| Network List Manager Policies f@an i i i
I ‘ﬂg Wireless Network (IEEE 302,11 P

ﬁ’. Windows Font Cache Serv... Mot Defined Mot Defined
ﬁ’f-,rWindowsImageAcquisiti... Mot Defined Mot Defined
R;}Windowslnstaller Mot Defined Mot Defined
ﬁj_"-ILWindows Management In... Mot Defined Mot Defined
ﬁ‘jWindows Modules Installer Mot Defined Mot Defined

£ Wind o ore Cepsice (U Blot Defined Blot Defined

1 ﬁ)\' Windows Time Mot Defined Mot Defined
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The Windows Time Properties dialog box appears.

3. Check the ‘Define this policy setting’ box and select ‘Automatic’

Windows Time Properties [ > |

Security Policy Setting |

::tf'i' Windows Time

Define this policy setting

Select service startup mode:

() Manual
() Digabled
T | == 1[5 ]
4. Click OK.

5. Close the Group Policy Management Editor dialog box.

Enforcing the Domain Controller Policy

Use a domain controller This section describes how to enforce the domain computers to use the NTP
with these procedures. .
server settings (see page 135).

Complete these steps.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy
Management dialog box.
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2. Expand the Domain Controllers folder and click Default Domain
Controllers Policy.

£
__g File  Action View Window Help
@« 7= G

|5, Group Policy Management Default Domain Controllers Policy
4 é\ F:Jrest: Syftem,P[antPAx.local Scope |Detai|s I ol I Dcacton |
4[5 Domains §
4 5 System.PlantPAx.local Links
5 Default Domain Policy Lheplea s i this focation; [ system.PlantPAxlocal

Domaaio Cootrollers The following sites, domains, and OUs are linked to this GPO:

|‘f€f Default Domain C llers Polid

Location 2 Erforced  Link Enabled
[&] Domain Controllers No Yes

I+ f_‘% WHI Filters
I .:E Starter GPOs
b ([ Sites (<]

'Eéf Group Policy Modeling
[ Group Policy Results Security Filtering
The gettings in this GPO can only apply to the following groups, users, and computers:

@

Add... Properties

WMI Filtering
This GPO is linked to the following WMI fiter:

| “Nonex

3. Choose Authenticated Users in the Security Filtering box and
click Remove.

A warning popup box could appear.

i Do you want to remove this delegation privilege?

4. Click OK.
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S. Click Add, Domain Controllers, and then OK.

i Group Policy Management =El
5L File Action View Window Help [=]=]x]
X R

4 E Domains

b

- v

p.:asrm

|5 Group Policy Management
4 A Forest: System.PlantPAx.local

4 5 System.PlantPAx.local

s Default Domain Policy

|2 Domain Controllers
57 Default Domain Controllers Polic)

[ 5} Group Policy Objects

[ WMI Filters

I .:E Starter GPOs

ﬁ?f Group Policy Modeling
[ Group Policy Results

Default Domain Controllers Policy
Scope |Detaj|5 I Settings I Delegation |

Lirple=

Select this object type:

| |User.Gmup.orEu]|Hn security principal

From this location:

|5ystan.HmPMocai

Enter the object name to select (sxamples):

Domain Controllers

I |

Remove | | Properties |
WMI Filtering
This GPO is linked to the following WMI fitker:
| none: W | | Open

]

6. Right-click Domain Controllers and choose Enforced.

Default Domain Controllers Policy

Scope | Details | Settings | Delegation |

Links

Display links in this location: | System.PlantPAx Jocal

The following sites, domains, and OUs are linked to this GPO:

-

Location Enforced Link Enabled Path
1D - i
Enforced
:.'( | ﬂ ' Link Enabled |
| Delete Link(s) |

A popup window appears.

You have selected a link to a Group Policy Object (GPO). Except for
changes to link properties, changes you make here are global to the GPO,
and will impact all other locations where this GPO is linked.

["] Do not shaw this message again

7. Click OK.
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Default Domain Policy

Use a domain controller
with these procedures.

This section describes how to configure and enforce all servers and

workstations to be connected to the domain controller as an NTP client server.

The clock time is synchronized with the domain controller.

Configuring an NTP Client

Complete these steps to associate the domain controller with the NTP

client server.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy

Management dialog box.

2. Right-click Default Domain Policy and choose Edit.

E Group Policy Management
5 File Action View Window Help

5 Group Policy Management
A _ﬂ Forest: System.PlantP Ax.local
4 |55 Domains
4 F3 System.PlantPAx.local

Default Domain Policy
Scope | Details I Settings | Delegation
Links

| '!: _D__ef_au_lt Dq_main Po!i Display links in this location: E
2| Domain Controllers Edit... Olls ar
= Group Policy Objects Enfoiced

5 WMI Filters :
Y ¥ | | Link Enabled
] Starter GPOs

- . Cave Rennrt

The Group Policy Management Editor dialog box appears.

File  Action

LR 4

View Help

Group Policy Management Editor

\=] Default Domain Policy [PADCA.SYSTEM.
4 & Computer Configuration
4 || Policies
_| Software Settings
| Windows Settings

b v v |

_| Administrative Templates: Po
I+ || Control Panel
B ] MNetwork

| Printers

| Server

Credentials Delegation
> || Device Installation

| Disk NV Cache
Disk Quotas
|| Distributed COM
Driver Installation

File Classification Infra

P |

Filesystem
< T

mmaiaitldenu and Taskbar
[Eseen)
| Access-Denied Assistance

_| Audit Process Creation

Early Launch Antimalware

File Share Shadow Copy Providel

PLANTPA! ~ . System

Windows Time Service Setting

_| Locale Services
I Logon

licy definit _ —| Net Logon

= _| Power Management

| Recovery

| Rernote Assistance

| Remote Procedure Call

| Removable Storage Access

| Seripts

| Server Manager

| Shutdown

“| Shutdown Options

_| System Restore

“| Troubleshooting and Diagnostics
| Trusted Platform Module Services
| User Profiles

oad d UM components

structure

w

=] Allow Distributed |ink Tracking clients to use domain resour., ™
< >

> \_Extended /_(_Standargi[(_

116 setting(s)

3. In the tree configuration, click to expand the Computer Configuration

folder and choose Policies> Administrative Templates.
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4. In the System folder, click Windows Time Service.
5. Click to expand Windows Time Service and click Time Providers.

6. In the Time Providers folder, choose Configure Windows NTP Client.

File Action View Help
2 H= T

Locale Services

Legon
7| Met Logon
| Power Management

Configure Windows NTF Client

Edit policy setting
Recovery :
Remote Assistance Requirements: Enable Windows NTP Server
| Remote Procedure Call At least Windows Server 2003
‘| Removable Storage Access operating systems or Windows XP
Sihi Professional
cripts

Server Manager

_ Description:
Shutdown This policy setting specifies a set

| Shutdown Options of parameters for controlling the
System Restore Windows NTP Client.

: Troubleshooting and D'ragnost_ic If you enable this policy setting,

: Trusted Platform Module Service you can specify the following
User Profiles parameters for the Windows NTP
Windows File Protection Client.

5 Time Prmr[dels If you disable or do not configure

i this policy setting, the Windows
b (] Windows Components NTP Client uses the defaults of

% All Settings each of the following parameters.
b [ ] Preferences
4 4, User Configuration
b | Policies

MNtpServer
The Domain Name System (DNS)
) ~ ™I name or P address of an NTP

" | Extended /, Standard

3 setting(s)
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7. Click Enabled and type information as shown in the sample box.

The configuration data associates the domain controllers with the
NTP client server.

a Configure Windows NTP Client [= = S|
5] Configure Windows NTP Client PR

O Mot Configured Comment: i
(_) Disabled s

Supperted on: [ A eact Windows Server 2003 operating systems or Windows XP Professional ~
Options: Help:

NtpServer |PADCA.System.PIantPAx.IocaI,Dx‘l PADCI This policy setting specifies a set of parameters for controlling |

the Windows NTP Client.

If you enable this policy setting, you can specify the following i)

CrossSiteSyncFlags [2 : parameters for the Windows NTP Client.
ResolvePeerBackoffMinutes |15 3 If you disable or do not configure this policy setting, the

: Windows NTP Client uses the defaults of each of the following
ResolvePeerBackoffMaxTimes parameters.
7 5 MNtpServer

>

The Domain Name Systemn (DN5) name or [P address of an NTP
time source. This value is in the form of ""dnsName,flags""
where ""flags"" is a hexadecimal bitmask of the flags for that
host. For more information, see the NTP Client Group Policy
Settings Associated with Windows Time section of the Windows
Time Service Group Policy Settings, The default value is

time.windows.com, Jx038"",

SpecialPollinterval 300

<

3

EventlegFlags |0

<

Type
This value controls the authentication that W32time uses. The

Cancel || Apply |
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8. Click Time Providers (in the Windows Time Service folder) and click
Enable Windows NTP Client.

File Action View Help

X EEEN IR

] Locale Services

7] Logon B 5 i S
b ] NetLogon Select an item to view its description.

b | Power Management
| Recovery
] Remote Assistance
| Remote Procedure Call
| Removable Storage Access
[] Scripts
[ ] Server Manager
1 Shutdown
] Shutdown Options
[] System Restore
I [ | Troubleshooting and Diagnostic] |
[ Trusted Platform Module Service
[ User Profiles
] Windows File Protection
Fl ITaYa Fatty fTaat= atil
b |j RIS
[ All Settings
b [ ] Preferences
4 4, User Configuration
b | Policies

Extended /, Standard /

The Enable Windows NTP Client dialog box appears.
9. Click Enabled and then click OK.

Enable Windows NTP Client

O Not Configured ~ Comment:

At least Windows Server 2003 operati stems or Wi

Help:

This policy setting specifies whether the Windows NTP Client is
enabled.

Enabling the Windows NTP Client allows your computer to
synchronize its computer clock with other NTP servers. You
might want to disable this service if you decide to use a third-
party time provider,

If you enable this policy setting, you can set the local computer
clock to synchronize time with NTP servers.

If you disable or do not configure this policy setting, the local
computer clock does not synchrenize time with NTP servers.
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The Group Policy Management Editor reappears with the NTP
Client-server states ‘enabled.

= = = : E
- Time Providers
Select an item to view its description.  Setting State
\i£] Configure Windows NTP Client Enabled
iz Enable Windows NTP Client
|iz] Enable Windows NTP Server

Do not close the Group Policy Manager Editor dialog box.

Proceed to Configuring Windows Time Service to enable the service to
automatically commence on start up.

Configuring Windows Time Service

Complete these steps to enable the NTP server policy upon start up.

1. Inthe tree configuration of the Group Policy Management Editor dialog
box, click to expand the Computer Configuration folder and choose
Policies>Windows Settings>Security Settings.

2. In the System Services folder, click Windows Time.

g Group Policy Management Editor [ == [

File Action View Help

s XE = 5B
= Default Domain Policy [PADCA.SYSTEM.PLANTPAXLOCAL]F ~ || Service Name Startup Permission ~
4 (% Computer Configuration f{_‘éWindows Color Systemn Mot Defined Mot Defined
4[] Policies ﬁ",EWindows Connection Ma... Mot Defined Mot Defined
b [E] Software Seftings {{# Windows Driver Foundati.. Mot Defined Mot Defined
4[] Windows Settings ﬁ’_‘SWindows Encryption Prov... Not Defined Mot Defined

I> || Name Resolution Policy
|| Seripts (Startup/Shutdown)
4 T Security Settings
I _:ﬂ Account Policies
I+ __E] Local Policies
I 5 Eventlog

ﬁ’_}Windows Error Reporting .. Mot Defined Mot Defined
ﬁ_.iWindowsEventCollector Mot Defined Mot Defined
ﬁ’_.‘iWindowsE\rentLog Mot Defined Mot Defined
ﬁ’_.iWinduwsFirewall Mot Defined Mot Defined
I f{_‘éWindowsFontCacheSer\f... Mot Defined Mot Defined
ﬁ’“EWindowsImageAcquisiti... Mot Defined Mot Defined

ﬁ’_}Windowslnstaller Mot Defined Mot Defined
i ﬁ\’_TSWindows Management In... Mot Defined Mot Defined
b g File System ]j’_‘EWindows Modules Installer Mot Defined Mot Defined
b Wired Network (IEEE 802.3) Policies f.F Windows Presentation Fo... Mot Defined Mot Defined
b ] Windows Firewall with Advanced Security ﬁ’_.‘iWindows Remote Manag... Mot Defined Mot Defined
| Network List Manager Policies fwan i i i
b Zafl Wireless Network (IEEE 802.11) Policies | {®lWindowsTime ~ NotDefined Not Defined |
[ || Public Key Policies ¢ windows Update 0 Ing
I [ Software Restriction Policies {FWinHTTP Web Proxy Aut... Mot Defined Mot Defined
I [ Metwork Access Protection {{# Wired AutoCanfig Mot Defined Mot Defined
I (| Application Control Policies ﬁ’_;EWMI Performance Adapter Mot Defined Mot Defined =
I g IP Security Policies on Active Directory (SY5 ff_,iWorkstation Mot Defined Mot Defined
< m > b
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The Windows Time Properties dialog box appears.

3. Check the ‘Define this policy setting’ box and select ‘Automatic’

Windows Time Properties |2 |

Security Policy Setting |

éﬁ'i. Windows Time

Define this policy setting

Select service startup mode:

() Manual

() Digabled

L Jre=Ce ]

4. Click OK.

5. Close the Group Policy Management Editor dialog box.

Configuring Password Strength

Use a domain controller The password policy makes sure that security settings are enforced to help
with these procedures. protect the system from unauthorized users upon entering the system.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy

Management dialog box.

2. Right-click Default Domain Policy and choose Edit.

[ Group Policy Management Default Domain Policy
PR Fgrat: System.PlantPAx.local _Scope Detals| Seftings Dele

4 [ Z5 Domains : -

4 F3 System.PlantPAxlocal Linkes
54 Default Domain Palicy Display links in this location:

2| Domain Controllers The following sites, domains, and
I+ (2| PlantPAx
4 [ =t Group Policy Objects
[ Default Domain Controllers Policy

Location
3 System PlantP A local

WS Qefault qua_in Pc_t_li‘__ »
b % WM Filters B2 m
I L] Starter GPOs GPO Status 2
Is E{g Sites . . Back Up... fing
sti' Group Policy Modeling s nis GPO can only
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3. Inthe tree configuration of the Group Policy Management Editor dialog
box, click to expand the Computer Configuration folder and choose
Policies>Windows Settings>Security Settings>Account Policies.

4. Click the Password Policy folder and choose one of the policy options
that are explained in Table 19.

File  Action

= =

View Help

Group Policy Management Editor

BE |

4 A Computer Configuration
4 | | Policies
Software Settings
4 Windows Settings
> || Name Resclution Policy
|| Scripts (Startup/Shutdown)

b

~ || Policy

1z Enforce password history
Maximum password age
| Minimum password age

J Minimurm password length

1| Password must meet complexity requirements
Store passwords using reversible encryption

Policy Setting

24 passwords remembern
42 days

1 days

7 characters

Enabled

Disabled

< m

T Security Settings

I :‘_] Local Policies

I 2f Eventlog

I+ [ Restricted Groups

I [ System Services

I 4 Registry

I [ File System

I o Wired Network (IEEE 802.3) Pali

I | Windows Firewall with Advanc
_| Metwork List Manager Policies

I __,._m' Wireless Metwork (IEEE 802.11)

I> || Public Key Policies

I+ || Software Restriction Policies

I+ || Metwork Access Protection

w
> < m >

Table 19 - Password Policy Description

Policy

Description

Enforce password history

Complexity requirements are enforced when passwords are changed or created. These requirements include that the
password cannot contain the user's account name, parts of the user's full name that exceed two consecutive characters, or a
certain length of time that is exceeded before a similar password can be used.

Maximum password age

Security setting that determines the length of time before a password needs to be changed. Best practice is for password to
expire 30...90 days to help prevent attacks.

Minimum password age

Minimum password age must be less than the maximum password age. For example, if the maximum password age is
1...999 the minimum password age can be up to 998 days.

Minimum password length

Security setting that determines the least number of characters for a password. Typically, the value of characters is set
between 1...14. Zero characters if no password is required.

Password must meet complexity requirements

Security setting determines the minimum requirements to meet complexity requirements. For example, some uppercase or
lowercase characters, base 10 digits (0. ..9), or non-alphabetical characters.

Store passwords using reversible encryption

Reversible encryption is used for password authentication. Microsoft recommends that this protocol be disabled because it's
the same as storing plain text versions of the passwords. Microsoft states to use this policy only if ‘application requirements
outweigh the need to protect password information’.

5. Save your work.
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Configuring Account Lockout Policy

Use a domain controller This policy provides the ability to configure the number of password attempts
with these procedures. and how an administrator resolves a user lockout situation.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy
Management dialog box.

2. Right-click Default Domain Policy and choose Edit.

|5 Group Policy Management Default Domain Policy

PR Fgrat: Sy.stem.PIantPAx.IocaI Scope | Detals | Seftings Dele
4 [ Domains _ -

4 F3 System.PlantPAxlocal Linkes

é Default Domain Policy Display links in this location:

Domain Controllers The following sites, domains, and

Location
3 System PlantP A local

=[ Default Domain Pc_»_li‘__

b % WM Filters B2 m
I L] Starter GPOs GPO Status 2
Is E{g Sites . . Back Up... I'ing
sti' Group Policy Modeling e fis GPO can only

3. Inthe tree configuration of the Group Policy Management Editor dialog
box, click to expand the Computer Configuration folder and choose
Policies>Windows Settings>Security Settings>Account Policies.

4. Click the Account Lockout Policy folder and choose one of the policy
options that are explained in Table 20.

= Group Policy Management Editor == -

File Action View Help

s 2 Xz H=

4 & Computer Configuration ~ ||| Policy Policy Setting
4 [] Policies t [ Account lockout duration Mot Defined

b ] Software Settings 1s) Account lockout threshold Dinvalid logon atternpt

4 || Windows Settings

> || Name Resolution Policy

Scripts (Startup/Shutdown)
Security Settings
3 Account Policies
4 = accusnrd Doli
[ FOIICY
_._ﬁ Local Policies
| Eventlog

l| Reset account lockout counter after Mot Defined

n [ |

_4 Restricted Groups
7 System Services
o Registry
|4 File System
Wired Network (IEEE 802.3) Poli
| Windows Firewall with Advanc
_| Metwork List Manager Policies
-:1.‘—" Wireless Metwork (|EEE 802.11)
| Public Key Policies
_| Software Restriction Policies

|| Metwaork Access Protection W 2
< m > < m >

e

o v v
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Table 20 - Lockout Policy Descriptions

Policy Description
Account lockout duration A locked out account cannot be activated until reset by an administrator or the duration period for the lockout has elapsed.
Account lockout threshold This setting determines the number of failed logon attempts to cause a user account to be locked out. You can set a value

between 0...999 failed logon attempts. If you set the value to 0, an account is prevented from being locked out.

Reset account lockout counter after Setting specifies an amount of time that must expire before a lockout reactivates.

5. To set the number of lockout attempts before a lockout, double-click
Account lockout threshold.

6. On the Account lockout threshold Properties dialog box, click the

arrows Up or Down to set the number of invalid logon attempts.

Account lockout threshold Properties _

::ig. Account lockout threshold

Define this policy setting
Account will lock out after:

Bl

: invalid logon attempts

— o | o |[ B |

7. Click OK.
The Suggested Value Changes popup window appears with default time

settings based on your number of lockout attempts.

Suggested Value Changes -

Because the value of Account lockout threshold is now 3 invalid logon attempts, the settings for
the following items will be changed to the suggested values.

Policy Policy Setting Suggested Setting

125 Account lockout duration Mot Defined 30 minutes

1z Reset account lockout courter after Mot Defined 30 minutes

< m >

8. Click OK.
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The lockout configurations can be monitored on the Group Policy
Management Editor dialog box.

= =

Group Policy Management Editor

File Action View Help

BE |

b=

1 Wi

e

b
b Ld]uli‘

4 i Computer Configuration
4 || Policies
_| Software Settings

indows Settings

MName Resolution Policy

Scripts (Startup/Shutdown)
Security Settings
3 Account Policies

I 55 Password Policy

I 54 Account Lockout Policy

I 55 Kerberos Policy
| Local Policies
| Eventlog

o Restricted Groups

5 System Services

o Registry

4 File System
2o Wired Network (IEEE 802.3) Poli

| Windows Firewall with Advanc
| Metwork List Manager Policies
__.._nlf Wireless Metwork (IEEE 802.11)
_| Public Key Policies

_| Software Restriction Policies

| Metwork Access Protection
>

w

Policy
.| Account lockout duration

Policy Setting
30 minutes

Account lockout threshold

3 invalid logon attempt

Reset account lockout counter after

30 minutes

The example shows what a user receives when the configured number of
failed logon attempts occurs.

Jorge
SYSTEMMJorge

d account is currently locked out
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Administrator Security Audit

This section describes how administrators can audit lockout situations and
unlock personnel accounts. Complete these steps.

1. On the Event Viewer dialog box, right-click Security and choose
an account.

File Action View Help
s 2

2] Event Viewer (Local) B3l security MNumber of : nts available
4 Q Custom Views = g e - —
= el

4 [ Server Roles sywares gieianc tme ource ven a

F Active Directory Domain Servi @%Audi‘t Success 11/28/2017 %:02:57 AM  Microsoft Windows security auditing. 4624
T DHCP Server Audit Success 11/28/2017 2:02:57 AM  Microsoft Windows security auditing.

P DNS Server @, Audit Success 11/28/2017 9:02:54 AM  Microsoft Windows security auditing. i
T Remote Desktop Services @, Audit Success 11/28/2017 %:02:44 AM  Microsoft Windows security auditing, . Import Custor Vi...

T Administrative Events @k)\udit Success 11/28/2017 %:02:44 AM  Microsoft Windows security auditing. | Clear Log...
4 [ Windows Logs @\, Audit Success 11/28/2017 3:02:44 AM  Microsoft Windows security auditing.
| Application Q,Audit Success 11/28/2017 9:02:43 AM  Microsoft Windows security auditing.
@, Audit Success 11/28/2017 9:02:32 AM  Microsoft Windows security auditing,

= Setap <L Audit Success 11/28/2017 9:02:27 AM _ Microsoft Windows security au%_._ Find...
£ n ! Save All Events As...

] Forwarded Events
4 [ Applications and Services Logs

5] Active Directory Web Services General | Details View

DFS Replication ! Refresh
] Directory Service I A user account was locked out. I

4 Help
DNS Server .
5] Hardware Events Subiect:
Internet Explorer
& Key Management Service

Open Saved Log...
Create Custom Vi...

Filter Current Log...

Properties

Event 4740, Microsoft Windows security auditing. Attach a Task To ...

Log Name: Security

4 B Microsoft Source: Microsoft Windows security  Logged: 11/28/2017 9:02:57 AM T Attach Task To T..
b 7 Windows Event [D: 4740 Task Category:  User Account Manageme_

Event Properties

Copy

ThinPrint Diagnostics Level: Information Keywords: Audit Success
2] Windows PowerShell User: N/A Computer:  PADCASystem.PlantPAx. | Save Selected fues

- [} Subscriptions ) [< [ ¥ | | Refresh
(<] m [] —

Lt

The user account information appears.

In the Domain controller, the lockout information appears in the
Account tab of a user’s Properties dialog box.

Member Of I Dialin I Environment I Sessions

Remote control | Remote Deskiop Services Profle | COM=+
General I Address | Account | Profile: I Telephones I Organization

User logon name:

[iorge | [ @System.PlantP Ax ocal v
User logon name (pre-Windows 2000):

[sYsTEM | joras |
[ LogonHous.. | [ LogOnTo.. |

0 Unlock account. This account is cumently locked out on this Active
Directory Domain Controller.

Account pptions:

[ User must change password at next logon -~
[ User cannot change password l:‘
[[] Password never expires

[[] Store password using reversible encryption w

Account expires
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Use a domain controller
with these procedures.

Configuring Kerberos Policy

Complete these steps to administer network authentication.

1. Inthe tree configuration of the Group Policy Management Editor dialog
box, click to expand the Computer Configuration folder and choose
Policies>Windows Settings>Security Settings>Account Policies.

2. Click the Kerberos Policy folder and choose one of the policy options

that are described in Table 21.

B8 Group Policy Management Editor
File  Action

= =

View Help

BE |

4 i Computer Configuration ~ ||| Policy “
4 || Policies
_ Software Settings
4 || Windows Settings
> || Name Resolution Policy
|| Scripts (Startup/Shutdown)
4 T Security Settings
4 7 Account Policies
I 55 Password Policy

b gunt | ocko
Kerberos Policy

ocal Folicies

. Enforce user logon restrictions

| Maximum lifetime for service ticket
Mazxirmum lifetime for user ticket

| Maximum lifetime for user ticket renewal

Mazxirmum tolerance for computer clock synchronization

Policy

3
4
i Eventlog
o Restricted Groups
5 System Services
o Registry
4 File System
2o Wired Network (IEEE 802.3) Poli
| Windows Firewall with Advanc
| Metwork List Manager Policies
__.._nlf Wireless Metwork (IEEE 802.11)
| Public Key Policies

e

_| Software Restriction Policies
| Metwork Access Protection i

v

< m > < m

Policy Setting
Enabled

600 minutes
10 hours

7 days

3 minutes

Table 21 - Kerberos Policy Descriptions

Policy

Description

Enforce user logon restrictions

takes time and could slow network access to services.
The default is Enabled.

Security setting determines if the Kerberos V5 Key Distribution Center (KDC) validates every request for a session ticket
against the user rights policy of the user account. Validation of each request for a session ticket is optional; the extra step

Maximum lifetime for service ticket

for user ticket.

connection expires during the connection.
The default amount of time is 600 minutes (10 hours).

Security setting determines the maximum amount of time (in minutes) that a granted session ticket is used to access a
particular service. The setting must be greater than 10 minutes and less than or equal to the setting for Maximum lifetime

If a client presents an expired session ticket when it requests a connection to a server, the server returns an error message.
The client must request a new session ticket from the Kerberos V5 Key Distribution Center (KDC). Once a connection is

authenticated, it no longer matters whether the session ticket remains valid. Session tickets are used only to authenticate
new connections with servers. Ongoing operations are not interrupted if the session ticket that is used to authenticate the

154
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Table 21 - Kerberos Policy Descriptions

Policy

Description

Maximum lifetime for user ticket

Security setting determines the maximum amount of time (in hours) that a user's ticket-granting ticket (TGT) can be used.
The default amount of time is 10 hours.

Maximum lifetime for user ticket renewal

Security setting determines the time (in days) during which a user's ticket-granting ticket (TGT) can be renewed.
The default is 7 days.

Maximum tolerance for computer
clock synchronization

Security setting determines the maximum time difference (in minutes) that Kerberos V5 tolerates between the time on the
client clock and the time on the domain controller running Windows Server 2003 that provides Kerberos authentication.

To prevent ‘replay attacks; Kerberos V5 uses time stamps as part of its protocol definition. For time stamps to work properly,
the clocks of the client and the domain controller need to be in sync as much as possible. Both computers must be set to the
same time and date. Because the clocks of two computers are often out of sync, administrators can use this policy to
establish the maximum acceptable difference to Kerberos V5 between a client clock and domain controller clock. If the
difference between a client clock and the domain controller clock is less than the maximum time difference that is specified
in this policy, any time stamp that is used in a session between the two computers is considered to be authentic.

IMPORTANT: This setting is not persistent on pre-Vista platforms. If you configure this setting and then restart the
computer, this setting reverts to the default value.

The default is 5 minutes.

Use a domain controller
with these procedures.

3. Save your work.

Configuring an Interactive Logon

This policy configures a warning message to users of the consequences for
misusing company information. The policy is typically used for legal purposes.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy

Management dialog box.

2. Right-click Default Domain Policy and choose Edit.

|# Group Policy Management Default Domain Policy
4 4 Forest: System.PlantPAx.local _écope [Details | o
4 [Z4 Domains 2 ==
4 F3 System.PlantPAxlocal Linkes
Display links in this location:

i Default Domain Policy
b (=] Domain Controllers The following sites, domains, and
I+ (2| PlantPAx
4 [ =t Group Policy Objects

Location

g S .PlantP A local
\=[ Default Domain Controllers Policy & System.Fla =

= Default Domain Polic -
b [ WMI Filters | B2 | -
I L] Starter GPOs GPO Status i
b L7 Sites Back Up... fing

;e Group Policy Modeling pis GPO can only

Drrbrivn Lo D Kt
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3. Inthe tree configuration of the Group Policy Management Editor dialog
box, click to expand the Computer Configuration folder and choose
Policies>Windows Settings>Security Settings>Local Policies.
4. Click the Security Options folder and choose a policy option.
g Group Policy Management Editor = [o]
File Action View Help
| 7 XE= H=
=] Default Domain Policy [PADCASYSTEM.PLANTPAX.LO ~ || Policy = Policy Setting| ~
4 & Computer Configuration “i: Domain controller: Allow server operators to schedule tasks Mot Defined
4[] Policies i) Domain controller: LDAP server signing requirements Mot Defined
4 '_’ Software Settings 2z| Domain controller: Refuse machine account password chan... Mot Defined
# W.lndows Settlngs. ) ;. Domain member: Digitally encrypt or sign secure channel d... Mot Defined
b NEI:'HE Re<olution Policy 1) Domain member: Digitally encrypt secure channel data (wh... Mot Defined
Ay 2cr|pt.s (S;:art.up;Shutdown] 11 Demain member: Digitally sign secure channel data (when ... Mot Defined | _
N é :c:rlty Et:;g? i 1) Demain member: Disable machine account password chan... Mot Defined =
K j‘—? Lccolupn i ?ICIE‘ | = || 1 Domain member: Maximum machine account password age  Not Defined
4 | Local Policies : : : :
b j Audit Policy Domaln. member: R.equlre stror.19 (Wlnd.ows?_DDO or Iater].se... Mot Deffned t
¥ 8 ¢ Righ SE— i1 Interactive logon: Display user information when the session... Mot Defined
.s| Interactive logon: Do not display last user name Mot Defined
R 2| Interactive logon: Do not require CTRL+ALT+DEL Mot Defined
b [ 4 Restricted Groups 1) Interactive logon: Machine account lockout threshold Mot Defined
b [ System Services .| Interactive logon: Machine inactivity limit Mot Defined
I [ Registry i Mot Defi
I+ [ File System
I igj ‘Wired Metwork (IEEE 802.3) Policies 2| Interactive logon: Number of previous logons to cache (in c...  Not Defined
p [ Windows Firewall with Advanced Sel i) Interactive logon: Prompt user to change password before e.. Mot Defined
| Network List Manager Policies 2s| Interactive logon: Require Domain Controller authentication... Mot Defined
I alf Wireless Network (IEEE 802.11) Palici || Interactive logon: Require smart card Mot Defined
B _ Public Key Policies 1] Interactive logon: Smart card removal behavior Mot Defined
i ?’0&""3'5 BESt”Ct'_‘J” PO'!C'ES ||| s Microsoft network client: Digitally sign communications (al... Mot Defined |+
<] L] | > <] m >
5. Type the name of the group that receives the interactive message and
click OK.
Interactive logon: Message ttle for users attempti...|_? Il |
Security Policy Setting | Explain |
éﬂé‘ Interactive logon: Message title for users attempting to log on
[ Define this policy stting
[PantP A Syster|
[ Canced |[ ooy |
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6. Double-click the message text.
|=] Default Domain Policy [PADCASYSTEM.PLANTPAX.LD ~ || Policy o Policy Setting
4 i Computer Configuration 12| Domain controller: Allow server operators to schedule tasks ~ Not Defined
4 ] Policies Domain controller: LDAP server signing requirements Mot Defined
b ] Software Settings 12| Domain controller: Refuse machine account password chan... Mot Defined
4[] Windows Settlngs. ] '] Domain member: Digitally encrypt or sign secure channel d... Not Defined
B NEI?'HE Resolution Policy | Demain member: Digitally encrypt secure channel data (wh... Mot Defined
-‘:—’- zcrlpt.s (Sstart.up_aShutdownJ 12) Domain member: Digitally sign secure channel data (when ... Mot Defined
4B :cuArlt)r et;‘.l;gls. : | Demain member: Disable machine account password chan... Mot Defined
F -'lj e ; ? e = ., Domain member: Maximum machine account password age Mot Defined
4 [ Local Policies
b 3 Audit Policy 1) Domain member: Require strong (Windows 2000 or later) se.. Mot Defined
b 5 UserRights Assignment | Interactive logon: Display user information when the session... Mot Defined
b 3| Security Options 1| Interactive logon: Do not display last user name Mot Defined
b 5 Eventlog 1) Interactive logon: Do not require CTRL+ALT+DEL Mot Defined '
b [ & Restricted Groups | Interactive logon: Machine account lockout threshold Mot Defined
D g S)fStEmSENiCES nteracts o ne Bachine inactivite limd Mo .=_--.
b [ Registry Interactive logon: Message text for users attempting to log on  Not Defined
I 4 File System o Interactive logon: Message Title Tor users attempting to log on
I 7o/ Wired Network (IEEE 802.3) Policies 2:) Interactive logon: Number of previous logons to cache (in c.. Mot Defined
|| Windows Firewall with Advanced Se | Interactive logon: Prompt user to change password before e.. Mot Defined
ork Li nager Policie: 3 " Def

A message text dialog box appears to let you write and edit the template.

Interactive logon: Message text for users attempti... _

Security Policy Setting | ExplaFI

::‘g' Interactive logon: Message text for users attempting to log on

Define this policy setting in the template
This system is restricted to authorized users. Individuals who attemp| ~

Cancel | |

Aoply |

7. Click OK.

The example shows the interactive message that appears to users

during logon.

PlantPAx System

This system is restricted to authorized users. Individuals who attempt unautherized access will be prosecuted. If
you are unauthorized, terminate access now. Click OK to indicate your acceptance of this information.

>Important Any wamning that you display in the title or text should be approved by representatives from your
organization's legal and human resources departments.
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Enforcing the Domain Policy

Use a domain controller This section describes how to enforce the servers and workstations that are
with these procedures. associated with the domain controller to use the NTP client settings (see

page 145).

Complete these steps.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy
Management dialog box.

2. Expand the domain folder and click Default Domain Policy.
=
_3 File Action View Window

= 7= ¢ B

|5 Group Policy Management Default Domain Policy

4 5}\ Forest: System.PlantPAx.local Scope |Detaj|5 I St I Dcacton |
4 [Z4 Domains

4 3 System.PlantPAx.local Links

5/ Default Domain Policy Lheplea s i this focation; [ system.PlantPAxlocal
b =) Domain Controllers

=6 Policy Objects =
; = e, T Location Erforced Lk Enabled  Path
4 :-:; by i £ System. PlantP A local No Yes System.PlantF

4 er IS5

I+ ﬁ Sites
E‘ﬁ Group Policy Modeling <]
[ Group Policy Results

The following sites, domains, and OUs are linked to this GPO:

Security Filtering
The gettings in this GPO can only apply to the following groups, users, and computers:

-

| A Authenticated Users

Add... | Properties

WMI Filtering
This GPO is linked to the following WMI fiter:

| “Nonex

3. Choose Authenticated Users in the Security Filtering box and
click Remove.

A warning popup box could appear.

“h Do you want to remove this delegation privilege?

4. Click OK.
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5. Click Add, type an object, and then click OK.

i Group Policy Management =El
5L File Action View Window Help [=]=]x]
X R

|5 Group Policy Management
4 A Forest: System.PlantPAx.local
4 [Z4 Domains
4 3 System.PlantPAx.local
Eér:r Default Domain Policy
b =) Domain Controllers
I [t Group Policy Ohjects
I :"-:7, WMI Filters
b [[5] Starter GPOs
I+ ﬁ Sites
E‘ﬁ Group Policy Modeling

[¥ Group Policy Results

Default Domain Policy

Select this object type:

|User. Group, or Built4n security principal

From this location:

|Sy5tern.PiantPP«Jocal

I |

Remove | | Properties |
WMI Filtering
This GPO is linked to the following WMI fitker:
| none: W | | Open

6. Right-click the domain and choose Enforced.

Default Domain Policy
Scope | Details | Settings | Delegation |

Links

Display links in this location: | System.PlantPAx local

The following sites, domains, and OUs are linked to this GPO:

Fath

Location - Enforced Link Enabled
REE
Enforced
. (”]7 ﬂ | Link Enabled —[
| Delete Link(s)

A popup window could appear.

You have selected a link to a Group Policy Object (GPO). Except for
changes to link properties, changes you make here are global to the GPO,
and will impact all other locations where this GPO is linked.

["] Do not shaw this message again

7. Click OK.
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PlantPAx Users Policy Object

You can create policies for a group of users that restricts privileges and site
access. This section describes how to select a group and enforce a policy. For
example, a selected group of users cannot use USB drives for system security.

Use a domain controller

Define Group Access Level
with these procedures.

Complete these steps to select a specific group of users to link to a policy.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy
Management dialog box.

2. In the system domain folder, right-click a domain name and choose
Create a GPO in this domain, and Link it here.

-
=

Group Policy Management
3l File Action View Window Help

| P2 B XE G« H

|5 Group Policy Management

_ﬁ PlantPAx
4 Forest: System.PlantP Ax.local - : = -
4 (2 Domains Linked Group Policy Objects Group Poli
4 F3 System.PlantPAxlocal Link *rder GPO
a4 Default Domain Policy
I> 2| Domain Controllers
af = | PlantP.

160

b 3] Area Create a GPO in this domain, and Link it here...

o | Roles| ink an EBxisting |
ol USEVS% Block Inheritance
b 5 Group.Pq Group Policy Update...
p [ WMI Filtg
1[5 Starter Gf Group Policy Modeling Wizard...
I [ Sites New Crganizational Unit

s Group Policy Mq

4 Vi
% Group Policy Rey e

New Window from Here

3. Type a name for the Group Policy Object.
New GPO =3

Mame:

|PlartP A Users Policy Objsct |

Source Starter GPO:

| {none)

I ok J[ canca |

4. Click OK.
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Use a domain controller
with these procedures.

USB Drive Protection

Complete these steps to restrict a group of users from usinga USB drive.

Management dialog box.

Repeat step 1 and step 2 on page 133 to access the Group Policy

In the system domain folder, click Group Policy Objects, right-click

PlantPAx Users Policy Objects and choose Edit.

2L File Action View

Window Help

e AE L0 X6 BHE

‘Group Policy Management

4 [ Domains

b [&@ Sites

|2, Group Policy Management
Fl _‘:\3 Forest: System.PlantPAxlocal

4 3 System PlantPAxlocal
s/ Default Domain Policy

4 | 5 Group Policy Objects
=/ Default Domain Controllers Policy

b L WMI Filters
[ g Starter GPOs

PlantPAx Users Policy Object

Scope
Links

Display links in this location:

|Datails I Settings i Delegation |Status ‘

System.Plz

4 3] Domain Centrollers The following sites, domains, and OLs are linked t
[ Default Domain Controllers Policy =
Location
a, B Hlontbox =1 PlantPAx
# PlantPAx Users Policy Object =

- Areas

I Roles <

b &l Users

Security Filtering

The settings in this GPO can only apply to the follo

Y

D_Efault Domain Policy [ Name
| PlantPAx Users Policy onjec||'— =5 |I
L

‘ OFU Status

Rarlk LIn.

The Group Policy Management Editor dialog box appears.

3. Click to expand the Computer Configuration folder and choose User

Configuration>Policies> Administrative Templates>System.

4. Click Removable Storage Access and choose All Removable Storage
classes: Deny all access.

File Action

| 2

View Help

Group Policy Management Editor

=T

= PlantPAx Users Policy Object [PADCA.SYSTEM. ~ |
4 i Computer Configuration

i ] Policies

I || Preferences

- Removable Storage Access

All Removable Storage classes: Deny
all access

Setting
Set time (in seconds) to force reboot
CD and DVD: Deny read access

4 User Configuration s =
W:e: PU“CiESg Edit policy setting. | CD and DVD: Deny write access
; = Software Settings Requirements: Custom Classes: Deny read access
b [ Windows Settings At least Windows Vista =| Custom Classes: Deny write access
4 | Administrative Templates: Policy de) L Floppy Drives: Deny read access
L Description: S .
b ] Contral Panel Configure access to all removable =l Floppy Drives: Beny wiite access
- || Desktop storage classes, Removable Disks: Deny read access
[ Network pocaable Dicke: Dep Earce
| Shared Folders = | | This policy setting takes precedence AII Removable Storage classes; Deny all access
= over any individual removable
- || Start Menu and Taskbar . S L W 3 [ - Lo
= storage policy settings. To manage :
4 [ System : individual classes, use the policy Tape Drives: Deny write access
| Ctrl+Alt+Del Options settings available for each class. |i=| WPD Devices: Deny read access
_| Driver Installation . . : |i5] WPD Devices: Deny write access
“| Folder Redirection If you enable this policy setting, no
= i access is allowed to any removable
| Group Policy
- 2 storage class.
- || Internet Coemmunication Ma
| Locale Services If you disable or do not configure this
| Logon policy setting, write and read
E accesses are allowed to all removable
|| storage classes.
| scripts
| User Profiles
) b | Windows Components v <] m >
< 0 >| |\ Bddended f Standard /
14 setting(s)
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S. Click Enabled and OK.

m All Removable Storage classes: Deny all access

Previous Setting | | Next Setting

) Not Configured ~ COMMent:

O Disabled

Supported on:

At least Windows Vista

Help:

Configure access to all removable storage classes.

This policy setting takes precedence over any individual
removable storage policy settings. Te manage individual classes,
use the policy settings available for each class.

If you enable this policy setting, no access is allowed to any
removable storage class.

If you disable or do not configure this policy setting, write and
read accesses are allowed to all removable storage classes,
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Use a domain controller Configure Portable Device Enumerator Service
with these procedures.

Complete these steps to enable a service that enforces Group Policy Objects for
connected mass storage devices.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy
Management dialog box.

2. In the system domain folder, click Group Policy Objects, right-click
Default Domain Policy and choose Edit.

=

=L Group Policy Management
2l File Action View Window Help

s A Xd HE
[ Group Policy Management Default Domain Policy
4 —ﬁ Fgrest: S)r.stem.PIantPAx.IUcaI Scope | Details I Settings | Delegation I Status |
4 |55 Domains _
4 F3 System.PlantPAxlocal Links
a4 Default Domain Policy Display links in this location: System Fla
I 21 Domain Controllers The following sites, domaing, and OUs are linked tc
4 |2 PlantPAx o =
; : cation
PlantPAx U Policy Object =
Aa” i 5 System PlantPAxlocal
| Areas
Roles
2| Users <
4 [ 5 Group Policy Objects
\=] Default Domain Centrollers Palicy Security Filtering
'=| Default Domain Poli = eeainailu can only apply to the folla
\=] PlantPAx Users Polic] Edit... =
I :'_-y WMI Filters GPO Status ¥ 5 (SYSTEM\Domain Compt
: |> ] Starter GPO= Back Up...
b g Sites
sts Group Policy Modeling LSt s bac b .
_+ Group Policy Results Impart Settings... [

Save Report... |
I
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3. On the Group Policy Management Editor dialog box, open Computer
Configuration>Policies> Window Settings>Security Settings folders.

4. In the System Services folder, click Portable Device Enumerator.

File  Action

a5 n

Group Palicy Management Editor

View Help

(== |

4 (&l Comp
4[] Pol

vow [

3

F

=] Default Domain Policy [PADCA.SYSTEM.PLANT |

uter Configuration
licies

_| Software Settings
| Windows Settings

| Name Resolution Policy
|| Seripts (Startup/Shutdown)
T Security Settings

I+ _:ﬂ Account Policies

[+ j Local Policies

I j Event Log

I» | & Restricted Groups

b g Registry

I+ [ 4 File System

I 74 Wired Network (IEEE 802.3) Py

B || Windows Firewall with Advari

| Network List Manager Policie

f‘ﬂg ‘Wireless Metwork (|EEE 80211 |

| Public Key Policies

Software Restriction Policies

MNetwork Access Protection

| Application Control Policies

g IP Security Policies on Active

1 [

<] [T >

Service Mame ™

 Network Connections

{1 Metwork Connectivity Ass...
ff_;i- Metwork List Service

ﬁf;“ MNetwork Location Awaren...
ﬁ‘_; MNetwork Store Interface 5.
{{F Offline Files

f{; Optimize drives

ﬁ’,; Performance Counter DLL...
1k Performance Logs & Alerts

ﬁ‘_; Print Spooler

ﬁ:FPrinter Extensions and MNo...
F}Problem Reports and Solu...
ﬁ’,; Remote Access Auto Con...

J Remote Access Connecti...
ﬁ";E Remote Desktop Configur...
ff_;i- Remote Desktop Services

_.;P Remote Desktop Services ...
ﬁ‘_; Remote Procedure Call (R...
ﬁ:; Remote Procedure Call (R...
ffr; Remote Registry

Startup

Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined

Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined

Permission
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined

'- Portable Device Enumerat... Mot Defined Mot Defined

Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined

5. Check the ‘Define this policy setting’ box and select

Security Policy Setting

Porlable Device Enumerator Service Propertics |2 M|

ine this policy setting

Select service startup mode:

i

() Manual

() Digabled

Portable Device Enumerator Service

ok |l Cancdl ||

Aoy |

6. Click OK.

‘Automatic’

7. Close the Group Policy Management Editor dialog box.
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Software Access Restriction

Complete these steps to restrict a group of users from using

non-approved software.

1. Repeat step 1 and step 2 on page 133 to access the Group Policy

Management dialog box.

2. In the system domain folder, click Group Policy Objects, right-click
PlantPAx Users Policy Objects and choose Edit.

3 File Action View Window Help

o= 28| X d HE

5L Group Policy Management
4 _-;\_\‘ Forest: System.PlantPAx.local
4 |54 Domains
4 F3 System.PlantPAxlocal
;| Default Domain Policy

Domain Controllers
= Default Domain Controllers Pelicy

= Group Policy Objects
=[ Default Domain Controllers Policy
Default Domain Policy

PlantPAx Users Policy Obje

PlantPAx Users Policy Object
Scope | Details | Settings | Delegation | Status

Links
System.F

Display links in this location:
The following sites, domains, and OUs are linked

-

Location
[Z] PlantPAx

Security Filtering
The settings in this GPO can only apply to the fol

-

MName

Edit...

b L WMI Filters

The Group Policy Management Editor dialog box appears.

3. Click to expand the Computer Configuration folder and choose User
Configuration>Policies> Administrative Templates.

4. In the System folder, double-click Don’t run specified

Windows applications.

File  Action

L

View Help

= Group Policy Management Editor

=P i ; >
(=[ PlantPAux Users PU|I$.'}' OhJ.E[t [PADCA.SYST ~ . System
4 i Computer Configuration 5 z
b BB Policies Don’t run specified Windows Setting i
b e Breki applications _| Folder Redirection
references .
5 L . _| Group Policy
a User Configuration - et =
V:a: = Pclliciesg Edit policy sefting. _| Internet Communication Management
I+ | Software Settings Requirements: * Locale Services
b [ Windows Settings At least Windows 2000 | Logon
4 || Administrative Templates: Policy . —| Power Management
& Description: R ble St A
v ] Control Panel _ || Prevents Windows from running e i e
f ] Desktop = ||| the programs you specify in this | Seripts
B [ Network policy setting. _| User Profiles
Shared Folders i i i 12| Download missing COM components
gnu and Taskbar iyou Fhsble this policy sciting, i=| Century interpretation for Year 2000 &
users cannot run programs that
you add to the list of disallowed \iZ| Restrict these programs from being launched fro
i+ Alt+Del Options applications. o not display the Getting Started welcome screy
_| Driver Installation Custom User Interface
“| Folder Redirection If you disable this policy setting or
- o biv do not configure it, users can run revent access to the command prompt
°| Group Policy _ i L T
4 = e mmEnicalion E Don't run specified Windows applications
_| Locale Services This policy setting only prevents !
| Logon users from running programs that
| Power Management are started by the File Explorer 1| Windows Automatic Updates v
- BemovableStorages Acca process. It does not prevent users W
i B v g > || frem runnina proarams. such as = ! £
< m | > \Extended A Standardi'(
10 setting(s)
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5. Click Enabled, Show, and then type any application software to create
an access restriction.

Don't run specified Windows applications Previoits Setting

O Mot Configured Comment:

O Disabled

List of disallowed applications

Value

Supported on: [ At |east Windows 2000

regedit exe I

Options:

List of disallowed applications

6. Click OK.

The Don’t run specified Windows application dialog box confirms
the policy setting.

m Don't run specified Windows applications

Previous Setting | | Next Setting

) Not Configured ~ COMMent:
® Enabled
O Disabled

Supported on: [ At |east Windows 2000

Options: Help:

List of disallowed applications PrE\_.rents Wmdows from running the programs you specify in this | ~ |
policy setting.

If you enable this policy setting, users cannot run programs that
you add to the list of disallowed applications.

If you disable this policy setting or do not configure it, users can
Fun any programs.

This policy setting only prevents users from running programs
that are started by the File Explorer process, It does not prevent
users from running programs, such as Task Manager, which are
started by the system process or by other processes. Also, if
users have access to the command prompt (Cmd.exe), this
policy setting does not prevent them from starting programs in
the command window even though they would be prevented
from doing so using File Explorer,

MNote: Non-Microsoft applications with Windows 2000 or later
certification are required to comply with this policy setting.
MNote: To create a list of allowed applications, click Show. In the

oK | Cancel || Apply

7. Click OK.
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In the FactoryTalk® architecture, there are two separate directory types: Local
and Network. The Network Directory coordinates the communication
between the system elements on multiple clients and servers, such as data
servers, HMI servers, and alarm and event servers. If all of your products reside

on one computer, you can use the Local Directory.(l)

In a PlantPAx" system, the FactoryTalk Directory (FTD) centralizes and shares
information across multiple computer systems. The FTD makes this
information available through a lookup service to all software products that
participate in an application.

Windows Domain
FactoryTalk %
Directory
;|/~ N

IMPORTANT  Itis required to have a user name and password with administrator
privileges to install FactoryTalk software and to specify an FTD location.
Use the same user name and password for all FactoryTalk installations
on the PlantPAx system.

See Figure 9 on page 168 for the topics that are described in this chapter.

Considerations Consider the following suggestions before starting this chapter:

e The FTD server does not require redundancy to maintain availability of
the system if the FTD server fails. The FTD information is cached on
each computer that is participating in a distributed application as long as
the computer had previously accessed the FTD server.

e For compatibility purposes, you must install software components, such
as FactoryTalk Services Platform. You also can use the Product
Compatibility and Download Center (PCDC) at

hetp://www.rockwellautomation.com/global/support/pcde.page.

(1) Some FactoryTalk products, such as FactoryTalk® VantagePoint®, can address multiple FactoryTalk Directories.
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Figure 9 contains the topics that are described in this chapter. Click or see the

page number for quick access to a section.

Figure 9 - FactoryTalk Components Workflow

| Start )

h 4

Configure the FactoryTalk Directory - Enable Windows Firewall
+  Define Network Directory

See page 169

No Virtual
Environment

Virtual Image Templates
User Manual,

publication 9528-UM001

B
=

Y

License FactoryTalk Activation . Open Activation Manager

See page 175

Patches

Yes

Use FactoryTalk Patches From the PCDC

See page 177

See Chapter 6 Configure FactoryTalk Security
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Chapter 5

Configure the FactoryTalk

Directory

Use servers and workstations
with these procedures.

)

The PlantPAx system is integrated as a directory to all system computers as
defined by the FTD. The following procedures must be completed for all
computers in the PlantPAx system.

1. Click the Programs ﬂ symbol and choose Rockwell
Software®>FactoryTalk Tools>FactoryTalk Directory
Configuration Wizard.

b . BOOTP-DHCP Server 3
. FactoryTalk Activation 3
|, FactoryTalk Alarms and Events 3
All Servers and Workstations . FactoryTalk Historian SE v | | Accessibility »
|E Diagnostics Viewer . FactoryTalk Tools | Administrative Tools 4
il% Factendalk Diaanostics CounterMonitor | FactoryTalk View vl CGCM 3
FactoryTalk Directory Configuration Wizard . Logix Designer Tools » | | Embedded Lockdown Manager »
\[& FactoryTalk Help | RSLinx b | | Hiprom Software 3
[&] FactoryTalk Live Data Test Client |. RSLogix 5000 Enterprise Series » | | Maintenance 3
i FactoryTalk Security Systern Configuration Guide |, RSLogix 5000 Tools v | Microsoft Office 2
8} Import RSSecurity Configuration . RSNetWon v | | Microsoft SQOL Server 2008 4
!&v Log On to FactoryTalk L Utilities v | 1 Microsoft SOL Server 2008 R2 2
!ﬁ! RSS5ecurity Emulator Install [} FactoryTalk Administration Console . Roclwell Autemation 3
"E Specify FactoryTalk Directory Location 6 Studio 5000 . Roclwell Software
Windows Firewall Configuration Utility .. SharePoint 3
.. Startup 2
L VMware 3
. Windows Accessories 4
. Windows System 3
PN Adobe Reader XI
|| Desktop
2 FactoryTalk View Studio
;1 rch
PAG

2. Select ‘Configure the FactoryTalk Network Directory’ and click Next.
x|

) FactoryTalk Directory Configuration Wizard

FactoryTalk Directory Configuration

This wizard configures FactoryTalk Directory settings on this computer. A Factory Talk Diredory must
be configured beforeyou can usethis computerwith your Factory Talk software produds.
FactoryTalk Network Directory

Allows FactoryTalk software products to share centralized security and information settings aooss a
network.

FactoryTalk Local Directory

Allows FactoryTalk software products to share security and information settings only on this locl
computer.

Configure settings

Select the directories you want to configure on this computer.

anfigurethe FactoryTalk Network Direcory

[~ Configurethe FactoryTalk Local Diredory

‘what FactoryTalk Directories do | need to configure? |

concel help

To continue, click Next.

IMPORTANT  The FactoryTalk Local Directory is optional. But, you must use
FactoryTalk View Machine Edition (ME) software with the
Local directory.
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3. Type any Windows administrator user name and password for the
Network Directory, and click Next.

Use the same user name and password for Network and Local

Reconfiguring the FactoryTalk Network Directory allows youto reset a disabled administrato

and upgrade policies.

To continue, enter aWindows Administratoraccount username and password below.

Administrator User Name: |Adminish’ah0r

Password: |“‘=====x1

To continue, click Next. I Next = I Cancel |

170

directories.
7 FactoryTalk Directory Configuration Wizard _-|
) FactoryTalk Directory Configuration Wizard -
Reconfigure FactoryTalk Network Directory
Summary

Factory Talk Metwork Directory
Metwork Directory was successfully configured on this local computer.
Metwork Directory Server is located on this local computer.

Factory Talk Local Directory
MNot selected.

e Toreset a disabled FactoryTalk Security Administrator account, run this FactonyTalk
| | Directory Configuration Wizard again.

To closethis wizard, click Close. Help

4. Click Close.
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Enable Windows Firewall

Although an option, we suggest that you configure the Windows Firewall
utility. This utility creates necessary firewall rules to provide communication
between system elements. Complete these steps.

1. Click the Programs I symbol and choose Rockwell
Software>FactoryTalk Tools>Windows Firewall Configuration Utility.

N BN W N | FactoryTalk Historian SE v | | Accessibility v
E Diagnostics Viewer | FactoryTalk Tools .. Admini ive Tools 3
i@ FactoryTalk Diagnostics Counter Monitor 1. FactoryTalk View P C6CMm 3
@ FactoryTalk Directory Configuration Wizard | Logix Designer Tools * | . Embedded Lockdown Manager
|§ FactoryTalk Help 4. RSLinx » | . Hiprom Software 3
FactoryTalk Live Data Test Client . RSLogix 5000 Enterprise Series » | . Maintenance 3
ﬁ FactoryTalk Security System Configuration Guide 4. RSLogix 5000 Tools » | Microsoft Office 3
€3 Import RSSecurity Configuration 1. RSNetWorx » | . Microsoft SQL Server 2008 4
ew Log Onto FactoryTalk . Utilities » | 1. Microsoft SQL Server 2008 R2 4
ﬂ RSSecurity Emulator Install [} FactoryTalk Administration Console . Rockwell Automation 4
Specify FactoryTalk Directory Location 6 Studio 5000 | Rockwell Sof
Windows Firewall Configuration Utility .. SharePoint 4
| Startup 3
1. VMware 3
| Windows Accessories 4
1. Windows System 3
E¥ Adobe Reader XI
|_| Desktop
&l FactoryTalk View Studio
p Search

2. Click Accept and select ‘On with Exceptions’ for the new Firewall state.

Windows Firewall Configuration Utility

Click the OK bitton to apply configuration

; : 5 - changes and the New Firewall State to the
The items below are a list of suggested configuration changes for the Windows Wind Firewhll.

Firewall. These changes are needed fo allow correct operation of your Rockwell

Software products. If you choose to both decline these changes and enable the Click the Cancdl button to discard Wi
Windows Firewall, consult with your local network administration or security Firewall configlration changes.
professionals fo determine how to best protect this computer while operafing your

automation system.

r—Current Firewall
Click the Decline button to discard these changes and exit this dialog. Click the
Accept button to apply these changes to the Windows Firewall and exit. Click the the
Save button to write the changes to a file without modifying the Windows Firewall
configuration. See C\Documents and Settings\All Users\Application
Data\WFCUN\WFCULog.ixt for a log file of this and previous WFCU operations.

—New Firewall State

Copyright © 2011 Rockwell Automation Technologies, Inc. All nghts reserved.

& On with Exceptions

Expand All
Collapse All

3. Click OK.
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Define Network Directory

The Network Directory must be the same for all system computers. Any PASS
server can be used as the FTD server.

1. Click the Programs I symbol and choose Rockwell
Software>FactoryTalk Tools>Specify FactoryTalk Directory Location.

|, BOOTP-DHCP Server »
. FactoryTalk Activation 4
| FactoryTalk Alarms and Events b
. FactoryTalk Historian SE b | Accessibility 3
E Diagnostics Viewer . FactoryTalk Tools . Administrative Tools 4
f@ FactoryTalk Diagnostics Counter Monitor . FactoryTalk View H L CGEM 3
@ FactoryTalk Directory Configuration Wizard | Logix Designer Tools b | |, Embedded Lockdown Manager *
|'_§Q FactoryTalk Help 4. RSLinx » | . Hiprom Software 3
FactoryTalk Live Data Test Client | RSLogix 5000 Enterprise Series b | . Maintenance 4
ﬁ FactoryTalk Security System Configuration Guide . RSLogix 5000 Tools b | . Microsoft Office 3
€} Import RSSecurity Configuration 11 RSMNetWorx b | . Microsoft SQL Server 2008 4
ew Log Onto FactoryTalk . Utilities » | | Microsoft SQL Server 2008 R2 4
i |73} FactoryTalk Administration Console . Rockwell Autoration 4
Specify FactoryTalk Directory Location & Studio 5000 . Rockwell Sof
indows Firewall Configuration Utility 1. SharePoint 4
. Startup 3
L VMware 3
. Windows Accessories 3
1. Windows System 3
E8 Adobe Reader XI
|| Desktop
Bl FactoryTalk View Studio
p Search

2. Click Browse (ellipsis “...”) on the FactoryTalk Directory Server Location
Utility dialog box.

Use this dialog to change the Metwork directory that this computer belongs to. Thig setting affects all software that connects
to the Metwork, directory from this computer.

Use the FactoryT alk Directory installed on: ak.

Computer hosting directory server [connected) LCancel |

localhost s Hel
Help |

3. Type the same user name and password (with Administrator privileges)
that you used to configure the Network and Windows Directory.

User name: IAdministrator

Pazsword: Ixxxxxxxx>1

4. Click OK.
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5. Select Remote computer and type the FactoryTalk Directory server.

For example, PASSO1. You also can browse for a network name.

FactoryTalk Directory Server Configuration

Use the FactoryT alk Directory installed on:

" Thiz computer

+ RBemate computer

[P J

=]
ok I

LCancel

6. Verify the desired FactoryTalk server appears in the computer hosting

text box, and click OK.

to the Metwork, directory from this computer.

Use the FactoryT alk Directory installed on:

Computer hosting directory server [unknown)]

FactoryTalk Directory Server Location Utility -

Use this dialog to change the Metwork directory that this computer belongs to. Thig setting affects all software that connects

—

LCancel

PASSO

Help

7. Click OK on the message box.

4 I *. restart this computer.

FactoryTalk Directory Server Location Utility -

After changing the Network Directory Server location, shut down and

This message is a reminder to restart the computer after you finish

addingall servers and workstations to the FactoryTalk Directory.

8. Logon by using the server user name and password as shown in step 3.

Log On to FactoryTalk (New Server) -

User name: |Administrator

Password: | xxxxxxxx 1

I (] 8 I Cancel

9. Restart the computer.

10. Repeat step 5 through step 8 for all servers and workstations in the

PlantPAx application.

11. Shut down and restart the computer.
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When complete, the FTD computers appear in the FactoryTalk
Administration Console.

File VYiew Tools Window Help

‘Ba|E

E| System

-[Z1 Action Groups

=[] Policies

=3 Computers and Groups

]-E,; Metworks and Dev
¢ Users and Groups
#[C] Connections

Proceed to page 175 to activate software licenses.
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Use Factory'l'alk Activationto FactoryTalk Activation software provides a secure, software-based system to
APP'V Licenses apply Rockwell Automation’ licenses for continuous use of FactoryTalk

software and other Rockwell Automation software products.

Use the PASS with With FactoryTalk Activation software, there is no need for a physical
these procedures. master disk or any physical media. Instead, activation files are generated and
distributed electronically.

Open Activation Manager
PASSO1

On the selected Activation Manager computer, start the activation process by
opening the FactoryTalk Activation Manager.

1. Click the Programs ﬂ symbol and choose Rockwell
Software>FactoryTalk Activation>FactoryTalk Activation Manager.

The FactoryTalk Activation Manager window appears.

2| FactoryTalk Activation Manager [= [ = [

Home | Manage Activations | Advanced

Welcome to FactoryTalk Activation!

You are steps away from using your Rockwell Automation product. All you have to
do is activate your Rockwell product using FactoryTalk Activation.

Ready to get started? Want to learn more?

To activate your Rockwell To learn more about FactoryTalk

product. click one of the Activation before you get

following buttons: started, click the following
button:

Find Available Activations
Learn More...

Get New Activations

Rockwell Automation

2. Click Help to use the instructions to complete the activations.

For additional instructions and information on activation types, host
IDs, and how to use a plug and play dongle, see Activate Rockwell
Software Products, publication ETA-QS002.

You also can use the website at https://

activate.rockwellautomation.com.
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Table 22 - Activation Considerations

Table 22 provides some guidelines after you activate the software.

Consideration

Details

Software that is not activated

If the components you have installed cannot be activated, for example, because the activation server is unavailable,
then the software continues to run for up to 7 days. The seven-day grace period provides time to correct the problem
with acquiring activations, without disrupting critical applications. If activation is restored within 7 days, normal
operations resume. If activation is not restored, the grace period expires. After the grace period expires, if you restart
the components and activation remains unavailable, the software runs for 2 hours in Demo mode.

Location of activation server

The PASS is the primary choice for activation management and is recommended to be the location of the activation
server. In the instance that the PASS is not an acceptable location, for example, when you use a redundant PASS
solution, the EWS is the secondary choice. In this instance, the EWS can be a dedicated station with a permanent
Ethernet connection to the system. The FactoryTalk Activation software can be configured to run as both a server and
client utility.

Options for adding activation files to the PASS

To make concurrent floating activations available to activation clients, first you must download the activation files to
the activation server computer, from the Rockwell Automation® Activation window.

If the PASS has internet access, see Open Activation Manager on page 175.

If the PASS does not have internet access, the activations can be downloaded on another computer with internet
connectivity and then transferred to the PASS.

Protect activation files

Activation files are simple text files that must have a .lic extension.

As long as the lic extension is retained, you can copy or rename an activation file without harming it. However,
tampering with text inside the activation file can disable your Rockwell Software® products.

If an activation file is damaged or deleted, contact Rockwell Automation Technical Support.

For safekeeping, keep an original set of your activation files on back-up media. Use descriptive names for the files, so
that you can identify them later, and copy them back to the appropriate computers.

Activation files are locked to the Host IDs of the computers (or dongles) that need them. Activation fails for Rockwell
Software products on a computer where the specified Host ID is not recognized by the activation file.

176

Proceed to page 177 to learn how to access and configure software patches.
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Use FactoryTa'k Patches We recommend that you periodically review and update the available software

From the PCDC patches and firmware updates for the Rockwell Automation components on
your PlantPAx system. Before implementing Rockwell Automation updates,
we recommend that you verify them on a non-production system, or when the

Use a workstation with facility is non-active. Verification helps to make sure that there are no
these procedures. unexpected results or side effects.
D ! You must restart a computer after installing each patch.
All Computers IMPORTANT  Ifyouareinstalling a new PlantPAx system, we recommend that you use the

specifications in the PlantPAx Selection Guide, publication PROCES-SG001.

1. Click hetp://www.rockwellautomation.com/rockwellautomation/

support/downloads.page to open the Product Compatibility and
Download Center (PCDC).

You also can access the PCDC link from the ab.com website.

Rockwell
Automation Industries ~ Capabilities  Products ~ News &FEvents  Sales & Partners  Suppo

Home » Support » Product Resources #* Share & Print

Compatibility & Downloads

The Product Compatibility and Download Center (PCDC) can help you find product-related downloads
including firmware, release notes, associated software, drivers, tools and utilities.

What's New... Get Notified on Product Updates & Lifecycle changes, Import a list of devices, Find all ¥
products that support a feature, Perform a Global Search & More...

S
Support o Search PCOC n

Downloads

Overview
 Corcaions — Compare &3 Download
» Drawings Before upgrading ene or more products, check the compatibility  Select one or more products to view the available downloads
¥ Drivers & Firmware between the new product(s) and the other product(s} in the far those products.
} Electronic Data Sheets system. -
VP t Specificati » Find Downloads

gt et v Compare Products * Software Downloads by Serial Number

» Sample Code

2. Under Download, click Find Downloads.
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3. In the Product Search text box, type Patches.

&= ¢ @ @ @ httpsy//compatibility.rockwellautomation.com/Pages/MultiProductSelector.as wee 3
Rockwell
Automation USTEN THINK SOLVE! Search
Products & Technologies Solutions & Services News & Innovation Training & Events Sales & Partners Support
Search PCDC ﬂ
Product Compatibility
& Download Center
Compatibility / Download Center » Multi Product Selector

» Compare
» Download
S SELECTIONS @

+ Configured Views
» Available Versions

+ Fealures & Altributes. All Categories IEI All Families Izln

Resources

Fifsequenityfished Gucsboes I Patch Rall-up CPR9 SRx Latest patches for Software (Software/Utilities) I

» Tools & Resources

» Product Directory

o selel

The search results appear under the Search text boxes.
4, Double-click the search results.

Our example is Patch Roll-up CPR9 SRx.

- H N Rt keior x _

(&= C @ @ @ https://compatibility.rockwellautomation.com/Pages/MultiProductSelector.as L ww I o =

» Sign In  » Become & Member

nockwell + Rockwell Automation Worldwide
Automation USEN THINK SOVE Sezrch

Products & Technologies Solutions & Services News & Innovation Training & Events Sales & Partners Support About Us

Product Compatibility 2

& Download Center

» Compare

¢ Downipad

v SELECTIONS @
» Configured Views
» Avallable Versions a

+ Fealures & Atfributes Patches All Categories All Families ﬂ version
Resources 2k

Al e T G Patch Roll-up CPRI SRx Latest patches for Software (Software/Utilities) Nov
» Tools & Resources 'de

Compatibility / Download Center »  Mult Product Selector

select

+ Product Directory Oct
» Technical Support
» Literature Library
¢ Find a Sales Office
+ Find a Local Distributor Arim

Sep
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5. Do one of the following items:

e To select a version, click the search results to access a list. Select a
desired category and click Downloads.

e To use the current version, click Downloads.

Ro:kwell » Rockwell Autemation Worldwide
Automation UsTEN. THINK SOLVE: Searcn
Products & Technologies Solutions & Services News & Innovation Training & Events Sales & Partners Support About Us

o
Product Compatibility
& Download Center
Compatibility / Download Center ¥ Multi Product Selector
+ Compare
+ Download
S SELECTIONS @

+ Configured Views
» Available Versions

» Festures & Affributes Patches All Categories IEI All Families Eln E “ o |

Resources

+ErR00s08y A0 Questions Patch Roll-up CPRY SRx Latest patches for Software (Software/Utilities) @ Patch Roll-up CPRY SRx
+ Tools & Resources

+ Product Directory
+ Technical Support
» Literature Library

6. Click the Show Downloads button.

o]

Compatibility / Download Center » Multi Product Selector »  Find Downloads

DOWNLOADS @ t

SELECTIONS COMPARE E

['show selections - @ Downloads
Patch Roll-up CPR9 SRx H . Select Files
b
Latest patches for Software

7. In the Downloads list, click each box to add the item to the
Download Cart.

The number of items in the cart increase proportionally to the number
of boxes that you click. To remove an item from the cart, click a box to
remove a check mark.

Available Downloads | W Dovmiaads: 1
Product Selected: Patch Roll-up CPR9 SRx

Product Version:

General

Download Software Updates

Patches

-

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018 179



Chapter5  Configure FactoryTalk Components

8. Click the Download Cart and then click Download Now.

Download Cart =
Release Release Download -
Download ltem Version Date Note Size Comments
¥ Patch Roll-up ME

w

CLEAR 1 items JELGLL ow || CLOSE

You need a user name and password to download files.

9. Read the software license agreement and click Accept.

There are two ways to download the patches: managed or direct (browser).

Rockwel' » Rockwell Automation Worldwide
Automation STEN. THINK, SOWVE: Searcn

Products & Technologies Solutions & Services News & Innovation Training & Events Sales & Partners Support About Us

Rockwell Automation now offers two download methods from which to choose. Your download includes [ 1] files. You can
Rockwell Software manually download these files using the direct download method, or you can use our download manager to download the
files for you

+ Support Center
+ KnowledgeBase

PR Managed Download Direct Download

+ FAQ

Benefits of managed download

-Secure

llea vrne hrausear ar third narke Aramlaad

10. We recommend that you click Managed Download.

180 Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018



Configure FactoryTalk Components ~ Chapter 5

11. Click Save File and then click Run.

Do you want to run this file?

You have chosen to open: Iﬂ Name:
Bl Publisher: NOS Microsystems Limited

ichi T Applicati
which is: Binary File (355 KB) Ui
from: https://download.rockwellautomation.com EonSsitcemidministiatan s LERRBowniacel

Would you like to save this file?

[] Always ask before opening this file

While files from the Internet can be useful, this file type can potentially
harm your computer, Only run soff from publishers you trust,
What's the risk?

The Download Manager opens.

A progress bar shows the installer path to the download folder.

Download Complete

100.0%
Dowinload Folder

12. Click Open underneath the progress bar (next to the download
folder path).

Copy the downloaded patch folder to all PlantPAx servers and
workstations for which the patch applies.

13. Click Local Disk (C:) and choose Setup.exe.

“ i| F “— | Application Tools |
File Home Share View Manage v 0
@ - 1 | L0« RA » Patches » Patches- v & | ‘ Search 0 |
P Favoiites Name = Type Size L
Bl Desktop \y 803_RA_FactoryTalk_SR74 File folder
j’_ Downloads . 804 RA FTAE SR7 File folder
2] Recent places i B04_RA_FTAE_SRT1 File folder
1. 804 RA_FTAE SR73 File folder
18 This PC .\ 804 _RA_FTAE SR74 File folder
i Desktop v BD5_RA_FTGateway_370 File folder
:U Documents | 801_RA_RSLinx_Classic_380 File folder
i Downloads | 9071_RA_RSLinx_Classic_381 File folder
H, Music 1) 902_RA_RSLinx_Enterprise_580 File folder
& Pictures . 903_RA_FactoryTalk_SR8 File folder
(i Videos || 903_RA_FactoryTalk_SR81 File folder
& Local Disk (C:) . 904 RA_FTAE SR8 File folder
4 904_RA_FTAE_SR81 File folder
% MNetwork | 952_RA_RSLinx_Enterprise_330 File folder
1 953 RA FactoryTalk_SR9 File folder
1. 954_RA_FTAE_SR9 File folder
A Validate File folder
| Configxml XML File 10KB =
=N T,
135items 1 item selected 4.83 MB E =l
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14. Click Yes to install the patches.

Do you want to install the following patches?

Patch Install Patch Rollup

The installation will automatically terminate all Rockwell Automation software
processes.

15. Click Finish and Restart Now.

-
() The patches are being installed

Installation status:

+ Initializing installation
+ RSLinx Enterprise Patch (1of =

i sePat{iofy) (_J Installation Completed
 FactoryTalk Services Platform Patch {2 of 3)
< FactoryTalk Alarms and Events Patch (3 of 3)

You must restart your computer for the patches to take effect.

Finished

Patch Validation Summary
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Considerations

Configure FactoryTalk Security

FactoryTalk® Security provides access restriction to only those individuals who
legitimately need access to specific automation assets. FactoryTalk Services
Platform (FTSP) includes the FactoryTalk Administration Console that

provides the interface for configuring your system.

This chapter describes how to administer privileges to users and groups to
define who can access hardware devices and software products. Permissions
authenticate an identity and authorize that person to access that resource and
perform only allowed actions. The centralized security system with a modern
DCS, such as the PlantPAx” system, helps to make sure the data that is being
received and processed is from a trusted source.

The Users and Groups in the FactoryTalk View console let you control who
accesses the FactoryTalk system and from which computer. Access can be
restricted to a single user or group of users to help simplify the administration
of permissions.

When setting up security, create groups first and grant the appropriate
permissions to the group. With groups, you create a security structure without
needing to know exactly the users that comprise the groups. When users are
added to the group, they inherit the permissions that are granted to the group.

As shown in Figure 10, there are groups that require separate configuration:
¢ External — Involves Windows-linked user groups in a domain controller

e Internal — Includes users not in a domain but grouped in the

FactoryTalk Directory (FTD).

The overlap between these two groups creates a hybrid group.

Figure 10 - Users and Groups Example
Hybrid

IMPORTANT  Evenif your application has a domain, we highly recommend that you
configure a hybrid group. The internal connections, via the hybrid, permit
operations to continue if there is loss of a domain connection.
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Figure 11 contains the topics that are described in this chapter. Click or see the

page number for quick access to a section.

Figure 11 - FactoryTalk Security Workflow

( Start )

r
Configure FactoryTalk Users and Groups

See page 185

v
Define FactoryTalk System Policies

e o o o

See page 193

v
Define the Security System Policy

See page 197

h 4
Define FactoryTalk Product Policies

See page 199

r
Create Permission Sets

See page 200

A 4

Assign User Domain to FactoryTalk Directory
Create Internal Users and Groups

Use Default Terminal Client
Use the Same FactoryTalk Log On
Restrict Application Authorization

Audit Security Actions

See Chapter 7 Configure Controller Security
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Configure FactoryTalk Users
and Groups

Use an Engineering Workstation
with these procedures.

EWS

The FTD stores information about which users have access to the parts of a
control system. During the logon, FactoryTalk security uses this information to
verify an identity and then permissions that are assigned to the user.
Authorized users can then access secured parts of the application.

Assign User Domain to FactoryTalk Directory

The following subsections walk you through how to link user accounts in a
Windows domain into FactoryTalk security. These procedures, including
assigning groups, roles, and areas, must be completed for domain credentials to

be recognized in the FTD.
Linking External Users and Groups

Windows-linked user accounts must be assigned access rights to validate that
the users are authorized for the work that is approved for the group. (Domains

are explained in Chapter 3.)

1. Click the Programs E symbol and choose Rockwell Software®
>FactoryTalk Administration Console.

2. Select the network directory and click OK.

3. Under the Network Directory, click System and then Users and Groups
to expand both folders.

4. Right-click User Groups and choose New>Windows-Linked User
Group.

" FactoryTalk Administration Console I;Ii-

File View Tools Window Help
=
Explorer .
=% Network (PASSD1)
5[0 System
Cl Action Groups
+L] Policies
=E Computers and Groups
+-,5'E,5 Metworks and Devices
—:I Users and Groups

Authenti:”T User Group... |
€ Windows Security... I Windows-Linked User Group... I
E @ Administrators | |
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5. Click Add.

General

Click the Add button to select one or more Windows user
groups. When you dick the Create button, a new linked
user account will be created for each Windows user group
you have selected,

Remove...

Select this object type:
|Gmups or Builtin security principals

From this location:
EED

Enter the object names to select (zamples):

7. To search for the PlantPAx groups in the domain, open Entire Directory
and select a domain name (System.PlantPAx.local is
an example).

Select the location you want to search.

'Z7] Domain Cortrollers

2] ForsignSecurityPrincipals
2] LostAndFound

'Z7] Managed Service Accounts
=]

R (P

8. Click OK.
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Importing Active Directory Roles

Complete these steps to import specific roles, such as supervisor, operator,
maintenance, into groups.

1. On the Select Groups dialog box, click Advanced.
To access this dialog box, repeat step 1 through step 5 on pages 185-186.

Select this object type:
|Ernups

From this location:
|Sy5tem.PIantPPn(Joca|

Select this object type:

|Gmups Commen Queries
From this location: Name: Starts with v

[System PlantPAxlocal

Description: ’W‘
Enter the object names to select (zamples):
’ ["] Disabled accounts

[] MNon expiring password

Days since last logon:

=a

Description
PlantP A&« Administrator
PlantP fx Engineering
PlantPAx Maintenance
PlantPAx Maintenance Supervisor
PlantP&x Manager

2. Type PlantPAx.
3. Click Find Now to display a list of roles that you grouped in Chapter 3.
4. Select all desired windows-linked groups and click OK.
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5. To accept the selections, click OK on the following dialog boxes.

General

Click the Add button to select one or more Windows user
groups. When you dick the Create button, a new linked
user account will be created for each Windows user group
you have selected,
€5 SYSTEM\PLANTPAX ADMINISTRATOR
|Gmups €5 SYSTEMIPLANTPAX ENGINEERING
From this location: €5 SYSTEM\PLANTPAX MAINTENANCE
|‘Sy§em e - €5 SYSTEMIPLANTPAX MAINTENANCE SUPERVISOR

: €51 SYSTEMIPLANTPAX MANAGER

Select this object type:

Enter the object names to select (zamples): €5 SYSTEM\PLANTPAY OPERATING SUPERVISOR
€5 SYSTEM\PLANTPAX OPERATORS

PlantP fx Administrator; PlantP A« Engineering :

PlantP Ax Maintenance ; PlartPAx Maintenance Supervisor;
PlantPAx Manager; PlartPAx Operating Supervisor;

PlantP Ax Operators

All of the domain groups and roles are listed under the FTD
User Groups.

File View Tools Window Help

&S5 [E

=145 Network (PASSDT)
=0 System

-[Z1 Action Groups

=1 Policies

=E Computers and Groups

# &5 Networks and Devices

=1 Users and Groups
: [ User Groups ‘

Q Authenticated Users
@ SYSTEM\PLANTPAX ADMINISTRATOR
g SYSTEM\PLANTPAX ENGINEERING
Q SYSTEM\PLANTPAX MAINTENAMNCE
g SYSTEMVPLANTPAX MAINTENANCE SUPERVISOR
@ SYSTEM\PLANTPAX MANAGER
g SYSTEM\PLANTPAX OPERATING SUPERVISOR
Q SYSTEMM\PLANTPAX OPERATORS
g Windows Administrators
@ Administrators
_——
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Observe with area descriptions the terms

‘Advanced’ and ‘Basic.

« Advanced provides access to engineering
modifications on Process Library faceplates.

« Basicallows access to non-engineer functions,
such as Maintenance, Operator, on Process
Library faceplates.

See Area Groups on page 121 to configure security
for different areas of your application.

Importing Active Directory Areas

Complete these steps to assign groups with engineering or non-engineering
access rights. Engineering access allows modifications to Library faceplates.

1. From the New Windows-Linked User Group dialog box, click Add.
To access this dialog box, repeat step 1 through step 4 on page 185.

2. From the Select Groups dialog box, type an object name.
For example, Area.

3. Click Find Now.

Select this object type:
|Gmup5

From this location:
|System PlantPAxlocal

Commen Queries
Name: Starts with |}\rea

Description: |Start5w'rth v| |

["] Disabled accounts
[] MNon expiring password

Days since last logon:

pp— Description

HAreal” (_Advanced
Aeal' Basic e
System PlantPA. .
System PlantPA..
System PlartPA. .
A ) | System PlantPA.
A freald_Advanced System FlantPA..
- Afreald Basic System PlantPA...

HAreal5_Advanced

Arealb_Basic

4. Select an object from the list and click OK.

5. The object groups appear in the text box of the Selection Groups

dialog box.

Select this object type:
|Gmup5

From this location:
|System.PIantPP«x.IocaI

Enter the object names to select (zamples):

Arealll Advanced; Arealll Basic; Areall? Advanced:;
Areall2 Basic; Areald Advanced; Arealld Basic;
Areald Advanced: Areal4 Basic: Areal5 Advanced: Areal5 Basic

6. Click OK.
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7. Click OK again, and the assigned areas appear in the Network Directory
under User Groups.

Mew Windows-Linked User Group

BE |

190

General *d

Click the Add button to select one or more Windows user
groups. When you click the Create button, a new linked
user account will be created for each Windows user group
you have selected.

g SYSTEM\AREADT_ADVANCED

g SYSTEM\AREAD1_BASIC

g SYSTEM\AREADZ_ADVANCED

g SYSTEM\AREADZ_BASIC

g SYSTEM\AREAD3_ADVANCED

g SYSTEM\AREAD3_BASIC

g SYSTEM\AREAD4_ADVANCED

g SYSTEM\AREAD4_BASIC

g SYSTEM\AREADS_ADVANCED

g SYSTEM\AREADS_BASIC

Cancel | [ Heb

FactoryTalk Administration Console
File View Tools Window Help

Explorer

=1[L] System

[ Action Groups

[ Policies

[ Computers and Groups

&5 Networks and Devices

[Z3 Users and Groups

=L User Groups

g ASAMONIS_IUSRS

g Authenticated Users

g SYSTEMMVAREAODT_ADVANCED

g SYSTEMMVAREADT_BASIC

g SYSTEMMVAREAOZ_ADVANCED

g SYSTEMM\AREADZ_BASIC

g SYSTEMMVAREAD3_ADVANCED

g SYSTEMMVAREAD3_BASIC

g SYSTEMMVAREAOS_ADVANCED

g SYSTEMM\AREADS_BASIC

g SYSTEMMVAREAOS_ADVANCED

g SYSTEMMVAREAQS_BASIC

g SYSTEM\PLANTPAX ADMINISTRATOR
g SYSTEMM\PLANTPAX ENGIMNEERING
g SYSTEM\PLANTPAX MAINTENAMNCE
g SYSTEM\PLANTPAX MAINTENANCE SUPERVISOR
g SYSTEM\PLANTPAX MANAGER
g SYSTEMM\PLANTPAX OPERATING SUPERVISOR
g SYSTEMN\PLANTPAX OPERATORS
g Windows Administrators

!ﬁ Administrators

+(20 Users

+C| Connections

+[1 Permission Sets

Application j Communicaiions
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Create Internal Users and Groups

Use an Engineering workstation This section describes how to create an internal and a hybrid users group for
with these procedures. smaller systems that don’t have a domain infrastructure. A hybrid group, which
is composed of external (domain) and internal (FTD) users, is reccommended
D for continued operation if the domain connection is lost.
Complete these steps.
EWS P P

1. Click the Programs I symbol and choose Rockwell Software®

>FactoryTalk Administration Console.
2. Select the network directory and click OK.

3. Under the Network Directory, click System and then Users and Groups
to expand both folders.

4. Right-click User Groups and choose New> User Group.

File View Tools Window Help

ua|E

(=145 Network (PASSD1)
E@ System
[ Action Groups
#[ Policies
w23 Computers and Groups
-85 Metworks and Devices

User Group...
| Windows-Linked User Group...

5. Type a new user group name and click OK.

General

Name: [ PlantPx Admin |

Description:  §1 | neal PlantPAx Administrators|
E-mail:

Members:
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6. Right-click the Users folder, and choose New>FactoryTalk User.
7. Type a user name and description.

8. Enter a password and then type the same password as confirmation.

le View Tools Window Help

¢[_] Policies

#[L] Computers and Groups
i@ Metworks and Devices
=1 Users and Groups
E| User Groups

- PlantPAx Admin

- ASAMOT\IIS_IUSRS

Q Authenticated Users

- SYSTEM\AREAQ1_ADVANCED

@} SYSTEM\AREADT_BASIC

€ SYSTEM\AREA(2_ADVANCED

@} SYSTEM\AREADZ_BASIC

- SYSTEM\AREAQ3_ADVANCED

@} SYSTEM\AREAD3_BASIC

-8 SYSTEM\AREAC4_ADVANCED

@} SYSTEM\AREAD4_BASIC

- SYSTEM\AREAQS_ADVANCED

@} SYSTEM\AREADS_BASIC

- SYSTEM\PLANTPAX ADMINISTRATOR

- SYSTEM\PLANTPAX ENGINEERING

- SYSTEM\PLANTPAX MAINTENANCE

8 SYSTEM\PLANTPAX MAINTENANCE SUPERVISOR
8 SYSTEM\PLANTPAX MANAGER

- SYSTEM\PLANTPAX OPERATING SUPERVISOR
- SYSTEM\PLANTPAX OPERATORS

g Windows Administrators

ﬁ Administrators

General | Group Membership
User name: PlantP Ax Administrator

Full name:

Description: | Local PlantP Ax Administrator

E-mail: |

[#] User must change password at next logan
[ User cannot change password

[ Password never expires

[ Accourt is disabled

& F. FactoryTalk User...

+[] Conng ... emporary User...

LEaon

9. In the Group Membership tab, choose Add, and then select a group to
be linked to the new user.

m Group Membership I

Member or:

Filter Users
(®) Shaw groups only

Bemove. ..

10. Click OK.
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11. Repeat step 4 through step 10 to add a new local group and users to

Define FactoryTalk System
Policies

the system.

TIP  You canalso create guest users with known passwords to control this type of
access in the system.

For alist of HMI security codes, see the Rockwell Automation Library
of Process Objects, publication PROCES-RM002.

This optional section describes how to use Remote Desktop Services (RDS) to
access FactoryTalk applications, such as thin clients.

Use Default Terminal Client

Use an Engineering Workstation
with these procedures.

EWS

You have two server options: terminal client or server computer; terminal

being the default.

On the network directory (see steps 1...2 on page 191) under System>
Policies>System Policies, double-click Security Policy.

On the Policy Settings dialog box under Computer Policy Settings, leave
terminal client as the default for remote desktop services to be available.

TIP  Select Server computer from the pull-down menu and click OK if
you want external client computers to be able to log in to the FTD
without any pre-configuration. This option, however, does not let
you track specific actions from the terminal client.

= Systern Policies
v FactoryTalk Alarms and Events
] Application Authorization

] User Rights Assignment
Live Data Policy

Health Manitering Policy
1 Audit Polic

" FactoryTalk Administration Console = RELY
File View Tools Window Help
&
Explorer .
; ; : x
=45 Network (PASSOT) Security Policy Properties
—D System —_—
n Policy Setti
-[Z1 Action Groups SRS |
-] Policies
+|:| Product Policies Logon session lease 1 hour -
Account lockout threshold Dinvalid logon attempts |

Account lockout auto reset 15 minutes
Keep record of deleted accounts Disabled
Show deleted accounts in user list Disabled
Bl Computer Policy Seifings |z
| Reguire computer accounts for all client machines Enabled
B Directory Prolection Policy Setiings Teminal client
| Support non-secure clients Server computer

Audit non-secure client connections

+-,5'E,5 Metworks and Devices

3. Click OK.

Directory cache expiration
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Use the Same FactoryTalk Log On

You have options to enable/disable access to multiple FactoryTalk products
with the same FTD logon.

1. On the network directory (see steps 1...2 on page 191) under
System>Policies>System Policies, double-click Security Policy.

2. Scroll down to Single Sign-On Policy Settings and leave Enabled as

the default.
This setting lets you use the same FactoryTalk log in for multiple
products.
TIP  Select Disabled from the pull-down menu if you want separate
logins to be used for each FactoryTalk product.
Security Policy Properties 2
Policy Settings |
| |dentify terminal server clients using the name of Terminal client ~|
Bl Directory Protection Policy Settings
Support non-secure clients Allow
Audit non-secure client connections Enabled
| Directory cache expiration 0 hours before expiration
Bl Password Policy Selfings
Passwords must meet complexity reguirements Disabled
Minimum password length & characters
Previcus passwords remembered 3 passwords
Minimum password age 0 days =]
Maximum password age 0 days |
| Password expiration warning 14 days before expiration
Bl Single Sign-On Policy Settings
Enabled ™
i
[ l]sesiﬁﬂesigl—un Disabled
Determines whether users can log on once to the Factory T3k R AR Y
| to each FactoryTalk-enabled product separately.
oK | | Cancel | | Apply | | Help |

3. Click OK.
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Restrict Application Authorization

You can verify and configure FactoryTalk Services application authorization.

1. On the network directory (see steps 1...2 on page 191) under
System>Policies>System Policies, double-click Application
Authorization.

rd

FactoryTalk Administration Console

File View Tools Window

=145 Network (PASSDT)
: Systern
Action Groups

7] Batch

223 FactoryTall
#20 RSLogix 500
{00 RSMACC
0] Studio 5000
223 RSLogix Arg

&

£

£

£

&

£

{3 RSLogix 5
0 ControlFlas
{23 RSLogix 500
£
£
£
&
£
£
£
E

Help

Process ersion Computer Publisher Info | ~
FTAEArchiver.exs 2.74.0.8 owsn2 Rockwell Automation ]
FTAEArchiver.exe 2.74.0.8 PASS02A Rockwell Automation |
FTAEArchiver.exe 2.74.0.8 EWS01 Rockwell Automation | Refresh
FTAEArchiver.exe 2.74.0.8 owWso1 Rockwell Automation |
FTAEArchiver.exe 2.74.0.8 PASS02B Rockwell Automation |
FTDataUpdate exe 2.74.0.11 PASS024 Rockwell Automation
FTDataUpdate exe 2.71.0.4 ASIHO1A Rockwell Automation
FTDataUpdate. exe 2.74.0.11 EWS01 Rockwell Automation —

" T]nai—,u Indate_eva 2741 11 = WTN-NAESHYRTKCL L Dne'iﬂms:il & B lli

|

Settings

[+ Enable Default Access Mote: When selected, any new FTSP process will be automatically allowed access, If
unselected, any new FTSP process will be automatically denied access. You can toggle
the access permissions of a process above,

[ verify Publisher Info Mote: When selected, all FTSP processes will have its publisher information verified. If

the verification fails, the process will automatically be denied access.

| oc || Hep |[ conel

]

2. In the (lower) Settings section of the dialog box, use the ‘Enable Default
Access’ default.
This setting automatically authorizes application access.

3. If you want to require application verification, click “Verify Publisher

Info’ and click OK.
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Audit Security Actions

You can enable an audit to track configurations and security.
1. On the network directory (see steps 1...2 on page 191) under
System>Policies>System Policies, double-click Audit Policy.

2. Under Audit Policy Settings, select Enabled from the Audit security
access failures pull-down menu.

Audit Policy Properties -
Policy Settings |
Audit Policy Settings
Audit changes to configuration and control system Enabled
Audit security access failures Enabled [«
Audit security access successes Disabled
:".Autiit secu'llym ial;lm
Determines whether to generate an audit message when a user attempts an action
and is denied access.

3. Click OK.

Proceed to page 197 to determine security permissions for groups
and users.
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Define the Security System

Policy

Use an Engineering Workstation
with these procedures.

EWS

This section describes how to configure permissions for groups and users to
perform actions that are based on their security levels. The access level can be

based in the domain or local groups, however, the user needs to be a member of
only one single group. For example, if you are a member of the Administrators

and the Operators groups and you are denied access, you lose Administrator

permissions. You have the lowest security access in both groups.

Complete these steps.

1. On the network directory (see steps 1...2 on page 191) under

System> Policies, right-click System Policies and choose Security.

Explorer

=& Network (PASS01)
=23 System
(20 Action Groups

[ fnnlicatinn Atharizatinn

2. On the Permissions tab of the Security Settings for Systems Policies

dialog box, click Add.

The Select User and Computer dialog box appears.

3. Select a PlantPAx group and click OK.

Pemissions | Effective Permissions

Security Settings for System Policies

Permizzions for Administrators from All Computers.

@Administrators
g Authenticated Users
&4

fy

Bemave

Action
All Actions
Common

Rl g
QSYSTEM\PLANTPAX MAINTENANCE

g SYSTEMMPLANTPAX MANAGER

g SYSTEMWPLANTPAX OPERATORS
gw’indows Adminizstrators

QSYSTEM\PLANTPAX MAINTENANCE ...

QSYSTEM\PLANTPAX OPERATING SU...

Wigw permizsions by (®) User ) Action
Uszers Computers
@Administmtors !EAII Computers
€7 Al Users BB Al Computers Select User and Computer
&AHUWWIUUS Logon \!EA" Computers Select a uger [or uzer group) and computer [or computer group) pair.
Uszers Computers
QAII Users !EAII Computers

[ Do not inherit permissions

Filter Uzers

(®) Show groups o
Cancel | | Help | e

() Show users only

() Show all

Filter Computers
(®) Shaw groups only
O Shaw computers only

() Show all

| I |

Cancel | |

Help

4. Repeat step 3 to add each group.

5. When all groups are added, select one group at a time in the top half of
the Security Settings for System Policies dialog box.
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Table 23 - Group Security Levels

6. In the lower half of the dialog box, do one of the following actions:

e Click the ‘Allow’ or ‘Deny’ box for a bold-faced category to select

all boxes.

e Click ‘+ in front of a bold-faced category to display a list of
subcategories. Click each ‘Allow or ‘Deny’ box.

Security Settings for System Policies

Pemissions | Effective Permissions

Wigw permizsions by (®) User ) Action

L

€5 SYSTEM\PLANTPAX ADMINISTRA™ @ All Computers
€5 SYSTEM\PLANTPAX ENGINEERING @ All Computers
€5 SYSTEM\PLANTPAX MAINTENANC @8 All Computers
€5 SYSTEM\PLANTPAX MAINTENANC @8 All Computers
@ SYSTEM\PLANTPAX MANAGER gEAn Computers

Add Bemove
Permissions for S7STEMYPLANTPAX ADMINISTRATOR f L k
| Allow Deny 3
i Al Actions O
B Common O
Configure Security O E
Create Children O
Delete O
Execute O
List Children O
Baad v} [ o
———
[ Do not inherit permissions
| QK | | Cancel | | Help

If Deny is selected, a warning message appears.

7. Click “Yes’ to verify a permission that is being denied, if applicable.
8. Click OK when finished.

Table 23 is an example of security permissions per group classification.

System Policies Operator Operator Maintenance Maintenance Manger Engineer Administrator
Supervisor Supervisor
Configure Security Deny Deny Deny Deny Allow Allow

Create Children

Delete

Execute

List Children

Read

Write
See Appendix A for how to access an attachment that has suggested security
permissions on a Microsoft Excel spreadsheet. The tabs include permissions for
System Policies, Product Policies, Computer and Groups, Network and
Devices, Users and Groups and Connections.

198 Rockwell Automation Publication PROCES-UMO001B-EN-P - August 2018



Configure FactoryTalk Security ~ Chapter 6

T This section describes how to define users and groups with controller securit
erine actory d roduct group y
Policies in FactoryTalk software. Complete these steps.

1. On the network directory, click System>Policies>Product

Use an Engineering Workstation Policies>RSLogix 5000°>Feature Security.

with these procedures.
You also can configure feature security by clicking System>Policies,

D ! right-click Product Policies and choose Feature Security.
2. On the Policy Settings tabs, click Controller Secure.
EWS

4 FactoryTalk Administration Console = [T
File View Tools Window Help
&
Explorer .
=144 Network (PASSO1) W Feature Security Properties -
—|:| System
[ Action Groups By Setfngs
=[] Policies

—[:I Product Policies Bl Category
+1[1 FactoryTalk Gateway Project: New Corfigure Security

Print: Modify Options Corfigure Security |

R v Secuy
: o Toolbar: Configure Corfigure Security
(3 Studio 5000 Architect Flrmware.. Update. Corfigure Security
\Workstation: Modify Options Corfigure Security

(L RSLogix Architect
|21 Batch

=20 RSLogix 5

¢ m [ ControlFlash

3. Click Browse (...).
4. Click Add, select a PlantPAx group, and then click OK.

Configure Securable Action -

Policy Setting

Secure an unsecured controller

The following users or groups have access to this feature:

Users Computers Allow  Deny ~
!ﬁPIantPAx Admin !EAII Computers O
€5 SYSTEM\PLANTPAX ADN BB All Computers o
€5 SYSTEM\PLANTPAX ENG BB All Computers o |=
€5 SYSTEM\PLANTPAX MAI BB All Computers O
€51 SYSTEM\PLANTPAX MAIN B All Computers O
€5 SYSTEM\PLANTPAX MAN B All Computers O
€7 SYSTEMAPI ANTPAY OPF BB All Crmr ters mn__ ™ hd
Add... | | Femove
| ak. | | Cancel | | Help

5. Repeat step 4 to add all desired groups.
6. Click the ‘Allow’ or ‘Deny’ box.
7. Click OK.

Rockwell Automation Publication PROCES-UMO001B-EN-P - August 2018 199



Chapter6  Configure FactoryTalk Security

Create Permission Sets

=145 Network (PASSDT)
% FTViewDemo
B InstantFizz
=00 System
Action Groups

(0 Computers and Groups
@5 Metworks and Devices
[Z3 Users and Groups

(] Connections

Permission sets are an option to identify a set of actions that are allowed or
denied for one or more user groups or computer groups in a FactoryTalk
network directory. The permissions are used with the controller security
settings, and the same permissions can be used with multiple controllers.

When a user opens a project that has been secured with a permission set,
the Logix Designer application verifies that the ID of the FactoryTalk
Directory matches the ID stored in the project. Guest Users also can be
assigned permissions.

For more information, see the FactoryTalk Security System Configuration

Guide, publication FTSEC-QS001.
Complete these steps.

1. On the FactoryTalk Administration Console, right-click Permission Sets
and choose New Permission Set.

Hame; I FlantPA=Controllers

Description:

Permission Sets Ok II Cancel || Help

2. Type a name for the permission set and click OK.
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3. In the left column under Permission Sets, right-click the permission set

File View Tools Window Help

‘w3 |E

=145 Network (PASSDT)
gﬁ FTViewDemo
B InstantFizz

=00 System

Action Groups

Policies

Computers and Groups
=z MNetworks and Devices
Users and Groups
Connections
Permission Sets

name and choose Security.

Delete

Duplicate...

Security...

P

MNUM

The Security Settings for PlantPAx Controllers appears.

Pemissions | Effective Permizsions

‘Wiew permissions by: ®) User ) Action

Users Computers
€7 Administrators
€7 All Users
&Anonymms Logon

‘N Computers
FM Computers
’.N] Computers

Permizzions for Administrators from All Computers.

7

Action

All Actions
Common
RSLogix5
RSLogix500
RSLogix5000
SequenceManager

HEHEHEHBA

[] D st it permissions

4. Set the allowable actions by clicking the respective Allow
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Notes:
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Chapter 7

Configure the Controller

This chapter describes how to enable system communication and security
enhancements for PlantPAx” system controllers. We assume that you have a
basic understanding of the operation of Rockwell Automation® controllers. We
do recommend that you review the sizing guidelines in the PlantPAx
Distributed Control System Selection Guide, publication PROCES-SGO001,
to use the controller that fits your system requirements

To help mitigate the risk of data intrusion, controllers have enhanced
protection with the Studio 5000 Logix Designer” application. The layer of
device protection is independent of FactoryTalk® software security.

The security enhancements include the following (with the last three being
independent of FactoryTalk):

e Security Server Validation—To access a secured controller or project
file, the application verifies via the FactoryTalk Directory that you are
authorized for such use.

¢ Restricted Communication—ControlLogix" controllers accept
communication only through selected slots.

¢ Restricted External Data Access—External Access and Constant tag
attributes control access to tags and safeguard against changes to
their values.

e Source Protection—A source key can be applied to routines and
Add-On Instructions to guard against code from being edited inside the
Logix Designer environment.

Consideration Before starting this chapter, prioritize your system security level to match the

authorized users in FactoryTalk Security.
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Figure 12 shows the topics that are described in this section. Click or see the
page number for quick access to a section.

Figure 12 - Controller Security Workflow

( Start )

r
Use Architect for Controller Initiation

See page 205

r
Change Controller Properties

See page 207

h A
Configure Network Adapters

See page 210

F
Synchronize the Project

See page 212

Y
Configure RSLinx® Classic Software

See page 213

r
Download the Controller

See page 216
r - « (reate a Controller Logical Name
Enable Controller Security « Configure Authority Identifier
« Configure Communication Restrictions
See page 217 - (Configure Data Restrictions
- (onfigure Code Restrictions
h A

See Chapter 8 Configure Time Synchronization
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Use Architect for Controller The Studio 5000 Architect™ application provides a controller with pre-defined
Initiation functionality that is based on the selected system template. Once you select a
template and create a project, you must configure RSLinx software to
communicate the software data to the controller.
Use an Engineering Workstation
with these procedures, There are three templates available depending on the size and scope of
your project:

e Distributed Architecture— Multiple Process Servers: Contains two
PASS servers; multiple Operator Workstations (OWSs), and an
Ews Engineering Workstation (EWS).

e Distributed Architecture — Single Process Server: Contains one
PASS server; multiple Operator Workstations (OWSs), and an
Engineering Workstation (EWS).

e Process Skid with Logix Batch Sequence Manager: Skid-based
equipment that includes three CompactLogix™ controllers and one
PanelView™ terminal to be integrated into overall system.

Complete these steps to select a template.

1. Click the Programs ﬂ symbol and choose Rockwell Software®>
Studio 5000°".

The Studio 5000 Common Launcher appears.

Rockwell Software’

Studio 5000

Existing Project ~

From Import Sample Project

; = From Sample Project FErom Upload
Recent Projects
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The New Project dialog box appears.
I3} New Project [ > |

Project Types

,?iu Architect

Distributed Architecture - Multiple Process Servers

E] FactoryTalk View

j Logix

Distributed Architecture - Single Process Server

Process Skid with Logix Batch Sequence Manager

Narne: IPEantPAx I

I:ocation;|C:'\Users\Adminish’ator.SYSTEM\Documents\Stu|V|| Browse... |

2. Under Project Types, click to select Architect and then click the
second template (Distributed Architect - Single Process Server) for
this example.

TIP  The Common Launcher dialog box is used for all products in Studio
5000 environments. The product types that appear in the left pane
depend on the products that are installed for your workstation.

3. Type a program name and click Finish.

The Architect canvas can take a couple minutes to open. The canvas
appears with a layout of the architecture and a pre-defined controller

for the selected template.

& Studio 5000 Architect - PlantPAx
ELE EDT WIEW SYNC LBRARY MANAGEMENT T0DOLS WWDOW MELP

D E X AaXD-C_k A/ OO E | CorrailicCanle -[E QB . KE R
F— ] Toobox -0 x
- PlaniPix iz
Projects [ ot Coeo |
B Laxcor Compuiens
B Laxco Distrbuted /0 Moduies
B Laxcos v [
B Laxcos G
1’ rioos PIa"tPAX Dvstributed Archifecture - Smgle Frocess Server A E.“k:“'e“ ::‘::::w"n
B Plapsa Distrbutet Conrol System oty wiomation Tl Cybct S
4 Devices s ik Vislzation
£ Process Area o # Lirznes
Legs: Balch Sequence Marager b4 001} (7|

Process Lbrwy frd 0-01) (Read Only)

LONEDE Loucns

B FactoryTak Linw, PASS0N
& Bherbiet Bhemet
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For a detailed description of the Architect application, see the
PlantPAx Distributed Control System Application User Manual,

publication PROCES-UMO003.

Change Controller Properties This section shows how to use the Studio 5000 Logix Designer application

Use an Engineering Workstation
with these procedures.

EWS

inside the Architect project to modify a controller. Changes include how to
select another controller type, assign a name, and to enable redundancy, if
applicable. Complete the following steps.

1. In the top, left pane of the Architect project, right-click a controller
(LGXCO01 in our example) and choose Open Project in Designer.

A Studio 5000 Architect - PlantPAx
FILE EDIT WVIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW HELP
Haim X aX2-C-. k A/ OO [ i ControlNet Cable ~|

Project Bxplorer ~ B X} Process Area” _

4 PlantPAx
4 Projects
- B Lexco
B Loxco | Open Project in Designer u
, rowse lags...
LGXC03 rseal
B Loxco4 Update Project Changes...
- B Lexcos Update Changes from Online Controller... DAX
§2 PlantPax Commit Project Changes... System
4 Devices
B Process Properties...

Wait a short time while the Logix Designer application opens.

@ Logix Designer - LGXCOT [1756-L73 31.1]
% FILE EDIT VIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW HELP

AN * |l v % 5 Tk b B

I RUN — :

= oK I Path: AB_ETHIP-11172. 18, 1.100\Backplane\0* % = B

I Energy Storage 1.8
I myo Offfine Ng. Fgrgs | Np.Edits i | Redundancy i

Controller Organizer Go Online

Upload...

ontroller LGXCO1 Download

<7 Controller Tags
Controller Fault Handler

Program Mode

Run Mode

Power-Up Handler
4 Tasks

4 @Task_A_Evas

b L Task_A_MainProgram
V] @Task_B_‘IDOms

P4 Task_B_MainProgram
4 @Task_C_ZSfDms

P L Task_C_MainProgram
V] @Task_D_SfDDms

P4 Task_D_MainProgram

st Mode

Clear Faults

Go To Faults

Controller Properties

2. Right-click the controller icon f and choose Controller Properties.
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The Controller Properties dialog box appears.

Redundancy I MNonvolatile Memory I Capacity I Security I Alarm Log |
MajorFauks |  MinorFauks |  Date/Tme | Advanced |  SFC Bxecution

Rockwell Automation/Allen-Bradley
1756-L73 ControlLogix® 5570 Cortroller

31.001

[Laxcot

Template Application with only task layout pre-installed

|1756:A4  4-Slot ControlLogx Chassis

You can modify the controller name in the Name field. The template
default is LGXCOT.

If you change the name to a specific area, for example ‘Boiler, that is the
controller name after the application is synchronized.

3. To select another controller type, click Change Controller.

Changing the controller type will change, delete, and/or invalidate the
controller properties and other project data that is not valid for the new
controller type.

From
Type: 1756-L73 ControlLogix® 5570 Controller

Wersion: ST

To

Type:

4. Click the pull-down menu, select another controller from the list, and

click OK.
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5. Ifyou are using a redundant controller, click the Redundancy tab.

o Controller Properties - LGXCO1 -

General i Minor Faults I Date/Time I Advanced I SFC Execution |
Project Redundancy I Monvolatile Memory I Capacity I Security I Alam Log |

Advanced..
Redundancy Status
Partner Status Partner Minor Faults
M 3 Powerup ) Watchdog
i 10 ) Energy Storage
) Key Switch Mismatch 2 Program
[ ok ][ Canced || opl Help

6. Check the Redundancy Enabled box (only if you are configuring this
controller for redundancy) and click OK.

7. Click the Save icon M at the top of the Logix Designer window.
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COnfigure Network Adapters A local communication adapter added to a Logix controller provides for

communicate with PASS servers and workstations at the Supervisory level.

Complete these steps.
Use an Engineering Workstation

with these procedures.
P 1. Open a Logix Designer project.

2. In the Controller Organizer, right-click the controller backplane and
D choose New Module.
EWS

Controller Organizer v B X

al o=

4 Controller LGXCO1
4 Tasks
4 Motion Groups
4 Assets

¥ Logical Model
Pl 1/ Configuration

4 1756 Back _ e

[t [0] 179 A New Module...
Import Module...

Discover Modules...

&1 Paste Ctri=V
Properties Alt+Enter
Print k.

The Select Module Type dialog box appears.

Select Module Type

Catalog | Module Discovery | Favorites

|£m‘e.-' Search Text for Modue Type... | Clear Filters Hide Filters 2

[=] Module Type Category Fitters |~ Module Type Vendor Fitters ~
[ Analog i— Advanced Micro Controls Inc. {AMCI) IE
Communication I Hardy Process Solutions ||
[ Controller Hiprom Technologies
[] Digial > Molex Incorporated =
o il limn Dloseal o L1 i Ll

<| mn > <| mn || >

¥ (Catalog Mumber Description Vendar Category ~

1756-DNB 1756 DeviceNet Scanner Rockwell Autom...  Communication =
J I3 [ f il o T it

1756-EN2T

1756 10,100 M ... Communication

B o 10/ TUU B 7 aricat
1756-ENZTR 1756 10/100 Mbps Ethemet Bridge, 2-Port, Twisted-P...  Rockwell Autom... Communication

I756-EN2TSC 1756 10,100 Mbps Ethemet Bridae, Twisted-Pair Medi..  Rockwell Autom...  Communication |~
<| n | >
30 of 158 Module Types Found
["] Close on Create Close Help

3. Select a communication adapter for your application (Ethernet module
in our example) and click Create.
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The New Module dialog box appears.

(& New Module -
General® | Connection | RSNetWonx | Module Info | Intemet Protocal | Port Configuration | Time Sync |
Type: 1756-EN2T 1756 10/100 Mbps Ethemet Bridge, Twisted-Pair Media -
Vendor: Roclkwell Automation/Allen-Bradley
Parent: \ il I Ethemet Address I
Name: § LexcotEND1A | O Pivate Network: ~ 192.168.1.
Description: (®) |P Address: | 172 .18 . 1 . 100
e O Host Name:
Module Definition
Module Definition* x|
Revision: 10.001
Blectronic Keying: Compatible Module
Rack Connection: None =
Bevision: 10 W 001
Time Sync Connection: None I:
Electronic Keying: |C0mpaﬁble Module W |
Rack Connection: . -
Time Sync and Motion

Status: Creating

[ Canced | [ Heb

4. 'Type an adapter name and IP address.
See Table 24 for details.
5. Click Change.

6. On the Module Definition dialog box, select Time Sync and Motion
from the Time Sync Connection pull-down.

7. Click OK.

8. Repeat step 2 through step 7 for each slot in the local chassis of the

target controller.

IMPORTANT  You must synchronize your project to update the changes with the existing
controller information. This option sends the modified project from Logix
Designer back to the Architect application. See page 212.

Table 24 - Network Adapter Information

Name IP Address Architecture (at. No.
LGXCO1ENO1A 172.18.1.100 Star 1756-EN2T
LGXCOTENO1B 172.18.1.101 Star 1756-EN2T
LGXCO1ENO2 172.18.2.10 Device Level Ring/Star 1756-EN2TR
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Synch ronize the Project Complete these steps to update controller information in the
Architect application.
Use an Engineering Workstation 1. In the Architect application, right-click the controller and choose
with these procedures. Updatc Projcct Changes.

A Studio 5000 Architect - PlantPAx

FILE EDIT WIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW  HELP

PN W X aX92-C-. x A/ OO f o ControlNetCable -

Project Bxplorer ~ B X | Process Area‘—
EWS

A PlantPAx
4 Projects
8 il LGxcot
B Lexcoz Open Project in Designer ‘
-~ B Lexcoz Browse Tags...

E I—GXCDI| Update Project Changes... %
LGXCO% pdate Changes from Unline Controller... AX

B8 PlantPax !
" Commit Project Changes... | System

4 Devices

2 Process | Properties...

| |
The Update Summary dialog box appears.

A Studio 5000 Architect Update Summary -
The following changes will be updated to the associated projectis); any projects containing emors will be skipped.

4 f 1756173 LGXCO
@ Cortroller LGXCO1" will be changed from “1756-L73 to "1756-L75".
o Controller ‘LGXC01" firmware revision will be changed from 24"to 31"
o Chassis LGXC01R00 size will be resized to 7 positions
@ Module LGXCOTENDTE" will be added to "LGXCOTRO0, slot 2.
© Module LGXCOTENDZ wil be added to 'LGXCO1ROD, slot 4.
) Module LGXCOTENDTA will be added to "LGXCOTRO0, slot 1.

[ Always show this dialog Help

2. To see a preview of the synchronized changes, click P to expand
the project.

The changes appear in the Message box.
3. Click Update.
The Ethernet Configuration dialog box appears.
4. Leave the devices and their port configuration as is, and click OK.

A wait message appears while the project is being synchronized.
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Configure RSLinx Classic
Software

Use an Engineering Workstation
with these procedures.

EWS

Complete these steps to configure RSLinx Classic software, which is a
communication interface between the controller and FactoryTalk View
software products. Examples show how to configure two drivers: EtherNet/IP
and Ethernet.

1. Click the Programs I symbol and choose Rockwell
Software>RSLinx>RSLinx Classic.

| BOOTP-DHCP Server 2
| FactoryTalk Activation >
. FactoryTalk Alarms and Events 4
| FactoryTalk AssetCentre Agent 3
. FactoryTalk AssetCentre Client 4
| FactoryTalk Historian SE ¥ | | Accessibility
. FactoryTalk Tools v | | Administrative Tools
| FactoryTalk View » | CGCM
J..‘ .. Logix Designer Tools v | |, Embedded Lockdown Manager
t i Tools v |} RSLinx . Hiprom Software
% RSLinx Classic Backup Restore Utility |, RSLogix 5000 Enterprise Series v | | Maintenance
% RSLinx Classic Launch Control Panel | RSLogix 5000 Tools ¥ | | Microsoft Office
RSLinx Classic Online Reference I .. RSMetWon ¥ | |0 Microsoft SQL Server 2008
RSLinx Classic | Utilities v | . Microsoft SQL Server 2008 R2
[} FactoryTalk Administration Console . Rockwell Automation
& Studio 5000 | Rockwell Software
. SharePoint
L. Startup
L VMware
. Windows Accessories
. Windows System

8 Adobe Reader XI
2l FactoryTalk View Studio

oo

The RSLinx Classic dialog box appears.

2. Click the Communications tab and choose Configure Drivers.

ations

Station DDE/OPC Security W

| RSWho

Configure Drivers...

Configure Shortcuts...
Configure Client Applications...
| Configure CIP Options...
| Configure Gateway...

The Configure Drivers dialog box appears.

3. From the Available Driver Types pull-down menu, select the EtherNet/
IP Driver and click Add New.

Add New...

" Available Driver Types:
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4. To complete the driver selection, click OK and then Close on the
following dialog boxes.

Choose a name for the new driver.
[15 characters maximum

— Awailable Driver Types:

Cloze
EthertetdIP Criver LI Add New... | u

Help

— Configured Drivers:

Windows Default

Mame and Description | Status |
Intel{R) PRO/1000 MT Network Connection

AB_ETHIP-1 A Ethemet RUNNING Funning Configure. .. I
Startup... |
Start |
Stop |
Delete |

The EtherNet/IP devices in the network appear under the
network communication driver.

- File Edit View Communications 5tation DDE/OPC  Security Window Help

FPEECTER
v Autobrowse Refresh | ml..l Browsing - node 172.18.1.102 found
- Workstation, EWS01 ! ! !
== Linxk Gateways, Ethernet
=5 AB_ETHIP-1, Ethernet 172,18.1.100 172.18.1.101  172.18.1.106
172.18.1.100, 1736-EN2T, 1756-EN2T/D 1736-EM2T/D 1756-EM2T/D 1756-EM2T...

172.18.1.101, 1756-EM2T, 1756-EN2T/D
172.18.1.102, 1756HP-Time PTP Master, 1756HP-TIME/B ! ! !

172.18.1.105, 1756-EN2TR, 1756-EN2TR/C 172.18.1.105 172.18.1.108 172.18.1.107
172.18.1.106, 1756-EN2TR, 1756-EN2TR/C 1756-EN2T... 1756-EN2T... 1756-EN2T..

172.18.1.107, 1756-EM2TP, 1756-EN2TP/A
172.18.1.108, 1756-EM2TP, 1756-EM2TP/A g

172.18.1.102
1756HP-TI...

For Help, press F1
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5. To add an Ethernet driver for routing in another network, repeat step 1
and step 2.
6. Select Ethernet devices and click Add New.

—Awvailable Driver Types:
Cloze Station Mapping |

Help
Station Host Name

17218.2.10

r— Configured Drivers:

. — | T 17218310
ame and Description atuz 17212311

AB_ETHIP-1 A-E Ethemet RUNMING Running Configure.

172.18.5.10

Shartup.. | 172.18.5.11|
Driver

Choase a name far the new driver.

[15 characters maximum]

|aB_ETH-1 —lcanCEI

7. Click OK and type IP addresses.
. Click OK.

[e°]

The Ethernet devices in the network appear under the
network communication driver.

=5 File Edit View Communications Station DDE/OPC  Security Window Help

=] &| 518 Bliz| ¥

W Autobrowse Refresh | EA Browsing - node 172.18.5.11 found

- Workstation, EWS01 g g g
== Linx Gateways, Ethernet

24 AB_ETH-1, Ethernet 17218510 17218310 17218301
f] 172.18.2.10, 1736-EN2TR, 1736-EN2TR/C 1756-EN2T... 1756-ENZT... 1756-EN2T...
172.18.3.10, 1756-EN2TR, 1756-EN2TR/C
172.18.3.11, 1756-EN2TR, 1756-EN2TR/C é é
17218510, 1756-EN2TP, 1756-EN2TP/A 172185101 17218210
17218511, 1756-EN2TP, 1756-EN2TP/A 1756-EN2T... 1756-EN2T...

172.18.1.100, 1756-EM2T, 1756-EN2T/D

172.18.1.101, 1756-EM2T, 1756-EN2T/D

172.18.1.102, 1756HP-Time PTP Master, 1756HP-TIME/B
172.18.1.105, 1756-EM2TR, 1756-EM2TR/C

172.18.1.106, 1756-EM2TR, 1756-EM2TR/C

172.18.1.107, 1756-EM2TP, 1756-EN2TP/A

172.18.1.108, 1756-EM2TP, 1756-EM2TP/A

For Help, press F1 NUM 11/3017 [ 10:41 AM 2
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Download the Controller

1.

Complete these steps to download the controller.

In the Architect project, right-click a controller (LGXCO1 in our
example) and choose Open Project in Designer.
A Studio 5000 Architect - PlantPAx

FILE EDIT WVIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW HELP
e X g X92-C-_ x A, OO f = ControlNetCable ~

process e |

Project Explorer - 1 x
A PlantPAx
C Projects
B Lexco
B Lexco: | Open Project in Designer u
B Laxcos Browse 1ags...
B Loxcos Update Project Changes...
B Lexcos Update Changes from Online Controller... DAX
§8 PlantPix Commit Project Changes... System
4 Devices
B Process Properties...

2. Click the Who Active button.

EDIT VIEW
=

SEARCH

LOGIC COMMUNICATIONS TOOLS WINDOW  HELP

= T

V|"p % g

Path: AB_ETHIP-11172.18. 1, 100\Backplane\0*

f. Mo Forces

B Redundancy

b No Edits

4.

Browse the controller through the communication path (this action

o Who Active (RSLinx Classic)
) Autobrowsze

Refresh

== Workstation, EWS01

g - Linx Gateways, Ethernet

a5 AB_ETH-1, Ethernet

&5 AB_ETHIP-1, Ethernet

ﬂ 172.18.1.100, 1756-EN2T, 1756-EN2T/D

301 | |00, 1756-L75 LOGIX5575, 1756-L75/8 LOGIX5575)

¥ T, C-EMNZT, T4 i

w0 f] 02, 1756-EN2T, 1756-EN2T/D

-8 03, 1756HP-Time PTP Master, 1756HP-TIME/B
-] 04, 1756-EN2TR, 1756-EN2TR/C

f 172.18.1.101, 1756-EN2T, 1756-EN2T/D

8 177101105 1756 CMITD 175& CAITD O

Path: AB_ETHIP-11172. 18. 1. 100\Backplane\0
Path in Project: <none=

g 172.18.1.102, 1756HP-Time PTP Master, 1756HP-TIME/B
b

updates the path).
Click the controller path, Download, and then Set Project Path.
- | O -
~ Go Online
Download
-
Download offine project LGXCO1' to the controller,
i
- Connected Controller:
MName: <no name >
1 Type: 1756-.75/B ControlLogix® 5570 Controller
Path: AB_ETHIP-11172. 18. 1. 100\Backplane\0
Serial Number:  DO0BE442F
Security: Mo Protection
- 1 DANGER: Unexpected hazardous motion of machinery may occur.
Some devices maintain independent configuration settings that are
not loaded to the device during the download of the controller.
Verify these devices (drives, network devices, 3rd party products)

have been properly loaded before placing the controller into run
mode.

Failure to load proper configuration could result in misaligned data
and unexpected equipment operation.

Cancel Help

5. Click Download again.
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The Download Project Documentation and Extended Properties box
enables multiple parties to share information.

6. Click the controller [ symbol and select Run mode.

7. Click Yes.

@ Logix Designer - LGXCO1 [1756-L75 31.1]*
% FILE EDIT VIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW HELP

i AN T = e SN | v] % 5 Dk

I Program Mode \F

Path: AB_ETHIP-11172.18. 1, 100\Backplane'\0 | ik

I Energy Storage OK
I I/0 OK

'Favorites  Add-On

Rem Prog o Forces F_ No Edits 2 | Redundancy

Controller Organizer Go Offline Logix ign,e'r =
Upload... e
b 1 Controller LGXCO1 | Download
b Tasks Program Mode I\ Change controller mode to Remote Run?
4 Motion Groups = = r—
4 Assets g I Ein Mudr I
T Logical Model Test Mode
4 1/0 Configuration e
4 B9 1756 Backplane, 1736-A7 S
Go To Faults

[fo [0] 1756-L75 LGXCO1
b § [111756-EN2T LGXCOTENDT  Contraller Properties
b § [21 1756-EN2T LGXCOTENOTE
b 8 [4] 1756-EN2TR LGXCO1END2

Enable Controller Secu "ty You must be an authorized user to administer controller security.

Use an Engineering Workstation
with these procedures.

EWS

IMPORTANT  This procedure requires that you have defined FactoryTalk product policies.
See page 199.

Complete these steps.

1. In the Controller Organizer of the Logix Designer application,
double-click the controller icon to open the properties.

18.1.100\Backplane 0 & i e s s
b_ | No Edits 2 | Redundancy A “Favorites  Add-On  Safety Alarms Bt TimeriC
a Controller Properties - LGXCO1 =
| General I Major Faults I Minor Faults I Date/Time I Sedumngssd s FC Execittion |
| Project | Redundancy I Monvolatile Memory | Capacity I Security I Alarm Log |
Security Authority: | No Protection b |

sz only the selected Security Authority for Authentication and Authorization
Secure With: Logical Name

Pemission Set

[ Restrict Communications Except Through Selected Slots

Select Slots: m[1]2[3]4]5]6|

2. Click the Security tab.
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3. From the Tools menu, right-click Security and choose Log On.

& Logix Designer - LGXCO1 [1756-L75 31,1] = B
© FILE EDIT VIEW SEARCH LOGIC COMMUNICATIONS | TOOLS | WINDOW HELP

iy | D e ] ) (s Options... | e

B Run Security Log On...
bl .
m Controller OK E | Path: AB_ETHIP-11172.13.1.10 @3 Documentation Languages... Log Off SYSTEM\ADMINISIRATOR

R AU L

4. 'Type an authorized user name and password and click OK.

Log On to FactoryTalk - Network -

User name: | SYSTEM\Administrator |

Pazsword: | sseseneee |

| LChange Password... |

| ()3 | | Cancel |

See page 217 to configure users with controller security.
5. Click Yes on successive dialog boxes to confirm the project.

6. In the Controller Organizer, double-click the controller to open the
properties dialog box; click the Security tab.

| @ Logix Designer - LGXCO1 [1756-L75 31.1]"

FILE EDIT WIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW  HELP

i AN T = e SN | vi% % 5 i O E AL

I Run Mode 7 .

B Controller OK q Path: AB_ETHIP-1\172.18. 1. 100\Backplane 0 | = AL IRV

I Energy Storage OK 9 e A = =

= 1/0 0K Rem Run H! Mo Forces }' Mo Edits ﬂv Redundancy LI | . Favorites Add-On Safety Alarms Bit Timer/Ct
3 Controle Properties - LGXCO =]

b Controller LGXCDT | General I Major Faults I Minor Fautts I Date/ Time I Advanced : 'l SFC Execution

b Tasks | Project I Redundancy I Nonvolatile Memary I Capacity | Security’ AMam Log

4 Motion Groups

Ungrouped Axes Security Authorty: | FactoryTalk Securty fpass01) v|
4 Ass#s Use only the selected Security Authority for Authentication and Authorization
¥ Logical Model
4 1/0 Configuration Secure With: ® Logical Name <Controller Name>

4 B9 1756 Backplane, 1736-A7
[E3 [0] 1756-L75 LGXCO1
4 fJ [1]11756-EN2T LGXCOTENO1A

(Z) Permission Set

25 Ethemet [ Restrict Communications Except Through Selected Slots
4 ﬂ [2] 1756-EMN2T LGXCO1ENO1E
=5 Ethernet Select Slots: E1||‘||2|3|4|5|5|

fl [311756HP-TIME/B LGXCOTENDTT
4 [ [4]1756-EN2TR LGXCOTEND2

&= Ethernet
Change Detection
Changes To Detect: | 164FFFF_FFFF_FFFF_FFFF| [ Configure.. |
Audit Value: | 1mcaFﬂ_3553_3ﬂAﬂ_5(:93|
| Tracked State Value: 1640000_0000_0000_0000_0000_0000_000D_0000_0000| | View Componerts...
|| Description Template Application with only task ~

_000D_0000_0000_0000_0000_0000_0000

w

b

oK | [ Cancdl |

Ready Communication Software: RSLinx Classic

7. Select FactoryTalk Security Directory from the Security Authority
pull-down menu.

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018



Configure the Controller ~ Chapter 7

8. Click Use only the selected Security Authority for Authentication and
Authorization and click Apply.
A Warning message appcars.
Logix Designer |_|x
Enabling security for the controller might result in a loss of some
I L security privileges,
Do you wish to apply the controller security enabling change?
No | | Help
9. Click Yes.

Create a Controller Logical Name

Complete these steps to create a name for the controller in the
FactoryTalk Directory.

1. Click the Programs | | symbol and choose Rockwell
Software>FactoryTalk Administration Console.

Browse to the controller and then browse to the communication driver.

3. Right-click the communication driver and choose Properties.

¥ FactoryTalk Administration Console [- o

File View Tools Window Help
&
Explorer [=]
=125 Network (PASSD1) [~
+E§ FTViewDemo
+E§ InstantFizz
=@ Systemn
.[1] Action Groups
12 Policies
(] Computers and Groups
—-,5'2,5 Metworks and Devices
= 3 Workstation,EWSD1
= Linx Gateways,Fthernet
-,55'3 AB_ETH-1,Ethernet
= -,55'3 AB_ETHIP-1,Ethernet
: ¥ 172.18.1.100,1756-EN2T, 1756-EN2T/D
5 Backplane, 1756-A7/A or B

¥ 217s6-en Refresh

¥ 3.1756HP :

% Security...
.4 41756-Ey

¥ 17218.1.101,17 Properties...

¥ 172.12.1.102,1756HP-Time PTP Master, 17
4 172.12.1.105 1756-EN2TR 1756-EN2TR/C | ¥
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4. On the Device Properties dialog box, click the pull-down and select the
controller name.

TIP  Ifthe name does not appear in the Networks and Devices tree, open
RSLinx Classic and go to the controller resource with RSWho. When
you navigate to the resource in RSLinx Classic the controller path
information updates in RSLinx Classic.

Device Properties -

Device path:
|AB_ETHIP-1 4172.18.1.1008B ackplaneh0 |

Logical name:

§ Laxcon |

Area associated with 'LGXCO1"

Fiemove

o [ o | [ ]

5. Click OK.

Configure Authority Identifier

This optional procedure is necessary only if you want to access a controller
project from outside the system and still use FactoryTalk security. Projects that
are secured to a specific Security Authority cannot be recovered if the identifier
of the FTD that is used to secure the project no longer exists.

IMPORTANT  We recommend that you back up the FTD and save unsecured versions of the
project file to a secure location.

Complete these steps.

b
1. Click the Programs H symbol and choose Rockwell

Software>FactoryTalk Administration Console.

2. Click the Tools menu and choose FactoryTalk Security
Authority Identifier.

¥ FactoryTalk Administration Console [= o [

File View [ Tools | Window Help

3 [' 2 FactoryTalk Directon Option

g =114 ELYE
FactoryTalk Security Authority Identifier...

Emporary Password

FactoryTalk Diagnostics k
Export Policies...

Cl Action Groups

+C| Policies

+D Computers and Groups
S 2 Matwnarke and Nevicee
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3. Click Backup on the message window.

Modify Security Authority Identifier

Current Identifier:  6CCD1D48-3FF6-4944-BEF7-36A8F 22F 30BF

-| Generate ID | [ cancel | Help |

We recommend that you encrypt the file and enter a passphrase that you
use during the restore process.

4. On the Backup dialog box, click “Encrypt file contents’ and type a
passphrase; click OK.

Backup -

Specify archive name:

| Metwork - 6CCD 1D48-3FF6-4944-BEF 7-36A8F 22F 30BF |

Specify archive location:

| C:\Wsers\Public\Documents | EI

File Encryption

‘fou have the option to now protect your backup files with a passphrase. You will be required
to enter the passphrase when you restore any backup file that is passphrase protected.

MOTE: Backup files may be restored on any computer,

Encrypt file contents  (Clear the check box to create a plain text backup file)

Passphrase

Passphrase: ’.........—‘

SRR RERN |
e R

Complete these steps to restore a project on another computer.

Confirm passphrase:

1. Repeat step 1 and step 2 on page 220.

2. Click Restore on the message window.

3. Select a file and click Next.

4. Type the Restore passphrase and click OK.

5. Select ‘Restore Security Authority in Identifier Only’.
6. Click Finish.
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The Logix Designer application can be opened now in another system
directory. Observe the check in the box for “‘Use only the selected
Security Authority for Authentication and Authorization.

FILE EDIT WIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW  HELP

) & vl % 5 B s[5 F

b L A

‘Favorites Add-On Safety Alarms B  Timer/Ct

q' Path: AB_ETHIP-11172. 18, 1, 100\Backplane |0 % Z= 0

Rem Run H_! Mo Forces F_ No Edits i | Redundancy L]

MRS Controller Properties - LGXCO1 ]

b Controller LGXCDT 1 | General I Major Faults I Minor Faults I Date/Time I Advanced SFC Bxecution
b Tasks | Project I Redundancy I MNonvolatile Memory I Capacity | Security Alam Log

4 Motion Groups

Ungrouped Axes Security Authority: | FactoryTalk Security (pass01) Y] |
4 Assets
T, Logical Model I Use only the selected Security Authority for Authentication and Authorization I
4 1/0 Configuration Secure With: ® Logical Name <Controller Name:

4 B9 1756 Backplane, 1736-A7
[E3 [0] 1756-L75 LGXCO1
4 fJ [1]11756-EN2T LGXCOTENO1A

() Permission Set

&g Ethernet [ Restrict Communications Except Through Selected Slots
4 fJ [2]1756-EN2T LGXCOTEND1E
& Ethemet Select Slots: ml1]2]3]4]5]6]|

fl [311756HP-TIME/B LGXCOTENDTT
4 [ [4]1756-EN2TR LGXCOTEND2

_0000_0000_0000_0000_0000_0000_0000

&= Ethernet
Change Detection
Changes To Detect: | 16HFFFF_FFFF_FFFF_FFFF| [ Configure..
Audit Value: | 1S#CBFD_3553_EEAD_ABM|
| Tracked State Value: 1640000_0000_0000_0000_0000_0000_D000_0000_0000| | View Components...
|| Description Template Application with only task ~

w

m | b

|| Major Fault
(e

| Tz= Controller Organizer &E‘Loglcal Organizer
E‘Search Results Watch

QK || Cancel | Apply Help

Ready Communication Software: RSLinx Classic

The following steps are required if the file is returned and the authority
identifier does not work.

1. Click the Programs LI symbol and choose Rockwell
Software>FactoryTalk Administrative Console.

2. Click the Tools menu and choose FactoryTalk Security
Authority Identifier

Click Generate ID.
4. Click Close.
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Configure Communication Restrictions

This section describes how to restrict non-authorized communication modules

from being added to a ControlLogix backplane.

1. Inan Architect project, right-click a controller and choose Open Project
in Designer.

2. Under the I/O Configuration folder in the Controller Organizer,
double-click the controller.

The Controller Properties dialog box appears.
3. Click the Security tab.

o Controller Properties - LGXCO1 -
General |  MajorFauts | Minor Faults I Date/Time | Advanced | SFC Execution
Project | Redundancy |  Nonvolatie Memary I Capacity Security” I| Alam Log
Securty Authority: | FactoryTalk Security {pass01) v |

Use only the selected Security Authority for Authentication and Authorization
Secure With: (®) Logical Name <Controller Name>

() Permission Set

Restrict Communications Except Through Selected Slots

Select Siots: _ [1[203 456

Y Communication restricted through controller ports

Change Detection

Changes To Detect: | 16HFFFF_FFFF_FFFF_FFFF| [ Configure.. |

Aud Value: | 16HCB Fn_assa_sﬂAﬂ_A&iA|

Tracked State Value: ‘1anmm_nm}u_mm_m}m mm_nmn_mm_mm_mm‘ \iew Componsris...

_0000_0D00_0300_0000_0000_0000_0000

ok | [ G v ]| ]

4. Click the Restrict Communications Except Through Selected Slots box.

5. Select each number that represents an authorized communication
module slot in the controller.

Slot positions appear dimmed when selected.
6. Click Apply.

New data communication modules must have authorized access to be
installed in the selected slots.
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Configure Data Restrictions

This section describes how to program Logix data tags to control external
application access, such as HMI applications. The three external access tags are

the following:
e Read/Write
e Read Only

e None

1. Inan Architect project, right-click a controller and choose Open Project
in Designer.

2. Double-click Controller Tags.
The tags appear in the right pane of the project.

o Logix Designer - LGXCOT [1756-L75 31,1]*

% FILE EDIT VIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW  HELP

L (A RS ) G N v|% % 51 Bl

I Run Mode . )

B Controller OK q Path: AB_ETHIP-11172,18. 1. 100'Backplane\d o= 0

I Energy Storage OK .

= /0 OK Rem Run ¥ No Forces . NoEdits 2 | Redundancy o

Scope: | [BiLGXCO1 v| Shaw | Al Tags v| . 0at

4 Controller LGXCO1 o

S Contiler T Name =5| =« DataType External Access Constant tyle !

Controller Fault Handler DINT Read Cnly ecimal
Power-Up Handler b DataNone DINT None O ecimal

P Ml Tasks b DataReadOnly  DINT Read Only O ecimal

4 Meotion Groups

b Assets b DataReadWrite DINT Read/Write | ecimal

Y. Logical Model b L_CPU_MemUseD... INT[48] Mone | | Decimal
LY (R WA i . S— - oL E—— — =

3. To create a write restriction, click Constant to create a Read Only tag.

A Constant tag cannot have its values changed programmatically.

A Constant tag symbol (= appears in the Value column for the
selected tag

@ Logix Designer - LGXCO1 [1756-L75 31.1]*

. FILE EDIT VIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW HELP

A T | vie s a2 @

B Run Mode

B Controller OK a “ | Path: AB_ETHIP-1\172. 18. 1. 100\Backplane0 * = 0 4+
g msm o Rem Run F® Mo Forces F_ MNo Edits i | Redundancy “Favorites " Add-On

Controle Organizer MIEYY O conroter Tags - Loxcotcontroten < [

224
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= Scope: | [BiLGXCO1 v| show: |8l Tags
4 Controller LGXCO1
<7 Controller Tags Name =5|~ Value + Force Mask « Style
Controller Fault Handler b DataConsﬂ 3 Decimal
Power-Up Handler b DataMone 12 Decimal
P Ml Tacks b DataReadOnly a7 Decimal
3 Motion Groups
b Assets P DataReadWrite 83 Decimal
¥ Logical Model b L CPU_MemUseD... {} {..} Decimal
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The Logix Designer compiler helps prevent write data in the
reserved data.

@ Logix Designer - LGXCO1 [1756-L75 31.1]* - O x
% FILE EDIT VWIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW HELP

; | V|"ﬂ 2 E ] Tr= e

PR a' Path: AB_ETHIP-11172. 18. 1. 100\Backplane'p ® @z B O < ) [T Ao suB HUL |

oK
B /0 OK Rem Run ¥ No Forces . Mo Edits B | Redundancy i

2 4 )-Favori.'les Add-On  Process  Drives  Filter

Controller Organizer

& bar 5 ] [ e
4 & Controller LGXCD1 : : : " =
[E A i3 E i3 i3
<7 Controller Tags = : =) - L= i
Controller Fault Handler ad
Power-Up Handler 12
12 %3 DataCons
iy & DatacConsf
3 Motion Groups
[ Assets
¥, Logical Model
4 1/0 Cenfiguration
"

T3z Contraller Organi..| &E‘Logical Organizer

Errors

Q

fccepting the Pending Edits of o
rror: (Pend), Sheet 1, A1, OREFJ) DataConst: Routines cannot write Constant
omplete — 1 error({s), 0 warning(s)

1 Emors | | ! 0 Wamings | | o 1 Messages

] 1

tags.

E‘Search Results Watch

Ready Communication Software: R5Linx Classic Sheet 1 100% IG-‘I i

Configure Code Restrictions

Source Protection is applied to routines and Add-On Instructions to help
prevent third-party access to components. This section shows how to apply
Source keys, which are user-generated, case-sensitive passwords.

Complete these steps in Offline mode to enable a source key.

1. Inan Architect project, right-click a controller and choose Open Project
in Designer.

2. Click the Tools menu and choose Security>Configure
Source Protection.

@ Logix Designer - LGXCOT [1756-L75 31.1] - 0O x
FILE EDIT WIEW SEARCH LOGIC COMMUNICATIONS .TOOLS WINDOW  HELP
) (S N | Options...
= RUN . § I Security
= 0K I Path: AB_ETHIP-1\172.18.1.10) €% Documentation Languages... Log Off SYSTEM\ADMINISTRATOR. Fi AU
=m0 Offline B. NoForces fmpart bl Refresh Privileges ] Bit  Timer/Coun
Controller Organizer < Controller Tag Export 4 Configure Source Protection _
- 5 Lock All Unlocked Content
Scope: | [HLGx #§ EDS Hardware Installation Tool ° fackes Lemen ¥
Fl Tasks ~ Lock Component i
4 (B Task_A_50ms | Riarmie I Mation 4 Bnelil n
P L Task_A_MainProgram 55' b DataCony Monitor Equipment Phases & “F® V|| Extended Properties.. )
. BT motnni_ = S I 1

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018 225



Chapter7  Configure the Controller

3. Select any desired routine or Add-On Instruction to be protected, and
then click Protect.

Organize by: () Container () Source Protection

Source Protection Container

| Unknown Protection
Add-On Instructions

- o
\— FE MainRoutine Task_B_MainProgram
\— FE MainRoutine Task_C_MainProgram
\— FE MainRoutine Task_D_MainProgram
\— FE MainRoutine Task_E_MainProgram
\— FE MainRoutine Task_F_MainProgram
\— FE MainRoutine Task_G_MainProgram
\— FE MainRoutine Task_H_MainProgram
—{Zt L TaskMon Add-On Instructions

Source F ion Type: {Unp i}

Source Key Configuration...

4. Choose Source Key from the Protection Type pull-down menu and
click Specify.

Protection Type: i| Source Key W |
License

Source Key to
| F | | Shaw Seurce Key

|Conﬁm'| Tew Source Key: |

Source Key Name:

[ Allow viewing of companent(s)
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>

5. To specify a source key location, click Browse (ellipsis “...") to the path

and click OK.

Specify Source Key File Location

SYSTEM\Documents\Studio 5000\Projects\PlantPA] | .. |

I oK I Cancel

o Source key file (sk.dat) does not exist.

Create a new file?

Logix Designer 2

6. Click Yes to confirm the source key file creation (sk.dat).

7. Type a source key (and jot down) to be applied and then type the name
as shown in the example graphic, PlantPAxKeyName.

Protect

Protection Type: |Source Key b4 |

Source Key to Apply to Selected Component(s):

Confirm New Source Key:
| SRR BRERS |

Source Key Name:
| PlantPAxKeyName| |

Source Key Provider:
C:\Users\Administrator SYSTEM\Documents\s. ..

[ Allow viewing of component(s)

Ty v| [] show Source Key

|

Cancel | |

Help

8. Click OK.
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The source key name appears in the Source Protection column.

Organize by: () Container () Source Protection

Source Protection Container
iR AR B

| PlantPAxKeyMName

&) Diagnostics

L& L_cru Add-On Instructions
| {Unprotected}
@ MainRoutine Task_A_MainProgram
@ MainRoutine Task_B_MainProgram
@ MainRoutine Task_C_MainProgram
@ MainRoutine Task_D_MainProgram
@ MainRoutine Task_E_MainProgram
@ MainRoutine Task_F_MainProgram
@ MainRoutine Task_G_MainProgram
M MainRoutine Task H MainProaram
Source Protection Type: Source Key
Mame: PlantPAxKeyName
Vendor: <NfA=
Details: <NfA=
My Permissions: Protect, Edit, Copy, Export, View, Use
My Expiration: <NfA=

Source Key Configuration...

The source key file (sk.dat) is recorded in the path that you designated
in step 3.

Home Share View

- 1 | . <« Documents » Studio 5000 » Projects » PlantPAx v G| | Search PlantPAx

s

¥ Favorites Name Date modified Type

B Desktop . Cache 11/30/2017 %18 AM  File folder

]-, Downloads . Component 11/30/2017 %18 AM  File folder

"5l Recent places elab106a-85ec-4791-%e2-bbdd3f68dadd 11/30/2017 10:43 ... File folder

. FTViewApplications 11/30/2017 %:18 AM  File folder

1M This PC . Network Configuration 11/30/2017 %18 AM  File folder

_H Desktop . Process Area 12/1/2017 10:44 AM  File folder
_EIDocuments otP Ao ad 00017 o [ Architect Projec

H, Downloads || sk.dat 12/1/201711:00 AM  DAT File 1KB

‘ﬂf Music

_EI Pictures

B Videos

i, Local Disk (C:)

% MNetwork

Sitems  1item selected 118 bytes
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If the source key file is moved from the designated file location, the
component cannot be viewed.

@ Logix Designer - LGXCO1 [1756-L75 31.1]*
i FILE EDIT WIEW SEARCH LOGIC COMMUNIC

I RUN < "
= oK |~ Pt s ez —
I Energy Storage Source Protection Configuration:
Y mro Offline fl. MoForces
Controller Organizer Lo Organize by: () Container  (® Source Protection
= B= Source Protection Container endor
o PlantP AxkeyName - |:
rl C‘—) Task_B_100ms ~ L m ]
I !j Task_B_MainProgram Lk[]ucv;;rLProtechun s Protect Component(s) |:
n
4 @ Task_C_250ms {Unp_rute:ted} dl Unprotect Component(s)
P4 Task_C_MainProgram [ MainRoutine Task_A Make Viewable =
b (@ Task_D_500ms 1@ MainRoutine Task, Make Unviewable
" @ Task:E 1< @ MainRoutine 8
T } | [ MainRoutine ask_D_MainProgram
b L Task_E_MainProgram B MainRoutine Task_E_MainProgram -
rl @ Task_F 2= [l MainRoutine Task_F_MainProgram
[ !j Task_F_MainProgram @ Ma?nRuuh:ne Task_G_Ma?nProgram =
Al MainRouti Task H MainProaram

4 C‘—) Task_G_3s

P L Task_G_MainProgram
V] @ Task_H_10s

P4 Task_H_MainProgram

Source P n Type: Source Key
PlantPAxKeyName

<NJA>

<Nfas

= 'y Permissions: Protect, Edit, Copy, Export, View, Use
4 (B _Controller_Status /7 MY Exeatons S slA
4 L Diagnostics | Source Key Configuration. ..

<7 Parameters and Local Tjd
E@ LcPU

Unscheduled
4 Motion Groups

[ Assets i
¥ Logical Model =
LY (77 0 APy SO S

Ladder Diagram (Main) ~

I mmine CDEL L Wilimatimm ad |

9. To view the component, right-click the source key and choose

Make Viewable.
10. Click Close.

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018 229



Chapter7  Configure the Controller

Notes:
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Chapter 8

Configure Time Synchronization

In a PlantPAx" system, time synchronization is essential for controllers,
workstations, and servers to reference the same time for any event or alarm that
occurs. To provide accuracy for sequence of events and historical data, several
protocols are available to control and monitor the clocks. The internal clock
deemed the reference is called the Grandmaster clock.

This chapter describes procedures for configuring time-sync applications by
using two common protocols:

¢ Network Time Protocol (NTP)
e Precision Time Protocol (PTP)

NTP synchronizes time over the plant floor on an Ethernet network as shown
in Figure 13 and Figure 14. NTP sources Coordinated Universal Time (UTC)
as the universal standard for current time. Typically for Windows, a domain
controller sources UTC time and becomes the Reliable Time Server for

the domain.

Figure 13 - System Time Synchronization Example Using an External NTP Server

Operator Workstations Engineering Workstations

L]

Domain Controller Time Server

Application Servers
(Hypervisor) [
T
Firewall
Emulator Port123

LGXxco2

LGXCO1 oTP
NTP/PTP clock mode internal in switch
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Two methods are described to use UTC time in your domain:
e Viayour local network (intranet) or the Internet (Figure 13)
« Via GPS (Figure 14)

The Internet can introduce more propagation delays than GPS that can
cause inaccuracies in your system. Although the NTP system affords
algorithms to calculate accurate time for either method, the GPS method
provides better accuracy.

The Stratix switch is responsible for converting network time protocol (NTP)
to precision time protocol (PTP). This functionality is available only in the

Stratix 54x0 family.

GPS uses a global positioning system for high precision time accuracy. All
components, as shown in Figure 14, with real-time clocks follow the same
reference. However, a 1756HP-TIME module propagates directly to
computers, controllers, and other devices via Ethernet switches.

For more information on time synchronization and CIP Sync, see the
Integrated Architecture” and CIP Sync Configuration manual,

publication IA-AT003.
Figure 14 - 1756 Time Example (GPS Reference)

Operator Workstations Engineering Workstations

Domain Controller

W10 Gi1/1-12

Application Servers

(Hypervisor) NTP SN EEEE SRR N NTP L
¢ Te1/25
R IIIIIIIIIIIN...o.l e
SW001
PTP NTP
- g
e [T 1] '
GPS
il“ i“l - Antenna
HEEE
LGXCO1 lPTP o
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Considerations

Consider the following suggestions before starting this chapter:

e Decide which network time source — external NTP or GPS reference
— that you are going to use. For additional information, see Chapter 1
and Chapter 3 for switch address configuration and domain controller

connections with an N'TP server, respectively.

e To enable CIP Sync functionality in a ControlLogix" controller, select
Time Synchronization in Ethernet adapters by using Studio 5000° Logix

Designer software.

Figure 15 contains the topics that are described in this chapter. Click or see the

page number for quick access to a section.

Figure 15 - Time Synchronization Workflow

[ Start )

4
Configure UTC Time Source

See page 234

h 4
Configure PTP Time Sync for Ethernet Bridges

See page 239

r

See Chapter 9 Configure the PASS

«  Configure Internet Time Synchronization
« NTP to PTP Clock Conversion
- Configure GPS Time Synchronization

Enable Switch Port Modes
Configure PTP Time Synchronization for Controllers
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COnfigure UTC Time Source UTC is independent of time zones and enables NTP to be used anywhere in

the world regardless of time zone settings.

Configure Internet Time Synchronization

Use a domain controller This section describes how to configure the Windows Time Service
with these procedures, (w32Time) to use the Internet as a medium for sourcinga UTC time. Use the

% Windows time utility from an elevated command prompt.

PADCA

Complete these steps by using the domain controller that is hosting the
PDC emulator role (PADCA).
1. Open an elevated Command session and click the Windows Key.
The Start Menu appears.
2. Choose Command Prompt (admin).

3. From within this Command session, type the following while
substituting for the <pool> argument per your requirements:

w32tm /Contfig /ManualPeerList: <pool> /SyncFromFlags:Manual /
Reliable:yes /Update

IMPORTANT  <pool> is a place holder for the URL or URLs of multiple time
servers (for example, atomic clocks). If you cannot access the
Internet, those URLS could be of your parent domain controller. You
can research UTC sources for your proximity, but Table 25 has
examples that work for the U.S.

Table 25 - Internet <pool> Examples

Example Purpose

us.pool.ntp.org,0x8 URL specifies a single server
0.us.pool.ntp.org,0x8 1.us.pool.ntp.org,0x8 URLs specify the use of 4 unique servers
1.us.pool.ntp.org,0x8 2.us.pool.ntp.org,0x8

There are (at least) four server pools of pool.ntp.org. But, the preferred
assignment for <pool> is the first one (us.pool.ntp.org,0x8). Windows
Event Viewer can log errors for URLs that to not respond.

The 0x8 qualifier specifies Client Mode packets for server
communication. For more information, Microsoft

Knowledgebase 875424.

You can specify a list of URLs that are <space> separated and enclosed
in quotes. Make sure to append a type identifier for the URLs identifier
as shown in Table 25. For example, 0x8 (client mode).
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The illustration shows an example that sources the U.S. pool.

oo Administrator; Cmd |:

icrosoft Windows [Uersion 6.3.76881
{c)> 2013 Microszoft Corporation. All rights reserved.

SUWindowsssystem32>w3i2tm #Config AManualPeerList:ius.pool._ntp.org.BxB /SyncFromFlags:Manual ~/Reliahle:yes rsUpdate

If your system cannot access the Internet, <pool> can be a single target
such as your parent or local Domain controller. Your domain time might
not be within tolerable differences of other domains in your enterprise.

Table 26 - Local (non-internet) <pool> Example

Example Purpose
Uses the current computer (PADCA) as the time
source

PADCA Specifies a network time server on your local
network

4. After you have commanded the w32tm utility by using the new
configuration in step 3, use the Net utility to stop and then start the
Windows Time Service from the same command session.

sMindowsssysten3d2net stop wiZtime
he Windows Time sewrwvice is stopping.
he Windows Time service was stopped successfully.

sMindowsssystend2net start wiZtime
he Windows Time sewrvice is starting.
he Windows Time service was started successfully.
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Use an Engineering Workstation

with these procedures
EWS
236

NTP to PTP Clock Conversion

This section illustrates how to configure a Stratix 5400 to convert Network
Time Protocol (N'TP) to Precision Time Protocol (PTP),

1. From the Device Manager of the switch, click Configure and
choose PTP.

2. From the Mode pull-down, select NTP-PTP Clock.

3. Type a priority value for Priorityl and Priority2.

17218.0.20 x ==

<« c @ @ £ https//172.18.0.20/homed.shtrm|

Stratix 5400 Soluti
Allen-Br. adfey Der\?iu:exI\-'1anagarn~u3m?igc:}'|

v

Q nstwork | pTR 3 Network
Srnartparts
viod NTP-PTP Clack Global Macros
-| ock |
e . Port Settings
Priority1 | 126 | Port: Thresholds
Priarity2 | 127 | EtherChannels
riotity. o
Clock Identity: 0xF4:54:33:FF:FE: 11:64:20 WLAM Managerm
Offset From Masterins): 0 B
NTP
RoLting
STP Settings
5 MetFlow
* PTP Clock Settings
A Redundancy F
PTP Device Type: Grand Master clock - Boundary clock DLR.

RFR

4. Click Submit.

Configure GPS Time Synchronization

If you do not implement an Internet or intranet-based time source, this section
helps you configure a Global Positioning System (GPS) time source.

The 1756HP-TIME Module is used in the examples for this section. The
module receives the GPS time reference and propagates the time to the
computers by using NTP to the automation devices through PTP (CIP Sync).

The 1756HP-TIME module obtains time from various sources and provides
time synchronization on other devices, thus acts as a gateway between different
time synchronization methods.

1. Using the Logix Designer application, add the 1756HP-TIME module

to your project.

2. Right-click the module to access the Module Properties dialog box.
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3. Click the Configuration tab.

T o o s 2o [

General I Connection I Module Irfo | Configuration |Mvanced I Time Sync I Intemet Protocal I Port Configuration I Network I Vendor |

Source Settings
Source: |Intemal GPS (Receiver] V| External Source Address:

o] [a] [o] [o

NTF Update Interval: 1 hour

Coordinate System Time
Enable C5T Masterzhip

Time Output
CIP Sync [PTF)

Universal Time Reference

Metwork Time Protocol - NTP
Fre %16 Logix Controller Suppart [-2 years)

[JIRIG -B
webserver

Post Lock-Lost Transmission [ Enable ‘webserver

Advanced CIP Sync Settings

Pricrity 1; [Master Overide] Time To Live:
[Tie Breaker] Syne Interval [5):

Pricrity 2:

Description Settings

User Name: |1?58'T|ME

Uszer Location: |

Status: Running |

4. From the Source pull-down menu, select Internal GPS (Receiver).
5. In the Time Output area, select the desired Time Sync method.

The CIP Sync priority can be changed for the desired Time Sync
method.
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6. Click the Advanced tab.

T wosu rapeies s e e s [
| General I Connection | Module Info | Configuration IAdVEﬂCEd I Time Sync I Intemet Protocol I Port Corfiguration I Network I Vendor |
Wergion: 3.001
- O_‘"eme"_v O Signal strengh good

Simulation !

GPS B Signal strengh poor

| Sat. Signal [ Track histam

© (]
)
(-]

Status: Running | oK | | Cancel | Apply Help

You can follow the Master status in the Advanced tab.
7. Click the Time Sync tab.

This tab lets you confirm the Grandmaster Clock and the actual
time status.

Twoase s o e e o
| General I Connection | Module Info | Configuration I Advanced | Time Sync )l intemet Protocol I Port Corfiguration I Network I Vendor |
CIP Sync Time Synchronization: Enabled
UTC System Time: 1/6/1980 12:38:07 AM
Grandmaster Clock Local Clock
Description: Synchronization Status: Master
[User Name: 1756-TIME ~ Offset to Master: 0 ns
User Location: L] Backplane:
Protocol Address: AC.12.01.66
Physical Address: 00-60-35-22-11-99 .,
ek LSRR R Identity: DD035FFFE221159
Class: 7 (Eois 7
Aceuracy: El Accuracy: 37
Varance: 65535 Variance: 65535
Source: Oscillator Source: Oscillator
Priority 1: 128 Priority 1: 128
ety 2 1 Proriy 2: 128
Status: Running oK | | Cancel Apply Help
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Precision Time Protocol (PTP) enables precise synchronization of clocks in
onfigure ime T I (PTP) enables p ynch f clock
SynCh ronization for Ethernet measurement and control systems. PTP generates a Master-Slave relationship

among the clocks in the system. Clocks, which are synchronized over the

Brldges EtherNet/IP network, derive their time from a clock that is selected as the
Grandmaster clock. The Time Sync and Motion option must be enabled for
Use an Engineering Workstation Ethernet bridge modules to propagate time through the network via switches.
with these procedures.

1. In the Architect application, right-click a controller and choose Open
Project in Designer.
A Studio 5000 Architect - PlantPAx

EWS FILE EDIT WVIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW HELP
e X g X92-C-_ x A, OO f = ControlNetCable ~

Project Bxplorer ~ B X} Process Area” —
A PlantPAx
4 Projects
8 Lexco
B Laxco | Open Project in Designer u
B Lexcos Browse Tags...
B Lexcos Update Project Changes...
B Lexcos Update Changes from Online Controller... DAX
§8 PlantPax Commit Project Changes... System
4 Devices
B Process] Properties...
I [

2. On the General tab of the Module Properties dialog box, make sure that
‘Time Sync and Motion’ is selected for the connection.

See page 211 for procedures on how to change a Module Definition.

@ Logix Designer - LGXCOT [1756-L75 31,1 N
P FILE EDIT VIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW HELP

al D& o %

q’ Path: AB_ETHIP-11172.18. 1, 100'Backplane'0 " = A 4F 4 £ {uF ALr

Rem Run HE Mo Forces P NoEdits i | Redundancy

‘Favorites~ Add-On  Safely  Alarme Bt Tmer/Counter  Input/Dutp

General |Conr1edion | HSNeiWnrxl Module Info I Intemet Protocal I Port Corfiguration ITime Sync |

4 Controller LGXCO1

2 Tasks Type: 1756-EN2T 1756 10/100 Mbps Ethemet Bridge, Twisted-Pair Media

4 Mation Groups Vendor: Rockwell Automation,/Allen-Bradley

4 Assets Parent: liocal Ethemet Address

e Logical Model

Name: GXCO1ENDIA Frivate Network: 192.168.1. =
4 1/0 Configuration e |L b &
Description: ~ IP Address: 2. 18 1 100
s Host Name:

Module Definition

b [ [4] 1756-EN2TR LGXCOTENDZ Slot: 1
Revision: 10.001
Electronic Keying: Compatible Module
Rack Connection: None

Time Sync Connection: Time Sync and M

Drescription ~
Status Running

< “m >

Status: Running OK | | Cancel

T2z Controller Organizer %Logi(al Organizer
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3. Ifonline, click the Time Sync tab to confirm Grandmaster
clock settings.

General | Connection | ASMetwors | Module Info | Internet Pratocol | Port Configuration | Metworl

Enabled
8/13/2018 7:01:08 PM

CIF Sync Time Synchronization:
UTC System Time:

Grandmaster Clock

Local Clock

Drescription: Synchronization Status: Synchronized
Manufacturer Name: Rockwell Automat... | A Offset to Master: 0 ns
Model: 1783-HMS1BTG4... Backplane: M aster [Part 1)
Serial Mumber: FDO190BU07C Ethemet: Slave [Part 2)
Hardware Revision: 0x5 -

Ikt FEEEAARE T Identiy: DDOOBCFFFECEA30N

Class: 248 Class: 248

Arcuracy: 254 Accuracy: 254

Wariance: 65535 Yariance: £5535

Saurce: Dzcillator Source: Ozcill ator

Pricrity 1: 126 Priority 1: 128

IRy & 2 Friority 2 128

Enable Switch Port Modes

By default, PTP is disabled on all Fast Ethernet and Gigabit Ethernet ports.
The switch supports the following Synchronization Clock modes:

¢ End-to-End Transparent — In this mode, all switch ports are enabled by
default. The switch transparently synchronizes all slave clocks with the
master clock connected to the switch. This mode causes less jitter and
error accumulation than Boundary mode.

e Boundary — Use this mode for networks with fewer than four layers of
cascaded devices to avoid jitters and errors. The switch becomes the
parent clock to which the other devices that are connected to the switch
synchronize their internal clocks.

e Forward (default) — Traffic is forwarded through the switch (while
being prioritized by QoS) but is not acted on by the switch.

CIP Sync time synchronization supports Boundary and End-to-End
Transparent modes. End-to-End Transparent mode synchronizes all switch
ports with the Grandmaster clock by using the IEEE 1588V 2 End-to-End
Transparent clock mechanism, and is the preferred mode.

For more information, see the Stratix” Managed Switches User Manual,

publication 1783-UMO007.
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Configure PTP Time Synchronization for Controllers

A Logix controller that is CIP Sync enabled and designated the Grandmaster
clock is the real-time source for the control system. The controller synchronizes
with the PTP between the controllers and networks. Complete these steps.

1. Using the Logix Designer application, click the Open Controller™
Properties symbol.

@ Logix Designer - LGXCO1 [1756-L75 31,1*

© FILE EDIT WIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW  HELP
i Al = [ = B || vl % m Bl (Do B

PR a “ | Path: AB_ETHIP-1\172.18.1.100\Backplane'p % =

B 1/0 OK Rem Run ¥ No Forces P No Edits B | Redundancy

The Controller Properties dialog box appears.

o Controller Properties - LGXCO1 -
| Project | Redundancy | Nonvolatile Memang | Lapacity I Security I Alarm Log |
| General I Major Faults I Minor Faults | I Date/Time | Advanced | SFC Execution |

i) The Date and Time displayed here is Controller local time, not workstation local time
= Use these fields to configure Time attributes of the Controller.

| Set Date, Time and Zone from Workstation {4
Dste and Time:  [11/30/2017 5:30:27 PM | |Change Date and Time...|#
Tme Zone:  |(UTC+00:00) vle

[] Adiust for Daylight Saving (+01:00) =

Time Synchronize

= 1 DANGER. ff time synchronization is
[ Enable Time Synchronization disabled online, active axes in any
controller in this chassis, or any other

synchronized device, may experience
unexpected motion.

: GuardLogix 5560 and 5570 safety
2 Duplicate CST master detected controllers may fault if no other time master

) CST Mastership disabled exists in the local chassis.
3 No CST master

) |s the system time master

2 |s a synchronized time slave

2. On the Date/Time tab, click Enable Time Synchronization.

IMPORTANT  Use your local time to configure the Time Zone and Adjust for
Daylight Saving.

3. Click Advanced.
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4. Click OK on the Controller Properties dialog box.

. Controller Properties - Advanced Time Sync -
Time Synchronize
Enab\e Time Synchronization CIP Sync Time Synchronization:  Enabled
UTC System Time: 8/13/2018 DB:58:15 P
g :s the 3)"7:5“1 .tlm: :aﬁeir Grandmaster Clock Local Clock
5.7 Synenmonized ime siave Desciption; Synchionization Status: Synchionized
Physical Address:  F4-54-33-11-6A-81 - Dffset from Master: Bl ns
Clock Type: Unknown Type
Manufacturer Mame:  Rockwel Automatio Backplane State Slave [Part1]
Model: 1783-HMS1BTB4CGR
Sarial Mumber FRCAANANNT bl
Identity: F45433FFFET1EAB0 Identity: FFFFO001007B7455
Class: 248 Class: 248
1 : ’
The status ‘Is a synchronized slave’ appears S e AT i
when the controller is synchronized. Variance: £5535 Yariance: 65535
Source: Dseillator Source: Oscillatar
Priority 1: 126 Priority 1 5 [Master Ovenide)
Priority 2: 127 Priarity 2: 128 5 [Tie Breaker]

The Grandmaster clock reference can be confirmed.
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Configure the Process Automation System
Server (PASS)

The Process Automation System Server (PASS) is a required system element
for the PlantPAx” system. The PASS hosts essential software components that
run the system, including the FactoryTalk® Directory (FTD).

This chapter describes how to configure these components that comprise

the PASS:

e HMI server — Stores HMI project components, such as graphic
displays, and provides these components to Operator Workstations
(OWS) upon request

o Data server — Accesses information from the process controllers and
provides information to servers and workstations in the PlantPAx
system

e Alarm and Event server — Provides alarm information from the
controllers and servers to the OWSs upon request.

Considerations Consider the following suggestions before starting this chapter:

o The PASS server or servers must be deployed before doing the
procedures in this section.

— For templates based on your system requirements, see the PlantPAx

Virtualization User Manual, publication 9528-UMO001.
e Determine how many PASS servers are required for your architecture.

- See ‘Determining the Number of PASS Servers, in the PlantPAx
Distributed Control System Selection Guide,
publication PROCES-SG001.
e PASS servers can be configured as redundant for HMI servers, data
servers, and/or alarm servers.
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Figure 16 shows the topics that are described in this chapter. Click or see the
page number for quick access to a section.

Figure 16 - PASS Workflow

Start
r - Configure the Application
Configure Servers on PASS « (Configure the HMI Server
+ Primary HMI Server
See page 245 - Configure the Data Server
- Configure the Alarm and Event Server
L 4
Commit Project
See page 256
Y « Enable HMI Redundancy
Configure Redundancies « Enable Data Server Redundancy
- Shortcut Configuration Paths
See page 257 « Redundant ControlLogix Controller

« Enable Alarm and Event Redundancy

r
Create Alarm and Event Database

See page 281

r
Define HMI Security

- Configure FactoryTalk SE Security

See page 284

y

« (reate a FactoryTalk View ME Project
- Configure FactoryTalk View ME Security

«  Configure Time Synchronization for PanelView Terminals
See page 293 « Download the Application

Configure PanelView™ Plus

Configure an Application Server
See Chapter 10
~hapier & Information Server (AppServ-Info)
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COnfigure Servers on PASS In this section, you configure the human machine interface (HMI) server, data

server, and the Alarms and Events server.

Use an Engineering Workstation cOnﬁgure the App“cation
with these procedures

In this section, you configure the application on an engineering

workstation (EWS).

EWS01 Complete the following steps:

1. Click the Programs l symbol and choose Rockwell Software®>

Studio 5000°.
| BOOTP-DHCP Server v P
. FactoryTalk Activation 4
. FactoryTalk Alarms and Events 3
| FactoryTalk AssetCentre Agent 4
. FactoryTalk AssetCentre Client 3
. FactoryTalk Historian SE b Accessibility 3
. FactoryTalk Tools ¥ | | Administrative Tools 4
. FactoryTalk View > | CGCM 3
. Logix Designer Tools ¥ | |, Embedded Lockdown Manager »
. RSLinx » | .. Hiprom Software 4
. RSLogix 3000 Enterprise Series ¥ | | Maintenance 3
. RSLogix 3000 Tools b | . Microsoft Office 3
.. RSNetWon ¥ | | Microsoft SQL Server 2008 4
. Utilities » | . Microsoft SQL Server 2008 R2 3
; . Rockwell Automation 4
& Studio 5000 | Rockwell Software
. SharePoint 3
| Startup 3
L VMware 3
| Windows Accessories 3
. Windows System 3
E8 Adobe Reader XI
E FactoryTalk View Studio
p Search

The Studio 5000 splash screen appears.

2. Select an existing project (PlantPAx in the example).

Rockwell Software’

Studio 5000

New Project Existing Project ~

From Import Sample Project

% From Sample Project From Upload
Recent Projects
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IMPORTANT  If you want to change the application and/or area name, complete
step 3 through step 6. If you want to keep ‘PlantPAx’ as the

application name and 'Area’ as the area name, continue to Configure

the HMI Server on page 247.

3. In the Logix tree, double-click PlantPAx>Projects>PlantPAx.

4. Click OK to accept the default application name 'PlantPAx.

Profect Explorer > 8 x| Frcess oo [N
4 FlantPAx
4 Projects P’antPAX Distributed Arch
B Lexeon Distributed Controf System
B Lexcoz
§ oo  View SE Distributed Properties - P1..J 0% |
B Lexco4 ' 3
B Lexcos ——|
4 fB PlantPAx S
a b Ares MName: [PlantP x|
4 T Alarm Description: e
2 PlantPAx_AE
4 [k Data
“B PlantPAx_DAT
4 Bf PlantPAx_HMI
4 Graphics i
Displays Language: | English (United States). en- |
Global Objects
Images Lok || cancel |
4 Logic and Control
Macros
4 =l Devices
2 Process Area
LGXCO1 LGXCOZ LGXC

5. In the Logix tree, double-click PlantPAx>Projects>PlantPAx>Area.
6. If desired, change the Area name and click OK; otherwise click OK to

accept the default Area name 'Area.

246

Project Explorer - 7 x| Focess 1o
A PlantPAx
4 Projects P’antpzl x Distributed Arch
X Loon Distributed Control System -
B Lexcoz o
- B Lexco3 A Area Properties - Area . =
B Lexcos = = —
- B Laxcos General |
4 §% PlantPAx a —
a ea
E—: ge:hrm Description: =
3 PlantPAx_AE
4 % Data
“@ PlantPAx_DAT -
4 B PlantPAx_HMI
4 Graphics Application:  PlantPfx
Displays Type: View SE Distributed
Global Objects I = I| — |
Images
4 Logic and Control “
Macros
N Devices
& Process Area
LGXCO1 Lexcoz LGXC
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Configure the HMI Server

The HMI server is configured within your Studio 5000 Architect’ and
FactoryTalk View Site Edition (SE) application. The HMI server stores HMI
project components, such as graphic displays, and serves these components to
OWSs upon request. The HMI server can also manage tag databases and log
historical data. Multiple HMI servers can exist on the PlantPAx system.

Use an Engineering Workstation P"mary HMI Server
with these procedures
Complete the following steps.
D 1. Open the Architect application and a project.
EWS01

2. In the Project Explorer area, click PlantPAx>Projects>Devices>
Process Area and choose PASSO1.

Project Bxplorer - 0 X
4 FlantPAx
4 Projects
- B Lexco
- B Lexcoz
- B Lexcoa
- B Lexco4
- B Lexcos
- §B PlantPax
4 Devices
4 B Process Area
- M LGXCO1RO0
- Ml LGXCO02R00
- Ol LGXCO03R00
- M LGXC04R00

- ¥ CORBN0
[l pass01
B OWs01

B swoo1

The Computer Graphics Properties dialog box appears in the
Process Area layout page of an Architect project.

TIP  The following step does not change the name of the actual server, just the
name of the graphical representation of the server.
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3. In the General tab, change the server name to the project name.

P’an tPAX Distributed Architecture - Single Process Server R“ klw_lell
A : = Automation
Distributed Control System A Computer Graphic Properties - PASS01 |
W Device I Associated Projects |
Graphic Name: I|PASSD2A -I
Description:
[ ok ][ Cancel
LGNGOt LGAHCOZ LENCO3 LGNCO4 LGXCO5

4. In the Device tab, type the computer name that hosts the PASS.

For example, PASS02
A Computer Graphic Properties - PASSOT =
Itis also necessary to change, - '
by hand, the name of the o Regd o
graphical representation to Computer Name: [ PASS02A

the name of the PASS host.
—/

I /

S. Click OK.
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6. Ifyou need to change the name of the HMI server, click
Projects>PlantPAx>Area and choose PlantPAx_HMI

7. Type the new name and click OK.

Project Explorer ~ 3 x _
4 | PlantPAx « LA HMI Server Properties — PlantPAx_HMI
4 Projects | S |
- B Lexco Genera |
B Lexcoz
i Name:  JPtartPic il | 10
Description:
- B Lexcos
B Lexcos
4 §8 PlantPAx
4 & Mrea
4 T Alarm v
@ PlantPAx_AE 5
A Application: PlantP Ax
“F PlantPAx_DAT Type: View SE Distributed
4 B} PlantPAx_HMI Area: [Area v|@
- Graphics Host Computer:| PASS0ZA V|
Displays = =
Global Objects et [EROTE
Images
4 Logic and Control
Macros . =
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Configure the Data Server

Use an Engineering Workstation In this section, we create shortcuts on data servers (FactoryTalk Linx) to

ith th d .. . .
Wit These procectires connect controllers. The communication path to network devices is
automatically updated in a Studio 5000 Architect or FactoryTalk View project.
Complete the following steps.
EWS01

1. Ifyou need to change some configuration, right-click PlantPAx_DAT in
the Project Explorer and choose Properties to specify the server in the
graphical process display. Otherwise, continue with the next step.

Observe in the Communication pane (bottom example) that there is
no connection.

2. Drag the communication module from the LGXCO1 chassis and drop it
onto the PASS02A computer.

A Studio 5000 Architect - PlantPAx
FILE EDIT WVIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW HELP
P YO XD2-C-. x A /OO f o ControlNetCable - 00 & . 2 & 8 .

Project Bxplorer Process Area
- PlantPAx =

4 Projects P’antPAX Distributed Architecture - Single Process Server
- B Lexcor

Distributed Controf System
LGXCO2

B WS
-~ B Lexcoz
B Lexco4
- B Lexcos
B PlantPAx
4 B prea
4 B plarm
2 PlantPax_AE
4 [k Data
“B PlantPAx_DAT
4 E§ PlantPfx_HMI
4 Graphics

F]

Displays
Global Objects
Images

4 Logic and Control

Macros

4 Devices
4 & Process Area

- Ol LGXCD1ROO

= LGXCo2 LGXCD4
M | ~senannmnn
Communications - Process Area - 1 X
Communication Pane —> I| PASS02A (Generic Computer) j
4 B FactoryTalk Line, PASS02A
&5 EtherMet, Ethemat
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When the communication module is dropped onto the PASS server, the
Configure Module dialog box appears.

3. (Optional) Type a Description.
4. Accept the rest of the defaults and click OK.

7 Configure Module -
Type: 1756-EN2T 1756 10/100 Mbps Ethernet Bridge, Twisted-Pair M...
Vendor: Rockwell Automation/Allen-Bradley

Parent: PASS02A

Name:

Description:

Revision: H 1

Slot:

Address / Host Mame

) Private Network: 192.168.1.

@ [P Address: 72 18 1 104

) Host Name:

.

The communication shortcut is updated with the adapter name.

Communications - Process Area

PASS02A (Generic Computer) j
4 B FactoryTalk Linx, PASSO02A
4 Z BtherMet, Bthemet
fl 172.12.1.100, 1756-EN2T, LGXCDTEND
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A Studio 5000 Architect - PlantPAx
FILE EDIT WVIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW HELP
e YO aX2-C-.x A/ OO [ —|ControetCable - 0 & . B & 2

5. Drag the controller from the LGXCO1 chassis and drop it into the
PASS02A computer.

Project Bxplorer

4 PlantPAx
4 Projects
+ B Lexco
B Lexcoz
B Lexcos
B Lexco4
B Lexcos
4 §B PlantPax
4 B prea
4 B plarm
2 PlantPax_AE
4 [k Data
“B PlantPAx_DAT
4 E§ PlantPfx_HMI
4 Graphics
Displays
Global Objects
Images
4 Logic and Control
Macros
4 = Devices
4 B Process Area

> Ml LGXCD1ROO

252

Distributed Architecture - Single Process Server

PlantPAx

Distributed Controf System

0900080

git:-;: Y
B4

=]

LGXCO2

LGXCO3

The Add New or Modify Existing Shortcut dialog box appears.

7 Add New or Modify Existing Shortcut -
FactoryTalk Lire data servers:
4 §B PlantPix
4 T Aea
4 T} Data
“@ PlantPax DAT

Shortcut name:
LGXCO1 v]

New path: P

172.18.1,100! 1]

Offline tag file:
|C:‘\Users‘-.Administmtor.SYSTEM‘\Documents‘\Studio 5| | Browse... |

["] Enable Alamms and Events

An Architect project uses the template controller name by default.
Our example is LGXCO1.

We do not recommend that you change the shortcut name.
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6. Accept the defaults and click OK.
The shortcut is created for the controller.

Communications - Process Area - 1 X

|F'ASSDZA (Generic Computer) j

4 B FactoryTalk Line, PASS02A
4 Z BtherMet, Bthemet
s fl 17212.1.100, 1756-EN2T, LGXCOTEND
4 [ 1756-44, LGXCOTROD

—t— ] 0, 175675, LGXCD1

7. Save your work.
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Use an Engineering Workstation
with these procedures

L]

EWS01

254

Configure the Alarm and Event Server

The Alarms and Events server is configured within the Studio 5000 Architect
and FactoryTalk View SE application. This server publishes information from
controllers and servers available to all subscribing OWSs.

In this section, we describe how to configure alarm and event servers for
tag-based alarms. We also show how to set the alarm severity.

1. Ifyou want to change some Alarm and event configuration,
right-click Projects>PlantPAx>Area>Alarm>PlantPAx_AE in the

Project Explorer.

The Tag Alarm and Event Server Properties dialog box appears.

A Studio 5000 Architect - PlantPAx

FILE EDIT WIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW  HELP

DM YOI AXD-C-. x A/ OO [ | ControlNetCable -0 & . 28R -

Project Bxplorer

4 PlantPAx
4 Projects
B Lexco
B Lexcoz
B Lexcos
B Lexco4
B Lexcos
B PlantPAx
4 B prea
4 B plarm
2 PlantPAx_AE
4 [k Data
“B PlantPAx_DAT
4 E§ PlantPfx_HMI
4 Graphics

F]

Displays
Global Objects
Images

4 Logic and Control
Macros

4 Devices
4 & Process Area
- Ol LGXCD1ROO

-

SR o |

PlantPAx

Distributed Controf System

Distribute

/i Tag Alarm and Event Server Properties - Plant...

_Gﬁrl—ljrioﬁties

Name: PlantPfx AE |
Description:

Application: PlantP Ax
Type: View SE Distributed

Host Computer:

PASSDZA v|

PASS02A

Area: | Area/Alarm b | Li ]

i ]

[ ok ][ cancel

An Architect project defaults the alarm name and host computer.

2. (Optional) In the General tab, type a description and click OK.
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3. In the Priorities tab, accept the defaults and click OK.

/i Tag Alarm and Event Server Properties - PIanL.-

Enable server-assigned priorties
Severity Range

Priarity Low High
Urgert 1000
High 501 750
Medium 500
Low 1 250

[ ok ][ cancel |

For more information on alarm severity, see Appendix B in the Rockwell
Automation® Library of Process Objects Reference Manual, publication

PROCES-RMO002.

4. Save your project.

Proceed to page 256 to commit your project.
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Commit Project When you commit a project, all data is sent from the Architect project to the
FactoryTalk View application. The data is updated in the server for the
respective servers: HMI, Data, and Alarms and Events.

Complete the following steps:

1. In the Project Explorer, right-click PlantPAx>Projects>PlantPAx and
choose Commit Project Changes.

Project Exploer X

A PlantPAx =

" teon PlantPAx

B Lexcoz
B Lexcos
B Lexco4
f

Distributed Controf System

Open Project in Designer |

Add ’
- | |

Commit Project Changes... |
a m Al Delete |

2. In the Commit Summary dialog box, click Commit to perform the
commit process.

Studio 5000 Architect Commit Summary -

=3

The following changes will be committed to the associated project{s); any projects containing emors will be skipped

4 §3 View SE Distibuted - PlantPAx A

@ APP PlantP s wil be committed.

o AREA Area will be committed.

@ HMI PlantPAx_HMI wil be committed.

o HMI Plant P Ax_HMI will be committed.

@ AREA Data wil be committed.

o The shortcut LGXC01 of FactoryTalk Lir server PlantPfc_DAT will be created.
@ The device 'LGXCOTENDA will be created.

o The device LGXC01" will be created.

@ RSLE PlartPAx_DAT wil be committed.

B ARFA Alamn wil ha ~ammittad &4

[l Atways show this dialog Help I Commit I Cancel

3. Once a check mark appears next to your project in the Committing
Projects dialog box, the configuration of the servers is complete.

4. To close the Committing Projects dialog box, click Close.

A Studio 5000 Architect Commit Progress -
Committing project changes. This process could take some time depending on the size and number of projects.

' PlantPAx
V Finished
0 Emoris), 0 Waming(s)
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Configure Redundancies

Use a PASS with
these procedures.

PASS02A

This section describes for to configure redundancies for the HMI, Data, and
Alarm and Event servers.

Enable HMI Redundancy

This section describes how to copy the primary HMI server application folder
to the secondary HMI server. This procedure is performed only the first time
the primary HMI server is copied.

Copy the Primary HMI Server to the Secondary Server

To copy the primary HMI server to a location on the secondary server,
complete these steps.

1. Click the Programs ﬂ symbol and choose Rockwell
Software>FactoryTalk View>Tools>HMI Server backup and Restore.

Application Documenter

A% Application Manager

© Desklock

! Distributed Application Manager

M FactoryTalk View Alarm Migration Tool

B FactoryTalk View File Viewer

= FactoryTalk View SE Cache File Management Tool
= FactoryTalk View SE Secure Web Site Setup

ELY oun
=, HMI Server Backup and Restore

Uatabase Lonversion

# ME Firmware Upgrade Wizard

= ME Transfer Utility

" SEHMI Tag Alarm Log Setup

|'_§3—5j SE HMI Tag Alarm Log Viewer Help
[ SEHMI Tag Alarm Log Viewer

% SE Service Manager
& Tag Import and Export Wizard

1111

i . Accessibility »
J . Administrative Tools 4
}
. Embedded Lockdown Manager »
[ .. Maintenance 3
. Microsoft SQL Server 2008 4
| Microsoft SQL Server 2008 R2 4
. Rockwell Automation »
| FactoryTalk Activation v | | Rockwell Software
| FactoryTalk Alarms and Events ¥ | L Startup 3
| FactoryTalk Historian 5E v L VMware 3
| FactoryTalk Tools ¥ | | Windows Accessories 4
. Tools . FactoryTalk View . Windows System 4
. User Documentation ¥ | L) RSLinx + B8 Adobe Reader Xl
O FactoryTalk View Site Edition Client [} FactoryTalk Administration Console || Desktop
&l FactoryTalk View Studio 8 Studio 5000 & FactoryTalk View Studio
& Uninstall FactoryTalk View 7 Search
The Select Operation dialog box appears.
2. Click 'Backup HMI Server..
& Select Operation -
— Please select operation
Backup HMI Server
Restare HMI Server |
Cloge |
Help |
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The HMI server backup dialog box appears.
3. Click Browse for the Source HMI server.

Source HMI zerver:

I I Browse I
[ |

Destination backup path :

I Browse

[~ Exclude the datalog filesets

Start Backup I Cancel

4. Navigate to the primary HMI server that was created earlier
and choose the .sed file.

.« SE » HMIProjects » PlantPAx_HMI | Search PlantPAx_HMI P |

Organize = New folder
) —
0 Favorites T

B Desktop i KEY File folder
‘i, Downloads L LNG File folder
"5l Recent places | Local File folder
W Mer File folder
18 This PC 1 PAR File folder
[l Desktop S| Qiree File folder
j‘_l Documents L RecipePro File folder
@ Downloads . Startup File folder
‘H Music & TAG File folder
|2 Pictures | TREND File folder
j Videos 1 | TRENDPRO File folder

a Local Disk (C:) File folder
;LV..: PlantPAx_HMl.sed SED File 21 KB|
File pame: | PlantPfx_HMI.sed v | Application file (*.sed) v

MName Type

5. Click Open.
6. Click Browse for the Destination backup path.

The destination is on the same physical machine as the Source HMI
Server. 'Desktop' is a good choice because it’s convenient and easy
to access.

Source HMI zerver:

IE:\Documents and Settingsiall Uzers\Documents A SYiew EnterprizehSESH

Destination backup path :

I I Browse I

[~ Exclude the datalog filesets

Start Backup Cancel
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7. Choose any destination path and click OK.

‘Desktop’ is our example.

Browse for Folder -

- Desktop | ~
b G‘y Network
I | Libraries
> A Administrator
4 (M| This PC
I Music
[ | [f| Documents
I+ | pg Desktop
[ | &= Pictures
I g Downloads
> 8 Videos w

i

8. Check 'Exclude the dialog filesets.

o | HMI Server Backup -

Source HMI zerver:

|E:\Documents and Settingzhall Users\Documents\RSYiew Enterprise\SEYHM Browse

Destination backup path :

|E:\U zersh\Administrator, SYSTEMADesklop Browse

I|7 {Exclude the datalog filesets-él

I Start Backup I Cancel |

9. Click Start Backup.

When the backup is complete, the 'HMI server backup complete’ dialog
box appears.

10. Click OK.

HMI Server Backup and Restore -

|'0:| HMI server backup complete.

The Select Operation dialog box reappears.
11. Click Close.
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Copy Primary Folder to Secondary Server

The destination folder has to be cut from the primary physical machine and

Use a PASS with pasted on the secondary HMI server physical machine.

these procedures.
1. In Windows Explorer, navigate to the destination folder you created
(Desktop in our example), right-click the folder name, and choose Cut.

A Administrator File folder

PASS02A 18 This PC
= Libraries
G‘F Metwork
@ Control Panel
f Recycle Bin
| 1. PlantPAx HMI

File folder

Open
Open in new window
Share with 3

Restore previous versions

Include in library r
Pin to Start

Send to 3
Cut

2. Paste the HMI server folder into the secondary server folder
(Site Edition (SE) HMI Projects folder).

L EW = HMI Projects
“ Home Share View
’fj - TI| <« passlZb » Users » Public » Public Documents » RSView Enterprise » SE » HMI Projects >I v &
3% Favorites Name = Date modified Type Size
B Desktop J bin File folder
& Downloads InstantFizz_HMI File folder
=] Recent places | InstantFizz_SE File folder
(% CMD_ISAPLDLL Application extens... 619 KB
1% This PC |M| FactoryTalk View SE PNG image 18 KB
ju Desktop (%) HMI_ISAPLDLL Application extens... 440 KB
| Documents | HMIServer f201510:27PM A 2KB
& Downloads || HMIServer.aspx 015 213 PM 3KB
W Music || web.config 8/11/201510:27 PM  CONFIG File 1KB
=| Pictures
B Videos View L
i, Local Disk (C:) Sort by »
Group by 3
‘rﬁ MNetwork Refresh
Customize this folder...
Haste shortcu
Undo Copy Ctrl+Z
The default path is:
C:\Users\Public\Public Documents\RSView Enterprise\SE\
HMI projects.
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Set Up HMI Redundancy
Use an Engineering Workstation This section describes how to use HMI Properties to enable redundancy.
with these procedures
Complete these steps.
D 1. Click the Programs E symbol and choose Rockwell Software>
EWSOT Studio 5000.

2. From the Studio 5000 splash screen, select an existing project (PlantPAx
in the example).

3. In the Project Explorer, right-click PlantPAx>Projects>PlantPAx and
choose Open Project in Designer.

Prject Explorer ~ A x
A PlantPAx

- Projects
Distributed Control System

- B Lexco
LGXC02
LGXCO3

i
Al |
i
i

=

Open Project in Designer

4 B Areg
4 B oAl | Add v
il Update Project Changes...
|
a B Eif Commit Project Changes...
‘z
4 Bf F'I! Delete
4 Show Owner Mode
Properties...

4. In FactoryTalk View Studio, right-click the HMI server name and
choose Properties.

=l FactoryTalk View Studio - View Site Editi
File View Settings Tools Window Help
FES | DeEo o acE |

Explorer - PlantPAx_HMI
=145 Network (PASSDT)

= ffm PlantPAx
..&= Runtime Security

8

Delete

e

Add Controller Instruction Faceplates...

S Graphics
E Displa

[ Global Objects

i Symbol Factory

= | khraries

The HMI Server Properties dialog box appears.
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5. On the General tab, click 'Load and run startup components when
operating system initializes.

PlantPAx_HMI Properties -

General | Redundancy | Components

MName:

[ PlantpAx_HMI

Description:

Computer hosting the server:

PASS02A | ]

Startup Type
[

ioad and run startup components when operating system initializes

Project file {relative to server computer):

‘ C:Wsers\Public\Documents\RSView Enterprise\SE'HMI Projects\PlantPAx_HMI ‘

Mumber of displays: 0 Licensed maximum: Unlimited

[ ok ][ Cancel |l 2oty Help

6. Click Apply.
7. Click the Redundancy tab.

PlantPAx_HMI Properties -

Qenﬂ Redundancy Igomponents |
I rovide redundancy using a secondary server I

Secondary server

I PASS02B I

Startup type:
Load and run startup components when operating system initializes

Mumber of dizplays:  Unknown Licenzed masimunm; Unknown

Switchover options

@ Continue using the secondary server even when the primary server
= becomes available again

(O Switch over to the primary server when it becomes available

Feplication

Fieplicate Active to Standby...

-I Concsl | [ ooy |[ Hep |

8. Check 'Provide redundancy using a secondary server.

9. Click Browse (ellipses “...) and select the Secondary server.

10. Click OK.
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A message window appecars.

FactoryTalk View Studio [ x ]

The HMI server configuration data will be replicated from the Primary
. server to Secondary server, the existing HMI server configuration data
on the Secondary server will be overwritten, Do you want to replace it?

11. Click Yes.
Server Status

In this section, you verify the status of the Active (Primary) and
Standby (Secondary) servers.

1. In FactoryTalk View Studio, right-click the HMI server name and
choose Server Status

Zl FactoryTalk View Studio - View Site Editi
File View Settings Tools Window Help
FEE De(Elo o ae
Explorer - PlantPAx_HMI =]
=145 Network (PASSDT) i
: PlantPAx
&= Runtime Security
S5 Y PlantP A Hiyi Se—
3 System | Delete
B Cummﬁ Add Controller Instruction Faceplates...
23 HMI Tags
& Togs
=3 Graphics | Hroperties... |
[&#] Displays
[&#] Global Objects
& Symbol Factory o
| Appiication [ Commuricasons |
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2. In the Server Status dialog Box, verify the following:
e The Primary server (for example, PASS02A) is correct and ‘Active’

o The Secondary server (for example, PASS02B) is correct
and 'Standby’.

Server Status - PlantPAx/Area:PlantPAx_HMI -

Server status

Primary server: PASS02A

Primary status: | Active |

Secondary server:§ PASS028

Secondary status: | Standby |

Switchover options

() Switch over to the primary server when it becomes available

Server switchover

Click the Switchover button to switch the Active server. The server that is currently on
standby will become the Active server and the Active server will become the Standby server,

Apply Cancel | | Help

3. Click OK.
Replicate Active to Standby

In this section, you replicate the Primary properties from the Primary server to
the Secondary server.

IMPORTANT  Every change that is made in the Primary server must be replicated.
The replication process is always from the Active to the Standby.

1. In FactoryTalk View Studio window, right-click the HMI server name
and choose Properties.

zl FactoryTalk View Studio - View Site Editi
File View Settings Tools Window Help

_DD’* (== RF R

Explorer - PlantPAx_HMI =]
=& Network (PASS01) ~
=k PlantPAx

S % TSI

3 System Delete

HMI Tag Add Controller Instruction Faceplates...
g Tags | Server Status...

¥ 7 A g T 0
3 Graphic Properties...
[ Displ
& Global Objects
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The HMI server properties dialog box appears.

PlantPAx_HMI Properties -

| Qenen:l Redundancy I_Qomponents|

Provide redundancy using a secondary server
Secondary server

LComputer hosting the server:

|[]

Startup type:
Load and run startup components when operating system initializes

Mumber of dizplays: 0 Licenzed masimunm; Unlimited

Switchover options

@ Continue using the secondary server even when the primary server
= becomes available again

(O Switch over to the primary server when it becomes available

Feplication

Feplicate Active to Standby...

| OK || Cancel | Apply Help

2. On the Redundancy tab, click 'Replicate Active to Standby.

A replication warning appears.
3. Click Yes.

A progress bar shows the status of the copy process.

TIP  The Secondary server no longer automatically restarts when the
copy process completes.

4. Click Close.
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Enable Data Server Redundancy

This section describes how to configure a Secondary server and edit redundant
controller paths.

Set Up Data Redundancy

Complete the following steps.
1. Open your project (PlantPAx in the example). See step 1 through step 3
for more information.

2. In the Explorer, right-click PlantPAx>Area>Data>PlantPAx_DAT and
choose Properties.

zl

File View Settings Tools Window Help
) D[ o || e

Explorer—P.I.anﬂ)Ax;l.-I.Ml : .

&2 Runtime Security
EIE Area
|"‘_-EF Alarm
-k Data
L5 021 I

+& Plany Delete ‘

o S g % AP RO NN §

The FactoryTalk Linx Server Properties dialog box appears.

3. In the Redundancy tab, check ‘Provide redundancy using a secondary
server’ box.

FactoryTalk Linx Server Properties -

- I Redundancy h ams and Events

&I Provide redundancy using a secondary server.l

PAS502B

Switchover options

® Continue using the secondary server even when the
= primary server becomes available again.

~ Switch overto primary server when it becomes
" available again.

— o | oo [ ][ e
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4. Click Browse and select the secondary server.

S. Click OK.

Shortcut Configuration Paths

The PlantPAx system provides several methods for enabling communication
with controllers via shortcuts:

o Single Redundant Path (processor) — This ‘traditional’ redundant
path has a single IP address with a Simplex controller or redundant set
of controllers.

e Dual Redundant Path — Each of two adapter modules in a controller
chassis have their own IP address. If one adapter has a break in
communication, the other adapter is available as a redundant backup.

e Redundant ControlLogix’ controller — This method also requires fixed
IP addresses at the controller level. There is a primary IP address and a
secondary IP address configured for a redundant pair of Ethernet
adapters. A switchover from the primary controller uses the IP address
of the adapter in the secondary controller.

Configure a Single Redundant Path

This section describes how to configure an IP address for a Simplex controller.

1. If necessary, expand the primary Data server (PlantPAx_DAT in
the example).

2 FactoryTalk View Studio - View Site Edition (Network Distributed) - [Communication Setup - R_NA'ﬂs'GlobaVPIantPNefA..l;li-

mﬂ File View Settings Tools Window Help !Eu
18 |0 @(E|o|@ and |
Explorer - PlantPAx_HMI . [~ Device Shorteuts - I Frimary ISacandaw]
L:@ Network (PASS0T) m Remove ; =8 Q FactoryTalk Linx, PASSD24

fi PlantPAx _ = PR || mEm 1789-A17, Backplane
Runtime Security == EtherMet, AB_ETH-1
2= EtherMet, AB_ETHIP-1
|_;| = EtherMet, Ethernet
E|ﬂ 172.18.1.100, 1756-EN2T, LGXCOTENOA
E- Backplane, LGXCOTR0D

8, W0, 1756-L75, LGXCO1

-3 PCvialSB, 17-Node USB CIP Port

Action Groups
+D Policies § i )
] Computers and Groups Mode: Online |Not Browsing

+ == Networks and Devices
[0 Users and Groups i
+D Connections Shorteut Type |Processor _d

+[1] Permission Sets

Offline Tag File | C:YJzerg\Administrator. SYSTEM\Documents\Studio 5000'Projects\PlantPAx\Process Are. Browse. .. I

This path is currently assigned to the selected shartaut.

il Application 1 Communicaions MOk i Cancel | Verify ﬂj

2. Double-click Communication Setup.
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The Communication Setup window appears.
3. Click the shortcut (LGXCO1 in the example).

4. Click the Primary tab and select the path to the controller
(1756-L75, LGXCO1 in the example).

If you are using data server redundancy, you must configure a patch from
the secondary data server to the controller.

5. On the Communication Setup window, click the Secondary tab.

& FactoryTalk View Studio - View Site Edition (Network Distributed) - [Communication Setup - RNA://' $GIGbGI/PIantPAﬂA..|;|£-

@l File View Settings Tools Window Help |- [=]x]
18 Do a s
Explorer - PlantPAx_HMI [x]] | Device shortouts | Primaryl Secondary |
_@ Network (PASS01) Add | Remove | Apply = FactoryTalk Linx, PASS02B ~|
i PlantPAx = T | || G &3 1789-A17, Backplane
& Runtime Security @ EtherMet, AB_ETH-1
[T Area

-5 EtherMet, AB_ETHIP-1
=25 EtherMet, Ethernet
= ﬂ 172.18.1.100, 1756-EN2T, 1756-EN2T/D

CEF Alarm

L-EF Data

‘Bl PlantPAx_DAT

: 5---|‘—,_|ﬂ Communication Setup
@ PlantPAx HMI

SEa Systemn

(I Action Groups

o T1I0-ENZT, T730-EN2T/D
2, 1756-EN2T, 1756-EN2T/D 1
1 1756HP-Time/R 1756HP-TINMF/R "~

+( Policies < E— = :
+[:| Computers and Groups Mode: Online |Mot Browsing

# &5 MNetworks and Devices —= = =

Offline Tag File |C:\J..lsers\,-\dminish'ahor.SYSTEI'ﬂ\,Documents\,Sh.ldio 5000'Projects\PlantPAx'\Process Are, Browse... I
(1 Users and Groups s :

+D e Shortcut Type |Pr0cessor _.'_j

+D Permission Sets

e Click Apply button to assign selected path to this shorteut.
Application J Communicaiions

A Cancel | Verify | Help

Click Verify (third button to the left of OK).

Navigate to and select a path to the controller.

6
7. Click OK to close the verification dialog box.
8
9

. Click OK.

FactoryTalk Linx 2

Save the following changes to the shortcut 'LGXC01'?
Secondary path edited

- Old:
- New: 1756-A7/A or B.LGXCO1

Click Yes to apply changes. Click No to discard changes.

10. Review the summary of changes and click Yes to apply.

11. Right-click the data server name (PlantPAx_DAT in the example) in the
Explorer tree and choose Server Status.
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The Server Status dialog box appears.
12. Click OK.

Configure a Dual Path for a Simplex Controller

Complete these steps to configure dual IP address paths for separate adapters in
the same controller chassis.

LGXCO01
1. Expand the primary Data server (PlantPAx_DAT in the example).
2. Double-click Communication Setup.
L—,_‘ﬂ File View Settings Tools Window Help =T %]
FES DSEo @ acE |
Explorer - PlantPAx_HMI [=]| [ - Device Shorteuts Primary I Secondary |
=5 Network (PASSOT) Add | Remove =2 FactoryTalk Linx, PASS02A
o Plane = T €5 1789-A17, Backplane
-&= Runtime Security 2 EtherMet, AB_ETH-1
B Ares 5 EtherNet, AB_ETHIP-1
FJ‘L_EF Alarm =25 EtherMet, Ethernet
2-f] 172.18.1.100, 1736-EN2T, LGXCO1END1A
L= - -89 Backplane, 1756-A7/A or B
68 Jo. 1756-L75, LGXCO!
B PlantPAx HMI -89 PCviallSB, 17-Node USB CIP Port
3 System
2 Action Groups
[ Policies
(23 Computers and Groups Mode: Online [Mot Browsing
&5 Networks and Devices bﬂ"line TagFie
21 Users and Groups ‘
[ Connections frocessoy =
/(L1 Permission Sets :Eloscssasr:;eher
Symbolic
Unsolicited Message
CIP Object
Redundant Controller Path
Redundant ControlLogix Controller
is path is currently assigned to the selected shortcut.
Appﬁcdmlcomnwnica'ms I I /i\l ok | Eancell Verify_l Helpl

The Communication Setup window appears.

3. Click the shortcut (LGXCO1 in the example).
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@l File View Settings Tools

FHS| 0w

4. Click Shortcut Type and choose Redundant Controller Path from the

Processor pull-down.

Save the following changes to the shortcut 'LGXC01'?

Shortcut Type changed
- Old: Processor
- New: Redundant Controller Path

Shortcut redundancy changed (due to Shortcut Type changes)
- Old: Single Controller Path
- New: Redundant Controller Path
- <Pathl1>
- <Path2>
<Path1> is the original Single Controller Path.

Click Yes to apply changes. Click No to discard changes.

S. Click Yes.
6. Click the shortcut (LGXCO1 in the example).
7. Click the Secondary Tab and select (1756-L75, LGXC01

in the example).

Window Help

=8 BF R -

Explorer - PlantPAx_HMI

[=]

(- Device Shortcuts ————————————| Primary | Secondaryl

=145 Network (PASS01)
- fim PlantPAx
- &= Runtime Security

LEF Area

Data
=B PlantPAx_DAT

B ﬂ Communication Setup

o m PlantPA HMI
Em Systemn
[0 Action Groups
[Z Policies
Computers and Groups
=z Networks and Devices
Users and Groups
Connections
Permission Sets

Remove | aprl | =B FactoryTalk Linx, PASS02A

73 1789-A17, Backplane

&5 EtherNet, AB_ETH-1

&5 EtherNet, AB_ETHIP-1
=5 Etherhlet, Ethernet

2 f] 172.12.1.100, 1756-EN2T, LGXCOTENOTA

3 Backplane, 1756-A7/A or B
M. W0, 1756-L75, LGXCO!
3 PCuialSE, 17-Node USB CIP Port

Meode: Online

|Not Browsing

ffline Tag File
hortcut Type Redundant Controller Path
hortcut Path Timeout (sec.) 2
hortcut Path Check Interval (sec.) i

ease select child item to change path.

[0k cancel | veiity | Help|

MNUM

8. Do not click OK. Remain on the Communication Setup window to

finish configuring the adapter paths, starting on page 271.
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Select Path 1 for the Primary Data Server

Complete these steps to select the IP address for the path 1 adapter.

1. Select Path 1 for the shortcut.

L—,_‘ﬂ File View Settings Tools Window Help
FEHS DeE oo s

Explorer - PlantPAx_HMI E - Device Shortcuts Primary | Secondary |
=145 Network (PASSDT)

S Remove | aprl | -] FactoryTalk Linx, PASSOZA
an

-2 LGuaa v 1789-A17, Backplane
-&= Runtime Security i 2 Etherhet, AB_ETH-1
EE Area 7

5 EtherNet, AB_ETHIP-1

= ¥ Data
- 284 PlantPAx_DAT
5---|‘—,_|ﬂ Communication Setup
@ PlantPAx HMI
Em Systemn
@ Action Groups
/(3 Policies
Ei Computers and Groups Meode: Online |Not Browsing
@5 MNetworks and Devices —
@ Users and Groups - Offline Tag File
E}El Connections
E; Permission Sets

Browse, |
Redundant Controller Path ;I
hortcut Path Timeout (sec.) 2

Shortout Path Check Interval (sec.) 1

hortcut Type

is path is currently assigned to the selected shortout,

[0k cancel | veiity | Help|

MNUM

2. From the Primary tab, select the IP address for the path 1 adapter
and the controller.
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3. Click Apply.

L—,_‘ﬂ File View Settings Tools Window Help
FEHES | 0=[Elo D s
Explorer - PlantPAx_HMI E - Device Shorteuts —————————  Primany | Secondary |

Remove - =2 FactoryTalk Linx, PASS02A

B~ # LGXCO1

B3 17859-A17, Backplane
== Etherhlet, AB_ETH-1
r-&x EtherMet, AB_ETHIP-1
EE?E Etherlet, Ethernet
: 8 21100 FEL ¥ CD1ERINT A
@ ﬂ Communication Setup - Koo : i
o m PlantPA HMI :
=3 System .
Action Groups : : |
[ Policies < [T =]
Computers and Groups Meode: Online |Not Browsing
=z Networks and Devices
Users and Groups ffiine Tag File Browse, |
[Z1 Connections hortcut Type Redundant Controller Path LI
hortcut Path Timeout (sec.) 2
hortcut Path Check Interval (sec.) 1

lick Apply button to assign selected path to this shortout.

[0k cancel | veiity | Help|

MNUM

Select Path 2 for the Primary Data Server

Complete these steps to select a different IP address for a second adapter
for path 2.

1. Select Path 2 for the shortcut.

2. From the Primary tab, select the IP address for path 2 and the controller.
3. Click Apply.
4

. Click Yes twice to assign both paths to the Primary server.

@ Target controller of <Path1> is added manually
Save the following changes to the shortcut 'LGXC01'?
Make sure <Path1> and <Path2> are configured to the same controller
with different communication paths. Path2 changed
Do you want to continue? - Old:
- New: 1756-A7/A or B 2.LGXC01

Click Yes to apply changes. Click No to discard changes.
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5. Click the Secondary tab and select Path 1.
6. Select the IP address for the path 2 adapter and the controller.
7. Click Apply.

L—,_‘ﬂ File View Settings Tools Window Help
FEHES | 0=[Elo D s
Explorer - PlantPAx_HMI [x]] | Device shortauts —————————— g Seconday |

=145 Network (PASSDT) Remove | Apply | =5, FactoryTalk Linx, PASS028

E- # LGXCO01 B3 17859-A17, Backplane
i == Etherhlet, AB_ETH-1

&= Runtime Security

(i Area & EtherNet, AB_ETHIP-1
[#{CE Alarm &= EtherMet, Ethernet

- =85 PlantPAx DAT f 172.12.1.101, 1756-EN2T, 1756-EN2T/D

Iﬂﬂ Communication Setup : Backpnlane | Qrb
[ PlantPAx HMI i
=3 System

(21 Action Groups f] 2 1756-ENZT, 1756-EN2T/D 1

[ Policies 8l 3, 1756HP-Time/B, 1756HP-TIME/B

Computers and Groups Mode: Online |Not Browsing

=z Networks and Devices

(23 Users and Groups ffline Tag File Browse, |

[Z1 Connections hortcut Type Redundant Controller Path LI
/(L1 Permission Sets hortcut Path Timeout (sec.) 2
hortcut Path Check Interval (sec.) 1

lick Apply button to assign selected path to this shortout.

8. Click OK.

9. Click Yes on the message window.

Save the following changes to the shortcut 'LGXC01'?

Path2 changed
- Old:
- New: 1756-A7/A or B 2.LGXC01

Click Yes to apply changes. Click No to discard changes.
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Redundant ControlLogix Controller

‘2“%

- i I i I ControlLogix controllers.

Complete these steps to assign a fixed IP address to a redundant pair of

1. From the Communication Setup window, click the second shortcut
(LGXCO02 in the example).

L—,_‘ﬂ File View Settings Tools Window Help

FES DeEl oo aa

Explorer - PlantPAx_HMI [=]

—
—Device Shortcuts Frimary | Secondaryl

=145 Network (PASSDT)
=l PlantPAx
&= Runtime Security
E!LEF Area
i E'LEF Alarm
-F Data
£+ 8y PlantPAx DAT
5---|‘—,_| ﬂ Communication Setup
@ PlantPAx HMI
ED Systemn
[ Action Groups
E}El Policies
E Computers and Groups
El-fa MNetworks and Devices
D Users and Groups
E}El Connections
Ei Permission Sets

A_ddl Remove | Applyl

E| ® LGXC01
i # Pathl

B39 1789-A17, Backplane
= EtherMet, AB_ETH-1
== EtherMet, AB_ETHIP-1
=5 EtherMet, Ethernet

aty Controller
- Secondary Controller

Mode: Online |Mot Browsing

Redundant ControlLogix Controller -

Offline Tag File

Shortcut Type

Shortcut Path Timeout (sec.)
Shortcut Path Check Interval (sec.)

Please select child item to change path.

[ 0K cancel | Veiity | Help|

MIEIRA

2. Select Redundant ControlLogix Controller from the Shortcut Type
pull-down menu.
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3. Click Apply.

& FactoryTalk View Studio - View Site Edition (Network Distributed) - [Communication Setup - RNA://' $GIGbﬂI/PIanL|;|£-

L—,_‘ﬂ File View Settings Tools Window Help

18 D&(E|o| o s

Explorer - PlantPAx_HMI

[=]

Network (PAS501)

5 Bl PlantPAx_DAT
Iﬂﬂ Communication Setup

Systemn

|:| Action Groups

+/[1] Policies

+D Computers and Groups
+-,5'E,5 Metworks and Devices

+C| Users and Groups Offline Tag File B ]
/(] Connections Shortaut Type Redundant ControlLogix Controller _’J
+D Permission Sets Shortcut Path Timeout (sec.) 2

fShorhu..lt Path Check Interval (sec.) 1

-Device Shortouts -

Add Remove l Apply l

=~ 7 LGXCO1

| Primary 1 Secondary]

El-&5 EtherMet, Ethernet
- ﬂ 172.18.1.100, 1756-EN2T, LGXCOTENO1A
- ﬂ 172.18.1.101, 1756-EN2T, 1756-EMN2T/D
B 175121100 1 w—“’-Ti Wi =
ﬂ 172.18.1.105, 1756-EN2TR, 1756-EN2TR/

g
g

=/

0 E-ERD/ A G-RM2/A REDUNDANCY MO
Ry BEEMZTR/C

3, 1756-ENZTR, 1756-EN2TR/C 1
18 PCvial ISR 1?"Iill'\lndﬁ.ll."1ﬂ CIP Part 4

<
Mode: Online

Mot Browsing

Application 1 Communicasions

&| oK I Eancelj \u"erify] Help]
NM
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7.

Click the Primary Controller shortcut.

From the Primary tab, select the IP address of the adapter and the
primary controller.

Observe that our example shows the IP address of 172.18.1.105.

IMPORTANT  Make sure the HMI communication card is configured to disallow an
IP address swap.Configure a different IP address than the first HMI
communication card.

Click Apply.

A FactoryTalk Linx popup window appears with the message the target
controller is being configured.

]

FactoryTalk Linx

i . 1 Target controller of Redundant ControlLogix Controller is being

LY configured

Make sure <Primary Controller> and <Secondary Controller> are in the
same Redundant Pair.
Do you want to continue?

Click Yes.
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Another FactoryTalk Linx popup window appears with a message
that changes are being made to the controller shortcut (LGXCO02
for our example).

Save the following changes to the shortcut 'LGXC02'?

Primary Controller changed
- Old:
- New: 1756-A7/C.LGXC02

Click Yes to apply changes. Click No to discard changes.

8. Click Yes.

9. From the Communication Setup dialog box, click the
Secondary Controller.

L—,_‘ﬂ File View Settings Tools Window Help
FES| DEEo| @ acE |
Explorer - PlantPAx_HMI [=]| [I-pevice shortasts — Primary | Secondary |

=145 Network (PASSDT)
i PlantPAx
&= Runtime Security

=25 EtherMNet, Ethernet

o ® LGXC01 []---ﬂ 172.18.1.100, 1756-EN2T, LGXCOTEND1A
[]---ﬂ 172.18.1.101, 1756-EN2T, 1756-EN2T/D
g 172.18.1.102, 1756HP-Time/B, 1736HP-TIME/B
=

8, PlantpAx DAT :

B ﬂ Communication Setup
- m@ PlantPax HMI
Em Systemn s
(11 Action Groups B3 175A-FNITR 1756-FNITR/C
w3 Policies <] 0
= Computers and Groups Mode: Online |Not Browsing
=z Networks and Devices
(1 Users and Groups
E@ Connections Shortcut Type Redundant ControlLogix Controller ;I
Ei Permission Sets Shortcut Path Timeout (sec.) 2
 Shortout Path Check Interval (sec.) i

':-'-o Tag File Browse. ., |

lick Apply button to assign selected path to this shortout,

[ 0K cancel | Veiity | Help|

MNUM

10. From the Primary tab, select a different IP address for the adapter and
the primary controller.

Observe that our example shows the IP address of 172.18.1.106.
11. Click Apply.
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FactoryTalk Linx popup windows appear.

Target controller of Redundant ControlLogix Controller is being
configured

Save the following changes to the shortcut 'LGXC02'?

Make sure <Primary Controller> and <Secondary Controller> are in the
same Redundant Pair. Secondary Controller changed
Do you want to continue? - Old:

- New: 1756-A7/C 2.LGXC02

Click Yes to apply changes. Click No to discard changes.

12. Click Yes for each message.
13. Click the Secondary tab, and then click Primary Controller shortcut.

al File i Settings Ioo Window Help
FES|DeE|c|aaca|

[—
Explorer - PlantPAx_HMI [=]| I -pevice shortcuts

Primary Secondaryl
BE Network (PASSOT) Add | Remove I Apply |I =25 EtherMNet, Ethernet

TeTa 7] 172.18.1.100, 1756-EN2T, 1756-EN2T/D

.} |Primary Controller m| f . =

=8 PlantPAx_DAT OOt =
5---|‘—,_| ﬂ Communication Setup
o m PlantPA HMI
ED Systermn
Action Groups
[Z Policies < ]
Computers and Groups Mode: Online |Not Browsing
=z Networks and Devices
Users and Groups - Offline Tag File Browse. ., |
[ Connections hortcut Type Redundant ControlLogix Controller ;I
Permission Sets hortout Path Timeout (sec.) 2
- Shortcut Path Check Interval (sec.) i

f 5
ﬂ 3, 1756-EN2TR, 1736-EN2TR/C
3 PCvialSB, 17-Mode USE CIP Port 4 -
.l 172.18.1.1061172.18.1.1051_1756-FEN2TR 1?'»6-TN?..TR-{(.‘.V-
L1} B3

lick Apply button to assign selected path to this shortout,

[ 0K cancel | Veiity | Help|

NUM 2

14. Select the same IP address of the adapter and the controller that you did
for the data server for the primary controller in step 5 on page 275.

Observe that our example shows the IP address of 172.18.1.105.
15. Click Apply.
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FactoryTalk Linx popup windows appear.

Target controller of Redundant ControlLogix Controller is being
configured

o

Save the following changes to the shortcut 'LGXC02'?

Make sure <Primary Controller> and <Secondary Controller> are in the
same Redundant Pair.
Do you want to continue?

Secondary path edited
- Old:
- New: 1756-A7/C 2.LGXC02

Click Yes to apply changes. Click No to discard changes.

16. Click Yes for each message.
17. Click Secondary Controller.

L—,_‘ﬂ File View Settings Tools Window Help
FEHES | 0=[Elo D s
Explorer - PlantPAx_HMI [=]

—
~Device Shortcuts

Primary  Secondary |

=145 Network (PASSDT)
=n PlantPAx
&= Runtime Security

Add | Remove |

LGXCO1
® Pathl

El-&5 EtherMet, Ethernet
o [ 172.18.1.100, 1756-EN2T, 1756-EN2T/D
172.18.1.101, 1756-EN2T, 1756-EMN2T/D 1

].
® Path2 H
=]

Iﬂ 172.18.1.106[172.18.1.105], 1756-EN2TR, 1756-EN2TR/C
ackplane, -ATTL

=8 PlantPAx_DAT
5---|‘—,_|ﬂ Communication Setup
o m PlantPA HMI
ED Systermn
Action Groups

Secondary Controller

g 3, 1756-ENZTR, 1756-EN2TR/C 1

] LM PCviallSRE 17-Maode LISE CIP Part 3
< m

Mode: Online

Computers and Groups

=z Networks and Devices

Users and Groups

[Z1 Connections
Permission Sets

|Mot Browsing

- Offline Tag File
hortcut Type Redundant ControlLogix Controller
hortcut Path Timeout (sec.) 2

 Shortout Path Check Interval (sec.) i

Browse. . |

|

lick Apply button to assign selected path to this shortout,

Cancel

Veiify | Help|

18. Select the same IP address of the adapter and the controller that you did
for the data server for the secondary controller in step 10 on page 276.

Observe that our example shows the IP address of 172.18.1.106.
19. Click OK.
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FactoryTalk Linx popup windows appear.

FactoryTalk Linx 2

FactoryTalk Linx 2

[ . 1 Target controller of Redundant ControlLogix Controller is being

configured Save the following changes to the shortcut 'LGXC02'?

Make sure <Primary Controller> and <Secondary Controller> are in the
same Redundant Pair.

Do you want to continue?

Secondary Controller changed
- Old:
- New: 1756-A7/C.LGXC02

Click Yes to apply changes. Click No to discard changes.

20. Click Yes for each message.

Enable Alarm and Event Redundancy
Complete these steps.

1. In FactoryTalk View Studio, right-click
PlantPAx>Area>Alarm>PlantPAx_AE and choose Properties.

zl FactoryTalk View Studio -

File View Settings Tools Window Help
De(Eo o &

Explorer - Pianﬂ’Ax_i—I.Ml

=5 Network (PASSD1)

=iy PlantPAx
&= Runtime Security

Import and Export ...

+& Pllii Server Status...

=@ Systemn IW‘

[ Action Groups ‘

T-D Policies

The Tag Alarm and Event Server Properties dialog box appears.
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2. On the Redundancy tab, check ‘Provide redundancy using a secondary

alarm server.

Gen Redundancy §Priorities and History

E Provide redundancy using a secondary alam senrer.l

Secondary alamm server

Switch back options

® Continue using the secondary server even when the primary
becomes available again.

(O Switchback to the primary server when it becomes available.

3. From the pull-down menu, select the Secondary server.

4. On the Priorities and History tab, verify the alarm severity ranges

and click OK.

Severity Range
Low High

Alarm and Event History
[ Enable history
Datat definition:

Computer name:
Database name:
Cache file path:
|C:"-.Pn:ug|am Data"RockwelAlams

Log language:
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Create Alarm and Event
Database

Use an Engineering Workstation
with these procedures

EWS01

You must create a database to enable Alarm and Event history.
Complete the following steps:

1. From FactoryTalk View Studio Explorer, right-click
System>Connections>Databases and choose New Database.

Explorer - PlantPAx_HMI B
_.@ MNetwork (PASS501)
1 PlantPAx
=3 System
D Action Groups
+[:| Policies
+[:| Computers and Groups
w25 Metworks and Devices
+[:| Users and Groups

The Alarm and Event Historian Database Properties dialog box appears.

2. Contfigure the new database.

a. Type a definition name.

Alarm and Event Historian Database Properties -

General |Size Management I Advanced |

Definition name:

| Production Alarms

Type:

(O Microsoft SQL Server Express (@) Microsoft SQL Server

Computer name:
| ASISO1 | E

Database user name:

[== |

Database password:

Database name:

| ProductionAlarms| | EI

Show Usage. ..

"o | e | e

b. Click the type of SQL Server you want to use.

c. Type the Computer name or click Browse (ellipsis *..") to navigate to
the computer name.

d. Type a Database user name.

e. Type ‘SA’ for the user and the SA password, or use other

known credentials.
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f. Type anew Database name or click Browse (ellipsis “...") to navigate to
a database name.

3. Click OK.
A log on popup window could appear.
4. Type the user name ('sa for the dedicated database).

IMPORTANT  The user name must match the SQL server user account.

SQL Server Log On -

Enter the user name and password of a database user with
system administrator privileges.

User namefl| sa

Password: | oy u | Cancel |

5. Type the password and click OK.

A popup window appears and asks if you want to create the database.

Database does not exist 2

The database will be created. The database user will also be created. If the user
already exists, the user will be assigned access to the database. Do you want to
create the database?

6. Click Yes.
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The SQL Server Log On dialog box appears.
7. Right-click the Alarm and Event server.
The Server Properties dialog box appears.
8. On the Priorities and History tab, check 'Enable history'.
= FactoryTalk View Studio - View Site Edition (Network Distributed) ==l =
Settings Tools Window Help

File View

5| Do o s

PlantPAx_AE Properties

=145 Network (PASSDT)

fn PlantPAx
&= Runtime Security
S0k Area

[ PlantPAx_AE

[k Uata

B PlantPAx_HMI
:D Systermn
[Z3 Action Groups

(21 Policies

(L3 Computers and Groups
== Networks and Devices

Genemll Hed'—'”dand| Priorities and History |I

Priorities
[ Enable server-assigned priorities
Severity Range
Priority Low High
Urgert
Hih
Medium
Low 20|

Alarm and Event History

(2 Users and Groups Enable history
1[Z] Connections Datat definition:
Q Databases |Pr0duction Alams ]
@ Production Alarms
[ Historical Data Computer name: ASIST
..[[] Historical Data ME Database name: ProductionAlamms
#[_1 Permission Sets Cache file path:
|C:\ngmmData'\Rod{well\Narms |
Log language:
[English {United States), en-UUS vl
Application | Communicatons -| Cancel | [ Aoy |[ Heb |
NUM

9. From the pull-down menu, select the database definition.

10. Accept the default Cache file path.

11. From the pull-down menu, select the Log Language.

12. Click OK.
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Define HMI Security This section describes how to configure security for the FactoryTalk View

Site Edition (SE) software.

Configure FactoryTalk SE Security

Runtime security must be set up to provide each account or user group with the
correct FactoryTalk View security codes. The security codes verify that
operators, maintenance personnel, and engineers have permission to run
secured commands, open secured graphic displays, or write to secured tags

at runtime.

IMPORTANT  See Rockwell Automation Library of Process Objects, publication
PROCES-RM00?2, for a list of security codes and descriptions.

Use a PASS with

these procedures. Import FactoryTa/k Site Edition Security Tags

Complete the following steps to import security tags on the PASS.

PASS02A

1. Click the Programs ﬂ symbol and choose Rockwell

Software>FactoryTalk View>Tools>Tag Import and Export Wizard.

" SEHMI Tag Alarm Log Setup | FactoryTalk Activation » | | Rockwell Software
a SE HMI Tag Alarm Log Viewer Help . FactoryTalk Alarms and Events » | L Startup 3
LI SEHMI Tag Alarm Log Viewer | FactoryTalk Historian SE k| VMware 3
SE Service Manager . FactoryTalk Tools » | . Windows Accessories 3
Tag Import and Export Wizard |, Tools . FactoryTalk View | Windows System }
.. User Documentation . FactoryTalk ViewPoint * || Desktop
0 FactoryTalk View Site Edition Client | FactoryTalk ViewPoint ME v |2 FactoryTalk View Studio
Bl FactoryTalk View Studio . RSLinx » ﬂ PC settings
FactoryTalk Administration Console ,Q Search
6 Studio 5000 ﬁ Store
. Roclwell Automation 3

The Tag Import and Export Wizard dialog box appears.

2. From the Operation pull-down, select Import FactoryTalk View tag

CSV files and click Next.

o - Tag Import anc

Select the operation you would like to perform.

Operation
I Import FactoryTalk View tag CSV files V] I

284 Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018


http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm002_-en-p.pdf

Configure the Process Automation System Server (PASS) ~ Chapter 9

3. From the Project Type pull-down, select Site Edition and click Browse
(ellipsis “...).

Choose the FactoryTalk View project you want to import into,
Destination projegts

Project Type:
Project:

The Select Destination Project dialog box appears.

4. Select the path of SE>HMI Projects>PlantPAx_HMIL

10 << SE » HMIProjects » PlantPax_HMI | Search PlantPAx_HMI e |

Organize = New folder = [ @

T

¢ Favorites —~ MName Type Size
B Desktop i KEY File folder
H, Downloads L LNG File folder
“El Recent places M Local File folder

W Mer File folder

18 This PC 1 PAR File folder
i Desktop S| Biree File folder
i| Documents | RecipePro File folder
@ Downloads | Startup File folder
‘H Music 4 TAG File folder
| & Pictures .. TREND File folder
I Videos 1 . TRENDPRO File folder

a Local Disk (C:) : - File folder
v §| | PlantPAx_HMI.sed SED File 39 KB|

File name: |PLantPAx_HMI.sed v| Supervisory Edition Projects ("2 v

5. Select PlantPAx_HMlI.sed and click Open.
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6. Click Next and Browse (ellipsis “...") for the ProcessLibrary4-
SecurityAndConstantsTags.CSV file. This file is distributed with the
PlantPAx Library of Process Objects Library.

Choose the FactoryTalk View project you want to import into,

Destination projects
Project Type: |Sihe Edition

Choose the FactoryTalk View CSV files you want to import.

i Import files
Project: C:'\Users\Public\Documents \RSView Enterprise \SE\HMI

Projects\PlantPax_HMI\PlantP Ax_HMI.sed

7. Click Open.

© = 1|8 » ThisPC » Downloads

Organize = New folder
: ]

4 Favorites = Name e
B Desktop | L] ProcessLibrary4-SecurityAn CSV File
H, Downloads
“El Recent places

1M This PC
_h' Desktop
j’_l Documents
‘i, Downloads
‘n Music
ﬂ Pictures
»i Videos
£, Local Disk (C3)

n T=
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Choose the FactoryTalk View CSV files you want to import.

Import files

[ Tags

[ alarms

8. Click Next twice, and then click Finish.

C:\Users\Administrator SYSTEM\Downloads

ProcessLibrary4-SecurityAndConstantsTags. C5V Choose the import options you want.

Import options

Tags

O Update existing (slower)

Click the Finish button to import the database.

Source
C:\Users\Administrator SYSTEM\Downloads\ProcessLibrary4-SecurityAndConstantsTag:

Destination
C:Wsers\Public\Documents\RSView Enterprise\SEHMI
Projects\PlantPAx_HMIPlantPAx_HMI.sed

Mumber of lines in import files:
Tags: 104lines  Alarms: 0 lines

INFORMATION: Tag Import file 'C:\Users\Administrator, 5YSTEM\Downloads \ProcessLibrary4-
INFORMATION: Folders - Successful Creations 2

INFORMATION: Tags - Successful Creations 100

INFORMATION: {09:32:25) Database import complete,

file 'C\Users\ ADMINI~1.5Y5\AppData\Local\Ternp' 1\ PlantP Ax_HMI.DBI' fc

9. To close the window, click X

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018

287



Chapter9  Configure the Process Automation System Server (PASS)

Setting Group Security
Use an Engineering Workstation Complete these steps to set security permissions to groups on the workstation.
with these procedures.
1. Click the Programs ﬂ symbol and choose Rockwell
Software>Studio 5000.
EWS01 || BOOTP-DHCP Server .
. FactoryTalk Activation 4
| FactoryTalk Alarms and Events 3
| FactoryTalk AssetCentre Agent 4
| FactoryTalk AssetCentre Client 3
. FactoryTalk Historian 5B F | Accessibility 3
| FactoryTalk Tools ¥ | | Administrative Tools 4
. FactoryTalk View v L CGCM 3
| Logix Designer Tools ¥ | |, Embedded Lockdown Manager »
. RSLinx ¥ | |, Hiprom Software 3
.. RSLogix 5000 Enterprise Series ¥ | | Maintenance 3
. RSLogix 5000 Tools ¥ | . Microsoft Office 3
. RSMetWorx ¥ | | Microsoft SQL Server 2008 3
| Utilities ¥ | |, Microsoft SQL Server 2008 R2 4
[Fak FactoryTalk Administration Console . Rockwell Automation 4
Studio 5000 | Rockwell Software |
- . SharePoint 3
| Startup 3
L VMware 3
.. Windows Accessories 4
. Windows Systermn 4
P8 Adobe Reader XI
E FactoryTalk View Studio
}3’ Search

The Studio 5000 splash screen appears.

2. In the Studio 5000 splash page, select a recent project (PlantPAx in the
example).

3. In the Project Explorer, right-click PlantPAx>Projects>PlantPAx
and choose Open Project in Designer.

Project Bxplorer - 1 X
4 Ll PlantPAx
v PlantPAx
" B Lexcor Distributed Control System
v B Lexcoz
v B Lexcos
v B Lexcos
v B Laxcos
BN Pl
4 Iz Open Project in Designer
s Add 3
B Update Project Changes...
4
Commit Project Changes...
b E Delete
4 il Devices Show Owner Mode
b & Proo Properties...

The FactoryTalk View Studio dialog box appears.
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4. To verify that the security tags have been imported, choose
PlantPAx>Area>PlantPAx_HMI>HMI Tags and double-click Tags.

gfile View Settings Tools Window Help

! De(Eo| @ &
Explorer - PlantPAx_HMI =]
=5 Network (PASSD1) ~

-1 PlantPAx

-&= Runtime Security

[ PlantPAx_AE

EF Data
B, PlantPAx_DAT

HMI Tag Alarms
A Alarm Setup
& Suppressed List
‘-3 Logic and Control
: @ Derived Tags

Data Log Models
== RecipePro+

Application J Communicaiions ]

U7 FactoryTalk View Studio - View Site Edition (Network Distributed) - [Tags - /PlantPAx/Area] I;Ii-

Mg rE 4 oo 8

Tag

Name: | Security\AckAlarms |
Type: String Security: SI Prey

Description; | Acknowledge/Reset Alarms |
Mext

Length:

Data Source

Type: () Device  (®) Memory

Tnitial Value: | ABCDEF |
Retentive e

Search For: | Alm |Tag Name Type Description ~

AckAlarms Str Acknowledge/Reset Alj
SecurityVddvancedBatch  String  Exception Processing
Security\BatchException String Exception Processing
Security\BypassFeedbar String Can Bypass Feedback
Securityi\Bypassinterlocl String Bypass Permissives i
SecuritiChangeloopMo  String Change Loop Mode [M
SecurityiConfighlarms String Alarm Configuration
SecurityiConfigConstant: String Configure device cons
SecurityiConfigDeviceBe String Change the setup of th
SecurityiConfigDeviceHk String Change the configurati
SecurityiConfigDeviceTii  String  Configure device time|
»

ERERR R

sy
=

|

—_
p—y

~

MUM

IMPORTANT  If the security tags have not been imported, see Import FactoryTalk
Site Edition Security Tags on page 284 for procedures.

5. In the FactoryTalk View Studio window, double-click
PlantPAx>Runtime Security.

2l FactoryTalk View Studio - View Site Edition (Network Distributed) - [Runtime Security - RNA://$Global/PlantPAx] [ = = -
& File Edit View Settings Tools Window Help HEE

S DeElo o o
Explorer E

2| Systemn

[Z3 Action Groups

1 Policies

+/Z1] Computers and Groups
; =z MNetworks and Devices
[Z3 Users and Groups
+{_] Connections

#1771 Permission Sets

Specify the FactoryT alk Security accounts that will have runtime access to the FactorT alk View SE application.

Click the Security Accounts button to add or remove an account, and to assign &-F security codes. Click the browse
buttonsz [...] to select optional Login and Logout macros for the account,

AccountID: [[ALL USERS] |

Login Macra: | | D Prev
Logout kacro: | | D Mex

Account Login

ALL USERS

The Runtime Security panel appears on the right side of the window.

6. Click Security Accounts 4& .
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The Security Settings dialog box appears.

7. Click Add.
n Security Settings for PlantPAx -
Pemissions I_Eﬁective_F';nissions
‘Wiew permissions by ®) User ) Action
Uszers Computers
@NI Users !ENI Computers

Bemove

Permizzions for All Users from Al Computers.

Action Allow Deny
All Actions O O
FactoryTalk View Security Codes O
| QK | | Cancel | | Help

The Select User and Computer dialog box appears.
8. Click a PlantPAx group and click OK.

Select User and Computer -

Select a uger [or uzer group) and computer [or computer group) pair.

Uszers ~ Computers
5 SYSTEMAAREADS_BASIC BB A4l Camputers
€5 SrSTEMAAREADS_ADVANCED

Each group has its own security code. €5 SYSTEMAPLANTPAX ENGINEERING
For example, ‘A" for Operators, ‘B’ for €] SYSTEM\PLANTPEX MAINTENANCE
Operating Supervisory. - €51 SYSTEMAPLANT P MAINTENANCE .
€51 SYSTEMAPLANTPAX MANAGER q
€51 SvSTEMVPLANTPAX OPERATING SU.

Seea list ofsecurity codes on page 291. QSYSTEM\PLANTPAX OPERATORS
- -,
< m >
Filter Uszers Filter Computers
(®) Shaw groups only (®) Shaw groups only
() Show users anly O Shaw computers only
O Show all O Show all

The group name appears in the top half of the Security Settings
dialog box.

Cancel | | Help |

9. Repeat step 7 and step 8 until all PlantPAx groups are selected.
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10. Select 'All Users' and click Remove.

You can assign security to each PlantPAx group based on letters (A...G).

Security Settings for PlantPAx -
Permissions | Effective Permissions n Security Settings for PlantPAx -
Wigw permizsions by (7 At N
i ! Vs & Pemissions | Effective Permissions
— il i ‘Wiew permissions by ®) User ) Action
I !ﬁﬂll Users !EAII Computers I_
= Uszers Computers ~
g SYSTEM\PLANTPAX ADMINISTRA’@NI Computers g SYSTEM\PLANTPAX MAINTENANC@NI Computers
€5 SYSTEM\PLANTPAX ENGINEERING @8 All Computers €51 SYSTEM\PLANTPAX MANAGER B All Computers
€} SYSTEM\PLANTPAX MAINTENANC B8 Al Compters v 0 3 =
= = €5 SYSTEM\PLANTPAX OPERATORS @ All Computers "
Add... I Remave I = = =
Permizzions for All Users from Al Computers. ] .
Action Allow Deny | s | | Lo |
All Actions O O Permizzions for 5YSTEMAPLANTPAX OPERATORS from All Computers.
FactoryTalk View Security Codes O Action Allow Deny |~
All Actions a o |=
B FactoryTalk View Security Codes O O |
A O
B O
E O
D O i
< [ >
QK | | Cancel | | Help

| Cancel || Help

11. Select a group from the Users list.

The default is that all FactoryTalk View Security Codes are
checked Allow.

12. Click the Deny checkbox beside the FactoryTalk View Security Codes

that you do not want to allow permission for the selected account.

For example, allow security of ‘A’ for an Operator but deny ‘B; ‘C’, ‘D"

Table 27 - Recommended Group Security Codes

Group Security Code
Operators A
Operating Supervisor B
Maintenance C
Maintenance Supervisor D
Engineering E
Manager F
Administrator G

13. Click OK.

14. Repeat stepl1 through step 13 for each user or group account that you
want to set up with runtime security.
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The PlantPAx groups that you set up with runtime security appear in the
Account section of the Runtime Security dialog box.

292

ol

=

File

FactoryTalk View Studio - View Site Edition (Network Distributed) - [Runtime Security - RNA://$Global/PlantPAx]

Edit View Settings Tools

S DeElo o o

Window Help

<

g Tags

/(1] Graphics

S59 HMI Tag Alarms
- Alarm Setup
-dgw Suppressed List
Legic and Control
@ Derived Tags
6 Events

-[& Macros

-8 Client Keys

=3 Datalog

-EF Data Log Models

= T PP .

i ApplicalimJ Communicaiions ]

BE |
HEIE]

Explorer - PlantPAx_HMI @
= @ Ne"cj\clvorkpf:xASSD‘l] Specify the FactoryT alk Security accounts that will have runtime access to the FactoryT alk View SE application.
T aﬁ ant ; = Click the Security Accounts button to add or remove an account, and to assign A-P security codes. Click the browse
&= Runtime Security buttons [...] to select optional Login and Logout macros for the account.

Area

[EF Alarm Account 1D; |[F'LANTF'A>< ADMIN] |
[ PlantP A AE = ! _ =

_:F Data Login Macro: | | D 5

_i B, PlantPAx_DAT Logout Macro: | | |:|

= [ PlantPAx_HMI
-[2] Command Line
=3 HMI Tags Account Login

[[PLANTPAX ADMIN

[SYSTEM\PLANTPAX ADMINISTRATOR]
[SYSTEM\PLANTPAX ENGINEERING]
[SYSTEM\PLANTPAX MAINTENANCE SUPERVISOR]
[SYSTEM\PLANTPAX MAINTENANCE]
[SYSTEM\PLANTPAX MANAGER]
[SYSTEM\PLANTPAX OPERATING SUPERVISOR]
[SYSTEM\PLANTPAX OPERATORS]

For Help, press F1

MUM

15. Click Save
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Configure PanelView Plus

Use an Engineering Workstation
with these procedures

EWS01

This section describes how to configure the HMI Machine Edition software
for use with PanelView applications.

Create a FactoryTalk View ME Project

In this section, you create a FactoryTalk View ME project.

Complete the following steps:

1. Click the Programs ﬂ symbol and choose Rockwell

Software>Studio 5000.
|| BOOTP-DHCP Server N 4
. FactoryTalk Activation 4
| FactoryTalk Alarms and Events 3
| FactoryTalk AssetCentre Agent 4
| FactoryTalk AssetCentre Client 3
. FactoryTalk Historian SE F | Accessibility 3
| FactoryTalk Tools ¥ | | Administrative Tools 4
. FactoryTalk View v L CGCM 3
| Logix Designer Tools ¥ | |, Embedded Lockdown Manager »
. RSLinx ¥ | | Hiprom Software 3
.. RSLogix 5000 Enterprise Series ¥ | | Maintenance 3
. RSLogix 3000 Tools ¥ | . Microsoft Office 3
. RSMetWorx ¥ | | Microsoft SQL Server 2008 3
. Utilities » | |, Microsoft SQL Server 2008 R2 3
[Fa} FactoryTalk Administration Console . Rockwell Automation 4
Studio 5000 . Rockwell Software
. SharePoint 3
| Startup 3
L VMware 3
. Windows Accessories 3
. Windows Systermn 4
Adobe Reader XI
E FactoryTalk View Studio
}:’ Search

The Studio 5000 splash screen appears.

2. In the Studio 5000 splash page, select a recent project (PlantPAx in
the example).
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3. Drag the desired PanelView object (2711P-K15C4A9 in the example)
from the Library Management panel and drop it in the Process

Area panel.
Process Area” bl ll Toolbox - 31X
“ B Filtar. YT -
Distributed Architecture - Single Process Server Au lam“ 4 Product Catalog -
I Computers
ASE02A WS01
+ Distributed 1/0 Modules
(| * Drives
* Motion Control
* Network Infrastructure

* Programmable Control Systems

4 \fisualization

* Generic Computer
4 (Graphic Terminals
4 F711P PanelView Plus 6 Graphic Terminal
[+ 44inch Displays, 400 Model
B4nch Displays, 600 Model
* F4inch Displays, 700 Model
10Hnch Displays, 1000 Model
* 124nch Displays, 1200 Mode!
4 154inch Displays, 1500 Mode!
B 2711P-B15C4A8
[ 2711P-B15C4A9
B 2711P-B15C408
B 2711P-B15C409
L 2711P- 448

2711P-K15C4A9

| o4l

LGXcoz LGXCO3 LGXCO4

| 50% -8 8 ;
AL S el 2 [ 2711PKI5C4D9

B 2711P-T15C4A8
B 2711P-T15C4A9
B 2711P-T15C408
B 2711P-T15C409
+ 2711PC PanelView Plus & Compact Grapk

MName Kind Type Ci i | i D ipii

The new graphic dialog box for the PanelView object you selected (1500
PanelView Plus 6 in the example) appears.

4. Type the name of the PanelView graphic (PVS001 in the example).

# New 15-inch Displays, 1500 Model 2711P PanelView Plus 6 _.

Name: [Pvs0o1 |

Description:

IE fddress; [172 .18 . 1 . 29|

Catalog Number: ’W b |
i| ok [N Cancel |

5. Type the IP address of the PanelView object and click OK.

The new project dialog box for the PanelView object appears.
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6. Type the name of the PanelView project (PVS001 in the example) and
click OK.

% New 15-inch Displays, 1500 Model 2711P PanelView Plus.

Name: I PVS001 I |

Description:

Resolution: PVPlus 1500 (1024x768)
Scale Replace Displays
[T] Scale OnTop Displays

Language: | English (United States), en-US 7] |

7. Connect any port on the switch to the PanelView.

Process Area”
Distributed Architecture - Single Process Server
®
2]
= Connection
i
LGXCo2 LGXCO3 LGXCD4 LGXCD5
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8. Drag the communications module from the chassis (LGXCO1 in the
example) and drop it on the PanelView.

Process Area”

o ; ; Rockwell
Distributed Architecture - Single Process Server -
P IantP AX Automation
Distributed Control System

ASS0EA

The Configure Module dialog box appears.
9. Click OK.

i Configure Module =
Type: 1756-EN2T 1756 10/100 Mbps Ethernet Bridge, Twisted-Pair M...
Vendor: Rockwell Automation/Allen-Bradley

Parent: PV5001

Name: LGXCOTENDTA

Description:

Revision: H 1

Slot:

Address / Host Mame

) Private Network: 1921681, 1

© IP Address: 72 18 . 1 1od

) Host Name:

Cancel
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10. Drag the controller module from the chassis (LGXCOI in the example)
and drop it on the PanelView module.

Process Area”

P’antPAX Distributed Architecture - Single Process Server An‘:noo':mgﬂ
Distributed Control System e o
-

LGXCOZ LGXCO3 LGXCOD4 LGXCO5

The Add New or Modify Existing Shortcut dialog box appears.
11. Click OK.

" AddNew or Modify Existing Shortcut |26

FactoryTalk Lire data servers:

4 B PVS001
"i FactoryTalk Lirx

Shortcut name:
LGXCO1 v]
MNew path:  172.18.1. 172.18.1.
Offline tag file:
|C:\Users‘-.Administmtor.SYSTEM‘\Documents‘\Studio 5| | Browse... |

G
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12. In the Project Explorer panel, right-click the project name (PVS001 in
the example) and choose Commit Project Changes.

Project Explorer
- PlantPAx
4 Projects P’antPAX Distributed Architecture - Single Process Server
- B Lexcor Distributed Control Systom s i
b B Lexco2 & !
PV3001
B Lexcos a
b B Lexcos
> B Loxcos
" §2 PlantPAx
.
=5 P‘J"Si Open Project in Designer
B Fact{  adg R
4 = Devices
C B Commit Praject Changes...
Delete
Show Owner Mode
Properties...
PYS001 (2711P-K15C4AS) —1['1
4 B FactonyTalk Linx, 172.18.1.29
4 & Btherlst, Bthemet
4 17218.1.100, 1756-EN2T, LGXCOTEND
4 T 1756-A4, LGXCOTROD LEXCO4 LGXC0S
fl 0. 1756175, LGXCO1
The Commit Summary dialog box appears.
13. Click Commit.
A Studio 5000 Architect Commit Summary |

298

The following changes will be committed to the associated project(s); any projects containing emors will be skipped.

4 [ View ME Station - PVS001

@ APP PVS001 will be committed.

o HMI PVS001 will be committed.

o The shortcut "LGXC01" of Factory Talk Liree server "RSLirx Enterprise’ will be created.
o The device LGXCOTENDTA will be created.

o The device LGXC01" will be created.

@ RSLE RSLinx Enterprise wil be committed.

[ Always show this dialog Help I Commit I Cancsl
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4 Studio 5000 Architect - PlantPAx

Project Explorer -~ 0 X

4 PlantPAx

a Projects
B Lexco
B Lexcoz
B Lexcos
B Laxcos
B Lexcos
B8 PlantPAx

14. Click Close to close the Committing Projects dialog box.

7 Studio 5000 Architect Commit Progress -
Committing project changes. This process could take some time depending on the size and number of projects.

v PVsSOD1
v Finished
0 Emor(s), 0 Waming(s)

15. In the Project Explorer panel, right-click the project name (PVS001 in
the example) and choose Open Project in Designer.

FILE EDIT VIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW HELP
e o X92-C-. k A/ OO ControlNetCable -FI [ & . & 2 & .

c1

P’antPAX Distributed Architecture - Single Process Server
i

“B Facl Add

Communications - Process Properties...

[Pusom (2711P-K15C409)

4 Devices Update Project Changes...
b & Pr ° Commit Project Changes...
Delete
Show Owner Mode

4 B FactonyTalk Ling, 17218129
4 Fr BtherNet, Ethemet
4 f] 172121100, 1756-EN2T, LGXCO1END
a [l 1756-A4, LGXCO1R0D
A 0. 1756175, LGXCO

Distributed Control System P! it
- o | Puse
= &
®
13
!
LGXCO2Z LGXCo3 LGXCO4 LGXCD5

The FactoryTalk View Studio window appears.

TIP Do not close this window as it is used in later procedures.
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Configure FactoryTalk View ME Security

Runtime security must be set up to provide each account or user group with the
correct FactoryTalk View security. Complete these steps.

1. If the FactoryTalk View Studio window is not already open, do the
following:

a. Click the Programs E symbol and choose
Rockwell Software>Studio 5000.

b. In the Studio 5000 splash page, select the PanelView project.
c. In the Project Explorer, right-click on the PanelView project and

choose Open Project in Designer.

2. In the Explorer panel of the FactoryTalk View Studio window,
double-click PVS001>PVS001>PVS001>System>Runtime Security.

2l FactoryTalk View Studio - View Machine Edi
File Edit Setup View Application Tools Windo

FES De 2Ec o 8cE

Explorer - PVS001 [=]
=45 PVSOD1 (EWSD1) ~
=i oy PVSO0T
=8, pyson
=253 Systemn
=

EB Audit Trail Setup
28 CSV Export Setup
G} Global Connections
w Startup
=34 HMI Tags
L Tags
=3 Graphics
+E Displays

[ Global Objects

Eﬁ Symbol Factory

+@' Libraries

+E Images
[f] Parameters
Local Messages
-5 Alarms
ﬁ Alarm Setup
=1 Information
% Information Setup

Appllcanm J Communicaiions ]

The Runtime Security window appears.
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3. Click Add to insert local users groups.

& Runtime Security - /PVS001/ [=][=]B

ME Runtime 4.00 and later | ME Runtime 3.20 and earlier

Uze this tab to specify the FactoryT alk. Security accounts for Machine Edition Runtime [MER] versions 4.0 and later.
Select a FactoryT alk Security account with the Add button and then assign A-P security codes. Click the browse
buttonz [...] to select optional Login and Logout macros for the account,

AccountD:  [DEFAULT | (oot e

Vs Ve Mc MD
Login Macrao: | ||:| VIE WF WG @H Prev

LogoutMacro:| ||:| M [ WK ML
Add... Remove WM MN M0 WP

Account A|B|C|D|E|F|G|H|I |J |K|L|M|N|O|P|Login ~
2
3
4
5
1
7
8
9 b
< >

4. Choose Create New> User group in the Select User or Group window to
create PlantPAx user groups.

Select User or Group | = [ & - New User Group -

General
QAII Users
@Administrators MName: PlantPAx Operators

g Authenticated Users

indows Administratars Bescripton:
gﬁuest Users E-mail: | |
Members:

Boetion ] Gergon.

Filter Uzers Windows linked user group.
) Show groups only

() Show users only

(E) Shaow all Remove...

ak. Cancel | | Help

The New User Group dialog box appears.
5. Type the user group name and click OK.
6. Repeat step 4 and step 5 for all desired PlantPAx user groups.
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7. Click ‘Show users only” and then click Create New>FactoryTalk User

8. In the General tab of the New User dialog box, type the PanelView user

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018

to create a user.

Select User or Group | = I:'-
QAIIUsers

@Administrators
g Authenticated Users
€7 FlantPax Admin
!ﬁ FlantPas Engineering
!ﬁ PlantPas Maintenance
!ﬁ PlantPas Maintenance Supervisor
!ﬁ PlantPs Manager
!ﬁ FlantPax Operating Supervizor
!ﬁ PlantPas Operators
indows Administratars
g Guest Users

Filter Uzers

Show groups only

how users only

() Show gll

ak. | Cancel || Help

name followed by a password.

Select User or Group | = I:'-

&Anon}lmous Logon

FactoryTalk User...

\imndowslinked USEr...

Filter Uzers
(O Shaw groups oy

(®) Show users only

() Show gll

ak. | Cancel || Help |

Mew FactoryTalk User

General | Group Membership

User name: IOpemtor

Full name: |

Description: |

E-mail: |

User must change password at next logon
User cannot change password
Password pever expires

[ Accourt is disabled

Password:

Corfirm:
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9. In the Group Membership tab, click Add.
10. Select a PlantPAx group and click OK.

Mew FactoryTalk User -
Generzl | Group Membership |I
Membefar:
Select User Group | = [2 -
@Administrators
€7 FlantPax Admin
!ﬁ FlantPas Engineering
!ﬁ PlantPas Maintenance
!ﬁ PlantPas Maintenance Supervisor
!ﬁ PlantPs Manager
bRl nasabings nervizor
[ ok |[ cCancel || Hep [ Cancel | [ Hep
11. Click OK.
Mew FactoryTalk User -
Group Membership
Member of:
ﬁPIamPP« Operators |

I oK I| Cancel | [ Heb

IMPORTANT  Observe that the selected group is being added to the user; the user is not
being added to the group.

12. Repeat step 8 through step 11 for all desired users.
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13. Click Add to insert all PlantPAx user groups.
& Runtime Security - /PVS001/ [=][=]x]
ME Runtime 4,00 and later | ME Runtime 3.20 and earlier
Uze this tab to specify the FactoryT alk. Security accounts for Machine Edition Runtime [MER] versions 4.0 and later.
Select a FactoryT alk Security account with the Add button and then assign A-P security codes. Click the browse
buttonz [...] to select optional Login and Logout macros for the account,
Soeuriy Codos Select User or Group | = [ & -
AccountD:  [DEFAULT | iy
4 VB MC MD
Login Macro: | | |:| QA" Users
E MF WG VH
Logout kacro: | | |:| W ¥ MK ML 3
M VN V0 VP
Remove am " ng
!ﬁ PlantPas Maintenance
Account AlBIC|IDIE|F|G !ﬁ PlantPas Maintenance Supervisor ~
!ﬁ PlantPs Manager
!ﬁ FlantPax Operating Supervizor S
2 !ﬁ PlantPas Operators
3 gw’indows Adminizstrators
4 ] Giuest Users
5
6
i
8 Filter Uzers
9 (® Show groups only
10 () Show users only
n O Show all
12
13
Cancel Hel
14 | [ el
15 v
>
14. In the Select User or Group dialog window, select a User Group and
click OK.
The group name appears in the Account list.
15. Repeat step 13 and step 14 for all desired groups.
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We recommend that you remove the default security codes if you are
using the Process Library objects. For more information, see the
Rockwell Automation Library of Process Objects Reference Manual,
publication PROCES-RM002.

& Runtime Security - /PVS001/ [=][=]B

ME Runtime 4.00 and later | ME Runtime 3.20 and earlier

Uze this tab to specify the FactoryT alk. Security accounts for Machine Edition Runtime [MER] versions 4.0 and later.
Select a FactoryT alk Security account with the Add button and then assign A-P security codes. Click the browse
buttonz [...] to select optional Login and Logout macros for the account,

| Security Codes

AccountD:  [DEFAULT
Os Oe Oc Oo

Login Macre: | ||:| Oe OF Os [OH
Logout kacro: | | |:| Ok OL
Add... Remove Lo [P
YYYYYYYYYYYYYYYY
2 IPEANTPAEX ADMIN] YYYYYYYYYYYYYYYY
3 |[PLANTPAX ENGINEERING] YYYYYYYYYYYYYYYY
4 |[PLANTPAX MAINTENANCE SUPERYISOR] Y ¥ Y Y Y Y Y Y YYYYYYYY
5 |[PLANTPAX MAINTENANCE] YYYYYYYYYYYYYYYY
6 |[PLANTPAX MANAGER] YYYYYYYYYYYYYYYY
7 |[PLANTPAX OPERATING SUPERYISOR] YYYYYYYYYYYYYYYY
8 |[PLANTPAX OPERATORS] YYYYYYYYYYYYYYYY
< >

16. For each of the user groups, click a user group in the account section and
type Y’ (yes) or ‘N’ (no) for the respective security codes.

17. Click Close when all security codes are assigned to the groups.

18. When asked, confirm that you want to save Runtime Security.
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Configure Time Synchronization for PanelView Terminals

PanelView terminals are used for applications that monitor, control, and
display information graphically. The terminals provide operators a quick and
efficient status of their application.

Complete the following steps for the controller project:

1. If the Studio 5000 Logix Designer® application is not already open,
do the following:

a. Click the Programs E symbol and choose
Rockwell Software>Studio 5S000.

b. In the Studio 5000 splash page, select the controller project.
c. In the Project Explorer, right-click on the controller project and

choose Open Project in Designer.

2. When not using the 1756 HP -TIME module, create a Get System
Value (GSV) instruction to capture the controller clock, according to
the example that follows.

e Class Name — WallClockTime
e Attribute Name — LocalDateTime
e Dest — Create a DINT array [7] (LocalDateTime[0]...[6])

GSV ~
Class Name

WallClockTime —

lame LocalDateTime
LocalDateTime[0]
20174

Tag Element: LocalDateTime[0]
Element Data Type: DINT

Tag Data Type: DINT[7]

Tag Scope: Controller

Value: 2017

TIP  We recommended that this GSV instruction be triggered every
minute (60 seconds).

Complete the following steps for the PanelView project:

1. If FactoryTalk View Studio is not already open, do the following:

a. Click the Programs E symbol and choose
Rockwell Software>Studio 5000.

b. In the Studio 5000 splash page, select the PanelView project.

c. In the Project Explorer, right-click on the PanelView project and
choose Open Project in Designer.
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2. In the FactoryTalk View Studio window, double-click
PVS001>PVS001>PVS001>System>Global Connections.

FactoryTalk View Studio - View Machine Edition

zl

Eile Edit View Application Tools Window Help
HLEE DE#E = 0 &c
Explorer - PVS001 [=]
=1 PVS0DT (EWSO1) ~

=ik PVS0D1
= PVs0o1
== System
Project Settings

‘-3 Graphics
[ Displays

[#] Parameters

23 Alarms
Bl Alarm Setup

[ Global Objects

& Runtime Security
® Diagnostics List Setup
EH Audit Trail Setup

Local Messages

BE |

&

Global Connections - /PVS001/

B |

Date and time output interval [seconds]: J@

Date and Time ] Display1 Macro | Backlight | Memory |

Maimurn update rate: |4 v} zeconds

Connection

Tag or expression

Expm

‘rearn

Day of Week:

Manth:

[ray of Month:

Hour:

Miriuite:

Second:

Remate Date and Time:

Remate rear:

Remote Maonth:

Femote Day of Month:

Remate Hour:

Remate Minute:

Remote Second:

l Tag

The Global Connections panel appears at the right side of the window.

The following steps create Remote Time references.

3. For the first remote connection, click the Browse button (ellipsis “...).

4. Find the proper tag and click Open.

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018

307



Chapter9  Configure the Process Automation System Server (PASS)

The tag appears in the Tag expression column.

5. Repeat step step 3 and step 4 for the rest of the remote connections.

= FactoryTalk View Studio - View Machine Edition - [o [
Eile Edit View Application Tools Window Help

FES De 2E < o a8

Explorer - PVS001 Birs Global Connections - /PVS001/ [=[=]3
=45 PVSOD1 (EWSD1) ~
‘Eﬂ PVS001 Date and time output interval [seconds]: 150 Maimurn update rate: |4 v} zeconds
_®évzigem Date and Time ] Display1 Macro] Backlight] Memory]
l_E-I Project Settings Connection Tag or expression l Tag | Expm
- & Runtime Security ear e
® Diagnostics List Setup = Dap of Week: ses
B8 Audit Trail Setup Manth:
[ray of Month: 11+
Hour: s
Miriuite: s
Second:
Femate Date and Time: {LGXCO LocalD ateTime]5).0F ey +re
Femate Year: {LGXCO LocalD ateTime[0]} ey R
= 2 Remote Maonth: A[LGHCO LacalD ateTime[1]} res rer
73 d Grap.hlcs Femate Day of Month: {{LGXED‘I }LocalDateTimeH} 1aas +er
=[] Displays Remote Hour: {[LGXCO1 LocalDateTime[3]}
[ Global Objects Remate Minute: {[LGACON LocalD ateTimel4]}
i Symbol Factory : ALGHCOT JLocalD ateTime[E]: pee ses
@' Libraries
+E Images
-[#] Parameters
Local Messages
-ﬂ Alarms ¥ 0Ok | Cancel Help

Application | Communicasons |

NUM

When using the 1756 HP -TIME module, information is available.
e

Scope: | [EILGXCOT v| Show: |NITags V”Y.local V|
Name -2|a Value + Force Mask il Properties v 0
P Locak3:l.Time.Status 2#0000_0000_0000_0000_0000_0000_1000_0101 4 General
Local:3:1.Time TimeValid 1 Name Local:3:1.Time
Local:3:1.Time. CIPSyncOutputEnabled 0 Eescrlptlon
sage
Local:3:1.Time.NTPOutputEnabled 1 T e
ype Base
Local:3:L.Time|RIGBEQutputEnabled 0 Alias For
Local:3:1.Time.C5TMasterEnabled 0 Base Tag
Local:3:l.Time.CSTMastership 0 Data Type HT:1736HP_CLO...
S LGXCO1
Local:3:1. Time.CSTDuplicateDetect 0 i e,
External Acc... Read/Write
Local:3:l.Time.SimulationModeActive 1 Style
P Locak3:|.TimeYear 2017 Constant Mo
P Local3:l.Time.Month 12 = Required
b Local:3:.Time.Day 12 Visible
X Permission Set < Controller Inhe...
b Locak3:.Time.Hour 1
b Data
b Local3:l.Time.Minute 1l b Produced Connection
b Local3:[.Time.Second 6 b Consumed Connection
b Local:3:l.Time.MicroSecond 924702 » Parameter Connections {0:0}
b Local:3:LUTC £ il
P Locak3:|.CST Fi Ee|
P Locak3:.C5TOffset ik {..
P Locak3:l.GPS Ty 1
4/[»|'{ Monitor Tags |£ Edit Tags / < m [ »
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Download the Application

This procedure downloads the runtime application file from the workstation
to the PanelView.

Complete the following steps:

1. If the FactoryTalk View Studio window is not already open, do the
following:

a. Click the Programs E symbol and choose
Rockwell Software>Studio 5000.

b. In the Studio 5000 splash page, select the PanelView project.

c. In the Project Explorer, right-click on the PanelView project and
choose Open Project in Designer.

2. From the Application menu, choose Create Runtime Application.

Zl FactoryTalk View Studio - View Machine Edition = [ 1= -
File View | Application Tools  Window Help

m 3 L ati
Explorer —
=145 PVSE— -
'Eﬂ P\ Application Properties...
=L 5
|§| Project Settings
-& Runtime Security
® Diagnostics List Setup
-EH Audit Trail Setup
.28 CSV Export Setup
G} Global Connections
W startup

ViewPoint Administration

The Create Runtime Application dialog box appears.
3. Click Save to accept the default file name.

@\ <] m

Network

File pame: | PWS001 . mer ] |

Save as type: | Runtime 10.0 Application {~.mer) W |

Conversion to development application

®) Always allow conversion
() Mewer allow corersion

() Conversion protected by password

FactoryT alk ViewPoint version

Include YiewPoint content
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4. In the FactoryTalk View Studio ME window, click the

Transfer Utility [=* |icon.

2 FactoryTalk View Studio - View Machine Ec
File View Application Tools Window Help

& De 2El=]e &

|Explorer - PVS001

Transfer Utility

& Runtime Security
LIS Miannnctics |ick Setun =

The Transfer Utility window appears.

5. Verify the Source file default path and select the destination
PanelView terminal.

6. The first time that you download this file, click Replace
Communications.

7. Click Download.

=l Transfer Utility

D ownload Upload ] Compare

Iiﬁ:\U zersiPublichD ocumentshR SYiew Enterprise\ME \Runtime\FYS 0071 mer

[T Dowrload as: ]PVSDD‘I

Destination storage type:
1 Internal Storage :J WARNING:

1N

¥ Fun application at start-up Include a goto configure mode button in your application if
= when application runs ——————— you need to access the configuration mode screens.
iienbo brmtcalns Include a shutdown button in vour application if you want to

|1 Delete Log Files be able to shut it down,

Select destination terminal:

=2 FactoryTalk Lin, EWS01 [~
39 1789-A17, Backplane
@ EtherNet, AB_ETH-1

@ EtherNet, AB_ETHIP-1

172.18.1.29, PanelView Plus 6 1500, PanelView Plus 6 1300
ﬂ 172.18.1.101, 1756-EM2T, 1756-EN2T/D
g 172.18.1.102, 1736HP-Time/B, 1756HP-TIME/B v

Mode: Select  |Not Browsing
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8. When the download completes, a dialog box notifies you that the
download is successful.

Transfer Utility

|'0'I The download has completed successfully.

9. Click OK.
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Notes:
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Considerations

Configure an Application Server Information
Server (AppServ-Info)

IMPORTANT  Before starting this chapter, make sure that the FactoryTalk® Historian
template has been deployed and initialized. If you are not using the
Historian template, refer to Knowledgebase Answer ID 491889 - Migrating
and/or Upgrading to FactoryTalk Historian Site Edition
at https://www.rockwellautomation.custhelp.com.

This chapter describes procedures for configuring the Information
Management application server (AppServ-Info) with the
FactoryTalk View Historian Site Edition (SE) software and the
FactoryTalk® VantagePoint” server.

The Historian SE tool lets you collect, manage, and analyze real-time data from
the PlantPAx” system.

IMPORTANT  We do not recommend installing data management (Historian) and
decision reporting (VantagePoint) software on the same AppServ-Info
server for small-scale applications. Use separate servers to
maximize performance.

The VantagePoint software tool helps make informed business decisions with
the plant floor data used as a gauge of the manufacturing process. You can use
the VantagePoint software with mobile devices, tablets, and phones to generate
reports via importing historical data tags.

Consider the following suggestions before starting this chapter:

FactoryTalk Historian

e When you plan your FactoryTalk Live Data location, be sure to enable
buffering and high availability with failover capability.

o Consider a collective if you want high availability with redundant
Historian servers.

FactoryTalk VantagePoint
Although the procedures in this chapter only expose historical data, you must

decide the type of report variables that are required to generate your
manufacturing intelligence.
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Figure 17 shows the topics that are described in this chapter. Click or see the

page number for quick access to a section.

Figure 17 - AppServ-Info (Historian) Workflow

« (reate a Firewall Rule for Primary Historian Server

Configure Historian SE Server Collective Create a Firewall Rule for Secondary Historian Servers
« Change the Historian Identification
See page 315 - Set Security Settings
« (reate a Server Collective
Configure a Historian SE Server - Create a Historian Server
> « Create a Default Node Interface
See page 331 - Create a Synchronization Path

Configure a Node Interface - Configure Primary Node Interface Server

- (onfigure Secondary Node Interface Server

See page 342

Configure FactoryTalk Live Data Connectors | « Configure a FactoryTalk Live Data Primary Connector
- (onfigure a FactoryTalk Live Data Secondary Connector
See page 358 - Confirm Unit Failover Diagnostics

- (reate PIPerfMon System User

Configure Performance Monitor Interface |+ Confiqure the PiPerfMon Interface
« Import PIPerfMon Digital State

See page 373 « (Create PIPerfMon Interface Health Points
l - Monitor PIPerfMon Interface
Enable Performance Monitor « Adding PIPerfMon User

«  Adding PIPerfMon Firewall Rule

See p_aTe 387 - Enabling PIPerfMon Counter Service

Configure FactoryTalk Historian Connectivity

See page 396

View Pl Builder Excel Add-in

See page 398

h
FactoryTalk VantagePoint Historian Tags

See page 399

h 4

Chapter 11 Configure Asset Management (AppServ-Asset)
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conflgl."e Historian SE Server IMPORTANT  Aserver collective is required for high availability. If you are not using a
Collective collective, skip to Configure a Historian SE Server on page 331.

Use the Historian servers A server collective consists of two FactoryTalk Historian SE servers (primary
with these procedures. and secondary) that have the same configuration database. The collective
provides the same association between the key values in the FactoryTalk
Historian SE tables on all servers. The collective also helps confirm that the

H H archive data files have the same structure on all servers.

ASIHO1A ~ ASIHO1B Keep the following in mind regarding server collectives:

e When creating a server collective, you must always us fully qualified host
names, not IP addresses. Therefore, the name resolution functionality
must work on the network.

e If you make one or more FactoryTalk Historian SE servers members of a
collective, you must restart them after the server collective is created.
Otherwise, FactoryTalk Administration Console does not recognize any
of the third-party tag licenses you have on your servers.

e To create a server collective on computers that have the Windows
Firewall turned on, you must manually open the TCP 445 port between
the two computers. See the Microsoft documentation for more
information.

e The Windows user that configures server collectives must be a domain
user and must be mapped to the piadmin user.

e The same "Windows user to piadmin user mapping' must be performed
on both the primary and secondary server in the collective.

e Activate your server collective in the FactoryTalk Administration
Console.

Create a Firewall Rule for Primary Historian Server

This section describes how to create an inbound rule for your

Windows firewall on the primary Historian server (ASIHO1A). Be sure

to add the 445 rule for FactoryTalk SE even if you see existing rules that allow
port 445.

Complete the following steps.

1. In the bottom left corner of the Windows Desktop, click the

Windows I icon.
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2. Click Control Panel and choose Windows Firewall.
P Action Center {+] Administrative Tools ["gd AutoPlay
Kl Color Management [E Credential Manager @ Date and Time
Default Programs s Device Manager @ Devices and Printers
= Display @' Ease of Access Center Folder Options
\a Fonts @ Internet Options &% i5CS! Initiator
&2 Keyboard “;3‘ Language F Mouse
¥ Network and Sharing Center Motification Area lcons [ Phone and Modem
@ Power Options [& Programs and Features 9 Region
™ RemoteApp and Desktop Connections % Sound 1B System
ﬂTaskbar and Mavigation 12| Text to Speech [ Troubleshooting
82, User Accounts @ Windows Firewall & Windows Update
The Windows Firewall Window appears.
3. Click Advanced Settings.
7y
e v 1 | <« All Control P:
Control Panel Home
Allow an app or feature
through Windows Firewall
[‘;i' Change notification settings
[‘;i' Turn Windows Firewall on or
off
B Restore defaults
f‘g\ Advanced settings
Troubleshoot my netwaork
The Windows Firewall with Advanced Security window appears.
4. Right-click Inbound Rules and choose New Rule.
F Win
File Action View Help
&= 2= =
' Windows Firewall with Advance RITGTTTEHT S
[EG3 Inbound Riglage
Outbound New Rule...
2a Connectio Filter by Profile WL
- B Monitoring .
Filter by State b xe
Filter by Group (5
Exe
View 3
Be
Refresh nthu
Export List... nthiL
nthc
Hel
£ —_ ML
|| @E\rentf_lientML
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The New Inbound Rule Wizard - Rule Type window appears.
5. Click Port and then click Next.

4 New Inbound Rule Wizard x|

Rule Type

Select the type of firewall rule to create.

Steps:
» PRule Type Wwhat type of rule would you like to create?
» Protocol and Ports
@ Action ) Program
@ Profile Rule that controls connections for a program.

@ Name ® Paort

Fiule that contrals connections for a TCP or UDP port.

O Predefined:

BranchCache - Content Retrieval [Jses HTTF]

Fiule that controls connections for a ‘Windows experience.
) Custom

Custom rule.

< Back I Mest » I | Cancel

6. Click Specific local ports, type 445" in the text box, and then click Next.

& New Inbound Rule Wizard -

Protocol and Ports

Specify the protocals and ports ta which this rule applies.

Steps:
@ FRule Type Droes this rule apply to TCP ar UDP?

@ Protocal and Ports

@ Action
@ Profile

@ Mame
Dioes this rule apply to all local ports or specific local ports?

O All local ports

® Specific local ports:

< Back I| Mest » |I| Cancel
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7. Click Next on each of the successive dialog boxes to do the following:
e Allow the connection

o Apply the rule to the Domain, Private, and Public
The New Inbound Rule Wizard - Name appears.

8. Type a name for this rule (Collective Connection in the example) and
click Finish.

4 New Inbound Rule Wizard x|

Name

Specify the name and description of this rule.

Steps:
@ FRule Type

@ Protocol and Ports

@ Action
@ Profile -

Collective Connection ﬂ
@ Mame

Deszcription [optional]:

< Back I| FEinigh |I| Cancel

Your inbound rule for your firewall is created.
Create a Firewall Rule for Secondary Historian Servers

To create an inbound rule for your Windows firewall on secondary Historian

servers, repeat step 1 through step 8.
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Use a Historian server
with these procedures.

ASIHO1A or ASIHO1B

Change the Historian Identification

IMPORTANT  Perform this section only if you are running VMware Template or if you have
cloned a FactoryTalk Historian server.

Otherwise, continue to Set Security Settings on page 321

In this section, you create a ServerID for one of the FactoryTalk

Historian servers.

Complete the following steps.

1. In Windows desktop, click File Explorer and navigate to

c:\Program Files\Rockwell Software®\FactoryTalk

Historian\Server\adm.

[ A8 Application Tools adm
Home Share Wiewn Manage F 0
(-| - TH » This FC » Local Disk {C:) » Program Files » Rockwell Softaare v FactoryTalk Historian b Server b adm v & I‘ Search adm o] |
e
- Favori - Marme Date modified Type Size a
< Favorites
B Desktop pibackup 9724202 TA6PM  Windows Batch File 13 KB
pibackuptask 972472012 TA6PM Windows Batch File AKB
& Downloads
- || PlB&GenExarmple.dif 972472012 T16PM DIF File 6KE
1= Recent places
| pibalist.dif 92472012 TE PR DIF File 1KE =
/8 This PC ::pibatch.dif 972472012 716 PM DIF File 2z KB-.
R Desktop Pi.;.??“‘?ﬂ. g” ;‘" jgl zz;;m ..EPP.:““FET‘. :i;ii
B Documents pidiag 24, : pplication ,
R Diinioads pigetrnsg 972422 B33 PM Application 2,939KEB
0 Musi pigetrnsg_launch 9724202 TAGPM  Windows Batch File 1KB
usic
e w | piinstall.dif 02472012 716 PR DIF File 1KE v
=1 Birturas
S7items  1item selected 413 MB
1 1
2. Type 'emd' and press Enter.
| E} = | Application Tools adm |;|£-
Home Share e Manage 0
(-l * 1 " crd v| = ‘ | Search adm P |
3
e Favorites ~| Mame Date modified Type Size &
i Desktop 5] pibackup 9242012 T16PM Windows Batch File 13 KB
%) pibackuptask 9724202 TA6PM Windowes Batch File AKB
4 Dowenloads
: | PIBAGenExample.dif 9/24/2012 716 PR DIF File 6kE
= Recentplaces |2
| pibalist.dif 9/24/2012 TA6 PM DIF File 1KEB I
8 This PC o pibatch.dif 9/24/2012 716 PM DIF File ZKE
J Desktop LLE) p?c.onfig 072472012 233 P Appl?cation 4231 KB
Bl Documents pidiag 97242012 233 PM Application 6,283 KB
R Disiiriseds pigetrnsg 97242012 333 PM Application 2,999 KB
0 Musi |5] pigetrmsg_launch 9242012 T8 PM Windows Batch File 1KB
usic
T v || piinstall.dif 072422 T6PM DIFFile 1KE
=1 Birtires
S7iterns 1 item selected 4.13 MEB

The Command window appears and is in the ¢:\Program

Files\Rockwell Software\FactoryTalk Historian\Server\adm directory.

IMPORTANT  Make sure that you press 'Enter' after typing each command in the
following table.

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018

319



Chapter 10  Configure an Application Server Information Server (AppServ-Info)

See Figure 18 on page 320 for reference as you type the commands in

the following table:

Command

piconfig

table piserver

mode edit

istr name, serverlD

<hostname>, <new serverlD>

@exit

Figure 18 - Command Window

o Administrator; CVWIndows System32homd.exe I;Ii-

icrosoft Windows [Version 6.3.96881]
c>» 2813 Microsoft Corporation. All rights reserved.

:»Program Files“Rockwell Software“FactoryTalk Historian“Serversadmipiconfig
{Ls — » Plconfig> | tahle piserver
> table piserver
{Ls — PISERUER}> Plconfig> mode edit
> mode edit
{Ed — PISERUER} Plconfig» isty name. serverlD
> istr name, serverlD
¢(Ed - PISERVER> Plconfig> ASIHB1A, 8877c?c-1765-427b—adcf-a2bh8fdfh?87
> ASIHB1A,. 8A77c?c—1765-42YVh—adcf—aZbh8tdfhyE 7
¢(Ed - PISERVER} Plconfig> Pexit
PIconfig 1 Data lines
4 Command line
B Records in error...

1 Records Edited

:»Program Files“Rockwell Software“FactoryTalk Historian“Serversadm>

If you have connected before, the next time you access this FactoryTalk
Historian server, you see the following window.

[ Server ID Mismatch I;Ii-

The zerver ID has changed since the registration. Thiz normally happens when
the original Pl Server iz lost or replaced by a new install. Y'ou can either accept
the new 1D [rezets the registration] or create an alias/redirect the old [D to a given
zerver [defaults to the original].

Server. |!ASIHD‘I |
Registered ID:  [3077c7c1-1765-427b-adct-a2bbBfdfb232 |
Mew ID: [1b82bc34-65r2-4167-beet-3c1 9=4i67258 |
Options
O Ignore

Accept the new D

() Alias the original 1D to the selected server:

ASIHOT

3. Click 'Accept the new ID" and click OK.
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Set Security Settings

Use the Historian servers In this section, the security settings for the primary and secondary FactoryTalk
with these procedures. Historian servers are set.
pr— p—

Security Settings for the Primary Historian Server

. I

ASHOTA  ASIHOTB Set the security settings for the primary FactoryTalk Historian servers.
Complete the following steps.

1. Click the Programs l symbol and choose Rockwell
Software®>FactoryTalk Historian SE>System Management Tools.

1Vl UyO

. FactoryTalk Historian SE System
1. Help
M Interface Configuration Utility
@ MDB to AF Preparation Wizard

- -

Start FactoryTalk Historian SE 1 Accessibility 3
Stop FactoryTalk Historian SE . Administrative Tools 4
I stem Explorer |, Embedded Lockdown Manager »
System Management Tools .. Maintenance 4
System Tray | FactoryTalk Activation * | | Rockwell Software
. Uninstall FactoryTalk Historian Site Edition .. FactoryTalk Historian SE . Startup 4
| FactoryTalk Tools b VMware 3
J. RSLinx b | Windows Accessories 3
[k FactoryTalk Administration Console . Windows System r
Adobe Reader XI
|| Desktop
p Search

The 'Security Settings - PI System Management Tools (Administrator)'
window appears.
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2.

Under Collectives and Servers, check the server that you want to set the
security settings for.

File  Wiew Tools  Help

G H & @

Search

P

Servers
[ | a351H

R

[w] ASIHOA % 57 Disable SOK trusts Moo s Shongaass s

Server - ASIHOTA

52 Disable &P tusts

Disable explicit login restart of the Pl Base
52 Disable explcitlogin Gl

2 Disable explicitlogin for piadmin

2 Disable blank passwords

Search

e - _
ave
Je) | Save |

[ Alarms
[ Batch
[» Data

I Paints
A Security

[ Interfaces
[ IT Paints
[» Operation

Database Securty
Firewall
|dertities, Users, & Groups

Security Settings

Seszion Record

SYSTERNA

3.

4.

5.

dministrator || piadrin i

Under System Management Tools, choose Security>Security Settings.
The Security Settings slider appears on the right side of the window.

Set the slider to its lowest point and click Save.

In the Windows desktop, click the Programs I symbol and choose

Administrative Tools>Services.

Server Manager

",,.J Services
Ll System Configuration
[ System Information
Task Scheduler
&9 Windows Firewall with Advanced Security
[a] Windows Memory Diagnostic
E Windows PowerShell (x86)
% Windows PowerShell ISE (x36)
43 Windows PowerShell ISE . Accessibility 3
@ Windows Server Backup . Administrative Tools
. Embedded Lockdown M;

. Maintenance

. Rockwell Software

. Startup

L. VMware

Windows Accessories
. Windows Systemn

E¥ Adobe Reader XI

[ =
- ¥ vr v v v v

|| Desktop
p Search
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6. Right-click PI Base Subsystem and choose Restart.

-

Marme Cescription Status

o Performance Counter DLL ... Enables rern..

. Performance Logs & Alerts  Performanc..,

+ PLAF Link Subsystern Running
+ Plalarm Subsystern Running
i Pl &rchive Subsystern Running

o Pl Backup Subsystern
*3r| Ba :

Running
punning

%Pl Batch Generatar || Start

+ Pl Batch Subsystern | Stop unning

. Pl Buffer Subsystern| Pause

Pl License Manager | R;sume unning

Pl Message Subsyst] unnirng
Restart

o Pl Metwark Managj Eai 'Hnning

i Pl Performance Equ| Al Tasks P funning

Pl Performance Mor; Frifpat unning

Pl Ramp Soak Sirmul i funning

Pl Randorn Simulatg Bropettics funning

Pl Recalculatar Subs Help

4 Pl Shutdown Subsystem

Pl Snapshot Subsystern Running

i PLEAL Subsystern Running

Startup Type
Manual
Manual
Automatic
Automatic
Automatic
Automatic

atic

Manual
Automatic
Disabled
Automatic
Automatic
Automatic
Automatic
Automatic
Automatic
Automatic
Manual
Automatic
Automatic
Automatic

The PI Base Subsystem service restarts. When the status is running,

continue with the next step.

7. Close the Services and Administrative Tools windows.

Security Settings for the Secondary Historian Server

In this section, the security settings for the secondary FactoryTalk Historian

server are set.

Repeat step 1 through step 7 for the secondary Historian server.
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Use the Historian server
with these procedures.

ASIHOTA

324

Connect Primary Historian Server to Secondary Historian Server

In this section, you make a connection from the primary Historian server

(ASIHO1A) to the secondary Historian server (ASIHO1B).

Complete the following steps:

1. Open the PI SDK utility and click Connections.
2. Click in the white space and then click Add Server.

Collectives and Servers = | ﬂ @
|5&am‘] ,D|
R Server - AS
Servers
[] &siH m
ASIHOTA g
[] wIN-R2CDU3PYTOL
Connections..,
Sustem M Connect as., :
yzter Manage _D’i A51H Server ASIHOA
Search Check all SIHO Metwork Mode:
l; .;«Ia;n;s Uncheck all [0 ® WIN-R2CDU3PYTOL  Port Number:
atel
b Data ﬂ Refresh Default Lzer Mame:
[ Interfaces Connect as...
[+ 1T Paints
[ ber ation Change Password..,

I Add Server.., I

Remowe Selected Server

Refresh
Help...

3. Type the server name (ASIHO1B in the example) in the Network Node

text box.
@ Add Pl Server -
Metwark Path/FODN: JASIHOOE | |
El
Confirm:
Connection type: FI3
Part Murnber:

4. Accept the rest of the default entries and click OK.
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5. In the PI Connection Manager window, right-click a server that is not
necessary and choose Remove Selected Server.

SIH Server WIN-R2CDOU3IRPYT

O &

1@ ASHOA Metwork Mode:
W ASIHOE Part Mumnber:
O= )

Connect as.,

Change Password..,

Add Server.,

Remowe Selected Server

Refresh

Help...

6. Repeat this step for servers only that you do not need.

Once you have deleted all unnecessary servers, the PI SDK Utility
window looks similar to the following figure.

@ Pl SDK Utility -[alx]

File  Buffering Tools  Connections  Help

=@ PIsDK L155 asiHt Network Node: [AsiHOT v]
g g:::t:iizj Part Murnber: i)
@ Snapshot Tool Drefault Uszer Mame: |piadmin |

= % Taals Connect 10 Seconds
@ Message Log Connect as.. &0 Seconds
‘j Srpno Dot Disconnect
& Error Lookup
B Tracing Setup Refresh F5 FI3
@ KST Cleanup E=— T 44849691-1186-4b82-a0da-1d48h...

Remowe selected Server  Del

IP Address:
Fl Wersion:

Operating Systen:

Save

Default Server ASIHO

7. Click Save.
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8. In the 'Security Settings - PI System Management Tools
(Administrator)' window, make sure both FactoryTalk Historian servers
(ASIHO1A and ASIHO1B in the example) are checked. The window
appears similar to the following figure.

i Security Settings - PI System Management Tools (Administrator) =t =) -
File  “iew  Tools  Help
Collectives and Servers 2 @
‘.‘«'eafch ,O|
I Server - A5IHO1A
Ervers
ASIHOTA m 52 Disable APl tusts
ASIHOTE Eé Sg Ll R R Mate: This change requires a restart of
= % Disable explicit lagin the Pl Base Subsystem.
% Dizable explicit lagin for piadmin
4 Disable blank pazewords
Syztem kanagement Tools 3 P
Saarch D|
I Alarms
I Batch Server - ASIHOTE
I+ Data ':‘;{{ Disable 4P| rusts
E :;l:r::tzs ﬂ-__‘:\’ 82 Disable SDE tusts
[» Operation ~= % Disable explicit login
[ Paints —
4 Secuily % Digable explicit login for piadmin
D atabase Security % Disable blank passwords
Fireall
Identities, Users, & Groups L 5348
M appings & Trusts
Secuity Settings
Session Record
SYSTEMAdministrator | piadmin
Connect Secondary Historian Server to Primary Historian Server
Use the Historian server To connect the secondary Historian server (ASIHO1B) to the primary
with these procedures. Historian server (ASTHO1A), repeat step 1 through step 8 on the secondary
server (ASTHO1B).
H IMPORTANT  When you repeat step 3, type ASIHO1A in the Network Node text box on the
ASIHO1B Add Server dialog box.
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Create a Server Collective

Use the Historian servers In this section you create a FactoryTalk Historian collective (ASIHO1) that
with these procedures. includes FactoryTalk Historian servers ASIHO1A and ASTHO1B.

Create Collective and Add Historian Servers

ASIHO1A Complete the following steps.

1. In the Windows desktop, click the Programs I symbol and choose

Rockwell Software®>FactoryTalk Historian SE>FactoryTalk Historian

SE System>Collective Manager.

AboutPl-5DK . FactoryTalk Historian SE System I
Collective Manager . Help 3
# PISDKUtility (64-bit) Interface Configuration Utility
@@ PISDKUtility &) MDB to AF Preparation Wizard
f— Start FactoryTalk Historian SE 1 Accessibility 3
Stop FactoryTalk Historian SE . Administrative Tools 4
@ System Explorer |, Embedded Lockdown Manager »
ﬂ System Management Tools . Maintenance 4
ﬁ System Tray . FactoryTalk Activation b | | Rockwell Software
“ Uninstall FactoryTalk Historian Site Edition . FactoryTalk Historian SE . Startup 4
1. FactoryTalk Tools b VMware 3
1. RSLinx b | . Windows Accessories 3
b FactoryTalk Administration Console . Windows System 4
E¥ Adobe Reader XI
i_| Desktop
p Search
The PI Collective Manager (Administrator) window appears.
2. Click File and choose Create New Collective.
Eile | Edit Help
LConnections.., I._
Create Mew Collective... [_
Export Selected Collective.. L]
Exit |_
o }( | i]
The Create New Collective dialog box appears.
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3. Check both boxes and click Next.

Ny Create New Collective -

Werify that you have a valid backup of the Pl server that will be the
primary zerver of your new collective.

E | have verified my backups are valid I

Werify that all Pl Interfaces writing data to the Pl server that will be
your primary server are set up o communicate with all the servers that
will be added to your collective.

E | have verified my Pl interface servers configurationl

Back I et I| Cancel

The Existing or New Primary dialog box appears.
4. Check 'A newly installed PI server' and click Next.

Ny Create New Collective - Existing Or New Primary -

The Pl zerver that will be the primary server of the new collective is:
() An esisting Pl server that contains historical data

I'-'i," A newly installed P serverl

| Back |I Mext I| Cancel |

The Select Primary and Collective Name dialog box appears.
5. Select the primary FactoryTalk Historian server from the pull-down list.

If the server name does not appear in the pull-down list, click the ellipses
[] and select the server from the Connection Manager dialog box.

Ny Create New Collective - Select Primary and Collective Name -

Collective Primary; IASIHD‘IA vI l:l

PFrimary Description:

| Collective Name: IASIHD1 I

- Collective Description:

| Back |I et I| Cancel

6. (Optional) Type a description for the collective primary.
7. Type a unique name for the new collective.

8. (Optional) Type a description for the collective and click Next.
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10.
11.

12.

13.

14.

The Select Secondary Servers dialog box appears.

Select the secondary FactoryTalk Historian server from the pull-down

list.

If the server name does not appear in the pull-down menu, click Browse

(ellipses “...") and select the server from the Connection Manager

dialog box.

NE Create New Collective - Select Secondary Servers -

Primary Server: |ASIHD‘IA |

Secondary Servers

Server ,5IHOTB
Drescription:
Add
Server Werzion Drescription

Remove

| Back || et || Cancel |

(Optional) Type a description for the collective secondary.
Click Add.
The server is added to the server list.

(Optional) Add additional secondary servers by repeating step 9

through step 11 with another server.

When you are finished adding secondary servers, click Next.

NE Create New Collective - Select Secondary Servers -

Primary Server: |ASIHD‘IA |

Secondary Servers

Server || W | l:l

Drescription:
Add
Server Wergion Drescription
ASIHOTE
Remove

| Back |I et I| Cancel

The Select Archives dialog box appears.

Click Next on each of the successive dialog boxes to do the following:

o Accept the default number of archives to be copies

o Accept the default location for the temporary backup
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The Verify Selections dialog box appears.

15. Verify the information on this screen and click Next.

NE Create New Collective - Verify Selections -

Werify the following settings. Click Mext to begin the creation of the
collective. Click Back to change your selected options.

Collective Name: [A51HO1 |
Primary Server: |ASIHD‘IA |
Secondary Servers; ASIHIME

Advanced Options...

| Back |I et I| Cancel |

The Conversion Process dialog box appears.

The Conversion Process page displays the status and individual steps of
the conversion process.

N Create New Collective - Conversion Progress -

7z

Step 1 /9 - Stopping Secondary Pl Servers

Stopping FI License Manager on secondary node.
[A5IHO1B. System. PlantPasx. local)

Back Mext

The Server ID Mismatch window appears when the process completes.

[ Server ID Mismatch I;Ii-

The zerver ID has changed since the registration. Thiz normally happens when
the original Pl Server iz lost or replaced by a new install. Y'ou can either accept
the new 1D [rezets the registration] or create an alias/redirect the old [D to a given
zerver [defaults to the original].

Server. |!ASIHD‘I |

Registered ID:  [3077c7c1-1765-427b-adct-a2bbBfdfb232 |

Mew ID: [1b82bc34-65r2-4167-beet-3c1 9=4i67258 |
Options

O Ignore

ccept the new 1D

liaz the original ID to the selected server:

ASIHO Mew Server...

16. Click 'Accept the new ID" and click OK.
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The Finished page appears.

17. Click Finish to complete the Create New Collective process.

= Cieate New Colletive = Cinished [x]]

Collective ASIHO1 was successfully
created.
All running Pl process that were stopped were restarted. | Pl was not

running, only the core subsystems were started on the secondary servers.
Fleaze verify all required subsystems are running on the secondary

FEMVElS.
Back Cancel
COnfigure a Historian SE This section describes how to create a FactoryTalk Historian SE server.
Server
Create a Historian Server
IMPORTANT  To perform this procedure, make sure that you have completed step 1
through step 7 on pages 321...323.
Use the Historian server This section describes how to configure, test, and name a Historian
with these procedures. server connection.
1. Click Start and choose Rockwell Software”>FactoryTalk
o Administration Console.
ASIHOT or ASIHOTA (If s g
working with a collective) | TS e
. Embedded Lockdown Manager »
Maintenance 3
. FactoryTalk Activation 4 ] . Rockwell Software
. FactoryTalk Historian SE v Startup 3
. FactoryTalk Tools vl L VMware »
. RSLinx _. Windows Accessories 3
72k FactoryTalk Administration Console . Windows System 4
' Adobe Reader XI
|| Desktop
}“3 Search

The Select FactoryTalk Directory dialog box appears.
2. Click Network and then click OK.

Select FactoryTalk Directory

Select the directory pou want to uze.

| Metwark. v |

Cancel | | Help |

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018 331



Chapter 10  Configure an Application Server Information Server (AppServ-Info)

The FactoryTalk Administration Console dialog box appears.

3. In the FactoryTalk Administration Console, right-click
Network>System>Connections>Historical Data and choose New
Historian Server Connection.

File View Tools Window Help

B3 [[E

=145 Network (PASSDT)
oy PlantPAx
=0 System

[ Action Groups

7] Policies

#[L] Computers and Groups

i@ Metworks and Devices

7] Users and Groups

=

E
A
E
E

Connections

Databaszes

i MNew Historian Server Connection...

=@ Perrn|| | Security...

The New Historian Server Connection’ dialog box appears.
4. From the pull-down menu, select the Server or Collective Name.

S. Click Test Server Connection.

Drescription:

Historian for the praduction area of the plant

Server or Collective Mame:

ASIHO

@I < Back Mest » Finizh | Cancel

If the connection is good, a green check mark appears along with the text
'Server Found.

R

Server or Collective Mame:

[AsIHOT

Test Server Connection o Server found
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If the connection is not good, a yellow triangle appears along with the

text 'No server found'
s

T

Server or Collective Mame:

ASIHOT v

il

Test Server Cornection | A% Mo gerver found

- Ao

TIP  If the connection to the server is not good:

« Make sure that the correct Historian server is called out

« Make sure that the Historian server is installed correctly

6. Click Finish.

IMPORTANT  This step also creates an instance of the FactoryTalk Live Data (FTLD)

interface on the host.

7. In the FactoryTalk Administration Console, right-click
Network> System>Connections>Historical Data>'<Production

Historian>"> and choose Properties.

The Historian Server Connection Properties dialog box appears.

8. Click the Licensing tab.

The dialog box now shows both the Primary and Secondary servers.

IMPORTANT  Depending on your licensing, the dialog box could appear
differently. But, use the fhse.xxxK activation.

If using a collective, you must have two total and assigned licenses.

9. Type'l"in the Assigned column and click Apply.

Production Histarian - Historian Server Connection Prope..‘-
| Generall Licensingl Paint Sources |
Frimary Server: Secondary Server
[45HmE vl
Activation | Tatal [InUse Assigned | |
FHSE 50K [1 [0 1 |
[ Show Assigned | [ Showal |
@ | Ok | | Cancel |I Apply I

10. Click Apply.
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(reate a Default Node Interface

Use the Historian server Node interface FTLD1 is automatically created when the Historian server is
with these procedures, created. This interface must be deleted and two interfaces created on the
proper servers.

1. In the FactoryTalk Administrative Console, right-click on FTLD1 and
ASIHO1 (no collective) choose Delete.
ASIHOTA (with collective)

File Wiew Tools Window Help

& Metwork [PASS07]
i PlantPas

Action Groups
Fuolicies
Computers and Groups
Metworks and Devices
Uszers and Groups
Connections

B Databases

ED Historical Data

= E Production Histarian

Delete

Security..,

Properties...

2. To confirm the deletion, click Yes on the popup window.

3. To create an interface to collect data, right-click the Historian server and
choose New Data Collection Interface.

You are creating a connector to thC correct Historian server.
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The Data Collection Interface Properties dialog box appears.

4. On the General tab, select the PASS hosting the interface

(PASS02A in the example) from the pull-down.

5. Click OK.

Data Collection Interface Properties -
General | Scan Classes
Interface Type: Mame: 1D:
| FactoryTalk Live Data W | |FTLD 1 z
Drescription:

Default FTLD interface created by the FTH configure wizard.

Computer hosting the interface:
FactoryT alk Historian Server Connection:
Production Historian on ASIHOTA

Service Statuz

Mew

| Launch Interface Configuration Lkility... |

PASS024, v

@ I ak. I| Cancel || Apply

IMPORTANT  You need a host for both node interfaces. For a redundant pair, the

primary only is referenced.
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Use a PASS server with
these procedures.

PASSO1

336

Create a Synchronization Path

A common folder is used for files that are used for handshaking and

redundancy.
F1D
Synchronization
Folder o -
PASSOTA
See page 342 for connecting node interfaces.
IMPORTANT  We recommend that you use a server that is not running LiveData.

Complete the following steps.

1. In File Explorer, right-click Local Disk (C:) and choose New>Folder.

‘;__:- | E} = Drive Tools Local Disk (C) \;‘i-
Home Share View Manage v 0
© ~ 1 | » ThisPC » Local Disk (C) » v ¢ | | search Local Disk (C:) A

S
¥ Favorites MName Date modified Type Size
Bl Desktop Perflogs 8/ File folder
4§ Downloads .. Program Files ar File folder
=] Recent places . Program Files (x86) 8 File folder
ProgramData 8y File folder
1M This PC ) Users 8 File folder
jm Desktop . Windows 8/ File falder
| Documents Ll .mnd ar RMD File 1KB
& Downloads
W Music View ’
Z| Pictures Sort by *
B Videos Group by 4
iy Local Disk (C:) Refresh
Paste

G‘p MNetwork

7T items

Paste shortcut

Undo Copy

Share with

Ctrl+Z

3

New

Properties

!E,E;-..

|

ortcut |
Bitmap image
Contact
Rich Text Document

2. Name the new folder FTHSE_Failover.
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3. Right-click the new folder and choose Properties.

File Home Share View
e - 1 |a. » ThisPC » Local Disk (C:)
I Favorites Namme Type
B Desktop 2 Windows File folder
Downloads FTHSE_Failover o
g Recent pl : ioaam FEs 0 B
1=l Recent places . Program Files (x Oreitin Hew wirkdow
ProgramData I
2 i 3
1M This PC . Program Files Sheesyoily
& Desktop B inetpub Restore previous versions
| Documents | Users incitidde m ibrary 4
18 Downloads [ PlantPAx Utilities | Pin to Start
U Music . Perflogs | Send to 17
| Pictures | Cut
;-ﬂ Videos Copy
iy Local Disk (C:) I
Create shortcut
% Metwork Delete
Rename

The FTHSE_Failover Properties dialog box appears.

Genera S I Previous Versions | Customize
Metwork File and Folder Sharing

FTHSE_Failover
l Not Shared

Network Path:
Mot Shared

Advanced Sharing

Set custom permissions, create multiple shares, and set other
advanced sharing options.

4. From the Sharing tab, click Advanced Sharing.
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5. From the Advanced Sharing dialog box, click Share this folder, and then

click Permissions.

Settings
Share name:

[ FTHsE Failover

Limit the number of simultaneous users to: n

Comments:

= =

Lo [ conee

Share Pemissions

Group or user names:

&

Pemissions for Everyone
Full Cortrol

Change

Read

7. Click Object Types.
8. Select Computers and click OK.

Select this object type:

|Users. Groups, or Built4n security principals
From this location: Obiject types:
|System PlantPAxlocal

Select the types of objects you want to find.

Enter the object names to select (zamples):

[ Check Mames

o (o]
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9. Type PASS into the text box, and click Check Names.

Select this object type:

|Users. Computers, Groups, or Built-in security principals | | Object Types... |

From this location:
|5ystem.P1amPMoca|

Enter the object names to select (examples):

10. Select a match from the search and click OK.

More than one object matched the name "PASS". Select one or more names
from this list, or, reenter the name.

Matching names:

Logon Mame {pr...  E-Mail Address Description In Folder

stem.PlantP ...
stem.PlantP ...

The example shows a primary and secondary server selected to create a
folder for a redundant pair.

11. Click OK.

Select this object type:
|Users. Computers, Groups, or Built-in security principals

From this location:
|5ystem.P1amPMoca|

Enter the object names to select (zamples):
PASS02A; PASS02B
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12. To provide Read/Write access to the folder, select the primary server and
click all three Allow checkboxes.

Share Pemissions

Group or user names:

Pemissions for PASS02A
Full Control

Change
Read

13. Click Apply.

14. Select the secondary server and click all three Allow checkboxes.

Share Pemissions

Group or user names:
% Everyone

’ SYSIENLEASSIS)
Q PASS02B (SYSTEM\PASS02BS)

Pemissions for PASS02B

Full Cortrol
Change
Read

15. Click OK.
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16. To complete the procedure, click OK and Close.

Advanced Sharing -

Share this folder
Settings
Share name:

| FTHSE_Failover Y] |

Limit the number of simultaneous users to: 16777 5 - . e
ose Cancel Apply

Comments:

| Permissions || Caching |

OK | Cancel | | Apply |

Proceed to page 342 for procedures on how to configure a data pipeline

between FactoryTalk data servers and FactoryTalk Historian servers.
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Configure a Node Interface

Use a PASS server
with these procedures.

PASS02A

This section describes how to configure FactoryTalk Live Data (FTLD)

connectors. The FTLD interface is a FactoryTalk Live Data client that enables
process data to be passed between a FactoryTalk Live Data server (for example,
FactoryTalk Linx) and a FactoryTalk Historian server. Each instance of the
FTLD Interface can provide data to a single FactoryTalk Historian SE server

or collective.

Configure Primary Node Interface Server

This section describes how to connect the Historian server to the PASS server

with node interfaces.

See page 336 for creating a synchronization folder.

Synchronization

Node

Folder

/ Interface

/

FID
£
A

PASSO1A /

PASS02A

Historian

Node
Interface

PASS028B

S~—_

Configure the Server Connection

Complete the following steps:

1. Click the Programs ﬂ symbol and choose Rockwell
Software>FactoryTalk Historian SE>FactoryTalk Historian SE
System>AboutPI-SDK.

# AboutPIl-SDK

| FactoryTalk Historian 5E System

Collective Manager
@@ PISDKUtility (64-bit)
@@ PISDKUtility

342

| Help » lrol S / S | Accessibility »
M Interface Configuration Utility . Administrative Tools 4
@ MDB to AF Preparation Wizard | Embedded Lockdown Manager »
m OPC HDA Tool | Maintenance 4
m OPC Tool .. Microsoft SQL Server 2008 3
E= OPCClient Tool |, Microsoft 50L Server 2008 R2 4
| @ System Explorer . Rockwell Automation 3
n System Management Tocls | FactoryTalk Activation » | | Rockwell Software
'ﬂ System Tray | FactoryTalk Alarms and Events ¥ | | Startup 3
. Uninstall FactoryTalk Historian Live Data Interface | FactoryTalk Historian SE L VMware 4
|, FactoryTalk Tools ¥ | | Windows Accessories 3
.. FactoryTalk View r | | Windows System 3
| RSLinx » B8 Adobe Reader XI
[} FactoryTalk Administration Console || Desktop
8 Studio 5000 &l FactoryTalk View Studio
p Search
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The PI SDK Utility window appears.

2. Expand PI SDK and click Connections.

3. Right-click anywhere in the white space and choose Add Server.

File  PISDK Buffering

Tools  Connections

Help

=/ %@ PISDK

About PIST

(1 P!

i@l Support Data
@) Error Lookup
B Tracing Setup
|@ K5T Cleanup

[ ® pass H

Network Node:

Connect

Refresh

Connect as...

Disconnect

F5

piadmin

10

60

Add Server... Ins

Remove selected Server  Del

Description:
Connected User:
IP Address:

Pl Version:

Operating System:

Default Server: PASS

The Add PI Server dialog box appears.

4. Type the Network Path (If you are using a collective, type the primary

machine name) and click OK.

Network Path/FQ

DN:

5. Click the box next to the new server (ASIHO1 in the example).

File  PISDK Buffering

Tools

LConnections  Help

=/ %@ PISDK
@ About PISDK

Y Connections
@ Snapshot Tool
=1 ¥ Tools
@ Message Log
i@l Support Data
@) Error Lookup
B Tracing Setup
|@ K5T Cleanup

I ;B ASIHO1
® PASS

Network Node:

Port Number:
Default User Name:
Connection Timeout:

Connection Type:
Collective ID:
Description:
Connected User:
IP Address:

Pl Version:

Operating System:

Data Access Timeout:

ASIHDT
5450

piadmin

10 | Seconds

E———

P13 protocol 3.4
35db2801-837c-4251-80e2-6ceb. .

piadmin

F13.4350.18
Windows NT AMDE4 6.2.5200

ASIHD1 connected as piadmin
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Use a domain controller with

these procedures.

If the connection is successful, the connection information appears in

the same window.

6. If there are servers listed that are not required, right-click the server

name and choose '"Remove selected server'

ing Tools

LConnections  Help

<% ASIHD1

oo

‘ Network Node:

tDese

Connect
Connect as...

Disconnect

Refresh

Add Server...

F5

Ins

Remove selected Server  Del

Description:

Crannartad |lasr

7. When asked if you want to delete the server, click Yes.

8. Close the PI SDK Utility window.

Creating a PI Buffer Service User

You must create a service user to enable PI buffering service.

1. From the Server Manager, click Tools and choose Active Directory Users

and Computers.

2. Expand the domain folder (System.PlantPAx.local), right-click

Managed Service Accounts and choose New> User.

File Action View Help

Active Directory Users and Computers

R EEE L EES R
] Active Directory Users and Computers [PADC| Name - Type Description

| Saved Queries
3 System.PlantPAx.local
I+ || Builtin

| Computers

[ |

5| Domain Controllers

[ || ForeignSecurityPrincipals

=8 Mana"ged Service Accounts
4 (3| PlantPax

o | Areas

| Roles
o Users

Delegate Control...
Move...

Find...

There are no items to show in this view.

| Users

New

3

< | m

'Create a new object...

All Tasks
View

Cut

Delete
Rename
Refresh
Export List...
Properties

Help

Computer

Contact

Group

InetOrgPerson
msDS-ResourcePropertyList
mslmaging-P5Ps

MSMQ Queue Alias
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The New Object - User dialog box appears.

MNew Object - User

2 \ Createin:  System.PlantPAclocal/Users
First name: PlBufferService Initials: l:l
Last name: | |
Full name: | PlBufferService |

User logon name:

|Dibuﬁerservice | | @System PlartPAxlocal v|
User logon name (pre-Windows 2000):
|SYSTEM\ | |pibuﬁerservic:e |
Ba: Mext > | | Cancel |
3. Complete the User text boxes.
Item Description
First name Type a name for the Pl buffering service.
IMPORTANT: The ‘Pl ‘preface is the name of the
0SISoft product.
Initials Optional; you can leave blank.
Full name Type the same name for the Pl buffering service.

User login name

Type the same name for the Pl buffering
service and click the pull-down to select your
domain folder.

User logon name (pre-Windows 2000)

Use the SYSTEM\ default and type the same name
for the Pl buffering service.

IMPORTANT  The logon password creates a service user, not a person. The service
user grants access to system computers for placing data into

memory (buffer).

4. Click Next.
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& Createin:  System.PlantP A« local/Users

5. Type your password twice, and make sure that there is a check mark in
the following boxes:

e User cannot change password

e Password never expires (indefinite service for system access)

Password: |ooooooooo

& Createin:  System.PlantP A« local/Users

When you click Finish, the following object will be created:

[ User must change password at next logon
[ User cannot change password

[ Password never expires

[ Accourt is disabled

Full name: FiPerfmon
User logon name: piperfmon@System PlantP Ax local

The user cannot change the password,
The password never expires.

Use an AppServ-Info server
with these procedures.

ASIHOTA

6. Click Next and then click Finish.
(reating Security Mappings

This procedure associates the service user identity with the Historian mapping
and trusts.

1. Click the Programs I symbol and choose Rockwell
Software>FactoryTalk Historian SE>System Management Tools.

. FactoryTalk Historian SE System
L. Help

M Interface Configuration Utility
@ MDB to AF Preparation Wizard

-

1UI OYOL

Start FactoryTalk Historian SE i 1 Accessibility 3
@] Stop FactoryTalk Historian SE . Administrative Tools 3
B iy, .
stem Explorer |, Embedded Lockdown Manager »
em Management Tools . Maintenance 3
g 3
v stem [T ., FactoryTalk Activation » | |, Rockwell Software
ay J y !
. Uninstall FactoryTalk Historian Site Edition . FactoryTalk Historian SE . Startup 4
| FactoryTalk Tools b VMware 3
1 RSLinx b | Windows Accessories 3
[k FactoryTalk Administration Console 1 Windows System r
E8 Adobe Reader XI
|| Desktop
p Search
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The PI System Management Tools window appears.

2. Do the following steps:

a. Under Servers, check the server that you want to set the security
settings for.

b. Under System Management Tools, choose Mappings & Trusts.

c. Click Add Mappingicon -
The Add New Mapping dialog box appears in the right pane.
d. Click Browse (ellipsis “..)).

3 Pl System Management Tools (Administrator) =i [ X
Fle View Tools Help
Servers O IEIEEEEA
|_‘~'='5-'c-7 p -
> Mappings | Trusts |
Servers
Mapping Server Collective Description Pl Identity Enabled
3 Add New Mapping -
System M Tools ‘windows Account: |Required
Sedth P Vindows SID: | =
[» Alams
I+ Batch Description:
I» Data
I Interfaces
b IT Poirts Server: [AsHO1 v]
I» Operation Pl |dentity: Requied
e nitity: | equire: | l:l
Digital States [[] Mapping is disabled
Perfformance Equations
Point Builder reate Cancel
Point Classes
Pairt Source Table
Totalizers
4 Security
Database Securty
Firewall
saptitisg oups
Session Record
| SYSTEMN\ Administrator | piadmin

The Add New Mapping dialog box appears in the right pane.

3. Select the PIBufferService user that you created earlier.

4. Click OK.
Select User, Computer, or Group -
Select this object type:
|U5er. Group, or Builtin security principal | | Object Types... |
From this location:
|U5ers | | Locations... |

Enter the object name to select (zamples):
PlBufferService ([pibufferservice @System . Plant P Awx local Check Names

o | o
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5. Click Browse, then select a group from the Type pull-down men.

6. Select a desired identity and click OK.

;| SYSTEMpibufferservice
[ | [

Windows SID:  [5-1-5-21-3778824255-40441222)

Description: Select from server ASIHO1
ope
Server: |RSIHD‘I W Defining against a Pl Group is not the prefe i method of configuring a Pl

Mapping. Instead, define against a Pl |dentity where possible.

Pl Idenity: [Required

[] Mapping is disabled

MName Description
8 FTHAdministrators  The administrative P| Group formerty named "piadmin”
8 FTHEngineers
& FTHOperators

. [SYSTEM pibufferservice | [
[5-15-21-3778824255-40441222

[AstHD

Pl Identity: |piusers
["] Mapping is disabled

7. Click Create.

File  View Tools Help

Servers X |F B8 ERIE e
Seardh —'_._._[

Servers Mappings | Trusts |
[# ASIHO1 Mapping Server  Collective Description Pl ldertity Enabled
_&_SYSTEM\pl‘buﬂ'erseMce ASIHO1 piusers True

| System Manag
Seardh

I» Alarms

I» Batch

I» Data

I Interfaces

I IT Points

I» Operation

4 Points
Digital States
Performance Equations
Point Builder
Point Classes
Point Source Table
Totalizers

4 Security
Database Security
Firewall
Identities, Users, & Groups
Mappings & Trusts | < |
Security Settings

:\pibLn"ferservice'to Pl Identity ‘piusers’ on Server "ASIHO1".

SYSTEM\Administrator | piadmin B
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Use a PASS server
with these procedures.

-

PASS02A

Configuring the Interface

Complete the following steps to configure buffering for the server that

you connected.

1. Click the Programs I symbol and choose Rockwell
Software>FactoryTalk Historian SE>Interface Configuration Utility.

LRFEPINES

FactoryTalk Historian SE System 3 Y o :
Hel 3 0 Y4 | Accessibility ,
Interface Configuration Utility ; # | = Administrative Tools 4
MDB to AF Preparation Wizard " | Embedded Lockdown Manager »
OPC HDA Tool | Maintenance 4
OPC Tool 10 Microsoft SQL Server 2008 3
OPCClient Tool 1. Microsoft SOL Server 2008 R2 4
System Explorer . Rockwell Automation 4
System Management Tools | FactoryTalk Activation b | | Rockwell Software
System Tray | FactoryTalk Alarms and Events b | Startup 3
Uninstall FactoryTalk Historian Live Data Interface | FactoryTalk Historian SE 1 VMware »
|, FactoryTalk Tools b | Windows Accessories 3
| FactoryTalk View F | | Windows System 3
|, RSLinx » B8 Adobe Reader XI
[} FactoryTalk Administration Console || Desktop
6 Studio 5000 2 FactoryTalk View Studio
p Search

The PI Interface Configuration Utility window appears.

2. From the Tools menu, choose Options.

Interface

B ¥ Log Files... Ctrl+L

Buffering... Ctrl+B
e . Run apisnap

Besciption Diagnostics... Ctrl+D

Point Sources...

Date/Time Properties... Ctrl+A

Versions:

General
Wdefan View Digital State Sets...

Interface Tag Creation Utility...
Interface Communication Test Utility...

Interface Specific Configuration...

Disconnected Startup

| Scan Class #

10 Rate
Interface Status

LI Fename |

Fl Data server Connection Status

Pl Host Infarmation

Server/Collective: I

SDK Member:

AP| Hostname:

User:

I
I
I
Type: I
I
I

Version:

Port:

r Interface [nstallation Path

Interface Batch Filename
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3. Click ‘Load interfaces from a selected list of PI Data servers.

Loading  Load Interfaces from these Pl Servers/Collectives

Maming Conventions " Load interfaces from default Pl Data server anly
[ebug
Reserved Point Sources
Service

Warnings

| oad interfaces from all known P D ata servers
E—

@ Load interfaces from a selected list of Pl Data servers

4. Click a server box and then click OK.

5. From the Tools menu, choose Buffering.

LI Fename |

un apisnap -
Fl Data server Connection Status

Besciption | Diagnostics... Ctrl+D

Point Sources...
T Date/Time Properties... Ctrl+A Pl Host Information
| View Digital State Sets...

Versions:

Server/Collective: I

Interface Tag Creation Utility...

SDK Member: |
Interface Communication Test Utility...

AP| Hostname:

Interface Specific Configuration...
User:

; Options...

Type:

- ocan Llasse
Disconnected Startup [ Version:

-~ Debug Port:

10 Rate i

Interface Status

Bath

r Interface [nstallation Path

Interface Batch Flename
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6. Click Yes, and then ‘Continue with configuration’ to initiate the
Buffering Manager wizard.

@ Pl Buffer Subsystem has not been configured on this system. Would

you like to configure it now?

Buffering Manager

Configuration, menitoring, and troubleshooting of buffering

Welcome to the Buffering Manager new installation wizard
This wizard will guide you through the initial configuration of buffering.

Continue with configuration it Buffering Manager

7. Select Buffer and click Next.

Buffering Manager

Configuration, monitoring, and troublesheoting of buffering

Detected PlInterfaces | Detected Pl Interfaces

Pl Data Archive Security Confirm the Pl interfaces and services for which you want to configure buffering.
Servers that are not selected will not be buffered.

Buffering Configuration
Detected Pl interfaces are listed by server,

Verification
Buffer Server Status

ASIHO1

Don't see all your Pl interfaces? Want to add another service? Select a service,

View messages | Detected Pl Interfaces help
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IMPORTANT Do step 8 and step 9 on the Buffering Manager, if applicable.
Otherwise, skip to step 10.

8. Click Change, type the user name and password (that you created
earlier), and click Next.

@ Buffering Manager - New Install Wizard -|o

Buffering Manager

Configuration, menitoring, and troublesheoting of buffering

Detected Pl Iitefates Pl Data Archive Security

Pl Data Archive Security | Review/update a mapping or trust for the selected Pl Data Archive server,

Buffering Configuration Windows account to run the Pl Buffering service: LocalSyshemE

Verificati
STEaRRl ASIHD1 €3 Connecting using piadmin is strongly not recommended
- Choose new Pl Data Archive security settings
o ASIHO1 2
Retry security test
(7] Buffering Manager - New Install Wizard =L -

Buffering Manager

M Configuration, monitoring, and troubleshooting of buffering

Detected Pl Interfaces Wlndows Secu”ty

Windows Security Select a Windows account to run buffering.
Pl Data Archive Security
Buffering Configuration ® Use Windows account (recommended)
) ] Windows user
Verification
SYSTEM\pibufferservice &
Password

This user will be added to the local Administrators group

() Use LocalSystem Account

View messages | Windows Security help Previous Next Cancel

IMPORTANT  If you miss the Change option on the New Install Wizard (or the
option does not appear), you must configure the Service logon.
For procedures, see Configure Service Logon on page 357.
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9. Click Next.

Buffering Manager

Configuration, monitoring, and troublesheoting of buffering

Detected Pl Interfaces
Windows Security

Pl Data Archive Security

Buffering Configuration

Verification

Pl Data Archive Security

Review/update a mapping or trust for the selected Pl Data Archive server.
Windows account to run the Pl Buffering service: SYSTEM\pibufferservice Change
ASIHO1 @) Success
5% ASIHOT Retry security test
Authentication method: S5PI
Pl identity: piusers | PIWorld

View messages | Pl Data Archive Security help

10. Click Next again.

Buffering Manager

Configuration, monitoring, and troublesheoting of buffering

Detected Pl Interfaces
Windows Security

Pl Data Archive Security
Buffering Configuration

Verification

Buffering Configuration
Specify the buffer location.

Buffer location:
CA\ProgramData\OS|soft\Buffering Browse...

Drives Available space Tofal space  Used space

c\ 219GE wrce |

Unsure which directory to select? Use recommended.

View messages | Buffering Configuration help
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11. Click ‘Exit new installation wizard’.

Buffering Manager

Configuration, monitoring, and troublesheoting of buffering

Detected Pl Interfaces Veriﬁcation

Windows Security Check the health bet PI Buffer Sul
Pl Data Archive Security

1 and each Pl Data Archive server.

' y @ Pl Buffer Subsystem successfully started.
Buffering Configuration

Verification @ Pl Buffer Subsystem is now ti

|
p 1al,

Server Status

@ AsiHO1 @ Connected successfully

€ The upgrade to PI Buffer Subsystem is compl

Y

View messages | Verification help

The following messages appear to complete the buffering configuration.

12. Click Yes and OK to confirm the PIICU dependency.

@ Buffering via the P| Buffer Subsystem has been disabled, would you like

to enable it now?

354
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13. From the Tools menu, choose Buffering and verify that your information
matches the dialog box shown.

IMPORTANT  If your Buffering Manager dialog box does not show a server with a

!
green check mark @, choose File>Add Server and repeat
step 8 and step 9 on pages 352-353.

(7] Buffering Manager =i -

File  View Help

Buffering Manager

Global b

Pl messages

P @ Global Buffering Status

P 9.0 months estimated buffer capacity o

P 0 events in queue

B 0 total events sent

weued events sent for all servers

Logical Servers

Select a server below for more detailed information
@
I\_

ASIHD1

14. Close the Buffering Manager.
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15. In the PI Interface Configuration Utility window, from the Tools menu
choose Options.
Interface
bk l7= 2 Log Files... Ctrl+L
Interface: Buifenng. . B LI Fename |
) Run apisnap )
Type: | E Fl Server Connection Status—,
Besciiptio | Diagnostics... Ctrl+D
; Point Sources...
Wersions: ) .
Eensral | 3‘3&!;": :,;::ter::s Sitksl Pl Host Infarmation
Unill:'r;tSD [ ERrin Server.-"[lollec:tive:l
P I Interface Tag Creation Utility... 0K Member: I
De.bug I Interface Communication Test Utility... et I
Failove | Interface Specific Configuration...
Perfar = Lzer: I
Flodip Options... Tope: I
i Health Pointz [=can Liasses _
Interface x| +] Wersion: |
ISDeg::tZ Scan Frequency | ScanClass # | Port: I
Interface Status Description: I
rInterface [nstallation Path
Interface Batch Filename
Cloze |
The Options dialog box appears.
16. Check 'Load interfaces from a selected list of PI servers.
Loading  Load Interfaces from these Pl Servers/Collectives
Maming Conventions " Load interfaces from default Pl Server anly
gebug A Paint 5 " Load interfaces from all known Pl Servers
SESPTNE ot Souiees ' Load interfaces from a selected list of Pl servers
ervice
.BAT Filez
Warnings
- Eance'
17. Make sure that the server is checked.
18. Click OK.
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Configure Service Logon

The following procedure is applicable only if the Change Option was not
available on the New Install Wizard dialog box.

1. On the PASS server, right-click Start menu and choose

Computer Managemcnt.

2. In the left pane, open Local Users and Groups and right-click Groups
and choose Administrators.
3. Click Add and type ‘SYSTEM \pibufferservice’
4. Click Check Names.
S. Click OK.
6. To assign the logon service account, from the Start menu, click Programs
and choose Administrative Tools>Services.
7. Right-click PIBuffer Subsystem and choose Properties.
8. On the Log On tab, click Browse.
Services ==
File Action View Help
e Ec= HmE »anp
", Services (Local) MName i Description Status Startup Type Log On As
. Performance Counter DLL ...  Enables rem... Manual Local Service
Derforg lerts Performanc... Manual Local Service
+; P| Buffer Subsystem i Running  Automatic Local Syste...

L0 Pl Mes] = x |fE-
Pl Buffer Subsystem Properties (Local Computer)

- Pl Ney 2 P P e

= PI-Buff | General| Log On | Fecovery | Dependencies | i

. PI-Buf{ L

% PIPC L Log on as: €

w5 PIPCL () Local Systemn account e

“Pluga Allows service to interact with desktop e

«: Portab 198

2% Power (® Thiz account: | I Browse... I €

w0 Print § ) S : 5

i Password: Select User or Service Account -

- Printen

i Proble| Confim pa g eject this object type:

< Remot |User or Service Account | | Object Types... |
" Remot]

R From this location:

+ Remaot] —

% Remotl IEntlre Dlrectoryl || Locations.. ||
“; Remot Enter the object name to select [examples):

< Remot PlBuferS ervice [pibufferservice@S ystem, PlantPAs local I Check Names I
~: Remot]

. Remot]
o I e

9. Click Locations, choose ‘Entire Directory; and click OK.
10. Type ‘SYSTEM\pibufferservice’ and click Check Names.

11.
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Use a PASS server
with these procedures.

PASS02B

Configure FactoryTalk Live
Data Connectors

Use PASS servers
with these procedures.

PASS02A  PASS02B

358

Configure Secondary Node Interface Server

In this section, you connect to the PASS02A servers and configure buffering
for the server.

Configure Server Connection
Repeat step 1 through step 8 on pages 342...344 for the PASS02B server.
Configure the Interface

Repeat step 1 through step 18 on pages 349...356 for the PASS02B server

Unilnt (Universal Interface) provides generic functions required by most
interfaces, such as establishing a connection to the Historian Server node and
monitoring the Historian Point Database for changes.

To minimize data loss during a single point of failure within a system, Unilnt
provides two failover schemas: (1) synchronization through the data source
(Phase 1) and (2) synchronization through a shared file (Phase 2).

Phase 1 Unilnt Failover uses the data source itself to synchronize failover
operations and provides a hot failover, no data loss solution when a single point
of failure occurs.

Phase 2 Unilnt Failover uses a shared file to synchronize failover operations
and provides for hot, warm, or cold failover. The Phase 2 hot failover
configuration provides a no data loss solution for a single point of failure
similar to Phase 1.

IMPORTANT  In this section, only Phase 2 Unilnt Failover is addressed.

The Unilnt failover scheme requires the data source be able to communicate
and service data to two interfaces simultaneously. Additionally, the failover
configuration requires that the interface supports outputs. A redundant
solution requires two separate interface nodes communicating with the data
source.

In a hot failover configuration, the interface copy that is in a backup role
collects and queues data in parallel to the interface that is in the primary role.
The interface in the backup role does not send the data that is collected to the
Historian server. However, if a failover occurs, the interface immediately sends
its data to the Historian server.
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Use a PASS Server with
these procedures.

PASS02A

Configure a FactoryTalk Live Data Primary Connector

The FactoryTalk Live Data 1 (FTLDInt1) is in the primary server (PASS02A
in the example).

Complete the following steps.

1. Click the Programs E symbol and choose Rockwell
Software>FactoryTalk Historian SE>Interface Configuration Utility.

2. In the PI Interface Configuration Utility window, choose
'FTLDintl (FTLDInt1)->ASIHO1' from the Interface pull-down list.

2| Pl Interface Configuration Utility - FTLDInt1 [= [ o |
Interface  Tools Help
NEX H e 3R 0 @
Interface: Rename
—
Type: FTLDInt L] Fockwell FactoryT alk Live Data —PI Server Connection Status
Description: ]Default FTLD interface created by the FTH configure wizard, 4. ASIHOTA. System.Plantf|
: % Wiiteable
Wersions: 1FTLDInt.exe version 4.5.5.23 Unilnt version 4.5.5.23
i~ General 1~ PI Host Information |
Faint Source:  |FTLD _J Server/Collective: ]ASIHG‘I LJ
. Disconnected Startup FILD X| SDK Member:  [asihDta ~|
Debug 4PI Hostname:  [ASIHD1A.System PlantPAxlo ~ |
- Failover |
- Perfarmance Paints I Interface 10 1 I User: 1piadmin
i Performance Counters Tune: [Briman: - P12

3. If the Interface ID is not already ‘1, change it to ‘1"
4. Click Service, and then Yes on the popup window.

£ Pl Interface Configuration Utility - FTLDInt1 =0 LT
Interface  Tools Help
DEX H/ »r=o0 3R A @ :
Interface:  [FTLD1 (FTLDInt1) > ASIHO1 »|  Rename
Type: m Rockwel FactoryTalk Live Data - P Data server Connection Status |
Description: ]Default FTLD interface created by the FTH corfigure wizard. ‘§ AS.IHD‘IA_System_PIantF
Versions:  [FTLDInt exe version 4.6.0.60 |Unilnt version 4.6.0.60 v i
(General [ Service Corfiguration -

Service name: JFI'LDInt‘I I[l:J'I _,-J Startup Type — -~ Create / Remove —
ISer\rice — * Atto

Failover

: o o s & LocalSystem " Disabled Remove
Health Points i
{7 [Domain‘]UserName

Performance Counters

Performance Poirts Pl Interface Configuration Utility =

PISDK "

Disconnected Startup

- Debug This interface service does not have a dependency on Pl Buffer Subsystem,
10 Rate p{ and Buffering is enabled. 05l strongly recommends setting the PlBufss service to [T~
Interface Status be a dependency of FTLDInt1.
Would you like Pl ICU to do this for you?
b
[ Ready [Stopped [ FTLDInt1 - installed

Display name: ]FI'LD‘I  Manual g
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S. Select Failover from the list on the left.

6. Check Enable Unilnt Failover.

Interface  Tools Help
NEXd oo 3R e
Interface: |FTLD1 [FTLDIrt1] -» ASIHO

Type: IFTLDlnt vl Fockwell FactoryT alk Live Data

Description: IDefauIt FTLD interface created by the FTH configure wizard,
|Unilnt version 4.5.5.23

LI Rename |

Fl Server Connection Status —
ASIHI A, System. PlantF
‘wiiteable

Wersions: IFTLDInt.exe version 4.5.5.23

able Unilnt Failover % Phase1 € Phae2

Unilnt
-PI 50K
- Dizconnected Startup

geriormance Faints

General " lgiint Failover

Failover |D# for this instance: I |

Failover ID# of the other instance: | | Browse |

[ Do Mot Fallover when both interfaces looze connection ta Pl
[T Failover contral tags are unsalicited [not scan based)

. Health Paints Rate at which the heartbeat point is updated/checked: I‘H}[H} milliseconds Hesat |
FTLDInt UFO Type: Synchronization File Path;

Service ICCILD ;I I Browsze |

19 histe Status | Tag | Exdesc | PointSource | ID | PointType | DigitalSet i Dev | CompMax
Interface Status

- Performance Counters

<

Cloze | Apply I

[FTLDIntT - Installed P

7. Click 'Phase 2.

Interface  Tools Help
NEXdreoo 3R e
Interface: |FTLD1 [FTLDIrt1] -» ASIHO

Type: IFTLDlnt vl Fockwell FactoryT alk Live Data

LI Rename |

Fl Server Connection Status —

Description: IDefauIt FTLD interface created by the FTH configure wizard,

ASIHI A, System. PlantF
‘wiiteable

Wersions: IFTLDInt.exe version 4.5.5.23

General r— Unilnt Failover
Unilnt [V Enable Unilrt Failover

" Phase 1 t' F‘haseZI
- Pl SDK

: Failover |D# for this instance: [1 [\PASSD2ZA\FTLDInt1
- Dizconnected Startup

- Debug Failover ID# of the other instance: |2 | Browse |

- Failaver . [~ Do Not Failover when bath intefaces loose connection to Pl
- Performance Points [~ Failover control tags are unsolicited fnot scan based)

: EZZﬁLmPa;iicountem Rate at which the heartbeat poirt is updated/checked: |1 000 milliseconds Feset |

FTLDInt Synchronization File Path:
Service I Browse I

10 R at
Inter:a:e Statuz | Exdesc | PointSource | Location1 | Pc ~
Mot Created FTLDInt1_UFO2_ActivelD [UFO2_ActivelD] FTLD 1

Mot Created FTLDInt1_UFO2_Heartbeat 1 [UFO2_Heartbeat:1]  FTLD 1 Int—

N MLIF0? Heartheat?1  FTIO 1 it Y
< m |

|Unilnt version 4.5.5.23

|~

| W

Cloze | Apply I

[FTLDIntT - Installed P

8. From the UFO Type pull-down list, choose HOT.

9. Click Browse to search for the Synchronization File path for the
secondary instance.
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The 'Select UFO synchronization file' dialog box appears.

10. Navigate to the Network>pass01>FTHSE_Failover directory (that was
created in the previous section).

11. Click Open.

e - 1~| . » Network » passO1 » FTHSE_Failover v ¢ I| Search FTHSE_Failover ye] |

Organize »  MNew folder = - [ @
¥ Favorites MName Date modified Type Size
B Desktop

Mo items match your search.
& Downloads

“Z Recent places

1M This PC

mm Desktop

=| Documents
& Downloads
' Music

=| Pictures

H Videos
£, Local Disk (C3)

?j Network

<] [T [ >

File name: [FTLDInt_FTLD_1 W | Dat Files (*.dat) W
I Open !vl Cancel

The 'Select UFO synchronization file' dialog box closes.
12. Right-click in the tag area and choose 'Create UFO_State Digital Set on

1
Server ASIHO1.
UFO Type: Synchronization File Path:
|HOT x| |\ipassO1\FTHSE Failover\FTLDInt_FTLD_1 dat Browse |
Status Tai Exdesc PointSource | Location1 | Pc ~
o eated D .
Mot Created FTLDInt1_UFO2_H Create UFO_State Digital Set on Server ASIHO1...
Mot Created  FT1 Dint1 [IFO2 H
<| m Create all points (UFO Phase 2)
The active 1D value is located on th Delete all points (UFO Phase 2) I
The primary interface active |D valu o
primary. The value of n must be a pol Correct all points (UFO Phase 2)

13. When you receive the Successfully created Digital Set "UFO_State' on
server ASTHO1 message, click OK.

14. Right-click in the tag area and choose 'Create all points (UFO Phase 2).

UFO Type: Synchronization File Path:
|HoT x| |\ipassO1\FTHSE Failover\FTLDInt_FTLD_1 dat Browse |

The active |D value is located on the
The primary interface active 1D valug o
primary. The valus of n must be a pos Correct all points (UFO Phase 2)

Cloze | Apply I
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15. When the status for FTLDIntl_UFO2_ActionID tags changes to
'Created; click Apply.

The 'Unilnt Failover’ configuration is not complete until the 'Other’
interface is selected' message appears.

16. Click OK.

Another popup message appears that ‘changes made to the interface
settings will not take effect until the interface service is stopped and
started’.

17. Click OK.

Configure a FactoryTalk Live Data Secondary Connector

Use a PASS server with
these procedures. In this section you configure FactoryTalk Live Data Secondary connector.

Complete the following steps.

H 1. In the PI Interface Configuration Utility window, click the folder
PASS028 symbol (Create a New Interface instance from a .BAT file).

iyl Pl Interface Configuration Utility = )= -

Interface Tools Help

Interface:

Type:

Description: ]

Wersions: | < undetermined »

General

Unilnt - ;
; Faint Source: Server/Collective:
- PISDK —J |

- Digconnected Startup }_J SDK Member: |

. De.bug APl Hostname: |
- Failowver

- Perfarmance Paints Interface [D: Uszer:

i Performance Counters

Ll Ll

Interface Status Drescription:

! Type:
i Health Points acan Classe - |
Interface __~__J Version: |
Service .
10 Rate Scan Frequency ] Scan Class # | Fart: :

Interface Batch Filename

J

e

The Open Interface Configuration File dialog box appears.
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2. Select LDInterface and click Open.

T | Lo PIPC » Interfaces » ] C-| | Search Interfaces

Organize »  New folder =

A A‘ e
ST Favorites 0 Mamne Date maodified

B Desktop || | LDinterface 3/10/2015 2:43 PM
H, Downloads . PlBaken :

5l Recent places . PlintStatus 9325 1216 PR
L PING 0/3/25 12:20 PM
18 This PC = L. PIPerfMon 0/3/20M5 12:20 PM
jm Desktop L SMMP 043725 1213 P
jj Documents . TCPResp 93205 12:16 Ph
j, Downloads . Unilnt 9/3/2015 12:24 Ph
W Music
E Pictures
I Wideos
&, Lacal Disk (C2)

[~][<] |
File name: | v| Batch Files {*.bat, *.new, *.bat,* «

I Open E Cancel

Organize »  MNew folder
— o

% Favorites > Name Date medified Type

B Desktop I |_] FTLDInt_FTLD.bat.bak I5.-"'| 5/2012 242 PM  BAKFile

‘i, Downloads
"5l Recent places

1M This PC
_H Desktop
il Documents
@ Downloads
W Music
ﬂ Pictures
L.‘ Videos
£, Local Disk (C:)

[][<] [ [5]

File name: | FTLDInt_FTLD.bat.bak v | Batch Files (*.bat, *.new, *.bat, * +
I Open |v| Cancel

The Select Host PI Server dialog box appears.
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4. Make certain that the appropriate server is selected for each
pull-down menu.

5. Click OK.
i
The Pl host node specified in the imported configuration file:

localhost
is either not in the known servers list, or is not a Pl 3.3 server. |f the

comect server is in the list below, please select it and press QK. If it is
not in the list below, pleaze first add it via the Add Server buttan, then
zelect it and press OK.
lizt, uze the Add Server button to add the server. Add Server
Please note, only 3.3 or later servers will be shown:

2] Select the host Pl Data server.-"c:ollec:tiv- ASIHD‘I -

Frimary

1]

Select Host Pl Data serverfcollective

1] If the comect server is not in the known servers

3] Select the collective member:

Cancel |

6. Select Service from the list on the left of the PI Interface Configuration
Utility - FTLDInt1 window.

364

2| Pl Interface Configuration Utility - FTLDInt1 - [ol]
Interface  Tools Help
NEX | 4| P OB R | @ |
Interface:  [FTLDInt1 -> ASIHO1 »|  Rename
Type: 1FI'LDInt vi Rockwell FactoryTalk Live Data -Pl Data server Connection Status |
Description: ] # ASIHD1B.System. FlantF
v Witeable
Versions:  [FTLDInt exe version 4.6.0.60 |Unilnt version 4.6.0.60
General Service Configuration - ;
Service name: FTLDInt1 I0: [ Aate fyne gl Remove,
[Ser\rice * Auto Create
Display name: FTLDA| 7 Manual
Failover : o o s T e o " Disabled
Health Points  Domain\IUserl
Performance Counters Dot s eine
Performance Points
F1 SDK
Disconnected Startup
Debug Installed services:
10 Rate Dependencies: topip AelookupSve ~
Interface Status PlBufss 4 ALG
AppHostSve
» | | AppIDSve
Appirfo w
<[ m [ T>
Application Experence
Close
;'Réae_r'y [ Service Uninstalled i EIFI;LD'I'nt"i - Net Installed 4

7. Type 'FTLDI' for the Display name and click Create.

8. Select General from the list on the left.

General Pl Host Infarmation
Pl DK Point Source:  [FTLD l:l Server/Callective: |IEE0 -
- Disconnected Startup FTLD J SDK Member.  (SETIRE -
~Debug APl Hostname: (IS -~
- Failover
- Perfarmance Paints I Interface 10 |1 I User: |piadmin
i Perfarmance Counters Toges [Prmare -P13

9. Ifthe Interface ID is not already '1; change it to '1.

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018



Configure an Application Server Information Server (AppServ-Info) ~ Chapter 10

10. Select Failover from the list on the left.

pilnt Failover
Enable Unilnt Failover

Pl SDK

. Failover ID# for this instance:
Dizconnected Startup

Failover ID# of the other insta

-
-

11. Check 'Enable Unilnt Failover.
12. Check 'Phase 2.

Unilnt Failover
¥ Enable Unilnt Failover " Phase 1 Il': Phase 2 I

Failover |D# for this instance: [T [\WPASSO2B\FTLDInt1

Failover ID# of the other instance: |2 | Browse

I Do not failover when both interfaces lose connection to P
I Failover control tags are unsolicited {not scan based)

Rate at which the heartbeat point is updated/checked: |5000 milliseconds

Synchronization File Path:

) | ==
Status | Tag | Exdesc | PointSource | Lo ~
Created ASIHO-FTLDInt_1_FTLD_UFO2_ActivelD [UFO2_ActivelD] FILD 1
Created ASIHO1-FTLDInt_1_FTLD_UFO2_Heartbeat_1 [UFOZ2_Hearbeat:1]  FTLD 1
Created  ASIHO-FTIDInt 1 FTI0O 1IFO? Heartheat 2 ILIFO? Heartheat?1  FTID 1Y

< m >

13. From the UFO Type pull-down list, choose HOT.
14. Click Browse to search for the UFO synchronization File Path.

15. Navigate to the Network>pass01>FTHSE_Failover directory
and click Open.

b2, Select UFO synchronization file =

L&) b4 TI‘ » Network » passO1 » FTHSE_Failover v GI

Search FTHSE_Failover » |

Organize »  MNew folder

& Downloads ~| Name Date modified Type :
| Recent places
Mo items match your search.
1 This PC

ju Desktop

| Documents

& Downloads

o' Music

= Pictures

H Videos
&, Local Disk (C3)

ﬁ‘ﬂ Network

vl|[< m [ >

File name: [FTLDInt_FTLD_1 v| All files (*%) v

I Open 1v| Cancel

The Select UFO synchronization file dialog box closes.
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16. Set the Failover IDs as shown in the following image.

Unilnt Failover

¥ Enable Unilnt Failover " Phase 1 * Phase 2
Failover ID# for this instance: |2 WPASSOZBNFTLD It
Failover ID# of the other instance: |1| I Browse I
I Do not failover when both Interaces lose connection to P

I Failover control tags are unsolicited {not scan based)

Rate at which the heartbeat point is updated/checked: |5000 milliseconds

UFO Type: Synchronization File Path:
[HOT | [\passOT\FTHSE_Failover\FTLDInt_FTLD_1 dat Browse
Status | Tag | Exdesc | Paint Source | Lo ~
Created ASIHO1-FTLDInt_1_FTLD_UFO2_ActivelD [UFO2_ActivelD] FTLD 1
Created ASIHOT-FTLDInt_1_FTLD_UFO2_Heartbeat 2  [UFO2_Heartbeat2] ~ FTLD 1
Created ASIHM-FTI Dint 1 FTID _LIFO? Heartheat 1 ILIFO? Heartheat-11  FTID 1
< m >

17. Click Browse to search for the secondary instance.

18. Select FTLDIntl (under PASS02A in the example) and click OK.

% Browse for other FTLDInt Unilnt Failover Interface

Interface: WPASSO2AMFTLD NG

Paint 5 ource: [FTLD o
T—

Other Failover Interface: | Failover 1D:

b E FTLDIn [PS=FTLD] [ID=1] [Phaze = 2] [* Current Interface]

I (] 8 I Cancel

A synchronize UFO settings popup window appears.

19. Click Yes to synchronize the UFO settings for this instance.
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Use a PASS server with
these procedures.

PASS02A

The failover and synchronization information appears in the
respective fields.

Plinterfa

Interface  Tools Help

DNEX|H »eno 3R|EH @

Interface

[FTLDInt1 > ASIHO1

Type: IFI'LDInt 'i Rockwell FactoryTalk Live Data

Performance Counters

_vj Rename |

Pl Data server Connection Status

™ Do not failover when both inteffaces lose connection to Pl
[ Failover control tags are unsolicted {not scan based)

Description: I & ASIHDA System.PlartF
.(v’ Fy = L.

WVersions: lFI'LDIm exe version 4.6.0.60 [Unilrt version 4.6.0.60

General — Unilnt Failover

FTLDInt [¥ Enable Unilnt Failovar ¢ Phasel (% Phase?2

fl:ri:-i;e Failover ID# for this instance I2 |\\FﬂSSGZE\FFLDIm1
Failover Failover ID# of the other instance: |1 |\\PﬂSSD2A\WLDInH
Health Foirts

<\

Created ASIHO1-FTLDIn_1_FTLD_UFOZ_Heartheat_2
Crated. .ﬁSJHﬂ.‘I_—E[I_[]Irn._]_l?[J.D_LIEQ?_iHeartheat 1

ETFSREJHEEHCE Paints Rate at which the heartbeat point is updated/checked: IW milliseconds
Disconnected Startup UFD Type: Synchronization File Path:
i Debug |HOT ;] |\\passﬂ1\FI'HSE7FaiIover\FFLDImJ—'I'LDj dat Browse |
10 Rat
Irrterfa:e Status | Status | Tag | Exdesc | PointSource Lo~
Created ASIHO1-FTLDInt_1_FTLD_UFOZ_ActivelD [UFO2_ActivelD] FTLD 1 ]

[UFOZ_Heartbeat:2] FTLD 14
MIFO? Hearthest-11 FTID 1v
>

Close I Apply

| Ready

E-Sk?p?ed

|FTLDInt1 - Installed

Return to the primary server for the following steps.

1. In the PI Interface Configuration Utility window, click Apply.

2. In the PI Interface Configuration Utility window, click Browse.

I

r Unilnt Failover

Enable Unilnt Failover

Failover ID# for this instance:

Failover ID# of the other instance: |2

" Phase 1

% Phase 2

1

|\\PﬁSSDZA\FI'LDInt1

[™ Do not failover when both interfaces lose connection to Pl
™ Failover control tags are unsolicited (not scan based)

Rate at which the heartbeat point is updated/checked: IECCC miliseconds Fieset |

4 Browse !I

UFO Type: Synchronization File Path:
|HoT x| |\ipassO1\FTHSE Failover\FTLDInt_FTLD_1 dat Browse
Status Tag Exdesc Point Source | ~

Created

Cre; - (17 Heartheat 7
< m

ASIH0T-FTLDIRt _1_FTLD_UFO2_Heartheat 1
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The Browse for other FTLDInt Inilnt Failover Interface dialog
box appears.

3. Select the 'FTLDIntl (PS=FTLD) (ID=1) (Phase=2)' line under
PASS02B and click OK.

Interface: WWPASSOZBAFTLDING

Faint Source: IFT LD 1D:

Other Failover Interface: I\\PASSDZMFT LDInt1 Failover 1D:

* Current Interface]

I (] 8 I Cancel

4. Click the Programs I symbol and choose Administration
Tools>Service.

File Action View Help
& | g =

fcﬁ Services (Local)

-

FTLD1 MName Description Status Startup Type
':,ah FactoryTalk Activation Helper Assists Fact.. FRunning  Automatic
Start the service Qﬁ FactoryTalk Activation Servi... Running  Automatic
& FactoryTalk Diagnostics CE ... Receives m... Manual
Description: % FactoryTalk Diagnostics Loc... Running  Automatic
OSlsoft FTLDInt1 Interface Service i FactoryTalk Linx Running  Automatic
".sg FactoryTalk Live Data Pool ... Running  Automatic
Ssg, FactoryTalk ViewPoint Adm... FactoryTalk.. Running Automatic
% FactoryTalk ViewPoint Alar.. Passesalar.. Running  Automatic
o) FactoryTalk ViewPoint Hist... IntegratesF.. Running Automatic
", FactoryTalk ViewPoint Reci... FactoryTalk.. Running Automatic
(;g FactoryTalk ViewPoint Strin...  FactoryTalk.. Running Automatic
7L e T Automatic Lo
5 FTLDIntAge Bt Running  Automatic
".sg FTSysDiag5 Stop . Running  Automatic
Ssg, FTView Sha Pause irt..  Running  Automatic
% FTViewSery Resume Running  Automatic

"'..ah Function Di Manual
{2 Function Di
(;g Group Palig

% Harmony | Refresh Manual

Restart
1 Manual

| All Tasks

Running  Automatic (T...

Manual
Manual (Trig...
Manual (Trig...

na .

Bxtended A Standard /

Opens the properties dialog box for the current selection.

5. Right-click FTLD1 and choose Properties
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6. From the Log On tab, click “local System account’ and click OK.

—
General Log On |hmvw I Dependencies |

Log on as:

Allow service to interact with desktop

() This account: | | | Browse...

Password: | |

LConfirm password: | |

7. In the PI Interface Configuration Utility window, click Apply and then

Play P to start the primary service (if not already running).

Interface  Tools _Hel,

nsx dl|roinelale

Interface: [FTLDT [FTLDInt1] -> ASIHO1 v| Rename |
Tuvpe: lm Fockwell FactoryT alk Live Data Fl Server Connection Status —

Description: IDefauIt FTLD interface created by the FTH configure wizard, ASIHA, System Plantf
‘wiiteable

Wersions: IFTLDInt.exe version 4.5.5.23 IUniInt version 4.5.5.23

General r— Unilnt Failover
Unilnt [¥ Enable Unilnt Failover € Phase1 (& Phase?

RLSDK Failover ID# for this instance: [ [\WPASSO2A\FTLDItT
Dizconnected Startup
Diebug Failover ID# of the other instance: |2 |\\PASSDZE\F|’LDInﬂ
Failawer . [~ Do Not Failover when bath intefaces loose connection to Pl
Performance Paints [~ Failover control tags are unsolicited (not scan based)

EZZﬁLmPa;iTSEDuntEIS Rate at which the heartbeat point is updated/checked: |1 ] miliseconds Reset |
FTLDInt UFO Type: Synchronization File Path:

Service IHOT LI I\\passﬂ‘l\FI'HSE_Faﬂover\FI'LDlm_FI'LD_‘I dat Browse

10 Rat
Inter:a:e Status Status | Tag | Bxdesc | PairtSource | Location | P ~
Created FTLDInt1_UFO2_ActivelD [UFO2_ActivelD] FTLD 1

Created FTLDInt1_UFO2_Heartbeat_1 [UFO2_Heartbeat:1]  FTLD 1
.Fmated_ElD.IuL‘l_LLED.'LHean.beai_L‘ NIFO? Heartheat 21 FTIN ]
£ m

[

I_ Invvalid walue in required field

Heay | Stopped [FTLDInt] - Installed

8. Ifasked "Would you like ICU to start this service for you?; click Yes.
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Return to the secondary server for the following steps.

Use a PASS server with
these procedu;leS. " 1. Select the Interface that is shown in the following image and click Play
¥ to start the secondary service.
r—
Iterface Tools  Hell
PASS02B NESXx 4 r o DR R e

Interface: [FTLDInt1 -> ASIHO1 v| Rename |
Type: IFTLDInt vl Fockwell FactoryT alk Live Data Fl Server Connection Status —

Description: I ASIHO &, Spstem. PlantF
‘wiiteable

Wersions: IFTLDInt.exe version 4.5.5.23 IUniInt version 4.5.5.23

General r— Unilnt Failover
¥ Enable Unilnt Failover " Phase1 (% Phase2

Pl 5Dk
Dizconnected Startup
Diebug Failover ID# of the other instance: |1 |\\PASSD2A\FI’LDInt1

- : [~ Do Not Failover when both interfaces loose connection to P
Perlormarice Poits [V Failover control tags are unsolicited (not scan based)

Ezmmpa;iiﬁwn‘e's Rate at which the hearibeat point is updated/checked: [1000 miliseconds  Resst |

FTLDInt UFO Type: Synchronization File Path:
Service IHOT LI I\\passﬂ‘l\FI'HSE_FaiJover\FI'LDInt_FI'LD_‘I dat Browse

10 Rate S = |
Interface Status _ﬁﬂlﬁs - | Bxdesc : | PaintSource | Location1 | PaintT ~
Created FTLDInt1_UFO2_ActivelD [UFO2_ActivelD] FE 1

Created FTLDInt1_UFO2_Heartbeat_2 [UFO2_Heartbeat:2] FTLD 1
.F:Pated_ELDlm_LU.EOLHean‘he.at_‘l_l‘llFﬂ?. Heartheat-11 FTITL 1
£ m

[

Failover |D# for this instance: |2 [\PASSD2B\FTLDInt1

a

Cloze |

[FTLDINt - Installed

2. Ifasked "Would you like ICU to start this service for you?, click Yes.

Confirm Unit Failover Diagnostics

1. In the Windows desktop, click the Programs I symbol and choose
Rockwell Software>FactoryTalk Historian SE>System
Management Tools.

| FactoryTalk Historian SE Systern 3
4 Help 3
M Interface Configuration Utility
@ MDE to AF Preparation Wizard

Use an AppServ-Info server

Start FactoryTalk Historian SE . Accessibility 2
with these pro(edures. % Stop FactoryTalk Historian SE . Administrative Tools 2
stemn Explorer .. Embedded Lockdown Manager *
-— Systern Management Tools .. Maintenance 3

System Tray | FactoryTalk Activation b | | Rockwell Software
. . Uninstall FactoryTalk Historian Site Edition . FactoryTalk Historian SE L Startup 3
. FactoryTalk Tools b L VMware 2
1. RSLinx Windows Accessories 2
ASIHO1A 3} FactoryTalk Administration Console . Windows System 3

Adobe Reader X|
| Desktop
p Search

The PI System Management Tools (Administrator) window appears.
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2. Click Data>Current Values.

File  View Tools Help

et P ag Mame  Server Collective Timestamp Value Engineering Units  Descriptor
Collective: ASIHO1

[+ asih01a  Primary

[] ASIHO1B  Secondary

I IT Points
I» Operation
I Points

I» Security

SYSTEM\Administrator | piadmin L

3. Click the Tag Search € icon.
The Tag Search window appears.
4. Type *FTLD* in the Tag Mask and click Search.

Basic Search | Advanced Search I Aliaz Searchl

Fl Server: Faint Type: Paint Clazs:

[esimne EiE v v]

Connections...

R Faint Source: Engineering Units: —
W |I| : | |x | Search

~ B Ly T

All*FTLD* tags are displayed.
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S. Click Select All and OK.
@ Tag Search I_I_-' =

Basic Search ] Advanced Search 1 Alias Seart:h1

Pl Server: Poirt Type: Point Class:
v Ap ol 3

Tag Mask: Point Source: Engineering Units:

[T : 1§ |

Descriptor: Walue: »

s —————

Server: Tag: Descriptor: Select Al
ASIH0T%as... FTLDInt1_UFO2_ActivelD =
ASIHD1'as... FTLDInt1_UFO2_Device...
ASIHO1\as... FTLDInt1_UFO2_Device... Pt Adtr...
ASIH0T'as... FTLDInt1_UFOZ2_Heartb...
ASIHD1'as. . FTLDInt1_UFDZ Hearth..
ASIHDT\as... FTLDInt1_UFO2_State_1 :

ASIHOT'as... FTLDInt1_UFO2_State_2
OK

Cancel

Help

< n >
| Ready | List Count: 7

The Tag Search window closes and all *FTLD* tags are displayed in the
Current Values - PI System Management Tools (Administrator) window
along with their values.

6. Ifdesired, click Play » to see the online status.

33 0 OEEID
Tag Name Server  Collective  Timestamp Value Engineering Units ~ De
i FTLDInt1 _UFO2 ActivelD asihl1a _ASIHD 9/10/20154:1453PM__ 2
FTLDInt1_UFO2_DeviceStatus_1 asih@1a ASIHO1  9/10/20154:14:38PM 0
FTLDInt1_UFO2_DeviceStatus_2 asih@1a ASIHD1 ~ 9/10/20154:14:52PM 0
FTLDInt1_UFC2_Heartbeat_1 ashl1a ASIHD1  9/10/20154:15:13PM 8
FTLDInt1_UFO2_Heartbeat_2 ashlla ASIHD1  9/10/20154:15:17PM 11
FTLDInt1_UFO2_State_1 ashl1a ASIHD1  9/10/20154:14:58 PM  Backup
FTLDInt1_UFO2_State_2 asihl1a ASIHD 9/10/2015 4:14:56 PM  Primary

IMPORTANT  We recommend that you use PerfMon for all computers and proceed

to Configure Performance Monitor Interface on page 373.
If your system does not require this option, proceed to page 396
to configure FactoryTalk Historian connectivity.
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Configure Performance
Monitor Interface

Use a Domain controller
with these procedures.

The Windows Performance Monitor (PerfMon) interface provides continuous
monitoring of historical data to evaluate the performance of a computer. The

‘PI’ preface is the name of the OSISoft product.

Create PIPerfMon System User

You must create a user that is actually a service to have privileges within other
computers on your system. This ‘user’ permits the system to access computers
to obtain data for a performance capture.

Complete these steps.

1. From the Server Manager, click Tools and choose Active Directory Users
and Computers.

The Active Directory Users and Computers dialog box appears.
2. Expand the domain folder (System.PlantPAx.local).

BE |

Active Directory Users and Computers

3. Right-click Managed Service Accounts and choose New>User.

File Action View Help
= §8 XE = H LaETER
] Active Directory Users and Computers[PADC;l MName - Type Description
B | Saved Queries Th it T
4 53 System.PlantPAxlocal ere are no items to show in this view,
I+ || Builtin
| Computers
2| Domain Controllers
I> || ForeignSecurityPrincipals
_| Managed Service Accounts
4 (3] PlantPAx Delegate Control...
o | Areas Move...
2| Roles Eind
o Users :
| Users Mew 3 Computer
All Tasks 3 Contact
View v Group
Cut InetOrgPerson
Delere msDS-ResourcePropertyList
B arne mslmaging-P5Ps
Refrech MSMQ Queue Alias
Export List... ; Lo
< L Properties
Create a new object... | ared rolder
Help
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The New Object - User dialog box appears.
MNew Object - User -
_;‘ Createin:  System.PlantPAclocal/Users
Last name: | |
Full name: | FiPerfmaon |
User logon name:
|piperfm0n | |@System.PIantPAx.Ioc:al V|
User logon name (pre-Windows 2000):
|SYSTEM\. | |piperfm0n |
B Ned> | [ Cancel |
4. Complete the User text boxes.
Item Description
First name Type a name for the PI PerfMon service.
IMPORTANT: The ‘PI’ preface is the name of the
0SISoft product.
Initials Optional; you can leave blank.
Full name Type the same name for the PI PerfMon service.
User login name Type the same name for the Pl PerfMon service and
click the pull-down to select your domain folder.
User logon name (pre-Windows 2000) Use the SYSTEM\ default and type the same name
for the P PerfMon service.

IMPORTANT  The logon password creates a service user, not a person. The service
user grants access to system computers for placing data into
memory (buffer).

5. Click Next.
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6. Type your password twice, and make sure that there is a check mark in
the following boxes:

e User cannot change password

o Password never expires (indefinite service for system access)

New Object - User -
J) Createin:  System PlantPAxlocal/Users New Object - User -
Password: |uouuu | J) Createin:  System.PlantP A« local/Users
Confirm password: |ouuuu| |

When you click Finish, the following object will be created:
[ User must change password at next logon

Full name: FiPerfmon A
User cannot change password
User logon name: piperfmon@System PlantP Ax local
Password never expires
N The user cannot change the password.
[ Acogurnt is disabled The password never expires.

e e

7. Click Next and then click Finish.

Configure the PIPerfMon Interface

You must enter an interface name and a points value. The points are the limit

Use an AppServ-Info server the interface uses based on the number of computers in your system. Each
that has the interface with variable — CPU usage, RAM, disk space — is one point. You can use the number
these procedures.

of points up to 20% of your FactoryTalk Historian SE software license.

H Assign the License

ASIHO1 Complete these steps to assign the interface license.

1. Click the Programs E symbol and choose Rockwell

Software>FactoryTalk Administration Console.

2. Select Network and click OK.
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3.

4.

Expand the System>Connections>Historical Data folders and
right-click Production Historian.

Select Properties.

rd

FactoryTalk Administration Console -|o] x

-[Z1 Action Groups
+[_] Policies

#[.] Computers and Groups
i@ Metworks and Devices
7Z1] Users and Groups
=L Connections

@ Databaszes

TRl .

File View Tools Window Help

Port Surces
Interface Type Points in Use

Rockwell 7

General i)

Interface Type Allocation Points in Use

PERFMON

(2] Historical Data ME
[ Permission Sets

E Production Historian

& Move Up | Delete
* Move Do'.'.-r.l

B [ o o 1w |

MNUM

IMPORTANT  Be patient because this dialog box could take a few minutes
to appear.

On the Point Sources tab, type an interface name (such as PerfMon) and
avalue for the points limit.

The value is the expected number of performance points in the system.
Click OK.

Close the FactoryTalk Administration Console.
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Configure the Interface Utility

Complete these steps to configure the PIPerfMon interface.

1. Click the Programs I symbol and choose Rockwell
Software>FactoryTalk Historian SE>Interface Configuration Utility.

| FactoryTalk Historian SE System 3
Hel 4
Interface Configuration Utility
MDE to AF Preparation Wizard . Accessibility 2
Start FactoryTalk Historian SE | Administrative Tools 2
Stop FactoryTalk Historian SE . CodeMeter 2
n System Explorer (64-bit) | Embedded Lockdown Manager »
D System Explorer . Maintenance 4
i#® System Management Tools 1. Microsoft Office 4
ﬂ System Tray || FactoryTalk Activation » | | Rockwell Software
. Uninstall FactoryTalk Historian Site Edition . FactoryTalk Historian SE . SharePoint S
| FactoryTalk Tools ¥ | | Startup 3
Ju RSLinx v | L VMware 3
[} FactoryTalk Administration Console . Windows Accessories 2
1 Windows System 3
I._i Desktop
£¥ PCsettings
1 Search
€ Store

The Interface Configuration Utility dialog box appears.

2. Choose New Windows Interface Instance from BAT file from the
Interface menu.

3. Select the PiPerMon.bat_new file under FactoryTalk Historian/PIPC/
Interfaces/PIPerf Mon.

[ Interface | Tools

Help

Tew UNTVIVIG Iterface InStancen

Delete Interface Instance...

Unregister Interface from ICU...

SDK Connections...

| Connect to Primary

Organize = New folder = [ @
B Desktop [~ Name Date modified Type Size
8 Downloads —

5l Recent places

18 This PC
jm Desktop
I| Documents
i. Downloads
W Music
=| Pictures
B Videos
&, Local Disk (C) ||
| DVD Drive (1) Ol

“

File name: | PIPerfMon.bat_new W | Batch Files (*.bat*, *.new®, *.zar +
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4. Click Open.
5. Select the FactoryTalk Historian server and click OK.

iyl Select Host Pl Data server/collective -

The Pl host node specified in the imported corfiguration file:
priccees

is either not in the known servers list, oris not a Pl 3.3 server. ff the

comect server is in the list below, please select it and press OK. it is

not in the list below, please first add it via the Add Server button, then

select it and press OK.

1) i the comect server is not in the known servers
list, use the Add Server button to add the server. Add Server
Please note, only 3.3 or later servers will be shown:

2) Select the host Pl Data ser\rer,-’collecti\r* ASIHOT - I

Core

6. Type a Point Source name and an Interface ID number.

2| Pl Interface Configuration Utility - PIPerfMon * -[alx]

Interface  Tools Help

NEX | H| reoo | 2R 08 @

Interface:  |PIPerfMon - ASIHO1 v|  Rename
Type: 1F‘IF‘erfMon vi PI Performance Monitor -Pl Data server Connection Status |
Description: ] ‘g ASIHOT
v Witeable
Versions: JPIPerfMon.eme version 2.1.0.88 ]Unilnt version 4.6.0.60
General General 1 Pl Host Information
PIPerfMon Point Source:  MPERFMON Server/Collective: ]i_'SIH-'_Tl _,J
Service )
e PERFMUN SDK Member:  [A51HD1 =l
‘- Failover . P
i APl Hostname:  [ASIHDT |
- Performance Counters Interface 1D: - User: 1piadmin
- Performance Points | | . =
e Sean Classes Type: iNon-repllcated -Pi3
- Disconnected Startup Version: |P13.4.395.80
L. Deb :
0 R;eug Scan Frequency | Scan Class # ] Port: 15"59
Interface Status + 00:00:05 1
~ 00:01:00 2 ! I—
i~ Interface Installation Path -
IC:\ngmm Files (xB6)\Rockwell Software'\Factc
Interface Batch Filename
|PIPerfMon bat
g
;'Réae_r'y ;'Rl'.lnning i f'PlFiér'f'Mon - Installed 4

IMPORTANT  The Point Source name must match the interface name that you
typed in the Historian Production dialog box on page 376.

The Interface ID number must be unique in the system.

7. Click Apply.
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8. Click OK to restart the interface service.

tM  Interface Changes Require Restart

Changes made to the interface settings will not take affect until
the interface service is stopped and restarted.

[~ Do not display this again for this interface |

Import PIPerfMon Digital State

Complete these steps to import digital sets and states for the Performance

Use these procedures with an Monitor service. Digital states create a relationship between values and text
AppServ-Info server oran
Engineering Workstation that has
FactoryTalk Historian installed.

state names.

For example, 0 = Good, confirmed good quality; 1 = Good, assumed
good quality.

ASIHOT EWS 1. Open the Historian folder by clicking the Program button I and

choosing Rockwell Software>FactoryTalk Historian SE>System
Management Tools.

@ MDEB to AF Preparation Wizard | Accessibility
%| Start FactoryTalk Historian SE . Administrative Tools

5| Stop FactoryTalk Historian SE . CodeMeter
Q Systemn Explorer (64-bit) ., Embedded Lockdown Manag
er i . Maintenance
System Management Tools . Microsoft Office
ySLEM | ray . FactoryTalk Activation ¥ | | Rockwell Software
. Uninstall FactoryTalk Historian Site Edition I | FactoryTalk Historian SE .. SharePoint
ryTalk, s, W

The Digital States - PI System Management Tools dialog box appears.

2. Under Servers, select the server that is being configured for the
PIPerfMon interface.
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3. Under Points, open Digital States and click the Import button.
i Digital States - Pl System Management Tools (Administrator) =
File View Tools Help
el 2 4 | ASIHO [[ state ] State Name-
Servers ™ BatchAct | R 1 -
ASIHO1 Interface Status
Y Phases & Import Digital Set(s) [ = |
p?alarrn33 Comma delimited file with sets and states:
pialamcontrol
Y pisgcalam “
B SYSTEM )
System Management % UFO_State e
o T Sets in file:
Seardh jol
I» Alarms et
I» Batch
I» Data
I Interfaces
I IT Points
I» Operation
Overwrite Options
(®) Do not overwrite existing sets
) Import set with a different name i set already exists
: (O Prompt before avenwriting existing sets
Point Classes —~ Z - i
Paint Source Table ) Automatically overwrite existing sets
Totalizers
I Security Import set(s) to server: |,\SIHD‘I
Session Record
[SYSTEMA
4. From the Import Digital Set(s) dialog box, click the folder icon.
5. Navigate to C:\Program Files (x86)\Rockwell Software\FactoryTalk
Historian\PIPC\Interfaces\PIPerf Mon
6. Select the PI_PIperfmon_DS.csv and click Open.
% Open xT]
(—J x 1‘I| .« Local Disk (C:) » Program Files (x86) » Rockwell Software » FactoryTalk Historian » PIPC » Interfaces » PIPedfMon v O |I| Search PIPerfMon »p |
Organize = Mew folder =~ [ @
Bl Desktop Ll Name : Date modified Type Size
& Downloads = = =
E PI_PIPerfMon_DS.csv I 20151216 PM  Microsoft Excel C... 1 KBI
=l Recent places . e —— — .
18 This PC
1z Desktop
| Documents
& Downloads
' Music
= Pictures
H Videos
&, Local Disk (C:)
?ﬂ Network -
File name: | P|_PIPerfMon_DS.csv v| CSV Files (*.csv) v
Open Cancel
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7. Click Create Set(s).
fse

import Digital Set(s) | = | = NG |

Comma delimited file with sets and states:

|C:\Program Files §c86)\Rockwell Softwars\FactoryTalk Histori|
File Preview

Sets in file: 1

Set

State 0 State 1 State 2
PIPerfI‘u'Ion NOT INITIALIZED OFFLINE  NO ACCESS

< m

Owerwrite Options

(®) Do not overwrite existing sets
) Prompt before ovenwriting existing sets
O Automatically overwrite existing sets

() Import set with a different name if st already exists

Import set(s)to server: |ASIHD‘I

8. Click Close.
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Create PIPerfMon Interface Health Points

Complete these steps to associate the PerfMon interface with the health tags

Use an AppServ-Info server that monitor a device heartbeat for diagnostics. The heartbeat count
that has the interface with determines if the system is working. If there is a stoppage, you can analyze what
these procedures.

prompted the fault or device error.

. 1. Click the Program button E and choose Rockwell
ASIHOT Software>FactoryTalk Historian SE>Interface Configuration Utility.

2. From the Interface pull-down, select PIPerfMon.

3. From Health Points on the left, right-click
PIPerfMon.DeviceStatus and choose Create.

%} Pl Interface Configuration Utility - PIPerfMon - [axT]
Interface  Tools Help
NEX Hd| » ia|BRIE|@© _
Interface:  |PIPerfMon - ASIHO1 »|  Rename
Type: iF‘IF‘erfMon vi PI Performance Monitor -Pl Data server Connection Status |
Description: ] ‘é' ASIHOT
v Witeable
Versions: JF‘IF‘erfMon.eme version 2.1.0.88 Unilnt version 4.6.0.60
General - Unilnt Interface Health Monitoring Points -
FlPerfMon Status ] Tagname | Type ] Scz A
Service Mot Created  sy.st. ASIHO1.PIPerfMon Inteface Poirt Count [UI_POINTCOUNT] o
Uniilrt Mot Created sy .st. ASIH01.PIPerfMon.Heartbeat [UI_HEARTBEAT] 0
e Not Created| sy st ASIHD1 FIPefMon.Device Status N =
| Health Poirts Mot Created  sy.st. ASIHO1.PIPedfMon.Scan Class Information Create (1]
. Mot Created sy.st. ASIH01.PIPerfMon IO Rate Create Al 0
Sh e Not Created sy.st.ASIHO1.PIPerfMon Message Court ek 0!
Peormancs Poirts | | Not Created sy.st.ASIHO1.PIPeMon Output Rate o ]
PI'SDK Not Created sy.st.ASIHO1.PIPerfMon Qutput Bad Value Rate 0
Disconnected Startup Mot Created sy st. ASIHO1.PIPerfMon. Trigger Rate Delete All ]
Debug Mot Created sy st.ASIHO1.PIPerfMon. Trigger Bad Value Rate = 0
|0 Rate Mot Created sy .st.ASIHO1.FIPefMon.Scan Class 10 Rate scll Caorrect 0
Mot Created sy st ASIHO1.PIPerfMon Scan Class Bad Value A 1]
Interface Stat A
PEEDEE Not Created sy st ASIHO1 PIPertMon Scan Class Scan Counf | 2 =<t A1 0
Not Created sy .st. ASIHO1.PIPerfMon.Scan Class Scans Skipy Rerarae o |[¥
Fd | m >
Refresh Snapshots
Refresh Table
To create, delete, comect, or rename a Unilnt Interface Health PEi-nt. use right mouse button.
Close
;_'Réac'fy ;_'Rl'.lnning I F‘IF‘erfMon - Installed 4
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4. Right-click PIPerfMon.Heartbeat and choose Create.

Interface  Tools Help

NESX Hd >0 BR|IE®

Inteface:  |PIPerfMon -> ASIHOT v|  Rename |
Type: lm PI Performance Monitor P| Data server Connection Status
Description: I ¢ leT.

Versions: IPIPa'anﬂ.ene version 2.1.0.88 Unilnt version 4.6.0.60
[Genersl [~ Unilnt Interface Health Monitoring Poirts

PlPerfMon Status | Tagname I Type
Service Mot Created sy.st. ASIHO1.PIPerfMon.Interface Point Court [UI_POINTCOUNT]
Unilrt O1.PIP
. Failover Created sy.st.ASIHD1.PIPefMon. Device Status Create
Mot Porks Not Created sy st.ASIHD1.PIPefMon.Scan Class Inf

Create Al
Per e Co s Mot Created sy.st. ASIH01.PIPerfMon IO Rate |
Delete

T Mot Created  sy.st. ASIHO1.PIPerfMon Message Count
- Pefoamance Foirts Not Created sy st ASIHD1.FIPerfMon Output Rate
- P1SDK Not Created sy.st.ASIHO1.PIPerfMon.Output Bad Value Delete All
- Disconnected Startup Mot Created sy st. ASIHD1.PIPerfMon. Trigger Rate I

i Debug Not Created sy .st. ASIHO1.PIPefMon. Trigger Bad Value Correct

10 Rate Not Created sy.st.ASIHD1.PIPerfMon.Scan Class 10 Rat Coiect Al

Mot Created  sy.st. ASIHD1.PIPefMon. Scan Class Bad Ve
Interface Stat
RS Not Created sy st ASIHO1 PIPerfbonScan Class Sean @ | pename

Mot Created  sy.st. ASIHO1.PIPerfMon.Scan Class Scans
< ] m Refresh Snapshots

I Refresh Table

&
>

S ToocoooooooooEoitn

||

To create, delete, comect, or rename a Unilnt Interface Health Point, use right mouse button.

[ Runring | PIPerfMon - Installed

5. Under Service, choose pibufss and click the left arrow to move to the
Dependencies box.

Interface  Tools Help

NESX d» o RRIA O

Interface:  [PIPerfMon > ASIHDT =] Rename |
Type: lm Pl Performance Monitor Pl Data server Connection Status
Description: I ¢ leT.

Versions:  |PIPerfMon.exe version 2.1.0.88 |Unilnt version 4.6.0.60
— Service Configuration

Service name: IFIF‘erfMon |DZ|
- con |
Display name: IPI Performance Monitor full version) " Manual

() & - B
Log on as: & NT Service'\PIPerfMon Disabled Femhva |

¢ [Domain‘]UserName

il Startup Type Create / Remove

Disconnected Startup
. Debug
10 Rate
Interface Status

Installed services:

[ PIPerfMon - Installed

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018 383



Chapter 10  Configure an Application Server Information Server (AppServ-Info)

6. Type the same user name and password that you initially created for the

service. See page 374.

Interface  Tools Help

NEX|dr»rea R @le

Inteface:  |PIPerfMon -> ASIHOT v|  Rename |
Type: PIPerfMan ~| Pl Performancs Monitor P| Data server Connection Status

Description: I ASIHDT

Versions:  |PIPerfMon.exe version 2.1.0.88 |Unilnt version 4.6.0.60
General  Service Corfiguration

PIPerfMon - . 5 Startup Type Create / Remove
Service name: PIPerfM; 1D:
Service I on I il * Auto

Create
Unilrt Display name: IPI Performance Monitor full version) " Manual 4'

i~ Failover : " NT Service \PIPerfMon " Disabled Remove |
Health Points Lo onzi

Performance Courters = {Doma U aie

Performance Poirts UserName: ISYSTEM\piperﬁmn

F1 SDK
; Disconnected Startup
IO g:tb”g { Installed services:

e i %
; AelookupSve

Interface Status i g

Application Experence

Close Apply

[ PIPerfMon - Installed

7. Click Apply.
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8. Open Services, right-click PI Buffer Subsystem, and select ‘Automatic’
as the Startup type.
Q’ Services - O x
File Action View Help
e [EEcz B »enw
{',; Services (Local)
Pl Buffer Subsystem Name * [~
i, Performance Counter |
Start the service % Performance Logs & A
-ﬂ gs
., | | General :
PI AF Link Subsystem enersl | Log On | Recovery | Dependencies |
5'3 Pl Alarm Subsystem Service name:  pibufss
-, Pl Archive Subsystem i . PRELED
. Pl Backup Subsystem e RS
(. Pl Base Subsystem Description:
‘., Pl Batch Generator Int
: ELEalCh L RRS et | | i 1o executzble:
- Pl Buffer Subsystem R | "C:\Program Files\Rockwell Software'\Factory Talk Historian'\PIPC\bin'\pibuf
o Pl License Manager
5, Pl Message Subsystem|| | Sirup tpe:
2% Pl Network Manager
Pl Performance Equatid
Pl Performance Monitd. | Service status:  Stopped
Pl Ramp Soak Simulatd
- Pl Random Simulator ( | Start | | Stop | | Pause | | Resume
S‘ﬂ Pl Recalculator Subsyst | vy can specify the start parameters that apply when you start the service
"% Pl Shutdown Subsyster) | | from here.
. Pl Snapshot Subsystent
"f' el Start parameters:
4 P1SQL Subsystem
[ Pl Totalizer Subsystem
. Pl Update Manager
5 PI-Buffer Server !
{5 DI_Duibfnr Comune bl [
Extended /(Stand.ard/
9. Click OK.
10. To restart the interface service, click OK.
Changes made to the interface settings will not take affect until
the interface service is stopped and restarted.
[~ Do not display thi his interface ;
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Use these procedures with an
AppServ-Info server or an
Engineering Workstation that has
FactoryTalk Historian installed.

Monitor PIPerfMon Interface

Complete these steps to verify that the interface has a good working status.

ASIHO1

L]
]

EWS

1. Click the Program button I and choosing Rockwell
Software>FactoryTalk Historian SE>System Management Tools.

@ MDB to AF Preparation Wizard 1. Accessibility

Start FactoryTalk Historian SE . Administrative Tools

Stop FactoryTalk Historian SE 1. CodeMeter

a Systemn Explorer (64-bit) . Embedded Lockdown Manag
1. Maintenance

System Management Tools . Microsoft Office
€M | ray | FactoryTalk Activation ¥ | | Rockwell Software
. Uninstall FactoryTalk Historian Site Edition I . FactoryTalk Historian SE . SharePoint
Talk dmals 4

PP,

The PI System Management Tools dialog box appears.

File View Tools

Help

2. Inleft, top pane, search for the appropriate server with the interface.

Servers

EX% > 5 BEO

Seardh

Tag MName

Servers
[ .*\SIHD‘Il

sy.st. ASIHD1.PIPerfMon . Device Status
sy st ASIHO1.PIPerfMon. Heartbeat

System it

Seardh

I» Alarms
I» Batch
4 Data
Archive Editor
Stale and Bad Points
I Interfaces
I IT Points
I» Operation
I Points
I» Security

Server Collective  Timestamp
asih01 4/14/2017 12:01:41 PM
asih01 4/14/2017 12.11:01 PM

Engineering Units

seconds

SYSTEM\Administrator | piadmin L

3. In the lower, left pane, expand the Data folder and click Current Values.

After you search for tags you need, the Value category displays the
health state of the interface and the number of seconds between the

heartbeat counts.
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Enable Performance Monitor

computers.

Perform this procedure in all system computers.

All servers ...

)

... and workstations

Adding PIPerfMon User

Complete these steps to create a performance monitor user.

1. Click the Windows |?|__| symbol.
2. Click Control Panel and choose User Accounts.
& Control Panel\All Control Panel ltems

This section describes how to enable PIPerfMon to collect data from system

Adjust your computer's settings

Ll |@ » Control Panel » All Control Panel ltems » v & | Search Control Panel »p |
View by:  Small icons ~
{+] Administrative Tools g AutoPlay

P Action Center
Kl Color Management
[8 Default Programs
= Display
! Folder Options
&% i5CS! Initiator
F Mouse
l! Personalization
[E Programs and Features
% Sound
ﬂ Taskbar and Navigation

82, User Accounts

Credential Manager

24 Device Manager

@' Ease of Access Center
la Fonts

EB Keyboard

¥ Network and Sharing Center
|5 Phone and Modem
=g Region

@ Sync Center

2| Text to Speech

ﬂ Windows Firewall

% Date and Time

r!,_g Devices and Printers
Flash Player (32-bit)
Internet Opticns

€$‘ Language

Notification Area lcons
E Power Options

™5 RemoteApp and Desktop Connections
1B Systern

[8 Troubleshooting

B% Windows Update
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3. Click Manage User Accounts and click Add.

®

- 1 ‘* » Control Panel » All Control Panel ltems » User Accounts

v O ‘ | Search Control Panel

Control Panel Home

Manage your credentials

Manage your file encryption

certificates By Change User Account Control settings
@ Configure advanced user @l Manage User Accounts
profile properties

Change my environment

Make changes to your user account

Users | Advanced

& Use the list below to grant or deny users access to your computer,

SYSTEM\Adminis

SYSTEM\Administrator] and to change passwords and other settings.

Users for this computer:

User Name Domain Group

Administrator PASS02A Administrators

I Add... I Remove Properties

Password for Administrator

% To change the password for Administrator, click Reset Password,

[ o J[ el ][ aomv

4. Type the same user name and Domain that you did to grant system

access for the PerfMon service. See page 384.

Add a domain account

Enter someone’s user name and domain to give that person permission to use this computer,

User name: | piperfmon

Domain:| SYSTEM

S. Click Next.
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6. Click Other and choose Performance Monitor Users.

What level of access do you want to grant this user?

() Standard
Standard accounts can use most software and change systemn settings that don't affect other
the security of this PC.

() Administrator
Administraters have complete contrel over the PC, They can change any settings and access|

the files and programs stored on the PC,
I© Other: Performance Monitor Users

Members of this group can access performance counter data locally and re

You're almost done

The following user will be able to sign in to this PC and access system resources.

SYSTEM\piperfmon

7. Click Next and Finish.
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Adding PIPerfMon Firewall Rule

Perform this procedure in all system computers.
Complete these steps to configure port settings to allow external computer

r— .
connections to extract system data.
L ]
ST
1. Click the Windows E symbol.
All servers... ...and workstations

2. Click Control Panel and choose Windows Firewall.

@ - 7t |@ v Control Panel » All Control Panel ltems »

W C-| | Search Control Panel

390

Adjust your computer’s settings

P Action Center

g] Color Management
Default Programs

!J Display

_ Folder Options

&}, i5Csl Initiator

& Mouse

.l;l Personalization

ﬂ Programs and Features
% Sound

Taskbar and Navigation
82, User Accounts

3. Click Advanced Settings.

Administrative Tools
Credential Manager
ﬂ Device Manager

9 Ease of Access Center
U4 Fonts

&= Keyboard

ﬁ Metwork and Sharing Center

&n Phone and Modem
‘_,ﬁ Region

@ Sync Center

E] Text to Speech

ﬂ Windows Firewall

View by:  Small icons *

g AutoPlay

ﬂ Date and Time

é Devices and Printers
Flash Player (32-bit)
Internet Options

§$ Language

= Notification Area lcons
3 Power Options

@ RemoteApp and Desktop Connections
1B System
Troubleshooting

B Windows Update

@ - 1 |o v Control Panel » All Control Panel ltems » Windows Firewall

] C-| ‘ Search Control Panel

Control Panel Home

Allow an app or feature
through Windows Firewall

@' Change notification settings

) Turn Windows Firewall on or
off

@ Restore defaults

@ Advanced settings

Troubleshoot my network

Seealso
Action Center
Metwork and Sharing Center

Help protect your PC with Windows Firewall

Windows Firewall can help prevent hackers or malicious software from gaining access to your PC through

the Internet or a network.

. @ Domain networks

Connected (&)

Metworks at a workplace that are attached to a domain

Windows Firewall state:

Incoming connections:

Active domain networks:

Notification state:

On

Block all connections to apps that are not on the list
of allowed apps

& System.PlantPAx.local 2

Do not netify me when Windows Firewall blocks a
new app

. @ Private networks

Not connected @‘

. @ Guest or public networks

Mot connected @‘
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4. Expand the Windows Firewall folder, right-click Inbound Rules, and

choose New Rule.

S. Click Port and then click Next.

File Action View Help

| 2 3
&P Windows Firewall with Advance Bt it s Rule Type
Inbound Select the type of firewall rule to create.
&3 Outboun New Rule...
% Connectio] | Eiier by Profile b e Sters:
B, Monitori
[ Sl | Filter by State v lexd @ Rule Type What type of rule would you like to create?
Filter by Group » ®X48 @ Protocol and Ports
View » 4 @ Action ) Program
Wi Profil Rule that controls connections for a program.
| Refresh wi ® "™ne
| Export List... vy @ Name ® Port
e Rule that controls connections fora TCP or UDP port.
' Help
. ) Predefined:
|B|E|nchCache - Content Retrieval (Uses HTTF) W
Rule that controls connections for a Windows experience.
) Custom
Custom rule.
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6. For TCP, click Specific local ports and type 135, 445.

IMPORTANT  The two port numbers listed in step 6 must be configured to allow
system data exchanges with external computers.

g MNew Inbound Rule Wizard -

Protocol and Ports

Specify the protocols and ports to which this rule applies.

Steps:

@ Fule Type Does this rule apply to TCP or UDP?
» Protocol and Ports ® TCP

@ Action ) upp

@ Profile

@ Name

Dioes this rule apply to all local ports or specific local ports?

s 05

Eampie: ou, 443, 5000-5010

O Al local ports
@ Specific local ports:

7. Click Next.
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8. Click Next for the Action step.

Do not change any settings.

Action
Specify the action to be taken when a connection matches the conditions specified in the rule

Steps:

@ Rule Type What action should be taken when a connection matches the specified conditions?

@ Protocol and Ports

3 (@) Allow the connection
@ fction This includes connections that are protected with [Psec as well as those are not.
@ Profile
N () Allow the connection if it is secure

Ll This includes only connections that have been authenticated by using IPsec. Connections
will be secured using the settings in IPsec properties and rules in the Connection Security
Rule node.

Customize.

) Block the connection

9. Click Next for the Profile step.

Do not change any settings.

Profile
Specify the profiles for which this ule applies.

Steps-

Rule Type When does this rule apply?

Protocol and Ports
Action [¥| Domain

Profile Applies when a computer is connected to itz comporate domain

¥ Private
Applies when a computeris connected to a private network location, such as a home
or work place.

[v| Public
Applies when a computer is connected to a public network location.

Name
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10. Type a name and click Finish.

Name

Specify the name and description of this rule.

Steps:
Fule Type
Protocol and Ports
Action

Profile I-Niﬂi |
| Perfmon Connection| I

Name:
Description (optional);

394 Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018



Configure an Application Server Information Server (AppServ-Info) ~ Chapter 10

Enabling PIPerfMon Counter Service
Perform this procedure in all system computers.

Complete these steps to enable the PIPerfMon service to start collecting

Jr—
. information from system computers.
— 1. From the Start menu, click Programs and choose Administrative
All servers ... ...and workstations

Tools>Services.

2. Right-click Performance Counter DLL Host and choose Properties.

File Action View Help
e BHdz Hm »enp

(,',3 Services (Local)

Description Status Startup Type Log On As

Local Service

Performance Counter DLL Host
Enables rem... . Mansal
Performanc... | Start

| Stop

*1 Performance Counter DLL ...
.} Performance Logs & Alerts
i.pf} Pl Buffer Subsystem

Start the service Local Service

Local Syste...

Description:

Enables remote users and 64-bit
processes to query performance
counters provided by 32-bit DLLs, If
this service is stopped, only local
users and 32-bit processes will be
able to query performance counters
provided by 32-bit DLLs.

(;k) Pl Message Subsystem

5 Pl Metwork Manager
’;g Pl-Buffer Server

"‘.M,, Pl-Buffer Server x64
,;g PIPC Log Server
ZipipC Log Server x64

2} Plug and Play

Service to b,
Serviceto b...

Service to ...
Serviceto ..

Enables a c...

| Pause

| Resume

| Restart

| All Tasks

Refresh

Local Syste...
Local Syste...
Local Syste...
Local Syste...
Local Syste...
Local Syste...
Local Syste...

i.pf} Portable Device Enumerator... Enforces gr.. Local Syste...
Local Syste...
Local Syste...
Local Syste...
Local Syste...
Local Syste...
Local Syste...
Local Syste...
Network 5.,
Local Syste...
Metwerk 5.,

Network 5.,

(;k) Power Manages p...
Automatic

Manual

£, Print Spooler This service ...

’;g Printer Extensions and Notif.. This service..
Manual
Manual
Manual
Manual

Manual

"‘.M,, Problem Reports and Soluti.. This service ...

,;g Remote Access Auto Conne,.. Creates a co..
':g Remote Access Connection...  Manages di.

.} Remote Desktop Configurat.. Remote Des.. Running
Allows user..,
(;k) Remote Desktop Services U...  Allows ther..
";.-, Remote Procedure Call (RPC) The RPCSS ..

’;g Remote Procedure Call (RP...

i.pf} Remote Desktop Services Running
Manual
Automatic

Manual

Running
Running
In Windows...

Extended ){Standardf

Opens the properties dialog box for the current selection,

3. Select Automatic as the Startup type and click OK.

General | Log On | Recovery I Jependencies |

Service name: PerfHost

Display name: Performance Counter DLL Host

Descrintion:
escription erformance counters provided by 32+bit DLLs.

“

Eables remote users and 64-bit processes to query | A

Fath to executable:
C A \Windows' SysWowb4d'perfhost exe

Startup type: I| Automatic v |I

Service status:  Stopped

Start ‘ | Stop | | Pause | ‘ Besume |

You can specify the start parameters that apply when you start the service
from here

Start parameters:
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Configure FactoryTalk
Historian Connectivity

Use all workstations
with these procedures.

)

AITEWS and OWS

This section describes how to connect the system elements with the
Historian server.

Complete the following steps.
1. On the Windows desktop, click the Programs I symbol and choose

Rockwell Software>FactoryTalk Historian SE>FactoryTalk Historian
SE System>AboutPI-SDK.

¢ AboutPl-5DK

Collective Manager
@@ PISDKUtility (64-bit)
@@ PISDKUtility

| FactoryTalk Historian SE System l
& Help 3 rol 1 Accessibility »
M Interface Configuration Utility . Administrative Tools 3
@ MDE to AF Preparation Wizard | Embedded Lockdown Manager »
ﬂ OPC HDA Tool . Maintenance »
E] QPC Tool 1. Microsoft SQL Server 2008 »
! OPCClient Tool J. Microsoft SQL Server 2008 R2 »
@ System Explorer | Rockwell Automation »
n System Management Tools . FactoryTalk Activation * | | Rockwell Software
m System Tray . FactoryTalk Alarms and Events v | | Startup »
. Uninstall FactoryTalk Historian Live Data Interface | FactoryTalk Historian SE L VMware 3
. FactoryTalk Tools b | | Windows Accessories »
. FactoryTalk View ¥ | | Windows System 3
|, RsLinx v B8 Adobe Reader x|
5 FactoryTalk Administration Console | Desktop
8 Studio 5000 2 FactoryTalk View Studio
p Search

The PI SDK Utility window appears.
2. Click the ‘+’ to expand the PI SDK folder and click Connections.
3. Right-click anywhere in the white space and choose Add Server.

File  PISDK Buffering Tools  Connections  Help
=@ PISDK L] ® pass ‘ Network Nods: [PAsS
~
5450)

Connect

piadmin
Disconnect =

@ Message Log &0
i@l Support Data Refresh F5
@) Error Lookup

B Tracing Setup
|@ KST Cleanup Remove selected Server  Del

Connect as...

Add Server... Ins

Description:
Connected User:
IP Address:

Pl Version:

Operating System:

Default Server: PASS

396 Rockwell Automation Publication PROCES-UMO001B-EN-P - August 2018



Configure an Application Server Information Server (AppServ-Info) ~ Chapter 10

The Add PI Server dialog box appears.
4. Type the Network Path and click OK.

TIP  Ifyou are using a collective, type the primary server.

@ Add Pl Server

Networkc Path/FQDN: IASIHD‘IN I
I oK I Cancel

S. Click the box next to the new server.

@ PI SDK Utility (Administrator) == -

File  PISDK Buffering Tools Connections Help

= pisk  ASIHOT Network Node: [siHot v]
@ About PISDK =
B Conncctions Port Number: 5450
4% Snapshot Tool Default User Name: |piadmin |
= #‘ Tools Connection Timeout: 10 Seconds
@ Message Log Data Access Timeout: 60 Seconds
i@l Support Data
@) Error Lookup
@ Tracing Setup Connection Type: P13 protocol 3.4
& KS5T Cleanup Collective 1D: 35db2801-837c-4251-80e2-6cebl. .
Description:
Connected User: piadmin
IP Address:
P Version: P134390.18
Operating System: Windows NT AMDE4  6.2.5200
Save
ASIHOT connected as piadmin

If the connection is successful, the connection information appears in
the same window.

6. If there are other servers listed that are not required, right-click on the
server name and choose 'Remove selected server.

ing Tools Connections Help

ﬂ ASIHO1 ‘ MNetwork Node: |
] @ pace
: . - Connect |
1ol Connect as... |
Disconnect |
: |
a Refresh F5
1 Add Server... Ins
I e ———
}p Remove selected Server  Del
Description:
Fannactad | laar

7. When asked if you want to delete the server, click Yes.

8. Close the PI SDK Utility window.
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View Pl Builder Excel Add-in  PI Builder lets you import and export PI points and Asset Framework objects
to and from Microsoft Excel Add-in spreadsheet.

Use an Engineering Workstation . . .
with thesg pmcedﬂre& IMPORTANT  Microsoft Excel 32-bit software must be installed for these procedures.

This section uses Microsoft Excel 2013. Your version could be different.

D ! To view the information in an Excel spreadsheet, complete these steps.

EWS01

1. Open your version of Microsoft Excel.

2. Click the PI Builder tab.

=] Book] - Excel 7 B - 0O X
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW PIBUILDER Sign iny
Data Server @ <Mone> ~ ,@ x () Select All gg % [\1 Show Values in Rows U Headers o:’:\bnut
Asset Server: (@ <Mone> - ( ) Deselect All y T & Show Values in Columns Settings @) Help
Publish Delete | Poinf Library Elements Event Refresh
Database: @<NUHE>' Reset to Template ¥ Eftirmes+ E 3
Connections Build [F] Retrieve ] Attribute Data References Resources i
Al - Jr v
A B C D E F G H J K L [ N Q P [~
_ -
2
3
5 1
6

You can select the desired server to generate a report in the top, left
corner of the spreadsheet.

IMPORTANT Pl Builder installation instructions are documented in the
Virtualization User Manual, publication 9528-UM001.
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Chapter 10

Configure FactoryTalk

VantagePoint Historian Tags

Use the Reporting Application
server with these procedures.

ASIVO1

This section shows how to import FactoryTalk Historian data tags. Data from

multiple Historian SE servers can be brought together into a single decision
support system by using VantagePoint as the information reporting software.

IMPORTANT  Before proceeding with this section, make sure that FactoryTalk Historian is
installed and configured.

Complete the following steps.

1. On the Windows desktop, click the Programs ﬂ symbol and choose
Rockwell Software>FactoryTalk VantagePoint>Manager.

I@ AboutPI-SDK

ntrol Systel
| Hel gy
Manager
# PISDKUtility (64-bit)
I@ PISDKUtility L Accessibility r
ih‘_ Portal . Administrative Tools r
|r ReadMe . Embedded Lockdown Manager »
|& Server Locator . Maintenance 3
| System Server . Microsoft Office 3
E Trend | FactoryTalk Activation * | | Rockwell Software
! . Uninstall P| Software Development Kit | FactoryTalk Tools * | .. SharePoint 3
|E_:’1 XY Plotter . FactoryTalk VantagePoint . Startup 3
J. RSLinx Fl VMware 3
FactoryTalk Administration Console . Windows Accessories r
. Windows System 4
Pa Adobe Reader XI
|| Desktop
}-.'J Search

The VantagePoint Manager window appears.

2. In the directory tree under Sources, right-click FactoryTalk and choose

New>Item.

7

File  Configuration Help

¥ Items - [FactoryTalk]

& FactoryTalk

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018

PEEFIETFIEEE el [
=) MyEnterprise ~
{1 Public ] ﬁ e
{9 Samples v4 I, I:
System _
{1 Applications Ttem type:
1 Common .
CF Licerse Qualified name:
1l Security Description:
1 Services
{1 Solutions = Created:
Ml Sources | Modified:
3% ob il
bl ociory o B I
;"j--ﬁ FactoryTal [d MNew 3 | w Shortcuts...
ﬁ FactoryTal -
£ . G ltem..
[y copy W
+  Expand All
+ Collapse All
[#] Refresh v
<4 Properties
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The New FactoryTalk Connector - Connector Information dialog
box appears.
3. Type the VantagePoint user password and click Next.
MNew FactoryTalk Connector
‘Connector Information

A FactoryTalk connector gives you access to various FactoryTalk data sources,

FactoryTalk directory
VantagePoint will connect to the FactoryTalk directory on this machine:

Directory host: passil

FactoryTalk user

VantagePoint can create a new, dedicated FactoryTalk user account that it can use
to access FactoryTalk resources. Enter a user name and password for this new account:

User name: VantagePoint

New FactoryTalk Connector

Connector Created
‘You may choose to import FactoryTalk data now or at a later time.

The FactoryTalk connector was successfully created.

Would you like to import data from FactoryTalk at this time?

Password:

[] Thisis an existing account, Use it as the FactoryTalk user insteal

Connector description (optional)
Enter a description for the new FactoryTalk connector:

I Yes, please I

Pressing "Finish” wil launch the FactoryTalk Import Wizard.,
) Mo, thank you

You may launch the FactoryTalk Import Wizard at any time by selecting
“Import...” from the 'pass01' connector context menu.

4. Click "Yes, please’ and Finish.

The FactoryTalk Import - Import Choices dialog box appears.

5. Click Twould like to import FactoryTalk Historian tags, and then
click Next.

Import Choices
‘fou can choose to import data from various FactoryTalk systems,

What would you like to import?

®

FactoryTalk Import

I would like to import FactoryTalk Live Data tags

I'Zii' I would like to import FactoryTalk Historian tags I

I would like to import FactoryTalk Alarms and Events information

Mext =

1=}

I | Cancel

400
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The Historian Import dialog box appears.

6. Check the Historian that you want to use and click Next.

Historian Import
Importing historian tags allows history retrieval via imported, historized Live Data tags.

Select one or more FactoryTalk historians from which to import tags:
Historian Last Imported  Tag Count  Description
E>roducﬁon Historian ~ Mever 1] Historian for the production area of the plant

7. Ifyou are not using an ME connector, click Finish.

Historian Import
Defining Live Data shortcuts to controllers read by Historians ME.

Current step applies to Historian ME connectors only. If you do not import Historians ME, dick 'Finish',
This information allows VantagePoint to create correlations between Live Data tags and Historian ME tags.

o : Controller
Historian ME Connector Shortcut to Controller read by Historian ME Slot Number

EI v

8. When the Tmport successfully completed' dialog box appears, click OK.

Import successfully completed.
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9. To confirm the import, click
System> Sources> FactoryTaIk> pass01>Historians> <Production
Historian> and look for 'Tags, where:
— Server = pass01

- Your Historian = Production Historian in the example.

=1 Sources

3% ob
ﬁ FactoryTalk

= ;; Historians
—’3 Production Historian

H #-*T¢ ShortcutTeController
#-{§ AlarmsAndEvents
4444 System
? FactoryTalkEnergyMetrix
Y, FactoryTalkHistorian
(i, EartrruTalkMetrics
B

w

Items {160} Description -~
[ BA:ACTIVE. 1 Batch Active Reg
¥ BA:CONC. 1 Concentration R{
P BALEVEL 1 Level Reactor 1

2 BA:PHASE. 1 Phase Reactor 1
4 BATEMP. 1 Temperature Re
(2 baeScf24-cab3-46c0-ad5d-a64df...  PlBatch storage
4§ CDEP 158 Light Naphtha Er
< m bd

calhost/Incuit

IMPORTANT  Adding new Historian points in the system requires a
synchronization action.

10. To synchronize the Historian, right-click
System>Sources>FactoryTalk> <server>>Historians>
<your Historian> and choose Synchronize.

i VantagePoint Manager
File  Configuration Help
% Items - [Production Historian] "3 Production Historian
Q 3|V -J': = @ EViEW M General |Prcperties IOperaﬁons ISecurity |
-3 System ~
E-C Applications I"i ‘Prcducﬁon Historian

[#-{_J Common
[#-{_J License
¥ Security Item type: Connector,FactoryTalk.Histt

-3 Services
& d Solutions Qualified name:  System.Sources.FactoryTal
= Sources Description: Historian for the production

k Db

| FactoryTalk Created: 9/11/2015 12:55: 19 PM

O pass01 Modified: §/11/2015 12:55:23FM

-1 Applications

='2 Historians

Prod bo Istoria H

E Engineering Uinity E{ Edit...

#-+t% Tags
[#-4¢ ShortcutTocCont] B»  Synchronize

-i_g AlarmsAndEvents

[#-%¢ System 43: Copy
’2 FactoryTalkEnergyMetrix % Delete ltem
1 FactoryTalkHistorian
F, FactoryTalkMetrics +  Expand All
Items (0) Descri 4 Collapse All
@ Refresh

<+  Properties
TArT

Synchronizing lets you update the VantagePoint references.

You are finished configuring the FactoryTalk VantagePoint Historian
tags and synchronizing the Historian.
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Considerations

Configure Asset Management (AppServ-Asset)

The Asset Management server (AppServ-Asset) provides a centralized tool to
secure, manage, and track asset-related information. The pool of information
provides analysis of system resources, including source controls, audits, and
change notifications.

This section describes how to configure an audit log. The log monitors and
records user interactions with FactoryTalk® software products. For example, if
an operator changes a setpoint in a controller, the change is logged for

future reference.

FactoryTalk AssetCentre software includes Device Type Manager interfaces
and disaster recovery back-up files. For procedures on these tools, see
Chapter 8 in the PlantPAx” DCS Application Configuration User Manual,
publication PROCES-UMO003.

Consider the following suggestions before starting this chapter:

¢ For more information on the PanelView™ audit log, refer to
Knowledgebase Answer ID 58977, Using FactoryTalk AssetCentre
to receive audits from a PanelView Plus,
at http://www.rockwellautomation.custhelp.com.

e We strongly recommend additional licensing for disaster recovery that
automatically backs up supported devices.
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Figure 19 shows the topics that are described in this chapter. Click or see the

page number for quick access to a section.

Figure 19 - AppServ-Asset Workflow

k4
Configure Diagnostic Settings

+ View Audit Log
See page 405

End
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Configure Diagnostic
Settings

Use all servers and workstations
with these procedures.

B "

ST ||=

The Audit Log monitors FactoryTalk-enabled software products and logs user
actions. Complete these steps to configure the Audit Log so that it can be
viewed in FactoryTalk AssetCentre.

IMPORTANT  All servers and workstations must be configured by using FactoryTalk
Administration Console or FactoryTalk View Studio. The examples in this
section use the FactoryTalk Administration Console.

1. Click the Programs ﬂ symbol and choose Rockwell
Software”>FactoryTalk Administration Console.

. BOOTP-DHCP Server 4
.. FactoryTalk Activation 4
. FactoryTalk Alarms and Events 4
.. FactoryTalk Historian SE ¥ | | Accessibility 3
. FactoryTalk Tools ¥ | | Administrative Tools 4
. FactoryTalk View » |l CGCM 3
. Logix Designer Tools ¥ | | Embedded Lockdown Manager »
.. RSLinx ¥ | | Hiprom Software »
. RSLogix 5000 Enterprise Series ¥ | | Maintenance 3
|, RSLogix 5000 Tools v | | Microsoft Office 3
. RSMetWore » | |, Microsoft SQL Server 2008 3
Ltilities » | | Microsoft 5OL Server 2008 R2 4
FactoryTalk Administration Console .. Rockwell Automation 4
|e Studio 5000 . Rockwell Software
. SharePoint 3
. Startup 3
L VMware 3
. Windows Accessories 3
. Windows System 4
Adobe Reader XI
&l FactoryTalk View Studio
1 Search

The Select FactoryTalk Directory dialog box appears.
2. Select Network and click OK.

Select FactoryTalk Directory

Select the directory pou want to uze.

| Metwark. v |

Cancel | | Help |

The FactoryTalk Administration Console window appears.

3. Right-click Tools>FactoryTalk Diagnostics and choose Setup.

File View | Tools | Window Help
| ; “¢' FactoryTalk Directory Server Options...
FactoryTalk Security Authority |dentifier...
Temporary Password K
FactoryTalk Diagnostics
Export Policies... |

1 fm PlantPAx ‘ ‘

Explorer

Systemn
(2 Action Groups
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The Diagnostics Configuration window appears.

4. In the Message Routing section, click FT View Diagnostics List.

Diagnostics Configuration

Diagnostics Setup Message Routing
EI- Destination Setup

- Device Health

- FT Wiew Diagnostics List
-FT Wiew ME &udit Trail

Select one or more logging destinations to configure messzage routing:

Meszage categories

mor Warning  [nfo At ‘

Wiew [
FT Wiew ME Audit Trail

-Local Log Operatar Iv Iv Iv I
ODEC Datah Local Lag
. atabase
GoEL Dotabase Engneer W [ - Recommended Settings
Secured
bevios B B ‘
Secure r r r r

r Accept mezzage from Windows CE devices
or Mobileiiew

I QK. II Cancel | Apply | Help |

5. In the '"Message categories' section, configure the desired level
of diagnostics.

Message Categories Notes

Operator If Info is checked, screen access is stored as an Event. If Secured also is
checked, the information is logged into the Event tag of FactoryTalk
AssetCentre software.

IMPORTANT: This setting does not show which computer accesses the
system; only on FactoryTalk Diagnostics Viewer.

Engineer If Audit is checked, Alarm acknowledgments are audited and displayed
regardless of the destination. HMI display changes (on FactoryTalk View
Studio software) also are logged.

Developer If Audit is checked, HMI tag value changes are audited regardless of
the destination.

Secure If Audit is checked, any changes on Studio 5000® are audited under the
Secured destination.

TIP  Click Help for more information on the message categories.

6. In the Message Routing section, click Local Log.
Diagnostics Configuration = [ = -

Diagnostics Setup Message Routing
EI- Destination Setup

. i Device Health
FT Wiew Diagnostics List Device Health

Select one or more logging destinations to configure messzage routing:
Meszage categories

FT ‘iew ME Audit Trail FT Wiew Diagnastics List Ermar Warning Info  Audit
Lacal Lag i V'EE Audit Trail Operatar v v v r
ODBC Database ODEC Datab. . .
il Secured Engneer I M W T +  Recommended Settings
Developer v v r r ‘
Secure r r r r

r Accept mezzage from Windows CE devices
or Mobileiiew

QK | Cancel | Apply | Help |
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7. Repeat step 5.
8. Click Apply and then click OK.

The Diagnostics Configuration window closes.

View Audit Log

A log of activity lets you view the messages. Complete these steps.

1. Click the Programs I symbol and choose Rockwell
Software>FactoryTalk AssetCentre Client>AssetCentre Client.

, AssetCentre Client | FactoryTalk AssetCentre Client _
= FactoryTalk AssetCentre Exported Log Viewer | FactoryTalk Historian SE b | Accessibility 2
PDC Field Edition |, FactoryTalk Tools b | . Administrative Tools 3
@ Release Motes | FactoryTalk View P CGEM 2
1 | Logix Designer Tools * | | Embedded Lockdown Manager
4. RSLinx » | .. Hiprom Software 4
| RSLogix 5000 Enterprise Series » | | Maintenance 3
1. RSLogix 5000 Tools » | . Microsoft Office 3
| RSNetWon » | L Microsoft SQL Server 2008 »
o Utilities » | 10 Microsoft SQL Server 2008 R2 3
[} FactoryTalk Administration Console . Rockwell Automation »
& Studio 5000 | Rockwell 5of
|, SharePoint 3
l Startup 2
L VMware 3
1 Windows Accessories 3
1 Windows System 3
B8 Adobe Reader XI
& FactoryTalk View Studio
JD Search
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2. Click Logs and then Audit Log.

File Edit View Tasks Tools Windows Help

D S e ) ) 3 & Asets | O AgentGroups [ Archive (I} Assets Lifecycle B Calibration @ DTM View

'1312&01?124 12/12/2017 12:46:  FactoryTalk Diag [ FacmT'a]ic Diag  EWS45\Administr | Modified Win
11211202017 124 1211272017 12:46: | FactoryTalk Diag | | FactoryTalk Diag | EWS45Wdministr | Modified Win
1211202017 124 | 121122017 12:46: | FactoryTalk Diag FactoryTalk Disg | EWS45\Wdministr | Modified \in
112/12/2017 124 1211212017 12:46: | FactoryTalk Diag | | | EWS45\Administr | Modified mes
1211212017 12:4 | 121122017 12:46: | FactoryTalk Diag EWS45\dministr | Modified mes
11211202017 124 1211212017 12:46: | FactoryTalk Diag | EWS45\Administr | Modified mes
1211202017 12:4 | 121122017 12:46; | FactoryTalk Diag | FactoryTalk Disg | EWS45\dministr | Modified \afin
121122017 124 | 12/12/2017 12:46:  FactoryTalk Diag | EWS45\Administr | Modified mes
12122017 12:4 | 12122017 12:46: | FactoryTalk Diag FactoryTalk Diag | EV/S45\Adrministr  Modified Win._

A HIAT 1T AC | Emctoe Talle Minn  MCdcdE | EocdeeaTal ifimd Jnﬁq--
< m

Log ltem Details:

Logged at: 1211212017 12:49:03 PM Location: EWS45

Occurred at: 121272017 12:49:00 PM Username: EWS45\ADMINISTRATOR
Source: FactoryTalk AssetCentre  Resource: Client

Attachments: 0

Message:

llenr lammnd in

3. Click ‘X’ to Close.
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Appendix A

Open Content

Access the Attachments

The Microsoft Excel spreadsheet and text files that are attached to this PDF
file contain security and switch information to customize application
requirements. Each security tab in the Excel spreadsheet has specific ‘Allow’
and ‘Deny’ security permissions.

To use the attachments, click the Attachments link (paper clip) and
double-click the desired file.

See How to Use Attachments on page 410.
£ 4 ME444|M@ |._ s ﬂb“ ——

LJ Attachments IE II‘
P B~ & &
Marme =

é % R4 Print Jan 15.joboptions
H5iPROCES-UMODLA-EN_P-Policie..,

LS00 172 18 0_01text

|| SW010_172_18_0_10.text User M danud |

| SWO20_172_18_0_20.text
L SW030_172_18_0_30.text

S Original Instructions

PlantPAx Distributed Contre

Infractviirtniva C ant

As a precaution when you open programs or files, select one of the choices
and click OK.

'DpenFiIe I S— lE|w|D|R|DJﬁ

/___( 5 The file "PROCES-UMO01A-EN_P-Policies.xlsx” may contain programs, macros, or viruses
l@’ that could potentially harm your computer. Open the file only if you are sure it is safe.
Would you like to:

@ Open this file
() Always allow opening files of this type

) Never allow opening files of this type

[ OK ] | Cancel
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How to Use Attachments
The Excel spreadsheet contains several tabs to access security permissions for
policy groups. Click a desired tab and use the suggested security along with the
procedures in Define FactoryTalk System Policies on page 193.
E - PROCES-UMO01A-EN_P-Policies.xlsx - Excel
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW
"_LI X_ it Calibri <A A= = ¥~ %‘\"."rap Text General _;-5 I_ A
Pa":te B womy = A el o ; <0 00 Conditional Forr:ai
i O — B I U-~ DA === &£ 3= EMergetiCenter -~ $ - % G0 30 Formatting ~  Table
Clipboard ] Font ] Alignment ] Mumber [F] Styles
K12 - fr
A B C D E F G H
20 Operator ) Maintanence ) e
Product Policies Operators ) Maintanence ) Manager Engineer |Administrator
1 Supervisor Supervisor
2 RSLogix5000
3 |Feature Security
4 | Project: New Deny Deny Allow Allow Allow Allow Allow
5 |Print: Modify Options Deny Deny Allow Allow Allow Allow Allow
& Controller: Secure Deny Deny Allow Allow Allow Allow Allow
7 Toolbar: Configure Deny Deny Allow Allow Allow Allow Allow
& Firmware: Update Deny Deny Allow Allow Allow Allow Allow
9 Workstation: Modify Options Deny Deny Allow Allow Allow Allow Allow
10 Studio 5000 Architect
11 |Feature Security
12 |Create Deny Deny Allow Allow Allow Allow Allow
13 |Open Deny Deny Allow Allow Allow Allow Allow
14 |Save Deny Deny Allow Allow Allow Allow Allow
15 |Batch
16 |. Batch Campaign
17 |.. Commands

The four text files contain switch configuration information. Double-click
the .txt file to open the respective file in a text editor, such as Notepad. Copy
and paste the switch configuration data into the CLI interface in the

Pul Ty software.

You can use these files to directly configure your switches according to this
manual’s directions by downloading the file contents into each of your
switches. If you use these files to configure your switch, we strongly
recommend that you verify all switch settings by logging into the switches and
viewing/verifying switch configuration by using the Device Manager.

See Using a Terminal Emulator (PuI'TY) on page 41 for procedures.
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Appendix B

Use all system computers
with these procedures.

Define a Workgroup and DeskLock Utility

If you don’t use a domain, you must configure a workgroup to make sure that
the name resolution is correct for the network. Workgroups are supported for

systems with 10 or fewer workstations and servers.

This appendix also includes procedures for how to enable an optional

DeskLock Utility.
Complete the following steps.

1. In Windows Notepad, open the file

C:\Windows\System32\Drivers\Etc\host and enter the IP addresses and

machine names for the computers in the workgroup.

Use a tab between each IP address and machine name.

W A etc = '='-
Home Share e 0
(-I - T| < Local Disk (C) » Windows » System32 » drivers » etc v O | Search etc P |
¢ Favorites Marme - Date modified Type Size
B Desktop B2Z/2013 325 AM  File 1KB
& Downloads 1 fmhos s.sa.m 05395913 44,90 Ak4 TAKA Cila Ao
=l Recent places || netwarks j hosts - Motepad = = -
|| protacal File Edit Forrmat View Help
1 This PC || services # For example: ~
m Desktop &
‘| Documents # 162.54.94.97 rhino.acme.com # source serwver
& Downloads # 38.25.63.18 X.acme.com # x client host
W Music
B ict # localhost name resolution is handled within DN3 itself.
N # 127.9.0.1 Llocalhost
8 Videos il localhost
i Local Disk (C3 172.18.1.12 PASSEL
172.18.1.13 ASIHE1A
172.18.1.14 ASIHE1B
172.18.1.15 EWsSal
172.18.1.16 ASISEL -
172.18.1.17 ASAMBL B
172.18.1.18 Cwsel
1
1

172.18.
172.18.

.19 PASSE2A
.28 PASSE2E

2. Copy the revised host file to all computers in the system.
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AppendixB  Define a Workgroup and DeskLock Utility

3. Configure each server network adapter with the correct IP address.

Internet Protocol Yersion 4 (TCPAPwA) Properties -

General

‘fou can get IP settings assigned automatically if your network supports
this capability, Otherwise, you need to ask your network administrator
for the appropriate IP settings,

() Obtain an IP address automatically

(®) Use the following IP address:

1P address: 172 .18 . 1 . 18
Subret mask: 285 .255 .255 . 0
Default gateway: 172,18 .1 .1

Obtain DMS server address automatically
(®) Use the Following DNS server addresses:

Preferred DNS server:

|

Aleernate DS server:

[ validate settings upon exit

| Ok | | Cancel |

4. Use a ping command to test name resolution, for example, ping PASS01.

(== |

o Administrator; CVWIndows System32homd.exe

icrosoft Windows [Version 6.3.96881]
c>» 2813 Microsoft Corporation. All rights reserved.

:~\>PING PASSHA1

inging PASSHA1 [172.18.1.121 with 32 bytes of data:
eply from 172.18.1.1 h 2 time{ims TTL=12
eply from 172.18.1.1 i

eply from 172.18. T

eply from 172.18. TTL=128

ing statistics for 172.18.1.12:

Packets: Sent = 4, Received = 4, Lost = @ (Bx loss>.
pproximate round trip times in milli-seconds:

Minimum = Bms. Maximum = Bms. Average = Bms

NI

S. Click X’ to close.
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Appendix B

Enable the Windows The FactoryTalk® View DeskLock utility, which is available for any workstation
DeskLock Utility ( opti on al) computer, provides control options for smaller environments that do not use

domain management.

Use all workstations
with these procedures. DeskLock is installed with FactoryTalk View software.

- _m Complete these steps.

1. Click the Programs symbol and choose Rockwell

EWS, WS Software”>FactoryTalk View>Tools>DeskLock.
2.
.. Maintenance 2
.. BOOTP-DHCP Server ¥ | | Rockwell Software
DesklLock | FactoryTalk Activation v | L) Startup 2
FactoryTalk View Sk Cache File Management Tool .. FactoryTalk Alarms and Events | VMware 3
FactoryTalk View SE Secure Web Site Setup | FactoryTalk AssetCentre Client ¥ | | Windows Accessories 4
SE HMI Tag Alarm Log Setup . FactoryTalk Historian 5E b | . Windows System 3
SE HMI Tag Alarm Log Viewer Help . FactoryTalk Tools » E Adobe Reader X|
SE HMI Tag Alarm Log Viewer . Tools | FactoryTalk View || Desktop
| User Documentation r| | RSLinx 4 ﬂ PC settings
L FactoryTalk View Site Edition Client FactoryTalk Administration Conscle }_J Search
G& Uninstall FactoryTalk View £§ Store
3. Click Set Up DeskLock.
Cesklock
[ Eppleation 1 ]
Fiestart Windows |
Exit DeskLock |
I Set Up DesklLock ... I
4. Login and click the Desktop tab.
5. Select ‘Replace existing desktop with DeskLock’ and click OK.
Desklock Setup
Logan T Desktop T Paszword T Behavior
" Use existing Windows desktop [Explorer.exe]
_> I(:' Beplace existing desktop with DesklLock I
— DeskLock Application
Frograms: Mame:
[Clent
2
3 Frogram:
g IE:\Program Filez [x86]%Rockwell S oftwaretRSView Ente Browse .. |
3 Command Line Parameters:
g Iblic\Documents\HSView E nterprisetSE SClient\Client. cfif Browse ...
9 window Style:
10 I MomalFocus LI
v Imclude a button on the DeskLock window
[~ Automatically run program at startup
Auta Start Delay [zec): IU
Defaults | QK I Cancel Help
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6. In the popup window, type the name of the application option in the
Name text box.

For example, type ‘Client’ if FactoryTalk View Client is to be
an application.

L M ame:
|Client

Frogram:

|E:\Program Filez [x86]%Rockwell S oftwaretRSView Ente Browse ..

Command Line Parameters:
|blic\Documents\F|SView E nterprisetSE SClient\Client. cfif

Browse ...
window Style:
| MomalFocus j

¥ Include a button on the DeskLack windaw
™ Automatically run program at startup

Auta Start Delay [zec) |0

You can enable up to 10 applications in the DeskLock.
7. Click the Password tab to configure local password management.

8. Click the Behavior tab to configure Hot Key settings and the

Ctrl+Ale+Del options.
DesklLock Setup
Logon T Desktop T Password T
Chil+al+D el Window Options Hat Key zettings
[ Dizable Shutdown Windows I Disable Task Switch keys [Al+T ab, Chil+Esc, Alt+Esc)
[~ Disable Task Manager
[ Disable Lock Computer I™ Disable Task Manager keys [Chl+Shift+E zc)

[ Disable Change Password

[ Dizable Windows hot keys [Windows Logo+?]
[ Disable Logaff

Open the Microzoft r
tManagement Consale for
Local Group Policies 15 AT

Defaults ak. Cancel Help
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Define a Workgroup and DeskLock Utility ~ Appendix B

9. To open the DeskLock under the Local Computer Policy, click
Microsoft Management Console.

‘%1 DESKLOCK - [Console Root\Local Computer Policy’\User Configuration\Administrative Templa...l;li-

File Action ‘iew Favorites Help

&= #| = H T
|1 Console Root . i System
4 E[ Local Cormputer Policy . o . =
= ) - Select an item to view its description,  Setting A
I> i Computer Configuration -
4 & User Configuration | Ctrl +Alt+Del Options
I>J Software Settings | Driver Installation
= Windows Settings _| Falder Redirection
4 || Administrative Templates B Grolip:Policy
b FoibalRaEa] | Internet Comrmunication Management
b Desktap | Locale Services
| Meboaork I Logan E
| Shared Folders | Powver Management
I | Start Menu and Taskbe | Rernowvable Storage Access
|| Systern | Scripts
I | Windows Components | User Profiles
= &l Settings Download missing COM components
Century interpretation for Year 2000
Restrict these programs fram being launched from
Do not display the Getting Started welcorme screen
Custorm User Interface
iz| Prevent access to the cornmand prompt <
< m >
€ n > \ Extended /(Standard/

10 settingis)

10. To enable DeskLock options and settings, restart your computer.
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Notes:
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Appendix C

Firewall Configurations

Common Ports Table 28 shows the most common ports that need to be considered during the

firewall configuration.

Table 28 - Common Firewall Port Descriptions

Port Type Usage

25 TCP SMTP mail

80 TCP Standard WWW port

123 ubp Network Time Protocol

135 TP Remote process calls

137 uop File and printer sharing

138 uop

139 TCP

445 TP Use in the Collective configuration and file and print sharing

1433 TP Communication to SQL server

1434 uop Browsing for SQL server

21060 uop Rockwell Automation® trace diagnostics

21061 uop
Rockwell Automation Table 29 shows the TCP/UDP ports for Rockwell Automation® firmware and
TCP/UDP Ports software products.

For periodic updates, see the Knowledgebase Answer ID 29402
at http://www.rockwellautomation.custhelp.com.

Table 29 - TCP/UDP Port Descriptions

Port Type Protocol Products Comments

23 TP Telnet Trusted® Diagnostic command-line interface
AADvance before release 1.3 (see also 55555)

25 TP SMTP 1769-L35E, 1769-L32E,1756-ENBT, Outbound email only

1756-EN2T,1756-EWEB, 1768-ENBT,
1768-EWEB, 1788-ENBT,1763-L16x

1766-L32x,FactoryTalk® AssetCentre,
FactoryTalk® Transaction Manager, RSSQL

67...68 ubp DHCP/BOQTP 1756-ENET,1756-ENBT,1756-EWEB, Client only
1756-EN2T,1794-AENT,1734-AENT,
1769-L35E, 1769- L32E,1788-ENBT,
1761-NET-ENI,1785-LXXE, 1785-ENET

,1791ES,1763-116x,1766-L32x, PowerFlex®
Drives, PowerMonitor™ 3000, PanelView™
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Firewall Configurations

Table 29 - TCP/UDP Port Descriptions

Port Type Protocol Products Comments
69 UDP TFTP 5820-El For binary download, used in conjunction
with BOOTP
80 TCP HTTP 1756-ENET,1756-ENBT,1756-EWEB, FactoryTalk ViewPoint and VantagePoint EMI
1794-AENT,1734-AENT,1769-L35E, server can use any other custom assigned port
1769-L32E,1788-ENBT,1761-NET- ENI
1785-LXXE,1785-ENET,1747-L55x,
1763-L16x,1766-L32x, PowerFlex Drives,
PowerMonitor 3000, PanelView, RSBizWare™,
RSView®32, FactoryTalk View SE, FactoryTalk®
VantagePoint®, FactoryTalk ViewPoint
123 upp NTP PowerMonitor 3000, AADvance Network time protocol
135 TCP RPC/Endpoint Mapper | FactoryTalk, RSMACC™ DCOM endpoint mapper
161 uop SNMP 1756-ENET,1756-ENBT,1794-AENT,
1734-AENT, 1769-L35E, 1769-L32E,
1788-ENBT, 1761-NET-ENI, 1785- LXXE,
1785-ENET, 1747-L55x,1766- L32x,
5820-El, PowerFlex Drives, PowerMonitor 3000,
PanelView
300...400 ubp Proprietary PowerMonitor 3000 Master/slave configuration
400...402 TCP RPC FactoryTalk Transaction Manager, RSSQL Transaction manager, compression server,
and configuration server
443 TP HTTPS FactoryTalk ViewPoint When using web server with secure certificate
502 TP ModbusTCP AADvance, Trusted® Master or slave (AADvance),
Slave only (Trusted)
1001...1009 uppP Proprietary 1426 PowerMonitor 5000 Waveform synchronized broadcast
Dynamic TCP DCOM FactoryTalk DCOM dynamic ports
(1024...65535+)
1089 TCP/UDP ff-annunc 1788-EN2FFR FOUNDATION Fieldbus
1090 ff-fimx
1091 ff-sm
1132 TCP SNCP AADvance Safety Network Control Protocol, used by OPC,
workbench debugger, and binding networks
1330 TP rnaprpc FactoryTalk Object RPC
1331 TCP rnaserv FactoryTalk Service control
1332 TP rnaserveping FactoryTalk Server health
1433 TCP N/A FactoryTalk® AssetCentre (server), SQL server communication (default port)
FactoryTalk VantagePoint RSMACC
1434 ubp N/A FactoryTalk AssetCentre (server), Recommended static destination port for MSSQL
FactoryTalk VantagePoint to minimize the number of ports open ona
firewall
See the Knowledgebase Answer ID 287932 at
http://www.rockwellautomation.custhelp.com
1947 TCP/UDP N/A SafeNet Sentinel Local License Manager Windows Service installed by Sentinel USB HASP
driver. This service is not required for USB dongle
to function.
See the Knowledgebase Answer ID 570831 at
http://www.rockwellautomation.custhelp.com
2000 TP Modbus RTU AADvance (Slave only), Trusted (Master or slave, | RTU packaged in serial stream. Other ports can
used for OPCand SOE) be assigned
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Table 29 - TCP/UDP Port Descriptions

Port Type Protocol Products Comments
2010...2011 uop Discover tool AADvance Used to configure systems. The tool sends
broadcast to 2010 and systems reply to port
20M
2222 ubp EtherNet/IP 1756-ENBT,1794-AENT, 1734-AENT, 1/0 communication that is used by products that
1769-L35E, 1769-L32€,1788-ENBT only support /0 over EtherNet/IP
2222 TCP sp 1785-Lxxe,1785-ENET,1771-DM((x), This is the source port for connections
1747-155x,5820-El, PowerMonitor Il
RSLinx® Classic, INTERCHANGE™
3060 TP rnadirft FactoryTalk Directory server file transfer
3622 TCP/UDP ff-Ir-port 1788-EN2FFR FOUNDATION Fieldbus
4000 uop Peer-to-peer Trusted Original simplex protocol
4120 TCP RPC RSBizWare Production server
a1 Server manager
122 PlantMetrics™ server
4123 Task manager
424 Scheduler server
425 Scheduler CTP server
4446 TP TCP/IP FactoryTalk Diagnostics (CPR SR3) See the Knowledgebase Answer ID 68260 at
http://www.rockwellautomation.custhelp.com
5000 ubp Peer-to-peer Trusted, AADvance Enhanced (new) protocol
5241 TP TCP/IP FactoryTalk Diagnostics (CPR9 SR4 and greater) | See the Knowledgebase Answer ID 68260 at
http://www.rockwellautomation.custhelp.com
5450 TCP FactoryTalk Historian Site Edition PI network manager
5454 Analysis Framework v1.x
5455
5456 ACE 2 scheduler
5457 Asset Framework server
5458 Pl notifications
5459 Asset Framework to OLEDB Enterprise
6000 TCP Workbench Trusted Online debugger
6543 TP rnaalarming FactoryTalk Alarming server
7002...7004 TP FactoryTalk AssetCentre (default) FactoryTalk AssetCentre services
7600 TCP FactoryTalk Event multiplexor
7700 Event server
7710 Directory server
7720 TP RSView SE, HMI server
7721 FactoryTalk View st Server Framework
7722 HMI activation
7723 Historical Data Log reader
8080 TCP HTTP RSBizWare Production server, reports
8081 Server manager
8083 TCP HTTP (TP Server
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Firewall Configurations

Table 29 - TCP/UDP Port Descriptions

Port Type Protocol Products Comments
10001...10006 TCP Serial data AADvance Transparent communication interface, where an
Ethernet host can talk through AADvance to a
serial port
27000...27009 TCP TCP/IP FactoryTalk® Activation Server, Foir more application required to run
FactoryTalk Activation Manager FLEXSVR,exe. an d LMGRD,exe, see the
Knowledgebase Answer ID 35717 and 184922 at
http://www.rockwellautomation.custhelp.com
44818 TCP/UDP EtherNet/IP 1756-ENET,1756-ENBT,1756-EWEB, Messaging, data transfer, upload/download,
1794-AENT,1734-AENT, 1769-L35E, peer messaging, and so forth; used mainly by
1769-L32€,1788-ENBT, 1761-NET- ENI, RoLinx
1785-LXXE,1785-ENET,1747- L55x,
1763-L16x,1766-L32x, PowerMonitor3000,
PanelView, RSLinx Classic, FactoryTalk Linx,
INTERCHANGE (rsicd)
49281 TCP TCP/IP FactoryTalk Live Data, HMI tag server
FactoryTalk View SE HMI tag server
55555 TCP Telnet AADvance from release 1.3 Diagnostic command-line interface
60093 TCP TCP/IP FactoryTalk Diagnostics (CPR9 SR2 and earlier) See the Knowledgebase Answer ID 68260 at
http://www.rockwellautomation.custhelp.com
65207 TP TCP/IP FactoryTalk VantagePoint Incuity® server advertiser
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enable
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Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018



Index

HMI
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server
configuration 247
enable redundancy 257
primary 247
hot standy routing
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hybrid group
security 183

1/0

network star 57

switches 55
1/0 network

switch configuration 52
identifier

authority 220
interface

delete node default 334
internal

security 183
users and groups 191
IP address

check setting 20
configuration 86
VLAN 18

join
domain 113

LAN
AandB 63

layer 2
switch 29, 31, 33, 35, 47, 54
switch configuration 55
switches 21

layer 3

switch 29, 31, 33, 35, 47
switches 21

local directory 167

log
view audit 407

log on

FactoryTalk 194
Logix 5000 Architect

canvas 206
lookup

FactoryTalk directory 169

M

management
group policy 131

manager
activation 175
manual
conventions 10
MCC
star switches 56
switch 62
switches 72
modify

controller property 207

naming
controller directory 219
conventions 10
network

adapter 210
directory 167
directory definition 172
1/0 57
1/0 switch configuration 52
overview 15
node interface

configuration 342

delete default 334

primary server configuration 342

secondary server configuration 358
NTP

default domain policy 143
server configuration 133
time sync example 231

0

overview

configuration network 15
control network 45

P

PanelView
configure time sync 306
download runtime application 309
Plus
configuration 293
parent domain
configuration 79
PASS

configuration 243
configure HMI server 247
FTD 243
workflow 244

patches
FactoryTalk 177
PCDC 177

PCDC

patches 177
PlantPAx
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workflow 19, 46

Rockwell Automation Publication PROCES-UM001B-EN-P - August 2018

423



Index

424

policy
domain controller default 133
enforce domain 158
enforce domain controller 140
FactoryTalk security 199
PlantPAx users object 160
security 197
port 47
descriptions 51
link aggregation (etherchannel) 38
ports
I/0 network 57
Precision Time Protocol (PTP) 35
primary
copy folder to secondary 260
HMI server 247
product
FactoryTalk policies 199
property
controller modification 207
protection
USB drive 161, 163
protocol
hot standy routing 41
PRP
I/0 switches 71
reboxes 68
PTP
controllers 241
enable 35
Ethernet bridges 239
purpose
document 9

Rapid PVST+

enable 33
redbox

controller 64
PRP distribution 68
redundancy

data server 266

enable on alarm and event server 279

HMI server 257
redundant

controller 73

star switches 63
redundant star

switches 63
reference

manual scope 9
report

server configuration 399

spreadsheet 398
restrict

code 224, 225

communication 220, 223

data 223, 224

system access 195
restriction

software access 165

ring
controller switches 59
topology 58
routing
and HSRP 41
enable switch 37
hot standby 41
VLAN gateway 43
runtime
download to PanelView 309
security 304

S

scope
DHCP 104
reference manual 9
security 196
audit 196
configure FactoryTalk View ME 300
controller 203
enable controller 217
FactoryTalk 183
FactoryTalk SE 284, 300
HMI 284
hybrid group 183
levels for group 198
runtime 304
system policies 197
workflow 184
server
NTP configuration 133
setting
check IP address 20
configure switch 20
shortcut
data server 250
smartports
configuration 47
software
access restriction 165
spreadsheet
reports 398
star
topology 53
static
IP address’ IP address
static 74
supervisory
DHCP scope 107
SW007 and SW008

description 55, 57, 60, 62, 65, 69
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controller ring 59
enable routing 37
express setup 21
1/0 55
initial setting 20
layer 2 configuration 55
MCC 56, 62, 72
port descriptions 51
PRP 1/0 (redbox) 71
redboxes 64
redundant star 63
ring 58
switch configuration
/0 network 52
sync
time configuration 231
synchronization path
Historian 336
system
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Rockwell Automation Support

Use the following resources to access support information.
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Forums, and Product Notification Updates. https://rockwellautomation.custhelp.com/

Technical Support Center
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System Policies

		System Policies		Operators		Operator Supervisor		Maintanence		Maintanence Supervisor		Manager		Engineer		Administrator

		Common

		Configure Security		Deny		Deny		Deny		Deny		Deny		Allow		Allow
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Product Policies

		Product Policies		Operators		Operator Supervisor		Maintanence		Maintanence Supervisor		Manager		Engineer		Administrator

		RSLogix5000

		Feature Security

		Project: New		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Print: Modify Options		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Secure		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Toolbar: Configure		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Firmware: Update		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Workstation: Modify Options		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Studio 5000 Architect

		Feature Security

		Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Open		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Save		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Batch

		. Batch Campaign

		. . Commands

		Abort Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Abort Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Add New Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Add New Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		All Properties		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Append Batch to Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		ConfigServers		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Delete Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Delete Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Disable Triggers		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Enable Triggers		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Hold Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Hold Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Move Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Move Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Pause Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Pause Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Restart Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Restart Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Start Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Start Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Stop Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Stop Campaign		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		. BatchView and ActiveX

		. . View

		Alarm Summary		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Arbitration		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Batch List		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Configuration		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Event Journals		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Exit		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Kelp		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Phase Control		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Phase Summary		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Procedure as SFC		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Procedure as Table		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Pompts		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Signatures		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		. . Phase Commands

		Abort		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Ack		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Acquire		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Clear Fail		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Disconnect		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Hold		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Pause		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Phase Auto Mode		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Phase Semi-Auto Mode		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Release		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Reset		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Restart		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Resume		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Start		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Stop		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		. . Commands

		Abort		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Ack		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Acquire		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Add Batch		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Auto		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Bind		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Bind Ack		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Clear Fail		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Comment		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Disconnect		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Force Transition		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Hold		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Manual		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		MatSvrControl		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Override		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Override Clear		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		ParamChange		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		ReativeStep		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Release		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Remove		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Reorder		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Restart		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Resume		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Semi-Auto		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Start		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Stop		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Timer-Compete		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Timer-Reset		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		. Equipment Editor

		. . Access Modes

		Full Edit		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		View Only		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		. Recipe Editor

		. . Access Modes

		Full Edit		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		View Only		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Asset Centre

		Address Book Policies

		View Address Book		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Edit Address Book		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Archive Policies

		Override Archive Check In		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Configure Database Limitations		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Override Archive Undo ChkOut		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Override Removal Local Copies		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Config Personal Arc File Assoc		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Config Personal Arc Work Fold		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Config System Arc File Assoc		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Config System Arc Work Fold		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Run Archive DB Cleanup Wiz		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Calibration Management Policies

		Display Calibration Mgm Data		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Perform Calibration Mgm		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Administer Calibration Users		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		General Policies

		Switch to Design mode		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Log Policies

		View Event Log		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		View Audit Log		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		View Diag and Health Log		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Change Diag and Health Log		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		View Diag and Health Log Sts		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Run Log DB Cleanup Wizard		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Process Device Config Policies

		Enable or Disable DTMs		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Edit DTM Network

		Run PDC Field Edition		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Schedule Policies

		Create a new schedule		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Edit a schedule		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Delete a schedule		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		View a schedule		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Command a Schedule		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Searching

		Create a Search		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		ControlFlash

		Feature Security

		Firmware: Update		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		FactoryTalk View

		Feature Security

		Configure Secure Web Site		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		RSLinx Classic

		Feature Security

		Clear DDE/OPC Event Log		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Config CIP Options		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Config Client Applications		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Config ControlLogix Gateway		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Config DDE/OPC Topic		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Config Drivers and Shortcuts		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Config Gateway		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Config Network Properties		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Edit DDE/OPC Project		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Edit Options		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Reset Station Diag Counters		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Shutdown		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		View NT Event Log		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		RSNetWorx

		Feature Security

		Access Configurations		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Go Online		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Modify Configurations		Deny		Deny		Allow		Allow		Allow		Allow		Allow







Computers and Groups

		Computers and Groups		Operators		Operator Supervisor		Maintanence		Maintanence Supervisor		Manager		Engineer		Administrator

		Common

		Configure Security		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Create Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Delete		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Execute		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		List Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Read		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Write		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		FT Transaction Manager

		Start, Stop and Assemble Cfg		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		RSLinx Enterprise

		Network Browse		Deny		Deny		Allow		Allow		Allow		Allow		Allow



















































































































































































































































































































































































































































































































































Network and Devices

		Network and Devices		Operators		Operator Supervisor		Maintanence		Maintanence Supervisor		Manager		Engineer		Administrator

		Common

		Configure Security		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		List Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Read		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Write		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		RSLogix5000

		Add-On Instruction: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Add-On Instruction: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Add-On Instruction: Modify		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Alarm: Clear Alarm Log		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Clear Fault		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Lock/Unlock		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Modify Mode		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Modify Revision		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Modify Type		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Controller: Unsecure		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Data Log: Clear Log Data Value		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Data Log: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Data Log: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Data Log: Enable/Disable		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Data Log: Modify		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Data Log: Read Log Data Value		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Firmware: Update		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Language: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Language: Switch Language		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Module: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Module: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Module: Maintenance High		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Module: Maintenance Low		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Module: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Motion: Command Axis		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Motion: Modify Configuration		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Nonvolatile Memory: Load		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Nonvolatile Memory: Store		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Phase: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Phase: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Phase: Manual Control		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Phase: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		PLC/SLC: Modify Tag Mappings		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Print: Report		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Program: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Program: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Program: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Compact		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Download		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Export		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Go Online		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Modify Path		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Open		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Save		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Save As		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Project: Upload		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Routine: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Routine: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Routine: Manual Control		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Routine: Modify Logic		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Routine: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Safety: Gen/Del Signature		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Safety: Lock/Unlock		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Safety: Modify Component		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Safety: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Safety: Modify Tag Mappings		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Tag: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Tag: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Tag: Force		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Tag: Modify Constant Property		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Tag: Modify Constant Tag Value		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Tag: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Tag: Modify Values		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Task: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Task: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Task: Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Trend: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Trend: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Trend:Modify Properties		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Trend: Run		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		User Defined Type: Create		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		User Defined Type: Delete		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		User Defined Type: Modify		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Sequence Manager

		Event Server: Cfg Archiv Service		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Event Server: Cfg Client Service		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Event Server: Cfg Decod Service		Deny		Deny		Allow		Allow		Allow		Allow		Allow

		Parameter: Change Parameter		Deny		Allow		Allow		Allow		Allow		Allow		Allow

		Parameter: En/Dis Expression		Deny		Allow		Allow		Allow		Allow		Allow		Allow

		Parameter: Force Param Eval		Deny		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Abort		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Change Active Steps		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Change Mode		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Change Ownership		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Clear Failures		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Hold		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Pause and Resume		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Reset		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Restart		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Set ID		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Start		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Sequence: Stop		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Abort		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Clear Failures		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Hold		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Pause and Resume		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Reset		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Restart		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Start		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Step: Stop		Allow		Allow		Allow		Allow		Allow		Allow		Allow

		Transition: Force Expression		Allow		Allow		Allow		Allow		Allow		Allow		Allow















































































































































































































































































































































Users and Groups

		Users and Groups		Operators		Operator Supervisor		Maintanence		Maintanence Supervisor		Manager		Engineer		Administrator

		Common

		Configure Security		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Create Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Delete		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Execute		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		List Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Read		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Write		Deny		Deny		Deny		Deny		Deny		Allow		Allow



























































































































































































































































































































































































































































































































































Connections

		Connections		Operators		Operator Supervisor		Maintanence		Maintanence Supervisor		Manager		Engineer		Administrator

		Common

		Configure Security		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Create Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Delete		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Execute		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		List Children		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Read		Deny		Deny		Deny		Deny		Deny		Allow		Allow

		Write		Deny		Deny		Deny		Deny		Deny		Allow		Allow
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!

! Last configuration change at 13:35:38 UTC Wed Aug 15 2018 by admin

! NVRAM config last updated at 13:45:57 UTC Wed Aug 15 2018 by admin

!

version 15.2

service nagle

no service pad

service tcp-keepalives-in

service tcp-keepalives-out

service timestamps debug datetime msec localtime show-timezone

service timestamps log datetime msec localtime show-timezone

service password-encryption

service unsupported-transceiver

!

hostname SW001

!

boot-start-marker

boot-end-marker

!

!

logging buffered 16384

no logging console

!

no aaa new-model

platform config-upgrade 15.2(6)E

switch 2 provision 1783-ims28rac

system mtu routing 1500

no ip source-route

ip routing

ip arp inspection vlan 1000

ip arp inspection vlan 1000 logging dhcp-bindings none

no ip cef optimize neighbor resolution

!

!

!

no ip domain-lookup

ip igmp snooping querier

vtp mode transparent

!

!

!

!

!

udld aggressive



ptp mode forward 

!

!

crypto pki trustpoint TP-self-signed-861450112

 enrollment selfsigned

 subject-name cn=IOS-Self-Signed-Certificate-861450112

 revocation-check none

 rsakeypair TP-self-signed-861450112

!

!

crypto pki certificate chain TP-self-signed-861450112

 certificate self-signed 01 nvram:IOS-Self-Sig#6.cer

!

spanning-tree mode rapid-pvst

spanning-tree portfast edge bpduguard default

spanning-tree portfast edge bpdufilter default

spanning-tree extend system-id

cip security password 105C061A0E00170700

errdisable recovery cause udld

errdisable recovery cause bpduguard

errdisable recovery cause security-violation

errdisable recovery cause channel-misconfig

errdisable recovery cause pagp-flap

errdisable recovery cause link-flap

errdisable recovery cause sfp-config-mismatch

errdisable recovery cause gbic-invalid

errdisable recovery cause l2ptguard

errdisable recovery cause psecure-violation

errdisable recovery cause port-mode-failure

errdisable recovery cause dhcp-rate-limit

errdisable recovery cause pppoe-ia-rate-limit

errdisable recovery cause mac-limit

errdisable recovery cause vmps

errdisable recovery cause storm-control

errdisable recovery cause inline-power

errdisable recovery cause arp-inspection

errdisable recovery cause link-monitor-failure

errdisable recovery cause oam-remote-failure

errdisable recovery cause loopback

errdisable recovery cause small-frame

errdisable recovery cause psp

errdisable recovery cause loopdetect

errdisable recovery interval 30

!

alarm profile defaultPort

 alarm not-operating 

 syslog not-operating 

 notifies not-operating 

!

alarm profile ab-alarm

 alarm link-fault not-forwarding not-operating fcs-error 

 syslog link-fault not-forwarding not-operating fcs-error 

 notifies link-fault not-forwarding not-operating fcs-error 

 relay-major not-forwarding 

!

alarm facility power-supply rps notifies

alarm facility power-supply rps relay major

alarm facility temperature secondary notifies

alarm facility temperature secondary syslog

alarm facility temperature secondary high 90

alarm facility temperature secondary low 0

!

!

!

!

!

!

vlan 300 

!

vlan 301

 name Native 

!

vlan 501

 name VLAN0501 

!

vlan 502

 name VLAN0502 

!

vlan 503

 name VLAN0503 

!

vlan 504

 name VLAN0504 

!

vlan 505

 name VLAN0505 

!

vlan 506

 name VLAN0506 

!

vlan 507

 name VLAN0507 

!

vlan 508

 name VLAN0508 

!

vlan 509

 name VLAN0509 

!

vlan 601

 name VLAN0601 

!

vlan 602

 name VLAN0602 

!

vlan 603

 name VLAN0603 

!

!

class-map match-all 1588-PTP-General

 match access-group 107

class-map match-all 1588-PTP-Event

 match access-group 106

class-map match-all qos-group-2

 match qos-group 2

class-map match-all qos-group-0

 match qos-group 0

class-map match-all qos-group-1

 match qos-group 1

class-map match-all CIP-Implicit_dscp_any

 match access-group 104

class-map match-all CIP-Other

 match access-group 105

class-map match-all voip-data

 match ip dscp ef 

class-map match-any voip-control

 match ip dscp cs3  af31 

class-map match-all CIP-Implicit_dscp_43

 match access-group 103

class-map match-all CIP-Implicit_dscp_55

 match access-group 101

class-map match-all CIP-Implicit_dscp_47

 match access-group 102

!

policy-map Policymap-Output-Wireless

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 40 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 16 

policy-map Voice-Map

 class voip-data

  police 320000 8000 conform-action set-qos-transmit 1 exceed-action set-qos-transmit 3

 class voip-control

  police 32000 8000 conform-action set-qos-transmit 2 exceed-action set-qos-transmit 3

policy-map Output-accesspoint

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 19 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 40 

policy-map Policymap-Output-Default

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 25 

 class qos-group-2

  bandwidth percent 25 

 class class-default

  bandwidth percent 25 

policy-map PTP-Event-Priority

 class qos-group-0

  priority

 class qos-group-1

  bandwidth remaining percent 40 

 class qos-group-2

  bandwidth remaining percent 40 

 class class-default

  bandwidth remaining percent 20 

policy-map CIP-PTP-Traffic

 class CIP-Implicit_dscp_55

  set qos-group 1

 class CIP-Implicit_dscp_47

  set qos-group 1

 class CIP-Implicit_dscp_43

  set qos-group 1

 class CIP-Implicit_dscp_any

  set qos-group 2

 class CIP-Other

  set qos-group 2

 class 1588-PTP-Event

  set qos-group 0

 class 1588-PTP-General

  set qos-group 1

policy-map Policymap-Output-Phone

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 60 

 class qos-group-2

  bandwidth percent 20 

 class class-default

  bandwidth percent 10 

!

!

! 

!

!

!

!

!

!

!

!

macro global description ab-global | ab-password

!

interface Port-channel1

 description SW040

 switchport trunk native vlan 301

 switchport mode trunk

 macro description switch-automation

 spanning-tree link-type point-to-point

!

interface Port-channel2

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

!

interface Port-channel3

 description connection to Vertec .12

 switchport access vlan 501

 switchport mode access

!

interface Port-channel4

 description connection to Vertec .13

 switchport access vlan 501

 switchport mode access

!

interface Port-channel5

 description SW020

 switchport trunk native vlan 301

 switchport mode trunk

!

interface Port-channel6

 description SW030

 switchport trunk native vlan 301

 switchport mode trunk

!

interface GigabitEthernet1/1

 description connection to Vertec .12

 switchport access vlan 501

 switchport mode access

 channel-group 3 mode on

!

interface GigabitEthernet1/2

 description connection to Vertec .12

 switchport access vlan 501

 switchport mode access

 channel-group 3 mode on

!

interface GigabitEthernet1/3

 description connection to Vertec .13

 switchport access vlan 501

 switchport mode access

 channel-group 4 mode on

!

interface GigabitEthernet1/4

 description connection to Vertec .13

 switchport access vlan 501

 switchport mode access

 channel-group 4 mode on

!

interface GigabitEthernet1/5

 description SW020

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 5 mode active

!

interface GigabitEthernet1/6

 description SW020

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 5 mode active

!

interface GigabitEthernet1/7

 description SW030

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 6 mode active

!

interface GigabitEthernet1/8

 description SW030

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 6 mode active

!

interface GigabitEthernet1/9

 description SW040

 switchport trunk native vlan 301

 switchport mode trunk

 macro description switch-automation

 alarm profile ab-alarm

 spanning-tree link-type point-to-point

 channel-group 1 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/10

 description SW040

 switchport trunk native vlan 301

 switchport mode trunk

 macro description switch-automation

 alarm profile ab-alarm

 spanning-tree link-type point-to-point

 channel-group 1 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/11

 description SW050

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/12

 description SW051

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/13

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/14

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/15

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/16

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/17

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/18

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/19

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/20

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/21

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/22

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/23

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/24

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface TenGigabitEthernet1/25

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

 alarm profile ab-alarm

 channel-group 2 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface TenGigabitEthernet1/26

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

 alarm profile ab-alarm

 channel-group 2 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface TenGigabitEthernet1/27

!

interface TenGigabitEthernet1/28

!

interface Vlan1

 ip address dhcp

!

interface Vlan300

 ip address 172.18.0.1 255.255.255.0

!

interface Vlan501

 ip address 172.18.1.1 255.255.255.0

!

interface Vlan502

 ip address 172.18.2.1 255.255.255.0

!

interface Vlan503

 ip address 172.18.3.1 255.255.255.0

!

interface Vlan504

 ip address 172.18.4.1 255.255.255.0

!

interface Vlan505

 ip address 172.18.5.1 255.255.255.0

!

interface Vlan506

 ip address 172.18.6.1 255.255.255.0

!

interface Vlan507

 ip address 172.18.7.1 255.255.255.0

!

interface Vlan508

 ip address 172.18.8.1 255.255.255.0

!

interface Vlan509

 ip address 172.18.9.1 255.255.255.0

!

interface Vlan601

 ip address 172.20.1.1 255.255.255.0

!

interface Vlan602

 ip address 172.20.2.1 255.255.255.0

!

interface Vlan603

 ip address 172.20.3.1 255.255.255.0

!

ip forward-protocol nd

!

ip http server

ip http authentication local

ip http secure-server

ip http tls-version TLSv1.2 

ip http session-idle-timeout 1200 

!

!

!

access-list 101 permit udp any eq 2222 any dscp 55

access-list 102 permit udp any eq 2222 any dscp 47

access-list 103 permit udp any eq 2222 any dscp 43

access-list 104 permit udp any eq 2222 any

access-list 105 permit udp any eq 44818 any

access-list 105 permit tcp any eq 44818 any

access-list 106 permit udp any eq 319 any

access-list 107 permit udp any eq 320 any

!

snmp-server community PlantPax RO

snmp-server enable traps snmp authentication linkdown linkup coldstart warmstart

snmp-server enable traps transceiver all

snmp-server enable traps call-home message-send-fail server-fail

snmp-server enable traps tty

snmp-server enable traps eigrp

snmp-server enable traps ospf state-change

snmp-server enable traps ospf errors

snmp-server enable traps ospf retransmit

snmp-server enable traps ospf lsa

snmp-server enable traps ospf cisco-specific state-change nssa-trans-change

snmp-server enable traps ospf cisco-specific state-change shamlink interface

snmp-server enable traps ospf cisco-specific state-change shamlink neighbor

snmp-server enable traps ospf cisco-specific errors

snmp-server enable traps ospf cisco-specific retransmit

snmp-server enable traps ospf cisco-specific lsa

snmp-server enable traps license

snmp-server enable traps bfd

snmp-server enable traps ethernet cfm cc mep-up mep-down cross-connect loop config

snmp-server enable traps ethernet cfm crosscheck mep-missing mep-unknown service-up

snmp-server enable traps auth-framework sec-violation

snmp-server enable traps bgp cbgp2

snmp-server enable traps ether-oam

snmp-server enable traps cef resource-failure peer-state-change peer-fib-state-change inconsistency

snmp-server enable traps cluster

snmp-server enable traps config-copy

snmp-server enable traps config

snmp-server enable traps config-ctid

snmp-server enable traps pki

snmp-server enable traps trustsec authz-file-error cache-file-error keystore-file-error keystore-sync-fail random-number-fail src-entropy-fail

snmp-server enable traps trustsec-policy peer-policy-updated authz-sgacl-fail

snmp-server enable traps trustsec-sxp conn-srcaddr-err msg-parse-err conn-config-err binding-err conn-up conn-down binding-expn-fail oper-nodeid-change binding-conflict

snmp-server enable traps energywise

snmp-server enable traps fru-ctrl

snmp-server enable traps entity

snmp-server enable traps event-manager

snmp-server enable traps hsrp

snmp-server enable traps ipmulticast

snmp-server enable traps ike policy add

snmp-server enable traps ike policy delete

snmp-server enable traps ike tunnel start

snmp-server enable traps ike tunnel stop

snmp-server enable traps ipsec cryptomap add

snmp-server enable traps ipsec cryptomap delete

snmp-server enable traps ipsec cryptomap attach

snmp-server enable traps ipsec cryptomap detach

snmp-server enable traps ipsec tunnel start

snmp-server enable traps ipsec tunnel stop

snmp-server enable traps ipsec too-many-sas

snmp-server enable traps isis

snmp-server enable traps msdp

snmp-server enable traps ospfv3 state-change

snmp-server enable traps ospfv3 errors

snmp-server enable traps power-ethernet group 2

snmp-server enable traps power-ethernet police

snmp-server enable traps pim neighbor-change rp-mapping-change invalid-pim-message

snmp-server enable traps cpu threshold

snmp-server enable traps rep

snmp-server enable traps ipsla

snmp-server enable traps vstack

snmp-server enable traps bridge newroot topologychange

snmp-server enable traps stpx inconsistency root-inconsistency loop-inconsistency

snmp-server enable traps syslog

snmp-server enable traps trustsec-interface unauthorized sap-fail authc-fail supplicant-fail authz-fail

snmp-server enable traps trustsec-server radius-server provision-secret

snmp-server enable traps vtp

snmp-server enable traps vlancreate

snmp-server enable traps vlandelete

snmp-server enable traps flash insertion removal

snmp-server enable traps port-security

snmp-server enable traps envmon fan shutdown supply temperature status

snmp-server enable traps stackwise

snmp-server enable traps ethernet cfm alarm

snmp-server enable traps alarms informational

snmp-server enable traps bulkstat collection transfer

snmp-server enable traps vrfmib vrf-up vrf-down vnet-trunk-up vnet-trunk-down

snmp-server enable traps errdisable

snmp-server enable traps mac-notification change move threshold

snmp-server enable traps vlan-membership

!

no vstack

!

line con 0

 login local

line vty 0 4

 login local

 transport input ssh

line vty 5 15

 login local

 transport input ssh

!

ntp server 172.18.1.10 prefer

!

end






!

! Last configuration change at 12:00:08 UTC Sun Aug 13 2034 by admin

! NVRAM config last updated at 12:00:12 UTC Sun Aug 13 2034 by admin

!

version 15.2

service nagle

no service pad

service tcp-keepalives-in

service tcp-keepalives-out

service timestamps debug datetime msec localtime show-timezone

service timestamps log datetime msec localtime show-timezone

service password-encryption

service unsupported-transceiver

!

hostname SW011

!

boot-start-marker

boot-end-marker

!

!

logging buffered 16384

no logging console

!

no aaa new-model

platform config-upgrade 15.2(6)E

switch 2 provision 1783-ims28nac

system mtu routing 1500

no ip source-route

!

!

!

no ip domain-lookup

ip igmp snooping querier

vtp mode transparent

!

!

!

!

!

udld aggressive



ptp mode forward 

!

!

!

!

spanning-tree mode rapid-pvst

spanning-tree portfast edge bpduguard default

spanning-tree portfast edge bpdufilter default

spanning-tree extend system-id

errdisable recovery cause udld

errdisable recovery cause bpduguard

errdisable recovery cause security-violation

errdisable recovery cause channel-misconfig

errdisable recovery cause pagp-flap

errdisable recovery cause link-flap

errdisable recovery cause sfp-config-mismatch

errdisable recovery cause gbic-invalid

errdisable recovery cause l2ptguard

errdisable recovery cause psecure-violation

errdisable recovery cause port-mode-failure

errdisable recovery cause dhcp-rate-limit

errdisable recovery cause pppoe-ia-rate-limit

errdisable recovery cause mac-limit

errdisable recovery cause vmps

errdisable recovery cause storm-control

errdisable recovery cause inline-power

errdisable recovery cause arp-inspection

errdisable recovery cause link-monitor-failure

errdisable recovery cause oam-remote-failure

errdisable recovery cause loopback

errdisable recovery cause small-frame

errdisable recovery cause psp

errdisable recovery cause loopdetect

errdisable recovery interval 30

!

alarm profile defaultPort

 alarm not-operating 

 syslog not-operating 

 notifies not-operating 

!

alarm profile ab-alarm

 alarm link-fault not-forwarding fcs-error 

 syslog link-fault not-forwarding fcs-error 

 notifies link-fault not-forwarding fcs-error 

 relay-major not-forwarding 

!

alarm facility power-supply rps notifies

alarm facility power-supply rps relay major

alarm facility temperature secondary notifies

alarm facility temperature secondary syslog

alarm facility temperature secondary high 90

alarm facility temperature secondary low 0

!

!

!

vlan 300 

!

vlan 301

 name Native 

!

vlan 501-509,601-603 

!

!

class-map match-all 1588-PTP-General

 match access-group 107

class-map match-all 1588-PTP-Event

 match access-group 106

class-map match-all qos-group-2

 match qos-group 2

class-map match-all qos-group-0

 match qos-group 0

class-map match-all qos-group-1

 match qos-group 1

class-map match-all CIP-Implicit_dscp_any

 match access-group 104

class-map match-all CIP-Other

 match access-group 105

class-map match-all voip-data

 match ip dscp ef 

class-map match-any voip-control

 match ip dscp cs3  af31 

class-map match-all CIP-Implicit_dscp_43

 match access-group 103

class-map match-all CIP-Implicit_dscp_55

 match access-group 101

class-map match-all CIP-Implicit_dscp_47

 match access-group 102

!

policy-map Policymap-Output-Wireless

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 40 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 16 

policy-map Voice-Map

 class voip-data

  police 320000 8000 conform-action set-qos-transmit 1 exceed-action set-qos-transmit 3

 class voip-control

  police 32000 8000 conform-action set-qos-transmit 2 exceed-action set-qos-transmit 3

policy-map Output-accesspoint

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 19 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 40 

policy-map Policymap-Output-Default

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 25 

 class qos-group-2

  bandwidth percent 25 

 class class-default

  bandwidth percent 25 

policy-map PTP-Event-Priority

 class qos-group-0

  priority

 class qos-group-1

  bandwidth remaining percent 40 

 class qos-group-2

  bandwidth remaining percent 40 

 class class-default

  bandwidth remaining percent 20 

policy-map CIP-PTP-Traffic

 class CIP-Implicit_dscp_55

  set qos-group 1

 class CIP-Implicit_dscp_47

  set qos-group 1

 class CIP-Implicit_dscp_43

  set qos-group 1

 class CIP-Implicit_dscp_any

  set qos-group 2

 class CIP-Other

  set qos-group 2

 class 1588-PTP-Event

  set qos-group 0

 class 1588-PTP-General

  set qos-group 1

policy-map Policymap-Output-Phone

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 60 

 class qos-group-2

  bandwidth percent 20 

 class class-default

  bandwidth percent 10 

!

!

!

!

!

macro global description ab-global | ab-password

!

interface Port-channel2

 description Group 2 Connection from SW011 to SW001

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

!

interface GigabitEthernet1/1

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/2

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 speed 100

 duplex full

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/3

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/4

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/5

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/6

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/7

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/8

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/9

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/10

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/11

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/12

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/13

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/14

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/15

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/16

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/17

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/18

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/19

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/20

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/21

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/22

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/23

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/24

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface TenGigabitEthernet1/25

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

 alarm profile ab-alarm

 channel-group 2 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface TenGigabitEthernet1/26

 switchport access vlan 300

 switchport trunk native vlan 301

 switchport mode trunk

 alarm profile ab-alarm

 channel-group 2 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface TenGigabitEthernet1/27

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface TenGigabitEthernet1/28

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface Vlan1

 cip enable

!

interface Vlan300

 ip address 172.18.0.11 255.255.255.0

!

ip default-gateway 172.18.0.1

ip forward-protocol nd

ip http server

ip http authentication local

ip http secure-server

ip http tls-version TLSv1.2 

ip http session-idle-timeout 1200 

!

!

!

access-list 101 permit udp any eq 2222 any dscp 55

access-list 102 permit udp any eq 2222 any dscp 47

access-list 103 permit udp any eq 2222 any dscp 43

access-list 104 permit udp any eq 2222 any

access-list 105 permit udp any eq 44818 any

access-list 105 permit tcp any eq 44818 any

access-list 106 permit udp any eq 319 any

access-list 107 permit udp any eq 320 any

!

!

snmp-server community rockwell RO

snmp-server enable traps snmp authentication linkdown linkup coldstart warmstart

snmp-server enable traps transceiver all

snmp-server enable traps call-home message-send-fail server-fail

snmp-server enable traps tty

snmp-server enable traps license

snmp-server enable traps bfd

snmp-server enable traps ethernet cfm cc mep-up mep-down cross-connect loop config

snmp-server enable traps ethernet cfm crosscheck mep-missing mep-unknown service-up

snmp-server enable traps auth-framework sec-violation

snmp-server enable traps ether-oam

snmp-server enable traps cluster

snmp-server enable traps config-copy

snmp-server enable traps config

snmp-server enable traps config-ctid

snmp-server enable traps pki

snmp-server enable traps energywise

snmp-server enable traps fru-ctrl

snmp-server enable traps entity

snmp-server enable traps event-manager

snmp-server enable traps power-ethernet group 2

snmp-server enable traps power-ethernet police

snmp-server enable traps cpu threshold

snmp-server enable traps rep

snmp-server enable traps vstack

snmp-server enable traps bridge newroot topologychange

snmp-server enable traps stpx inconsistency root-inconsistency loop-inconsistency

snmp-server enable traps syslog

snmp-server enable traps vtp

snmp-server enable traps vlancreate

snmp-server enable traps vlandelete

snmp-server enable traps flash insertion removal

snmp-server enable traps port-security

snmp-server enable traps envmon fan shutdown supply temperature status

snmp-server enable traps stackwise

snmp-server enable traps ethernet cfm alarm

snmp-server enable traps alarms informational

snmp-server enable traps bulkstat collection transfer

snmp-server enable traps errdisable

snmp-server enable traps mac-notification change move threshold

snmp-server enable traps vlan-membership

!

no vstack

!

line con 0

 login local

line vty 0 4

 login local

 transport input none

line vty 5 15

 login local

 transport input none

!

ntp server 172.18.1.10

!

end






!

! Last configuration change at 18:53:33 UTC Fri Aug 3 2018 by admin

! NVRAM config last updated at 18:53:33 UTC Fri Aug 3 2018 by admin

!

version 15.2

service nagle

no service pad

service tcp-keepalives-in

service tcp-keepalives-out

service timestamps debug datetime msec localtime show-timezone

service timestamps log datetime msec localtime show-timezone

service password-encryption

!

hostname SW020

!

boot-start-marker

boot-end-marker

!

!

logging buffered 16384

no logging console

!

no aaa new-model

platform config-upgrade 15.2(6)E

system mtu routing 1500

no ip source-route

ip arp inspection vlan 1000

ip arp inspection vlan 1000 logging dhcp-bindings none

!

!

!

no ip domain-lookup

ip igmp snooping querier

vtp mode transparent

!

!

!

!

!

udld aggressive



ptp mode gmc-bc 

ptp priority1 126 

ptp priority2 127 

!





!

crypto pki trustpoint TP-self-signed-856779392

 enrollment selfsigned

 subject-name cn=IOS-Self-Signed-Certificate-856779392

 revocation-check none

 rsakeypair TP-self-signed-856779392

!

!

crypto pki certificate chain TP-self-signed-856779392

 certificate self-signed 01 nvram:IOS-Self-Sig#3.cer

!

spanning-tree mode rapid-pvst

spanning-tree portfast edge bpduguard default

spanning-tree portfast edge bpdufilter default

spanning-tree extend system-id

cip security password 075F751817594D5542425F5F527E72707A6360

errdisable recovery cause udld

errdisable recovery cause bpduguard

errdisable recovery cause security-violation

errdisable recovery cause channel-misconfig

errdisable recovery cause pagp-flap

errdisable recovery cause link-flap

errdisable recovery cause sfp-config-mismatch

errdisable recovery cause gbic-invalid

errdisable recovery cause l2ptguard

errdisable recovery cause psecure-violation

errdisable recovery cause port-mode-failure

errdisable recovery cause dhcp-rate-limit

errdisable recovery cause pppoe-ia-rate-limit

errdisable recovery cause mac-limit

errdisable recovery cause vmps

errdisable recovery cause storm-control

errdisable recovery cause inline-power

errdisable recovery cause arp-inspection

errdisable recovery cause link-monitor-failure

errdisable recovery cause oam-remote-failure

errdisable recovery cause loopback

errdisable recovery cause small-frame

errdisable recovery cause psp

errdisable recovery interval 30

!

alarm profile defaultPort

 alarm not-operating 

 syslog not-operating 

 notifies not-operating 

!

alarm profile ab-alarm

 alarm link-fault not-forwarding not-operating fcs-error 

 syslog link-fault not-forwarding not-operating fcs-error 

 notifies link-fault not-forwarding not-operating fcs-error 

 relay-major not-forwarding 

!

alarm facility power-supply rps disable

alarm facility power-supply rps notifies

alarm facility power-supply rps relay major

alarm facility temperature secondary notifies

alarm facility temperature secondary syslog

alarm facility temperature secondary high 90

alarm facility temperature secondary low 0

!

!

!

!

!

!

vlan 300 

!

vlan 301

 name Native 

!

vlan 501-502 

!

vlan 503

 name VLAN0503 

!

vlan 504 

!

vlan 505

 name VLAN0505 

!

vlan 506

 name VLAN0506 

!

vlan 507-509,601-603 

!

!

class-map match-all 1588-PTP-General

 match access-group 107

class-map match-all 1588-PTP-Event

 match access-group 106

class-map match-all qos-group-2

 match qos-group 2

class-map match-all qos-group-0

 match qos-group 0

class-map match-all qos-group-1

 match qos-group 1

class-map match-all CIP-Implicit_dscp_any

 match access-group 104

class-map match-all CIP-Other

 match access-group 105

class-map match-all voip-data

 match ip dscp ef 

class-map match-any voip-control

 match ip dscp cs3  af31 

class-map match-all CIP-Implicit_dscp_43

 match access-group 103

class-map match-all CIP-Implicit_dscp_55

 match access-group 101

class-map match-all CIP-Implicit_dscp_47

 match access-group 102

!

policy-map Policymap-Output-Wireless

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 40 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 16 

policy-map Voice-Map

 class voip-data

  police 320000 8000 conform-action set-qos-transmit 1 exceed-action set-qos-transmit 3

 class voip-control

  police 32000 8000 conform-action set-qos-transmit 2 exceed-action set-qos-transmit 3

policy-map Policymap-Output-Default

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 25 

 class qos-group-2

  bandwidth percent 25 

 class class-default

  bandwidth percent 25 

policy-map PTP-Event-Priority

 class qos-group-0

  priority

 class qos-group-1

  bandwidth remaining percent 40 

 class qos-group-2

  bandwidth remaining percent 40 

 class class-default

  police 4000000

  bandwidth remaining percent 20 

policy-map CIP-PTP-Traffic

 class CIP-Implicit_dscp_55

  set qos-group 1

 class CIP-Implicit_dscp_47

  set qos-group 1

 class CIP-Implicit_dscp_43

  set qos-group 1

 class CIP-Implicit_dscp_any

  set qos-group 2

 class CIP-Other

  set qos-group 2

 class 1588-PTP-Event

  set qos-group 0

 class 1588-PTP-General

  set qos-group 1

policy-map Policymap-Output-Phone

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 60 

 class qos-group-2

  bandwidth percent 20 

 class class-default

  bandwidth percent 10 

!

!

! 

!

!

!

!

!

!

!

!

macro global description ab-global | ab-password

!

interface Port-channel1

 description SW001

 switchport trunk native vlan 301

 switchport mode trunk

!

interface GigabitEthernet1/1

 description SW001

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 1 mode active

!

interface GigabitEthernet1/2

 description SW001

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 1 mode active

!

interface GigabitEthernet1/3

!

interface GigabitEthernet1/4

!

interface GigabitEthernet1/5

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/6

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/7

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/8

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/9

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/10

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/11

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/12

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/13

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/14

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/15

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/16

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/17

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/18

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/19

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/20

 switchport access vlan 501

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 speed 100

 duplex full

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface Vlan1

 no ip address

 no ip route-cache

 shutdown

!

interface Vlan300

 ip address 172.18.0.20 255.255.255.0

!

interface Vlan301

 no ip address

!

interface Vlan501

 ip address 172.18.1.200 255.255.255.0

 cip enable

!

ip default-gateway 172.18.0.1

ip forward-protocol nd

!

ip http server

ip http authentication local

ip http secure-server

ip http tls-version TLSv1.2 

ip http session-idle-timeout 1200 

!

!

!

access-list 101 permit udp any eq 2222 any dscp 55

access-list 102 permit udp any eq 2222 any dscp 47

access-list 103 permit udp any eq 2222 any dscp 43

access-list 104 permit udp any eq 2222 any

access-list 105 permit udp any eq 44818 any

access-list 105 permit tcp any eq 44818 any

access-list 106 permit udp any eq 319 any

access-list 107 permit udp any eq 320 any

!

snmp-server community PlantPAx RO

snmp-server enable traps snmp authentication linkdown linkup coldstart warmstart

snmp-server enable traps transceiver all

snmp-server enable traps call-home message-send-fail server-fail

snmp-server enable traps tty

snmp-server enable traps eigrp

snmp-server enable traps ospf state-change

snmp-server enable traps ospf errors

snmp-server enable traps ospf retransmit

snmp-server enable traps ospf lsa

snmp-server enable traps ospf cisco-specific state-change nssa-trans-change

snmp-server enable traps ospf cisco-specific state-change shamlink interface

snmp-server enable traps ospf cisco-specific state-change shamlink neighbor

snmp-server enable traps ospf cisco-specific errors

snmp-server enable traps ospf cisco-specific retransmit

snmp-server enable traps ospf cisco-specific lsa

snmp-server enable traps license

snmp-server enable traps ethernet cfm cc mep-up mep-down cross-connect loop config

snmp-server enable traps ethernet cfm crosscheck mep-missing mep-unknown service-up

snmp-server enable traps auth-framework sec-violation

snmp-server enable traps bgp cbgp2

snmp-server enable traps ether-oam

snmp-server enable traps cef resource-failure peer-state-change peer-fib-state-change inconsistency

snmp-server enable traps cluster

snmp-server enable traps config-copy

snmp-server enable traps config

snmp-server enable traps config-ctid

snmp-server enable traps trustsec-sxp conn-srcaddr-err msg-parse-err conn-config-err binding-err conn-up conn-down binding-expn-fail oper-nodeid-change binding-conflict

snmp-server enable traps energywise

snmp-server enable traps fru-ctrl

snmp-server enable traps entity

snmp-server enable traps event-manager

snmp-server enable traps hsrp

snmp-server enable traps ipmulticast

snmp-server enable traps isis

snmp-server enable traps msdp

snmp-server enable traps ospfv3 state-change

snmp-server enable traps ospfv3 errors

snmp-server enable traps power-ethernet police

snmp-server enable traps pim neighbor-change rp-mapping-change invalid-pim-message

snmp-server enable traps cpu threshold

snmp-server enable traps rep

snmp-server enable traps ipsla

snmp-server enable traps vstack

snmp-server enable traps bridge newroot topologychange

snmp-server enable traps stpx inconsistency root-inconsistency loop-inconsistency

snmp-server enable traps syslog

snmp-server enable traps vtp

snmp-server enable traps vlancreate

snmp-server enable traps vlandelete

snmp-server enable traps flash insertion removal

snmp-server enable traps port-security

snmp-server enable traps envmon fan shutdown supply temperature status

snmp-server enable traps stackwise

snmp-server enable traps ethernet cfm alarm

snmp-server enable traps alarms informational

snmp-server enable traps bulkstat collection transfer

snmp-server enable traps vrfmib vrf-up vrf-down vnet-trunk-up vnet-trunk-down

snmp-server enable traps errdisable

snmp-server enable traps mac-notification change move threshold

snmp-server enable traps vlan-membership

!

vstack

!

line con 0

 password 7 1500040F0F3D2E2824

 login

line vty 0 4

 password 7 1500040F0F3D2E2824

 login local

 transport input telnet ssh

line vty 5 15

 password 7 1500040F0F3D2E2824

 login local

 transport input telnet ssh

!

ntp server 172.18.1.10 prefer

!

end






!

! Last configuration change at 18:49:00 UTC Fri Aug 3 2018 by admin

! NVRAM config last updated at 18:49:00 UTC Fri Aug 3 2018 by admin

!

version 15.2

service nagle

no service pad

service tcp-keepalives-in

service tcp-keepalives-out

service timestamps debug datetime msec localtime show-timezone

service timestamps log datetime msec localtime show-timezone

service password-encryption

service unsupported-transceiver

!

hostname SW030

!

boot-start-marker

boot-end-marker

!

!

logging buffered 16384

no logging console

!

no aaa new-model

platform config-upgrade 15.2(6)E

system mtu routing 1500

no ip source-route

ip routing

!

!

!

no ip domain-lookup

ip igmp snooping querier

vtp mode transparent

!

!

!

!

!

udld aggressive



ptp mode gmc-bc 

ptp priority1 126 

ptp priority2 127 

!

dlr ring 1

 mode supervisor

  precedence 255

dlr ring 2

 mode supervisor

  precedence 255

  control-vlan-id 503

dlr ring 3

 mode supervisor

  control-vlan-id 504





dlr ring 1

 ring-dhcp

  snooping enable



dlr ring 2

 ring-dhcp

  snooping enable



dlr ring 3

 ring-dhcp

  snooping enable



!

crypto pki trustpoint TP-self-signed-857057152

 enrollment selfsigned

 subject-name cn=IOS-Self-Signed-Certificate-857057152

 revocation-check none

 rsakeypair TP-self-signed-857057152

!

!

crypto pki certificate chain TP-self-signed-857057152

 certificate self-signed 01 nvram:IOS-Self-Sig#2.cer

!

spanning-tree mode rapid-pvst

spanning-tree portfast edge bpduguard default

spanning-tree portfast edge bpdufilter default

spanning-tree extend system-id

no spanning-tree vlan 501

cip security password 111B16061C050E0008

errdisable recovery cause udld

errdisable recovery cause bpduguard

errdisable recovery cause security-violation

errdisable recovery cause channel-misconfig

errdisable recovery cause pagp-flap

errdisable recovery cause link-flap

errdisable recovery cause sfp-config-mismatch

errdisable recovery cause gbic-invalid

errdisable recovery cause l2ptguard

errdisable recovery cause psecure-violation

errdisable recovery cause port-mode-failure

errdisable recovery cause dhcp-rate-limit

errdisable recovery cause pppoe-ia-rate-limit

errdisable recovery cause mac-limit

errdisable recovery cause vmps

errdisable recovery cause storm-control

errdisable recovery cause inline-power

errdisable recovery cause arp-inspection

errdisable recovery cause link-monitor-failure

errdisable recovery cause oam-remote-failure

errdisable recovery cause loopback

errdisable recovery cause small-frame

errdisable recovery cause psp

errdisable recovery cause loopdetect

errdisable recovery interval 30

!

alarm profile defaultPort

 alarm not-operating 

 syslog not-operating 

 notifies not-operating 

!

alarm profile ab-alarm

 alarm link-fault not-forwarding not-operating fcs-error 

 syslog link-fault not-forwarding not-operating fcs-error 

 notifies link-fault not-forwarding not-operating fcs-error 

 relay-major not-forwarding 

!

alarm relay-mode negative

alarm facility power-supply rps notifies

alarm facility power-supply rps relay major

alarm facility temperature secondary notifies

alarm facility temperature secondary syslog

alarm facility temperature secondary high 90

alarm facility temperature secondary low 0

!

!

!

!

!

!

vlan configuration 1006-1008

  no ip igmp snooping

!

vlan 300 

!

vlan 301

 name Native 

!

vlan 501-502 

!

vlan 503

 name VLAN0503 

!

vlan 504

 name VLAN0504 

!

vlan 505-509,601-603 

!

!

class-map match-all 1588-PTP-General

 match access-group 107

class-map match-all 1588-PTP-Event

 match access-group 106

class-map match-all qos-group-2

 match qos-group 2

class-map match-all qos-group-0

 match qos-group 0

class-map match-all qos-group-1

 match qos-group 1

class-map match-all CIP-Implicit_dscp_any

 match access-group 104

class-map match-all CIP-Other

 match access-group 105

class-map match-all voip-data

 match ip dscp ef 

class-map match-any voip-control

 match ip dscp cs3  af31 

class-map match-all CIP-Implicit_dscp_43

 match access-group 103

class-map match-all CIP-Implicit_dscp_55

 match access-group 101

class-map match-all CIP-Implicit_dscp_47

 match access-group 102

!

policy-map Policymap-Output-Wireless

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 40 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 16 

policy-map Voice-Map

 class voip-data

  police 320000 8000 conform-action set-qos-transmit 1 exceed-action set-qos-transmit 3

 class voip-control

  police 32000 8000 conform-action set-qos-transmit 2 exceed-action set-qos-transmit 3

policy-map Output-accesspoint

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 19 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 40 

policy-map Policymap-Output-Default

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 25 

 class qos-group-2

  bandwidth percent 25 

 class class-default

  bandwidth percent 25 

policy-map PTP-Event-Priority

 class qos-group-0

  priority

 class qos-group-1

  bandwidth remaining percent 40 

 class qos-group-2

  bandwidth remaining percent 40 

 class class-default

  bandwidth remaining percent 20 

policy-map CIP-PTP-Traffic

 class CIP-Implicit_dscp_55

  set qos-group 1

 class CIP-Implicit_dscp_47

  set qos-group 1

 class CIP-Implicit_dscp_43

  set qos-group 1

 class CIP-Implicit_dscp_any

  set qos-group 2

 class CIP-Other

  set qos-group 2

 class 1588-PTP-Event

  set qos-group 0

 class 1588-PTP-General

  set qos-group 1

policy-map Policymap-Output-Phone

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 60 

 class qos-group-2

  bandwidth percent 20 

 class class-default

  bandwidth percent 10 

!

!

! 

!

!

!

!

!

!

!

!

macro global description ab-global | ab-password

!

interface Port-channel1

 description SW001

 switchport trunk native vlan 301

 switchport mode trunk

!

interface GigabitEthernet1/1

 description SW001

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 1 mode active

!

interface GigabitEthernet1/2

 description SW001

 switchport trunk native vlan 301

 switchport mode trunk

 channel-group 1 mode active

!

interface GigabitEthernet1/3

 switchport trunk native vlan 301

 switchport mode trunk

 ptp sync limit 10000

 macro description switch-automation

 alarm profile ab-alarm

 spanning-tree link-type point-to-point

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/4

 switchport trunk native vlan 301

 switchport mode trunk

 ptp sync limit 10000

 macro description switch-automation

 alarm profile ab-alarm

 spanning-tree link-type point-to-point

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/5

 switchport access vlan 501

 switchport mode access

 load-interval 30

 no cdp enable

 ptp sync limit 10000

 dlr ring 1

 macro description ab-multiport-device

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

 ip dhcp snooping trust

!

interface GigabitEthernet1/6

 switchport access vlan 501

 switchport mode access

 load-interval 30

 no cdp enable

 ptp sync limit 10000

 dlr ring 1

 macro description ab-multiport-device

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

 ip dhcp snooping trust

!

interface GigabitEthernet1/7

 switchport access vlan 503

 switchport mode access

 load-interval 30

 no cdp enable

 ptp sync limit 10000

 dlr ring 2

 macro description ab-multiport-device

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

 ip dhcp snooping trust

!

interface GigabitEthernet1/8

 switchport access vlan 503

 switchport mode access

 load-interval 30

 no cdp enable

 ptp sync limit 10000

 dlr ring 2

 macro description ab-multiport-device

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

 ip dhcp snooping trust

!

interface GigabitEthernet1/9

 switchport access vlan 501

 switchport mode access

 load-interval 30

 no cdp enable

 ptp sync limit 10000

 dlr ring 3

 macro description ab-multiport-device

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

 ip dhcp snooping trust

!

interface GigabitEthernet1/10

 switchport access vlan 501

 switchport mode access

 load-interval 30

 no cdp enable

 dlr ring 3

 macro description ab-multiport-device

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

 ip dhcp snooping trust

!

interface GigabitEthernet1/11

 switchport access vlan 501

 switchport mode access

 load-interval 30

 no cdp enable

 macro description ab-multiport-device

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/12

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/13

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/14

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/15

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/16

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/17

 switchport access vlan 300

 switchport trunk native vlan 300

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 no cdp enable

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/18

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 no cdp enable

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/19

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 no cdp enable

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/20

 description controller VLAN501

 switchport access vlan 501

 switchport trunk native vlan 300

 ptp sync limit 10000

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface Vlan1

 no ip address

 shutdown

!

interface Vlan300

 ip address 172.18.0.30 255.255.255.0

!

interface Vlan301

 no ip address

!

interface Vlan501

 ip address 172.18.1.210 255.255.255.0

 cip enable

!

interface Vlan503

 ip address 172.18.3.1 255.255.255.0

!

interface Vlan504

 ip address 172.18.4.1 255.255.255.0

!

ip forward-protocol nd

!

ip http server

ip http authentication local

ip http secure-server

ip http tls-version TLSv1.2 

ip http session-idle-timeout 1200 

!

ip route 0.0.0.0 0.0.0.0 172.18.0.1

!

!

access-list 101 permit udp any eq 2222 any dscp 55

access-list 102 permit udp any eq 2222 any dscp 47

access-list 103 permit udp any eq 2222 any dscp 43

access-list 104 permit udp any eq 2222 any

access-list 105 permit udp any eq 44818 any

access-list 105 permit tcp any eq 44818 any

access-list 106 permit udp any eq 319 any

access-list 107 permit udp any eq 320 any

!

snmp-server community PlantPAx RO

snmp-server enable traps snmp authentication linkdown linkup coldstart warmstart

snmp-server enable traps transceiver all

snmp-server enable traps call-home message-send-fail server-fail

snmp-server enable traps tty

snmp-server enable traps eigrp

snmp-server enable traps ospf state-change

snmp-server enable traps ospf errors

snmp-server enable traps ospf retransmit

snmp-server enable traps ospf lsa

snmp-server enable traps ospf cisco-specific state-change nssa-trans-change

snmp-server enable traps ospf cisco-specific state-change shamlink interface

snmp-server enable traps ospf cisco-specific state-change shamlink neighbor

snmp-server enable traps ospf cisco-specific errors

snmp-server enable traps ospf cisco-specific retransmit

snmp-server enable traps ospf cisco-specific lsa

snmp-server enable traps license

snmp-server enable traps bfd

snmp-server enable traps ethernet cfm cc mep-up mep-down cross-connect loop config

snmp-server enable traps ethernet cfm crosscheck mep-missing mep-unknown service-up

snmp-server enable traps auth-framework sec-violation

snmp-server enable traps bgp cbgp2

snmp-server enable traps ether-oam

snmp-server enable traps cef resource-failure peer-state-change peer-fib-state-change inconsistency

snmp-server enable traps cluster

snmp-server enable traps config-copy

snmp-server enable traps config

snmp-server enable traps config-ctid

snmp-server enable traps pki

snmp-server enable traps trustsec authz-file-error cache-file-error keystore-file-error keystore-sync-fail random-number-fail src-entropy-fail

snmp-server enable traps trustsec-policy peer-policy-updated authz-sgacl-fail

snmp-server enable traps trustsec-sxp conn-srcaddr-err msg-parse-err conn-config-err binding-err conn-up conn-down binding-expn-fail oper-nodeid-change binding-conflict

snmp-server enable traps energywise

snmp-server enable traps fru-ctrl

snmp-server enable traps entity

snmp-server enable traps event-manager

snmp-server enable traps hsrp

snmp-server enable traps ipmulticast

snmp-server enable traps ike policy add

snmp-server enable traps ike policy delete

snmp-server enable traps ike tunnel start

snmp-server enable traps ike tunnel stop

snmp-server enable traps ipsec cryptomap add

snmp-server enable traps ipsec cryptomap delete

snmp-server enable traps ipsec cryptomap attach

snmp-server enable traps ipsec cryptomap detach

snmp-server enable traps ipsec tunnel start

snmp-server enable traps ipsec tunnel stop

snmp-server enable traps ipsec too-many-sas

snmp-server enable traps isis

snmp-server enable traps msdp

snmp-server enable traps ospfv3 state-change

snmp-server enable traps ospfv3 errors

snmp-server enable traps power-ethernet police

snmp-server enable traps pim neighbor-change rp-mapping-change invalid-pim-message

snmp-server enable traps cpu threshold

snmp-server enable traps rep

snmp-server enable traps ipsla

snmp-server enable traps vstack

snmp-server enable traps bridge newroot topologychange

snmp-server enable traps stpx inconsistency root-inconsistency loop-inconsistency

snmp-server enable traps syslog

snmp-server enable traps trustsec-interface unauthorized sap-fail authc-fail supplicant-fail authz-fail

snmp-server enable traps trustsec-server radius-server provision-secret

snmp-server enable traps vtp

snmp-server enable traps vlancreate

snmp-server enable traps vlandelete

snmp-server enable traps flash insertion removal

snmp-server enable traps port-security

snmp-server enable traps envmon fan shutdown supply temperature status

snmp-server enable traps stackwise

snmp-server enable traps ethernet cfm alarm

snmp-server enable traps alarms informational

snmp-server enable traps bulkstat collection transfer

snmp-server enable traps vrfmib vrf-up vrf-down vnet-trunk-up vnet-trunk-down

snmp-server enable traps errdisable

snmp-server enable traps mac-notification change move threshold

snmp-server enable traps vlan-membership

!

no vstack

!

line con 0

 password 7 095E410A1212121E07

 login

line vty 0 4

 login local

 transport input telnet ssh

line vty 5 15

 login local

 transport input telnet ssh

!

ntp server 172.18.1.10

!

end






!

! Last configuration change at 13:30:20 UTC Wed Aug 15 2018

! NVRAM config last updated at 13:42:06 UTC Wed Aug 15 2018

!

version 15.2

service nagle

no service pad

service tcp-keepalives-in

service tcp-keepalives-out

service timestamps debug datetime msec localtime show-timezone

service timestamps log datetime msec localtime show-timezone

service password-encryption

!

hostname SW040

!

boot-start-marker

boot-end-marker

!

!

logging buffered 16384

no logging console

!

no aaa new-model

platform config-upgrade 15.2(6)E

system mtu routing 1500

no ip source-route

ip routing

ip arp inspection vlan 1000

ip arp inspection vlan 1000 logging dhcp-bindings none

!

!

!

no ip domain-lookup

ip igmp snooping querier

vtp mode transparent

!

!

!

!

!

udld aggressive



ptp mode gmc-bc 

ptp priority1 126 

ptp priority2 127 

!





!

crypto pki trustpoint TP-self-signed-857110400

 enrollment selfsigned

 subject-name cn=IOS-Self-Signed-Certificate-857110400

 revocation-check none

 rsakeypair TP-self-signed-857110400

!

!

crypto pki certificate chain TP-self-signed-857110400

 certificate self-signed 01 nvram:IOS-Self-Sig#1.cer

!

spanning-tree mode rapid-pvst

spanning-tree portfast edge bpduguard default

spanning-tree portfast edge bpdufilter default

spanning-tree extend system-id

cip security password 044904050436494205

errdisable recovery cause udld

errdisable recovery cause bpduguard

errdisable recovery cause security-violation

errdisable recovery cause channel-misconfig

errdisable recovery cause pagp-flap

errdisable recovery cause link-flap

errdisable recovery cause sfp-config-mismatch

errdisable recovery cause gbic-invalid

errdisable recovery cause l2ptguard

errdisable recovery cause psecure-violation

errdisable recovery cause port-mode-failure

errdisable recovery cause dhcp-rate-limit

errdisable recovery cause pppoe-ia-rate-limit

errdisable recovery cause mac-limit

errdisable recovery cause vmps

errdisable recovery cause storm-control

errdisable recovery cause inline-power

errdisable recovery cause arp-inspection

errdisable recovery cause link-monitor-failure

errdisable recovery cause oam-remote-failure

errdisable recovery cause loopback

errdisable recovery cause small-frame

errdisable recovery cause psp

errdisable recovery interval 30

port-channel load-balance src-dst-ip

!

alarm profile defaultPort

 alarm not-operating 

 syslog not-operating 

 notifies not-operating 

!

alarm profile ab-alarm

 alarm link-fault not-forwarding not-operating fcs-error 

 syslog link-fault not-forwarding not-operating fcs-error 

 notifies link-fault not-forwarding not-operating fcs-error 

 relay-major not-forwarding 

!

alarm facility power-supply rps disable

alarm facility power-supply rps notifies

alarm facility power-supply rps relay major

alarm facility temperature secondary notifies

alarm facility temperature secondary syslog

alarm facility temperature secondary high 90

alarm facility temperature secondary low 0

!

!

!

!

!

!

vlan 300 

!

vlan 301

 name Native 

!

vlan 501-504 

!

vlan 505

 name VLAN0505 

!

vlan 506

 name VLAN0506 

!

vlan 507-509,601-603 

!

!

class-map match-all 1588-PTP-General

 match access-group 107

class-map match-all 1588-PTP-Event

 match access-group 106

class-map match-all qos-group-2

 match qos-group 2

class-map match-all qos-group-0

 match qos-group 0

class-map match-all qos-group-1

 match qos-group 1

class-map match-all CIP-Implicit_dscp_any

 match access-group 104

class-map match-all CIP-Other

 match access-group 105

class-map match-all voip-data

 match ip dscp ef 

class-map match-any voip-control

 match ip dscp cs3  af31 

class-map match-all CIP-Implicit_dscp_43

 match access-group 103

class-map match-all CIP-Implicit_dscp_55

 match access-group 101

class-map match-all CIP-Implicit_dscp_47

 match access-group 102

!

policy-map Policymap-Output-Wireless

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 40 

 class qos-group-2

  bandwidth percent 40 

 class class-default

  bandwidth percent 16 

policy-map Voice-Map

 class voip-data

  police 320000 8000 conform-action set-qos-transmit 1 exceed-action set-qos-transmit 3

 class voip-control

  police 32000 8000 conform-action set-qos-transmit 2 exceed-action set-qos-transmit 3

policy-map Policymap-Output-Default

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 25 

 class qos-group-2

  bandwidth percent 25 

 class class-default

  bandwidth percent 25 

policy-map PTP-Event-Priority

 class qos-group-0

  priority

 class qos-group-1

  bandwidth remaining percent 40 

 class qos-group-2

  bandwidth remaining percent 40 

 class class-default

  bandwidth remaining percent 20 

policy-map CIP-PTP-Traffic

 class CIP-Implicit_dscp_55

  set qos-group 1

 class CIP-Implicit_dscp_47

  set qos-group 1

 class CIP-Implicit_dscp_43

  set qos-group 1

 class CIP-Implicit_dscp_any

  set qos-group 2

 class CIP-Other

  set qos-group 2

 class 1588-PTP-Event

  set qos-group 0

 class 1588-PTP-General

  set qos-group 1

policy-map Policymap-Output-Phone

 class qos-group-0

  priority

  police 4000000

 class qos-group-1

  bandwidth percent 60 

 class qos-group-2

  bandwidth percent 20 

 class class-default

  bandwidth percent 10 

!

!

! 

!

!

!

!

!

!

!

!

macro global description ab-global | ab-password

!

interface Port-channel1

 switchport trunk native vlan 301

 switchport mode trunk

 macro description switch-automation

 spanning-tree link-type point-to-point

!

interface PRP-channel1

 switchport trunk native vlan 301

 switchport mode trunk

 spanning-tree bpdufilter enable

!

interface GigabitEthernet1/1

 switchport trunk native vlan 301

 switchport mode trunk

 no cdp enable

 ptp vlan 501

 macro description switch-automation

 alarm profile ab-alarm

 no lldp transmit

 no lldp receive

 spanning-tree portfast edge

 spanning-tree link-type point-to-point

 prp-channel-group 1

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/2

 switchport trunk native vlan 301

 switchport mode trunk

 no cdp enable

 ptp vlan 501

 macro description switch-automation

 alarm profile ab-alarm

 no lldp transmit

 no lldp receive

 spanning-tree link-type point-to-point

 prp-channel-group 1

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/3

 switchport trunk native vlan 301

 switchport mode trunk

 macro description switch-automation

 alarm profile ab-alarm

 spanning-tree link-type point-to-point

 channel-group 1 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/4

 switchport trunk native vlan 301

 switchport mode trunk

 macro description switch-automation

 alarm profile ab-alarm

 spanning-tree link-type point-to-point

 channel-group 1 mode active

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/5

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/6

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/7

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/8

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/9

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/10

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/11

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/12

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/13

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/14

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/15

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/16

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/17

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/18

 switchport access vlan 300

 switchport trunk native vlan 300

 alarm profile ab-alarm

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/19

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 no cdp enable

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface GigabitEthernet1/20

 switchport access vlan 501

 switchport trunk native vlan 300

 switchport mode access

 switchport port-security aging type inactivity

 switchport port-security

 load-interval 30

 no cdp enable

 macro description ab-ethernetip

 alarm profile ab-alarm

 spanning-tree portfast edge

 service-policy input CIP-PTP-Traffic

 service-policy output Policymap-Output-Default

!

interface Vlan1

 no ip address

 shutdown

!

interface Vlan300

 ip address 172.18.0.40 255.255.255.0

!

interface Vlan501

 ip address 172.18.1.220 255.255.255.0

 cip enable

!

interface Vlan505

 ip address 172.18.5.1 255.255.255.0

!

interface Vlan506

 ip address 172.18.6.1 255.255.255.0

!

ip forward-protocol nd

!

ip http server

ip http authentication local

ip http secure-server

ip http tls-version TLSv1.2 

ip http session-idle-timeout 1200 

!

ip route 0.0.0.0 0.0.0.0 172.18.0.1

!

!

access-list 101 permit udp any eq 2222 any dscp 55

access-list 102 permit udp any eq 2222 any dscp 47

access-list 103 permit udp any eq 2222 any dscp 43

access-list 104 permit udp any eq 2222 any

access-list 105 permit udp any eq 44818 any

access-list 105 permit tcp any eq 44818 any

access-list 106 permit udp any eq 319 any

access-list 107 permit udp any eq 320 any

!

snmp-server community PlantPAx RO

snmp-server enable traps snmp authentication linkdown linkup coldstart warmstart

snmp-server enable traps transceiver all

snmp-server enable traps call-home message-send-fail server-fail

snmp-server enable traps tty

snmp-server enable traps eigrp

snmp-server enable traps ospf state-change

snmp-server enable traps ospf errors

snmp-server enable traps ospf retransmit

snmp-server enable traps ospf lsa

snmp-server enable traps ospf cisco-specific state-change nssa-trans-change

snmp-server enable traps ospf cisco-specific state-change shamlink interface

snmp-server enable traps ospf cisco-specific state-change shamlink neighbor

snmp-server enable traps ospf cisco-specific errors

snmp-server enable traps ospf cisco-specific retransmit

snmp-server enable traps ospf cisco-specific lsa

snmp-server enable traps license

snmp-server enable traps ethernet cfm cc mep-up mep-down cross-connect loop config

snmp-server enable traps ethernet cfm crosscheck mep-missing mep-unknown service-up

snmp-server enable traps auth-framework sec-violation

snmp-server enable traps bgp cbgp2

snmp-server enable traps ether-oam

snmp-server enable traps cef resource-failure peer-state-change peer-fib-state-change inconsistency

snmp-server enable traps cluster

snmp-server enable traps config-copy

snmp-server enable traps config

snmp-server enable traps config-ctid

snmp-server enable traps trustsec-sxp conn-srcaddr-err msg-parse-err conn-config-err binding-err conn-up conn-down binding-expn-fail oper-nodeid-change binding-conflict

snmp-server enable traps energywise

snmp-server enable traps fru-ctrl

snmp-server enable traps entity

snmp-server enable traps event-manager

snmp-server enable traps hsrp

snmp-server enable traps ipmulticast

snmp-server enable traps isis

snmp-server enable traps msdp

snmp-server enable traps ospfv3 state-change

snmp-server enable traps ospfv3 errors

snmp-server enable traps power-ethernet police

snmp-server enable traps pim neighbor-change rp-mapping-change invalid-pim-message

snmp-server enable traps cpu threshold

snmp-server enable traps rep

snmp-server enable traps ipsla

snmp-server enable traps vstack

snmp-server enable traps bridge newroot topologychange

snmp-server enable traps stpx inconsistency root-inconsistency loop-inconsistency

snmp-server enable traps syslog

snmp-server enable traps vtp

snmp-server enable traps vlancreate

snmp-server enable traps vlandelete

snmp-server enable traps flash insertion removal

snmp-server enable traps port-security

snmp-server enable traps envmon fan shutdown supply temperature status

snmp-server enable traps stackwise

snmp-server enable traps ethernet cfm alarm

snmp-server enable traps alarms informational

snmp-server enable traps bulkstat collection transfer

snmp-server enable traps vrfmib vrf-up vrf-down vnet-trunk-up vnet-trunk-down

snmp-server enable traps errdisable

snmp-server enable traps mac-notification change move threshold

snmp-server enable traps vlan-membership

!

vstack

!

line con 0

 password 7 1500040F0F3D2E2824

 login

line vty 0 4

 password 7 1500040F0F3D2E2824

 login local

 transport input telnet ssh

line vty 5 15

 password 7 1500040F0F3D2E2824

 login local

 transport input telnet ssh

!

ntp server 172.18.1.10 prefer

!

end





